Copyright Notice

Notice
Document information is subject to change without notice by Siemens Switzerland Ltd. Companies, names, and various data used in examples are fictitious unless otherwise noted. No part of this document may be reproduced or transmitted in any form or by any means, electronic or mechanical, for any purpose, without the express written permission of Siemens Switzerland Ltd.

All software described in this document is furnished under a license agreement and may be used or copied only in accordance with license terms.

For further information, contact your nearest Siemens Switzerland Ltd. representative.

Credits
Desigo, Desigo CC, Cerberus DMS, Cerberus PRO, and Sinteso are registered trademarks of Siemens Switzerland Ltd.

Other product or company names mentioned herein may be the trademarks of their respective owners.

Edition: 2017-11-30
Document ID: A6V10415471

© Siemens Switzerland Ltd, 2017
Table of Contents

About this Document ........................................................................................................ 9
1  Getting Started ............................................................................................................. 13
  1.1  User Interface ........................................................................................................ 13
  1.2  Graphical Elements and Controls ....................................................................... 14
  1.3  Operational Workflows ...................................................................................... 16
  1.4  Starting and Exiting the System .......................................................................... 18
    1.4.1  Launching an Installed Client .................................................................... 18
    1.4.2  Launching a Web Client ............................................................................ 18
    1.4.3  Launching a Windows App Client .............................................................. 19
    1.4.4  Exiting the Application ............................................................................ 19
    1.4.5  Interrupting the Auto Logoff .................................................................. 20
    1.4.6  Accessing a Closed Mode Client .............................................................. 20
    1.4.7  Exiting a Closed Mode Session ................................................................ 20
    1.4.8  Changing Your Password ....................................................................... 21
    1.4.9  Doing an Operator Switchover .................................................................. 21
  1.5  System Screen ....................................................................................................... 22
    1.5.1  System Screen Reference .......................................................................... 22
    1.5.2  Working with the System Screen ............................................................... 27
  1.6  Types of Stations in the Management Platform ..................................................... 31
  1.7  Client Station Troubleshooting .......................................................................... 32
    1.7.1  Client Application Needs to Restart ......................................................... 32
    1.7.2  Troubleshooting Logon Problems .............................................................. 33
    1.7.3  Troubleshooting the Web Client and Windows App Client ....................... 33
2  System Manager ......................................................................................................... 34
  2.1  Working with System Manager ............................................................................ 34
    2.1.1  Creating Additional System Manager Windows ....................................... 34
    2.1.2  Closing Additional System Manager Windows ....................................... 34
    2.1.3  Changing the Pane Layout of System Manager ....................................... 35
    2.1.4  Allowing or Preventing Opening of the Secondary Pane ......................... 36
    2.1.5  Setting How Objects are Labeled in System Manager .............................. 36
    2.1.6  Setting How Selections Propagate to Other Panes .................................... 36
    2.1.7  Manually Propagating a Selection to Other Panes ................................... 37
    2.1.8  Sending a Selection to the Secondary Pane ............................................. 37
    2.1.9  Selecting an Object in System Browser .................................................. 38
    2.1.10 Selecting Multiple Objects in System Browser ........................................ 38
    2.1.11 Browsing and Selecting Objects with the Navigation Bar ......................... 39
    2.1.12 Revisiting Recent Selections from the Navigation Bar .............................. 40
    2.1.13 Setting a Favorite Location in System Manager ....................................... 41
    2.1.14 Revisiting Recent Selections from Recently Viewed ................................... 41
  2.2  System Manager Reference ................................................................................... 42
    2.2.1  Overview of System Manager .................................................................... 42
    2.2.2  System Manager Navigation Workflows .................................................. 43
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.2.3</td>
<td>Operating and Engineering Mode</td>
<td>45</td>
</tr>
<tr>
<td>2.2.4</td>
<td>Navigation Bar Reference</td>
<td>47</td>
</tr>
<tr>
<td>2.2.5</td>
<td>Recently Viewed Reference</td>
<td>48</td>
</tr>
<tr>
<td>2.3</td>
<td>System Browser</td>
<td>49</td>
</tr>
<tr>
<td>2.3.1</td>
<td>Working with System Browser</td>
<td>49</td>
</tr>
<tr>
<td>2.3.2</td>
<td>System Browser Reference</td>
<td>51</td>
</tr>
<tr>
<td>2.4</td>
<td>Textual Viewer</td>
<td>56</td>
</tr>
<tr>
<td>2.4.1</td>
<td>Working with Textual Viewer</td>
<td>56</td>
</tr>
<tr>
<td>2.4.2</td>
<td>Textual Viewer Reference</td>
<td>57</td>
</tr>
<tr>
<td>2.5</td>
<td>Operation/Extended Operation</td>
<td>60</td>
</tr>
<tr>
<td>2.5.1</td>
<td>Working with Operation/Extended Operation</td>
<td>60</td>
</tr>
<tr>
<td>2.5.2</td>
<td>Operation/Extended Operation Reference</td>
<td>61</td>
</tr>
<tr>
<td>2.6</td>
<td>Related Items</td>
<td>65</td>
</tr>
<tr>
<td>2.6.1</td>
<td>Working with Related Items</td>
<td>65</td>
</tr>
<tr>
<td>2.6.2</td>
<td>Related Items Reference</td>
<td>66</td>
</tr>
<tr>
<td>3</td>
<td>Alarms</td>
<td>69</td>
</tr>
<tr>
<td>3.1</td>
<td>Working with Alarms</td>
<td>69</td>
</tr>
<tr>
<td>3.1.1</td>
<td>Opening and Closing Event List</td>
<td>69</td>
</tr>
<tr>
<td>3.1.2</td>
<td>Selecting an Event in Event List (Fast Treatment)</td>
<td>69</td>
</tr>
<tr>
<td>3.1.3</td>
<td>Selecting Multiple Events in Event List</td>
<td>70</td>
</tr>
<tr>
<td>3.1.4</td>
<td>Sending Alarm-Handling Commands in Fast Treatment or Investigative Treatment</td>
<td>70</td>
</tr>
<tr>
<td>3.1.5</td>
<td>Handling an Event with Investigative Treatment</td>
<td>71</td>
</tr>
<tr>
<td>3.1.6</td>
<td>Handling an Event with Assisted Treatment</td>
<td>72</td>
</tr>
<tr>
<td>3.1.7</td>
<td>Interrupting Handling of an Alarm</td>
<td>80</td>
</tr>
<tr>
<td>3.1.8</td>
<td>Deselecting (Suspending) an Event in Event List</td>
<td>81</td>
</tr>
<tr>
<td>3.1.9</td>
<td>Entering an Event Note in the History Database</td>
<td>81</td>
</tr>
<tr>
<td>3.1.10</td>
<td>Viewing the Inline Information Text</td>
<td>81</td>
</tr>
<tr>
<td>3.1.11</td>
<td>Inspecting the Source of an Event in System Manager</td>
<td>82</td>
</tr>
<tr>
<td>3.1.12</td>
<td>Using the Contextual Pane in Event Handling</td>
<td>82</td>
</tr>
<tr>
<td>3.1.13</td>
<td>Changing the Sorting of Events</td>
<td>83</td>
</tr>
<tr>
<td>3.1.14</td>
<td>Handling Recurrences of an Event</td>
<td>83</td>
</tr>
<tr>
<td>3.1.15</td>
<td>Printing the Whole Event List</td>
<td>85</td>
</tr>
<tr>
<td>3.1.16</td>
<td>Filtering Event List</td>
<td>85</td>
</tr>
<tr>
<td>3.1.17</td>
<td>Customizing the Columns in Event List</td>
<td>90</td>
</tr>
<tr>
<td>3.2</td>
<td>Alarms and Event Treatment Reference</td>
<td>92</td>
</tr>
<tr>
<td>3.2.1</td>
<td>Event List and Alarms Operation Reference</td>
<td>92</td>
</tr>
<tr>
<td>4</td>
<td>Graphics Viewer</td>
<td>115</td>
</tr>
<tr>
<td>4.1</td>
<td>Working with Graphics Viewer</td>
<td>115</td>
</tr>
<tr>
<td>4.1.1</td>
<td>Commanding Off-Normal Properties</td>
<td>115</td>
</tr>
<tr>
<td>4.1.2</td>
<td>Commanding Properties in Graphics Viewer</td>
<td>115</td>
</tr>
<tr>
<td>4.1.3</td>
<td>Creating a Graphic</td>
<td>116</td>
</tr>
<tr>
<td>4.1.4</td>
<td>Creating a Graphics Sub-Folder</td>
<td>116</td>
</tr>
<tr>
<td>4.1.5</td>
<td>Deleting a Graphic Item</td>
<td>117</td>
</tr>
<tr>
<td>4.1.6</td>
<td>Disabling Point Centered Display Mode</td>
<td>117</td>
</tr>
<tr>
<td>4.1.7</td>
<td>Displaying a Graphic</td>
<td>117</td>
</tr>
<tr>
<td>Section</td>
<td>Title</td>
<td>Page</td>
</tr>
<tr>
<td>---------</td>
<td>----------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>4.1.8</td>
<td>Displaying and Hiding Coverage Area</td>
<td>118</td>
</tr>
<tr>
<td>4.1.9</td>
<td>Displaying Properties</td>
<td>118</td>
</tr>
<tr>
<td>4.1.10</td>
<td>Dragging Object Properties from the Graphics Viewer</td>
<td>118</td>
</tr>
<tr>
<td>4.1.11</td>
<td>Editing a Graphic</td>
<td>119</td>
</tr>
<tr>
<td>4.1.12</td>
<td>Enabling Point Centered Display Mode</td>
<td>119</td>
</tr>
<tr>
<td>4.1.13</td>
<td>Navigating to a Linked Element</td>
<td>119</td>
</tr>
<tr>
<td>4.1.14</td>
<td>Navigating to the Graphics Library Browser from System Browser</td>
<td>120</td>
</tr>
<tr>
<td>4.1.15</td>
<td>Printing from the Graphics Viewer</td>
<td>120</td>
</tr>
<tr>
<td>4.1.16</td>
<td>Selecting Objects from System Browser</td>
<td>120</td>
</tr>
<tr>
<td>4.1.17</td>
<td>Selecting Objects within Graphics Viewer</td>
<td>121</td>
</tr>
<tr>
<td>4.1.18</td>
<td>Using the Depths Navigation View</td>
<td>121</td>
</tr>
<tr>
<td>4.1.19</td>
<td>Working with the Aerial View</td>
<td>122</td>
</tr>
<tr>
<td>4.1.20</td>
<td>Zooming in the Graphics Viewer</td>
<td>122</td>
</tr>
<tr>
<td>4.2</td>
<td>Graphics Viewer Reference</td>
<td>123</td>
</tr>
<tr>
<td>4.2.1</td>
<td>Overview of Graphics Viewer</td>
<td>123</td>
</tr>
<tr>
<td>4.2.2</td>
<td>Graphics Viewer Workspace</td>
<td>130</td>
</tr>
<tr>
<td>5</td>
<td>Remote Notifications</td>
<td>138</td>
</tr>
<tr>
<td>5.1</td>
<td>Working with Remote Notifications</td>
<td>138</td>
</tr>
<tr>
<td>5.1.1</td>
<td>Sending a ‘New’ (Operator-Issued) Remote Notification</td>
<td>138</td>
</tr>
<tr>
<td>5.1.2</td>
<td>Monitoring the Progress and Outcomes of Sent Notifications</td>
<td>139</td>
</tr>
<tr>
<td>5.1.3</td>
<td>Re-Sending a Remote Notification from the Message Status List</td>
<td>140</td>
</tr>
<tr>
<td>5.1.4</td>
<td>Starting a Remote Notification from Event List</td>
<td>140</td>
</tr>
<tr>
<td>5.1.5</td>
<td>Stopping a Remote Notification from Event List</td>
<td>141</td>
</tr>
<tr>
<td>5.1.6</td>
<td>Stopping a Remote Notification from the Message Status List</td>
<td>141</td>
</tr>
<tr>
<td>5.1.7</td>
<td>Halting the Escalation of a Remote Notification</td>
<td>142</td>
</tr>
<tr>
<td>5.1.8</td>
<td>Disabling an Alarm-Triggered Remote Notification</td>
<td>142</td>
</tr>
<tr>
<td>5.2</td>
<td>Remote Notifications Reference</td>
<td>143</td>
</tr>
<tr>
<td>5.2.1</td>
<td>Overview of Remote Notifications</td>
<td>143</td>
</tr>
<tr>
<td>5.2.2</td>
<td>RENO Messages Reference</td>
<td>144</td>
</tr>
<tr>
<td>5.2.3</td>
<td>New Remote Notification in the Secondary Pane</td>
<td>152</td>
</tr>
<tr>
<td>6</td>
<td>Schedules</td>
<td>153</td>
</tr>
<tr>
<td>6.1</td>
<td>Working with Schedules</td>
<td>153</td>
</tr>
<tr>
<td>6.1.1</td>
<td>Working with BACnet Schedules</td>
<td>153</td>
</tr>
<tr>
<td>6.1.2</td>
<td>Working with Management Station Schedules</td>
<td>159</td>
</tr>
<tr>
<td>6.1.3</td>
<td>Working with Timeline Viewer</td>
<td>163</td>
</tr>
<tr>
<td>6.2</td>
<td>Schedules Reference</td>
<td>165</td>
</tr>
<tr>
<td>6.2.1</td>
<td>BACnet Schedules Reference</td>
<td>165</td>
</tr>
<tr>
<td>6.2.2</td>
<td>Management Station Schedules Reference</td>
<td>171</td>
</tr>
<tr>
<td>6.2.3</td>
<td>Timeline Viewer Reference</td>
<td>175</td>
</tr>
<tr>
<td>7</td>
<td>Trends</td>
<td>177</td>
</tr>
<tr>
<td>7.1</td>
<td>Working with Trends</td>
<td>177</td>
</tr>
<tr>
<td>7.1.1</td>
<td>Defining Trend Views</td>
<td>177</td>
</tr>
<tr>
<td>7.1.2</td>
<td>Working with Offline Trend Log Objects</td>
<td>187</td>
</tr>
<tr>
<td>7.1.3</td>
<td>Analyzing Trend Data</td>
<td>192</td>
</tr>
</tbody>
</table>
7.1.4 Printing Trend Data ........................................ 198
7.1.5 Manual Correction Application .............................. 200
7.2 Trends Reference .............................................. 204
7.2.1 Overview of Trends Application ............................ 204
7.2.2 Trends in Distributed Systems ............................ 205
7.2.3 Online and Offline Trends .................................. 205
7.2.4 Trend Data Storage .......................................... 206
7.2.5 Trends Workspace ........................................... 208
7.2.6 Trend View Properties ...................................... 223
7.2.7 Offline Trendlog Objects .................................... 228
7.2.8 Uploading Offline Trendlog Data Manually ............... 229
7.2.9 Manual Correction Application ............................ 230
7.2.10 Manual Correction Workspace ............................ 230
7.2.11 Manual Correction Toolbar ................................ 231
7.2.12 Filtered Data Section ....................................... 231
8 Reports .................................................................. 233
8.1 Working with Reports .......................................... 233
8.1.1 Creating a New Report Definition .......................... 233
8.1.2 Creating and Deleting Reports Folders ...................... 233
8.1.3 Configuring a Report Definition ............................. 234
8.1.4 Saving a Report Definition ................................... 248
8.1.5 Creating a New Report Definition from an Existing One 248
8.1.6 Modifying a Report Definition ............................... 249
8.1.7 Saving a Report Definition as the Default Template .... 249
8.1.8 Generating a Report Manually using Run or Run as .. 250
8.1.9 Generating a Report Manually from Related Items Tab 251
8.1.10 Generating a Report Automatically ....................... 251
8.1.11 Viewing Data of Deleted Objects .......................... 252
8.1.12 Printing Automatically Generated Reports ............... 252
8.1.13 Printing Manually Generated Reports .................... 253
8.1.14 Working with Reports in Run Mode ....................... 253
8.1.15 Generating a PDF Document ............................... 255
8.1.16 Generating an Excel Document without a Template . 255
8.1.17 Generating an Excel Document with a Template ....... 255
8.1.18 Routing Reports ............................................. 257
8.1.19 Exporting a Report Definition ............................... 261
8.1.20 Importing a Report Definition ............................... 262
8.1.21 Deleting a Report Definition ................................. 263
8.1.22 Aborting a Running Report Definition .................... 263
8.1.23 Working with Reports and Operators ...................... 264
8.2 Reports Reference .............................................. 268
8.2.1 Overview of Reports .......................................... 269
8.2.2 Reports in Distributed Systems ............................ 270
8.2.3 Reports Workspace .......................................... 272
8.2.4 Reports Toolbar .............................................. 273
8.2.5 Reports Ribbon — Home Tab ............................... 275
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>8.2.6 Reports Ribbon — Filter Tab</td>
<td>290</td>
</tr>
<tr>
<td>8.2.7 Reports Ribbon — Layout Tab</td>
<td>299</td>
</tr>
<tr>
<td>8.2.8 Reports Ribbon — Data Tab</td>
<td>301</td>
</tr>
<tr>
<td>8.2.9 Reports Ribbon — Settings Tab</td>
<td>302</td>
</tr>
<tr>
<td>8.2.10 Report Management Section</td>
<td>316</td>
</tr>
<tr>
<td>8.2.11 Related Items Tab</td>
<td>317</td>
</tr>
<tr>
<td>8.2.12 Reports Modes</td>
<td>318</td>
</tr>
<tr>
<td>8.2.13 Report Workpanes</td>
<td>320</td>
</tr>
<tr>
<td>8.2.14 Validating a Report Definition</td>
<td>324</td>
</tr>
<tr>
<td>8.2.15 Report and Operators</td>
<td>325</td>
</tr>
<tr>
<td>8.2.16 Reports Troubleshooting</td>
<td>332</td>
</tr>
<tr>
<td>9 Log Viewer</td>
<td>334</td>
</tr>
<tr>
<td>9.1 Working with Log Viewer</td>
<td>334</td>
</tr>
<tr>
<td>9.1.1 Accessing Log Viewer from System Browser</td>
<td>334</td>
</tr>
<tr>
<td>9.1.2 Configuring a Log View Definition</td>
<td>334</td>
</tr>
<tr>
<td>9.1.3 Managing Log View Folders</td>
<td>344</td>
</tr>
<tr>
<td>9.1.4 Saving a Log View Definition</td>
<td>344</td>
</tr>
<tr>
<td>9.1.5 Creating a New Log View Definition from an Existing One</td>
<td>344</td>
</tr>
<tr>
<td>9.1.6 Saving a Log View Definition as a Report Definition</td>
<td>345</td>
</tr>
<tr>
<td>9.1.7 Creating a Default Log View Template</td>
<td>345</td>
</tr>
<tr>
<td>9.1.8 Deleting a Log View Definition</td>
<td>346</td>
</tr>
<tr>
<td>9.1.9 Printing Log Grid Contents</td>
<td>346</td>
</tr>
<tr>
<td>9.1.10 Exporting a Log View Definition</td>
<td>346</td>
</tr>
<tr>
<td>9.1.11 Importing a Log View Definition</td>
<td>346</td>
</tr>
<tr>
<td>9.1.12 Viewing Object Properties and Hierarchy</td>
<td>347</td>
</tr>
<tr>
<td>9.1.13 Refreshing a Log View</td>
<td>347</td>
</tr>
<tr>
<td>9.2 Log Viewer Reference</td>
<td>347</td>
</tr>
<tr>
<td>9.2.1 Overview of Log Viewer</td>
<td>348</td>
</tr>
<tr>
<td>9.2.2 Log Viewer in Distributed Systems</td>
<td>351</td>
</tr>
<tr>
<td>9.2.3 Log Viewer Workspace</td>
<td>352</td>
</tr>
<tr>
<td>9.2.4 Log Viewer Toolbar</td>
<td>353</td>
</tr>
<tr>
<td>9.2.5 Select Columns Dialog Box</td>
<td>354</td>
</tr>
<tr>
<td>9.2.6 Custom Filter</td>
<td>355</td>
</tr>
<tr>
<td>9.2.7 Search Filter Dialog Box</td>
<td>359</td>
</tr>
<tr>
<td>9.2.8 Detailed Log Tab</td>
<td>361</td>
</tr>
<tr>
<td>10 Macros</td>
<td>364</td>
</tr>
<tr>
<td>10.1 Working with Macros</td>
<td>364</td>
</tr>
<tr>
<td>10.1.1 Browsing the Existing Macros in the System</td>
<td>364</td>
</tr>
<tr>
<td>10.1.2 Executing a Macro from the Operation Tab</td>
<td>364</td>
</tr>
<tr>
<td>10.1.3 Executing a Macro from a Graphic</td>
<td>365</td>
</tr>
<tr>
<td>10.1.4 Manually Executing the Project Backup Macro</td>
<td>365</td>
</tr>
<tr>
<td>10.1.5 Using a ‘Block Command Macro’ to Acknowledge all Devices on a Fire Network</td>
<td>365</td>
</tr>
<tr>
<td>10.2 Macros Reference</td>
<td>366</td>
</tr>
<tr>
<td>10.2.1 Properties and Commands of a Macro</td>
<td>367</td>
</tr>
<tr>
<td>10.2.2 Block Command Macros</td>
<td>369</td>
</tr>
<tr>
<td>Chapter</td>
<td>Section</td>
</tr>
<tr>
<td>---------</td>
<td>---------</td>
</tr>
<tr>
<td>11</td>
<td>Reactions</td>
</tr>
<tr>
<td>11.1</td>
<td>Enabling or Disabling a Reaction</td>
</tr>
<tr>
<td>11.2</td>
<td>Reactions Reference</td>
</tr>
<tr>
<td>11.2.1</td>
<td>Properties and Commands of a Reaction</td>
</tr>
<tr>
<td>12</td>
<td>Organization Modes</td>
</tr>
<tr>
<td>12.1</td>
<td>Manually Setting an Organization Mode</td>
</tr>
<tr>
<td>12.2</td>
<td>Organization Modes Reference</td>
</tr>
<tr>
<td>12.2.1</td>
<td>Properties and Commands of an Organization Mode</td>
</tr>
<tr>
<td>13</td>
<td>Address Book</td>
</tr>
<tr>
<td>13.1</td>
<td>Working with Address Book</td>
</tr>
<tr>
<td>13.1.1</td>
<td>Creating Email Recipients for Reports in the Address Book</td>
</tr>
<tr>
<td>13.1.2</td>
<td>Creating Recipient Groups for Remote Notifications in the Address Book</td>
</tr>
<tr>
<td>13.1.3</td>
<td>Assigning Existing Address Book Contacts to a Recipient Group for Remote Notifications</td>
</tr>
<tr>
<td>13.1.4</td>
<td>Importing Outlook Contacts into the Address Book</td>
</tr>
<tr>
<td>13.2</td>
<td>Address Book Reference</td>
</tr>
<tr>
<td>13.2.1</td>
<td>Details of an Address Book Contact</td>
</tr>
<tr>
<td>13.2.2</td>
<td>Address Book Toolbar</td>
</tr>
<tr>
<td>13.2.3</td>
<td>Address Book Search Field</td>
</tr>
<tr>
<td>13.2.4</td>
<td>Outlook Import Rules for the Address Book</td>
</tr>
<tr>
<td>14</td>
<td>Documents</td>
</tr>
<tr>
<td>14.1</td>
<td>Working with Documents</td>
</tr>
<tr>
<td>14.1.1</td>
<td>Viewing the Documents Configured in the System</td>
</tr>
<tr>
<td>14.1.2</td>
<td>Opening Documents from Related Items</td>
</tr>
<tr>
<td>14.1.3</td>
<td>Setting the File or Web Link of a Document Object</td>
</tr>
<tr>
<td>14.1.4</td>
<td>Making a Document Display as a Related Item of Other Objects</td>
</tr>
<tr>
<td>14.2</td>
<td>Documents Reference</td>
</tr>
<tr>
<td>14.2.1</td>
<td>Document Settings Fields</td>
</tr>
<tr>
<td>14.2.2</td>
<td>Document Toolbar Controls</td>
</tr>
<tr>
<td>15</td>
<td>Licensing</td>
</tr>
<tr>
<td>15.1</td>
<td>Licensing Reference</td>
</tr>
<tr>
<td>15.1.1</td>
<td>Licenses Properties</td>
</tr>
<tr>
<td>15.1.2</td>
<td>License Features List</td>
</tr>
<tr>
<td>15.1.3</td>
<td>Normal License Mode</td>
</tr>
<tr>
<td>15.1.4</td>
<td>Demo License Mode</td>
</tr>
<tr>
<td>15.1.5</td>
<td>Courtesy License Mode</td>
</tr>
</tbody>
</table>
About this Document

Purpose
This manual describes the features of the Desigo CC management station. It provides casual users with in-depth reference information for the different system features, including workflows, and is designed to support users in their daily site-related monitoring and controlling activities.

Scope
This document applies to Desigo CC Version 3.0.

Target Audience
End-Users are the primary users of the system. Depending on the specific application, end users can be a building services engineer, a security guard, a member of the fire brigade, the facility manager, and so on. They are responsible for monitoring and managing the facility and any related events. They have the appropriate training for operating the management station.
Liability Disclaimer

We have checked the contents of this manual for agreement with the hardware and software described. Since deviations cannot be precluded entirely, we cannot guarantee full agreement. However, the data in this manual are reviewed regularly and any necessary corrections included in subsequent editions. Suggestions for improvement are welcome.

Product Security Disclaimer

Siemens products and solutions provide IT-specific security functions to ensure the secure operation of building comfort, fire safety, security management and physical security systems. The security functions on these products and solutions are important components of a comprehensive security concept.

However, it is necessary to implement and maintain a comprehensive, state-of-the-art security concept that is customized to individual security needs. Such a security concept may result in additional site-specific preventive action to ensure that the building comfort, fire safety, security management or physical security systems for your site are operated in a secure manner. These measures may include, but are not limited to, separating networks, physically protecting system components, user awareness programs, in-depth security, and so on.

For additional information on building technology security and our offerings, contact your Siemens sales or project department. We strongly recommend signing up for our security advisories, which provide information on the latest security threats, patches and other mitigation measures.

## Document Conventions

The following table lists conventions to help you use this document in a quick and efficient manner.

<table>
<thead>
<tr>
<th>Convention</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Numbered Lists (1, 2, 3…) indicate a procedure with sequential steps.</td>
<td>1. Turn OFF power to the field panel.</td>
</tr>
<tr>
<td></td>
<td>2. Turn ON power to the field panel.</td>
</tr>
<tr>
<td></td>
<td>3. Open the panel.</td>
</tr>
<tr>
<td>One-step procedures are indicated by a bullet point.</td>
<td>• Expand the Event List.</td>
</tr>
<tr>
<td>Conditions that you must complete or must be met before beginning a procedure are designated with ▶.</td>
<td>▶ The report you want to print is open.</td>
</tr>
<tr>
<td>Intermediate results (what will happen following the execution of a procedure step), are designated with an indented ⇨.</td>
<td>1. Click Print.</td>
</tr>
<tr>
<td>Results, after completing a procedure, are designated with a ⇨.</td>
<td>▶ The Print dialog box displays.</td>
</tr>
<tr>
<td></td>
<td>2. Select the printer and click Print.</td>
</tr>
<tr>
<td></td>
<td>▶ The print confirmation displays.</td>
</tr>
<tr>
<td>Bold font indicates something you should type or select, or when a dialog box or window is specified.</td>
<td>Type F for field panels.</td>
</tr>
<tr>
<td></td>
<td>Click OK to save changes and close the dialog box.</td>
</tr>
<tr>
<td></td>
<td>The Create a New Project dialog box displays.</td>
</tr>
<tr>
<td>Menu paths in procedures are indicated in bold.</td>
<td>Select File &gt; Text, Copy &gt; Group, which means from the File menu, select Text, Copy and then Group.</td>
</tr>
<tr>
<td>File paths containing placeholders display the placeholders in italics enclosed in square brackets.</td>
<td>[installation drive]:[installation folder][project]...</td>
</tr>
<tr>
<td>Error and system messages are displayed in Courier New font.</td>
<td>The message Report Definition successfully renamed displays in the status bar.</td>
</tr>
<tr>
<td>Italics are used to emphasize new or important terms.</td>
<td>The reaction processor continuously executes a user-defined set of instructions called the control program.</td>
</tr>
<tr>
<td></td>
<td>This symbol signifies a Note. Notes provide additional information or helpful hints.</td>
</tr>
<tr>
<td>Cross references to other information in printed material are indicated with an arrow and the page number, enclosed in brackets:</td>
<td>For more information on creating flowcharts, see Flowcharts [→ 92].</td>
</tr>
</tbody>
</table>

## Getting Help

For more information about the Desigo CC products, contact your local sales representative.
Safety Messages According to ANSI Z535.6

ANSI standard safety messages are used throughout Help to make you aware of important information. ANSI distinguishes between *property damage* messages and *personal injury* messages.

- The property damage message has this label: NOTICE.
- The personal injury messages have these labels: CAUTION!, WARNING!, DANGER!

Examples:

<table>
<thead>
<tr>
<th>![Notice Icon]</th>
<th><strong>NOTICE</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Property Damage Warning Message</strong></td>
<td>Equipment damage or loss of data may occur if you do not follow a procedure or instruction as specified.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>![Caution Icon]</th>
<th><strong>CAUTION</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Caution Safety Message</strong></td>
<td>Minor or moderate injury may occur if you do not follow a procedure or instruction as specified.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>![Warning Icon]</th>
<th><strong>WARNING</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Warning Safety Message</strong></td>
<td>Personal injury or property damage may occur if you do not follow a procedure as specified.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>![Danger Icon]</th>
<th><strong>DANGER</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Danger Safety Message</strong></td>
<td>Electric shock, death, or severe property damage may occur if you do not perform a procedure as specified.</td>
</tr>
</tbody>
</table>
1 Getting Started

This section provides an introductory overview of the Desigo CC user interface and its typical navigation workflows.

1.1 User Interface

The exact screen layout will vary depending on your particular system’s configuration, and you may not see all the components described.

Main Screen Layout in Building Automation Profiles

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Summary bar</td>
<td>The main point of entry to all the functions of the software. It may be collapsed and you must click the down icon on the top right to display it.</td>
</tr>
<tr>
<td>2 Work area</td>
<td>Large central portion of the screen below the Summary bar. The window displayed here will vary depending on what system function is being used. It will typically contain the System Manager window. It can also display the Event List, or Investigative or Assisted Treatment windows, the system help and external documents or applications.</td>
</tr>
</tbody>
</table>
In particular, depending on the operational workflow, the following windows can display in the work area:

- **Event List**
  A list of all the events in the building-control system. This is the starting point for viewing and handling events. Depending on the particular system's configuration, Event List may be hidden or minimized into an Event bar and you can open it in the work area when needed by clicking its icon (in the Summary bar or in the Event bar).

- **System Manager**
  A multi-pane window for navigating, monitoring, and controlling all the components and subsystems of the site. Each pane contains a functional component of the management platform (for example, a browser for navigating and selecting system objects, a viewer for displaying site floor plans, tools for scheduling tasks, and so on).

- **Investigative Treatment** or **Assisted Treatment**
  When you start to process an event, one of these dedicated alarm-handling windows may open in the main work area to help you take the correct actions.

### 1.2 Graphical Elements and Controls

#### Layout and Panes

The system screen can display many windows, some of which are made up of multiple panes, divided by splitters. A window can contain up to four panes. Each pane houses a functional component of Desigo CC (such as a browser for navigating and selecting system objects, a viewer for displaying site floor plans or tools for inspecting the properties of objects).

![Diagram of window layout](image)

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>3</td>
</tr>
<tr>
<td>4</td>
</tr>
<tr>
<td>5</td>
</tr>
</tbody>
</table>
Interacting with the Graphical Elements

You can arrange panes of a window in different layouts or interact with a window and its panes in various ways. These include:

- Click the icons on the window title bar top to minimize, restore down, or maximize the window.

- Click the icons on the window title bar to quickly switch between the available preset layouts:
  - Selection, Primary, and Contextual panes. The Secondary pane displays only if it is already open.
  - Selection, Primary, and Contextual panes
  - Selection and Primary panes
  - Primary, and Contextual panes. The Secondary pane displays only if it is already open.
  - Primary pane only

- Resize the panes in a layout by dragging the splitters, or expand/collapse a pane by clicking the button on the splitter.

- Click the icon to lock the window layout. When the layout is locked, clicking one of the layout icons will not have any effect; this means that you cannot change the current layout, and resize, expand, or collapse the panes of the window.

- Normally, the Secondary pane opens on demand, when you make a selection that requires it. When the Secondary pane opens, it takes up half the space that would otherwise be allotted to the Primary pane.

- You can prevent the Secondary pane from opening by clicking the pushpin icon and locking the Primary pane. When the Primary pane is locked, any selections (such as Related Items) that would normally display in the Secondary pane are instead redirected to the Primary pane.
1.3 Operational Workflows

This section introduces you to the most common workflows for navigating and interacting with Desigo CC.

**Basic Navigation Workflow**

The following graphic shows the typical workflow for navigating the system:

1. Select a view (1) in System Browser, in the **Selection** pane, such as **Application View**.
   - The selected view displays in the System Browser tree.
2. Navigate the tree and select the object (2) you want to work with.
   - The information about the selected object displays in the **Textual Viewer** (3), in the **Primary** pane.
   - The properties of the selected object display in the **Operation** tab (4), in the **Contextual** pane.
   - Links to additional resources associated with the selected object display in the **Related Items** tab (5), in the **Contextual** pane.
3. Click a related item link (5), such as **New Remote Notification**, to open that resource in the **Secondary** pane.
   - The selected related item displays in the **Secondary** pane (6).
4. If necessary, click the icon (7) to display the navigation bar (8) with icons for moving back and forth between the most recent screens in the **Primary** pane and going back to the favorite location.
Object Association Workflow

The following graphic shows the typical workflow for manual selection and drag-and-drop, in order to associate two objects:

1. Select a view (1) in System Browser, in the **Selection** pane, for example **Application View**.
   - The selected view displays in the System Browser tree.

2. Navigate the tree to select the object (2) you want to work with, for example **Activity Log**.

3. Select **Manual Navigation** (3), to freeze the **Primary** pane, for example **Reports > Activity Log**.

4. Drag and drop the selected object (4), for example **Address Book**, to the reports area.
1.4 Starting and Exiting the System

This section contains instructions for: starting up or shutting down the Desigo CC client application, changing your password, or doing an operator switchover. Perform the procedures in this section as needed.

1.4.1 Launching an Installed Client

▷ You want to start Desigo CC on a computer where the Desigo CC software is installed as a normal Windows application.

1. Start Desigo CC from the **Windows Start** button or by clicking the icon on the desktop.
   - The logon dialog box displays. You can log on to the system as a Desigo CC user or Windows user.

2. Enter your username and password.

3. Select the domain.

4. Click **Logon**.

**Related Topics**
Doing an Operator Switchover [➙ 21]
Exiting the Application [➙ 19]
Troubleshooting Logon Problems [➙ 33]
Types of Stations in the Management Platform [➙ 31]

1.4.2 Launching a Web Client

▷ You want to start Desigo CC as a browser-based application, on a computer that was configured to operate as a Web Client.

▷ The authentication certificate was previously installed on the computer (see Browsing a Website or Web Application URL).

1. Launch **Microsoft Internet Explorer**.

2. In the address bar of the browser, enter the name of the computer where the Desigo CC Web Server resides (for example, //ITP0990c/).
   - **NOTE:** If you do not have this information, please contact your system administrator.
   - The Desigo CC page opens in the browser, and the Desigo CC tab contents display.

3. Click the Desigo CC tab, and select the **Web Client** thumbnail.
   - The logon dialog box displays in the browser.

4. Enter your username and password.

5. Select the domain.

6. Click **Logon**.

**Related Topics**
Troubleshooting Logon Problems [➙ 33]
Types of Stations in the Management Platform [➙ 31]
1.4.3 Launching a Windows App Client

➤ You want to start Desigo CC from a computer configured to operate as a Windows App Client, where the client software is downloaded and installed on demand from a browser.

➤ The authentication certificate was previously installed on the computer (see Browsing a Website or Web Application URL).

1. Launch Microsoft Internet Explorer.

2. In the address bar of the browser, enter the name of the computer where the Desigo CC Web Server resides (for example, //ITP0990c/).

   NOTE: If you do not have this information, please contact your system administrator.

   ➤ The Desigo CC page opens in the browser, and the Desigo CC tab contents display.

3. Click the Windows App Client thumbnail.

   ➤ The installation of Desigo CC starts. When completed, the logon dialog box displays.

4. Enter your username and password.

5. Select the domain.

6. Click Logon.

   NOTE: Each time you launch Desigo CC as a Windows App Client, a search for system updates is performed. If a new version of the software is available on the Web Server, you can choose to update it or continue using the previous version.

Related Topics
Troubleshooting Logon Problems [➙ 33]
Types of Stations in the Management Platform [➙ 31]

1.4.4 Exiting the Application

➤ You want to quit the Desigo CC application.

• In the Summary bar, select Menu > Exit.

➤ You are logged off and Desigo CC shuts down. If you were running Desigo CC as a browser-based web client, the logon dialog box displays on the screen.

Related Topics
Doing an Operator Switchover [➙ 21]
Exiting a Closed Mode Session [➙ 20]
1.4.5 Interrupting the Auto Logoff

▷ You are working on a Desigo CC station and your user group was configured for auto-logoff after a period of operator inactivity.
▷ The log off message box displays the time remaining before the automatic log off.

- To stop the logoff, move the cursor or press any key on the keyboard.
- The auto log off is interrupted.

1.4.6 Accessing a Closed Mode Client

In Closed Mode stations, when the computer is powered up Desigo CC starts automatically with the GMSDefaultUser logged on. To log on, you must log off the GMSDefaultUser and then log on with your own credentials.

1. In the Summary bar, select Menu > Logoff.
   - A message box informs you that Desigo CC will be closed and you will be logged on.

2. Click OK.
   - GMSDefaultUser is logged off. The initialization splash screen displays for a few seconds. Then the logon dialog box displays.

3. Enter your username and password.
4. Select the domain.
5. Click Logon.

- Desigo CC restarts in Closed Mode with your credentials.

Related Topics
Exiting a Closed Mode Session [➙ 20]
Troubleshooting Logon Problems [➙ 33]

1.4.7 Exiting a Closed Mode Session

In Closed Mode, you cannot shut down Desigo CC. You can only log off to end your session, after which the GMSDefaultUser is automatically logged on.

1. In the Summary bar, select Menu > Logoff.
   - A message box informs you that Desigo CC will be closed and the GMSDefaultUser will be logged on.

2. Click OK.
   - You are logged off. Desigo CC starts in Closed Mode and the GMSDefaultUser is automatically logged on.
1.4.8 Changing Your Password

➤ You are logged on as Desigo CC user, and the option to change the user’s password is available in the system menu.

1. In the Summary bar, select **Menu > Operator > Change User Password**.
   ➥ The password change window appears.

2. Enter the old password and new password.

3. Confirm password.

4. Click **Change Password**.
   ➥ A message informs you that the changes have been successfully saved.

**Related Topics**
Troubleshooting Logon Problems [➙ 33]

1.4.9 Doing an Operator Switchover

➤ You want to log onto a Desigo CC station to take over from the currently logged-on operator.

1. In the Summary bar, select **Menu > Operator > Switchover**.
   ➥ The **Switchover** window displays.

2. Enter the current user password, your username, password, and domain.

3. Click **Logon**.
   ➥ The current user is logged off from Desigo CC. The system splash screen displays, then Desigo CC restarts with your user credentials.

**Related Topics**
Troubleshooting Logon Problems [➙ 33]
1.5 System Screen
This section provides reference information and instructions for getting around the Desigo CC user interface.

1.5.1 System Screen Reference
This section provides reference information on the main components of the Desigo CC user interface. For related procedures see Working with the System Screen [➙ 27].

1.5.1.1 Main Screen Layout Reference
After starting Desigo CC and logging on, the main system screen displays. The exact screen layout will vary depending on the particular profile, and you may not see all the components described.

Main Screen Layout in Building Automation Profiles

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Summary</td>
<td>The main point of entry to all the functions of the software. It may be collapsed and you must click the down icon on the top right to display it.</td>
</tr>
<tr>
<td>2 Work area</td>
<td>Large central portion of the screen below the Summary bar. The window displayed here will vary depending on what system function is being used. It will typically contain the System Manager window. It can also display the Event List, or Investigative or Assisted Treatment windows, the system help and external documents or applications.</td>
</tr>
</tbody>
</table>

Related Topics
Summary Bar Reference [➙ 23]
1.5.1.2 Summary Bar Reference

The Summary bar is located along the top of the system screen, and is the main point of entry to all the functions of Desigo CC.

By default, it displays collapsed to a slim bar, and it has a series of indicators that provide an overview of the alarms in the system, grouped by category followed by the operator menu, a system integrity indicator, and the filter icon.

When the slim bar is expanded, on the left, the Summary bar displays the event lamps, grouped by category, while on the right, it has buttons for starting multiple System Manager windows, opening/closing Event List, and controlling the audio alert.

Depending on the profile it displays a specific set of event lamps, the Event Detail bar that highlights the most critical events in the system and allows you to open or close the Event List and control the audio alert.

---

Figure 1: Collapsed (Slim) Summary Bar

Figure 2: Expanded Summary Bar

1 Company logo

When you move your cursor on the logo, a tooltip tells you: Click to open the About Page. The About page displays information about the Desigo CC software.

2 Event lamps

Summarizes the alarms in the system, grouped by categories. You can click an event lamp, to open Event List filtered by that category. See Event List Reference [➙ 96] and Event Lamps Reference [➙ 94].

3 Client name

Indicates the computer name on a Server, Client, or FEP station.

NOTE: If you use a Web Client, the client name does not display.

4 Logged user

Indicates the full name of the person logged onto the system. It also provides a tooltip with the user's most important information (for example, full name, account name, language, and so on).

If the user's full name is not available, user name displays instead.

5 Date and time

- Indicates the system date and time.
- Displays the Windows calendar when clicked.
### Getting Started

**System Screen**

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td><strong>System menu</strong></td>
</tr>
<tr>
<td>7</td>
<td><strong>System integrity indicator</strong></td>
</tr>
<tr>
<td>8</td>
<td><strong>Expand/collapse</strong></td>
</tr>
<tr>
<td>9</td>
<td><strong>Event filter</strong></td>
</tr>
<tr>
<td>10</td>
<td><strong>Open/close Event List</strong></td>
</tr>
<tr>
<td>11</td>
<td><strong>Start a new System Manager</strong></td>
</tr>
<tr>
<td>12</td>
<td><strong>Audio Alert</strong></td>
</tr>
<tr>
<td>13</td>
<td><strong>Show/hide Event Detail bar</strong></td>
</tr>
</tbody>
</table>

1) This icon is not available in UL 864-compliant and ULC S527-compliant fire stations, Danger Management AT/EN, and Total Building Solution AT/NA profiles.

#### 1.5.1.3 License Mode Indication in Summary Bar

When the Desigo CC client application is running normally, with a valid and sufficient license available on the server, you will not see any special indication on the user interface.

Otherwise, the Summary bar changes color and displays a message to indicate the following special situations, along with the time remaining (days, hours, minutes, or seconds) that you can continue running the Desigo CC client application.

- **Demo** mode (green): There is no valid license available on the server. You can run the Desigo CC client application continuously for only 30 minutes.
- **Courtesy** mode (orange): The license on the server is valid but insufficient. You can run the Desigo CC client application continuously for only 30 days.
- **Engineering** license (blue): The Desigo CC client is running, for a limited duration, with a special license used by authorized technicians to set up and configure the system.

The license mode (color and text) is also visible when the Summary bar is collapsed.

---

For background information, see Licensing Reference [➙ 388].
1.5.1.4 **System Integrity Indicator Reference**

The system integrity indicator, located on the Summary bar [➙ 23], indicates the network connection and system status. Its color and animation reflect the connection status, as follows:

- **Green and animated**
  - Network connection with the server is active and the system is healthy (that is, server running properly).

- **Red and animated**
  - Network connection with the server is active but at least one system component is not active on the server (that is, server not running properly).
  
  **NOTE:** If a client disconnects from the server, this issue is visually indicated on the Summary bar by pink background, and **Client Disconnected** text in red. An error message informs you that the connection to the server has been lost and will be restored when possible.

- **Red and not animated**
  - Network connection with the server is inactive.

A tooltip displays when you move your cursor over the indicator, and provides network connection and system status information.

1.5.1.5 **Audio Alert Reference**

The audio alert is the sound emitted by a client station to notify the operator of alarms in the management platform. (If a site has multiple client stations, each one will emit its own audio alert.)

When a new alarm occurs, the client station emits an audio alert that continues for as long as that alarm remains unprocessed (that is, unacknowledged by the operator). If there are multiple incoming alarms, the audio alert continues to sound for as long as any of them remain unprocessed.

The audio alert ceases when the incoming alarms have been acknowledged. It will resume after 24 hours if a previously-acknowledged alarm has still not been fully processed (closed) by then.

An icon on the Summary bar [➙ 23] indicates the status of the audio alert. You can click this icon to temporarily silence the audio alert. Only in some profiles, you can also completely disable the audio alert. (A tooltip displays when you move the cursor over the icon, indicating which actions are available to you.)

The specific audio alert sound can vary depending on the type of alarm and is configuration-dependent. In case of multiple alarms, the audio alert sound will be the one for the most important (severe) event, irrespective of any filters or sorting you may have applied to Event List.

For related procedures, see **Temporarily Muting the Audio Alert** [➙ 29] and **Permanently Silencing the Audio Alert** [➙ 29].
Audio Alert Status

- **Active**
  The system has detected a new alarm, or there are still alarms in the unprocessed state. You can temporarily silence or permanently turn off the audio alert.

- **Muted**
  You temporarily silenced the audio alert. After 24 hours the system will automatically re-activate the sound (audio alert reminder).

- **Disabled**
  You completely disabled the audio alert. This means it is permanently turned off, and the system will not emit any sound when new alarms occur.

1) In UL 864-compliant and ULC S527-compliant fire stations, Danger Management AT/EN, and Total Building Solution AT/EN/NA profiles you can only temporarily silence the audio alert.

2) This status is available only in Building Automation EN/NA profiles. In particular, in Building Automation EN profile, the audio alert is permanently muted but you can enable it when required.

### 1.5.1.6 System Menu Reference

The Menu located on the Summary bar [➜ 23] provides several items for you to carry out different tasks.

- **Help**: Launches online Help.
- **Applications**: Opens a new System Manager window. See Creating Additional System Manager Windows [➜ 34].
- **Operator**: Performs the following tasks:
  - **Switchover**: See Doing an Operator Switchover [➜ 21].
  - **Change User password**: See Changing Your Password [➜ 21].
    **NOTE**: This option is not available if you are logged on as Windows user. Also, a message prompts you if you enter an invalid password.
- **About Page**: See Displaying the About Page [➜ 29].
- **Print**: See Printing from the System Menu [➜ 30].
- **Active Tasks**: See Switching Between Active Windows [➜ 27].
- **Exit**: Ends your work session, and shut down the system. See Exiting the Application [➜ 19].
- **Logoff**: (available in Close Mode only), logs you off and automatically logs on the GMSDefaultUser. See Exiting a Closed Mode Session [➜ 20].

### 1.5.1.7 Printouts Reference

In Operating mode, Desigo CC allows you to use any configured printer to print out application data:

- From the system menu on the Summary bar. See Printing from the System Menu [➜ 30].
- Directly from with system applications such as Event List, Reports, and so on. See, for example, Printing the Whole Event List [➜ 85]
Printouts Selection Dialog Box
The Printouts Selection dialog box displays when you print from the system menu. It lets you select system application printouts.

Print Preview Dialog Box
The Print Preview dialog box displays when you print from the system menu, or from an application. It lets you adjust the various printer options (margins, orientation, scaling and so on) before launching the print job.

<table>
<thead>
<tr>
<th>Print Preview Toolbar 1)</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Zoom in</td>
<td>Provides a close-up view of the printout. Keep clicking it to continue zooming in.</td>
</tr>
<tr>
<td></td>
<td>Zoom out</td>
<td>Reduces the view of the printout. Keep clicking it to continue zooming out.</td>
</tr>
<tr>
<td></td>
<td>Actual size</td>
<td>Fits the printout into the whole preview page.</td>
</tr>
<tr>
<td></td>
<td>Fit width</td>
<td>Fits the printout into the preview page’s width.</td>
</tr>
<tr>
<td></td>
<td>One page</td>
<td>Displays the printout one page per sheet.</td>
</tr>
<tr>
<td></td>
<td>Two pages</td>
<td>Displays the printout two pages per sheet.</td>
</tr>
</tbody>
</table>

1) These commands affect only the print preview, and not the printout.

NOTE:
The color option depends on the selected printer. If the Color printing check box displays dimmed and cleared, the selected printer cannot print color. If this check box displays dimmed and selected, the selected printer can print only color. Even when you can select to print color (or black and white), the printout may not correspond to the color option selected because of the printer drivers.

1.5.2 Working with the System Screen
This section provides instructions for some common tasks in the Desigo CC user interface. For background information, see System Screen Reference [➙ 22]. Perform the procedures in this section as needed.

1.5.2.1 Switching Between Active Windows
You have two or more active windows (for example, System Manager and Event List), and you want to bring a different one to the foreground on the system screen.

1. In the Summary bar, select Menu > Active Tasks.
2. From the thumbnail preview of the active windows, select the one you want to bring to the foreground.

Related Topics
System Screen Reference [➙ 22]
1.5.2.2 Expanding and Collapsing the Summary Bar

Expanding the Summary Bar
▷ The Summary bar displays collapsed.
1. In the Summary bar, click down ▼ on the top right or an event indicator.
▷ The Summary bar expands.

Collapsing the Summary Bar
▷ The Summary bar displays expanded.
1. In the Summary bar, click up ▲ on the top right.
▷ The Summary bar collapses.

Related Topics
Main Screen Layout Reference [➙ 22]
Summary Bar Reference [➙ 23]

1.5.2.3 Showing and Hiding the Event Detail Bar

Showing the Event Detail Bar
▷ The Event Detail bar is not visible and the command to show it is available on the Summary bar.
1. In the Summary bar, click down ▼.
▷ The Event Detail bar displays below the Summary bar.

Hiding the Event Detail Bar
▷ The Event Detail bar is visible, and the command to hide it is available on the Summary bar.
1. In the Summary bar, click up ▲.
▷ The Event Detail bar is hidden.

The capability to show/hide the Event Detail bar is not available in UL 864-compliant and ULC S527-compliant fire stations. Danger Management AT/EN, and Total Building Solution AT/NA profiles.

Related Topics
Main Screen Layout Reference [➙ 22]
Summary Bar Reference [➙ 23]
Event List Reference [➙ 96]
1.5.2.4 Temporarily Muting the Audio Alert

- The audio alert buzzer on a Desigo CC station is sounding, and you want to mute it temporarily.

1. In the Summary bar, click Audio Alert.
   - The icon changes to muted and the sound stops, even if there are still unacknowledged events. Muting applies only to the pre-existing events: the audio alert will still sound for any new events that come in.

1. To manually unmute the audio alert, click Audio Alert again.

Related Topics
Audio Alert Reference [➙ 25]
Summary Bar Reference [➙ 23]
Permanently Silencing the Audio Alert [➙ 29]

1.5.2.5 Permanently Silencing the Audio Alert

- You want to permanently disable the audio alert buzzer on a Desigo CC station, so that it does not sound even if new alarms come in.

1. In the Summary bar, right-click Audio Alert.
   - The icon changes to disabled.

1. To manually re-enable the audio alert right-click Audio Alert again.

The capability to permanently silencing the audio alert is not available in UL 864-compliant and ULC S527-compliant fire stations, Danger Management AT/EN, and Total Building Solution AT/EN/NA, and profiles.

Related Topics
Audio Alert Reference [➙ 25]
Summary Bar Reference [➙ 23]
Temporarily Muting the Audio Alert [➙ 29]

1.5.2.6 Displaying the About Page

- You want to view system information such as the Desigo CC version.

1. In the Summary bar, select Menu > About Page or click the company logo.
   - The About dialog box displays, and shows general information about the software.

2. (Optional) If you work on an Installed Client station, click System Info.
   - The System Information window displays detailed information about the Client computer.

3. Click OK.
1.5.2.7 Moving a System Window to a Second Monitor

**NOTE:**
When an additional monitor is available, you can move any system window, such as, System Manager, Investigative/Assisted Treatment, Help or Event List (in some Client Profiles only), from the default monitor to a second monitor. The Summary bar cannot be moved.

➤ Desigo CC is running as an Installed Client or Windows App Client on a computer connected to two monitors.
➤ You want to move a window from the default monitor to the second monitor. For example, you want to move the System Manager window.

1. Click **Restore Down** in the window.
   ➤ The window restores down, you can move it to another monitor, and the icon changes to **Maximize**.

2. Drag the window from the default monitor to the second monitor, and click **Maximize**.
   ➤ The window displays on the second monitor. If you minimize the window that displays on the second monitor, the corresponding icon displays in the Windows taskbar of the default monitor. If you maximize the window again, it displays on the monitor where you previously minimized it.

Related Topics
User Interface [➙ 13]

1.5.2.8 Printing from the System Menu

1. In the Summary bar, select **Menu > Print**.
   ➤ The **Printouts selection** dialog box displays.

2. *(Optional)* In the **Printouts selection** dialog box, do the following:
   – Clear the check boxes that correspond to the system application printouts you do not want to generate.
   – Click **Move up** or **Move down** to change the printout order.

3. Click **Preview**.

4. *(Optional)* In the **Print Preview** dialog box, do the following:
   – Use the zoom icon on the toolbar to zoom in/out and check the output. These toolbar controls only affect the preview, not the printout itself.
   – Adjust **Margins** (default is 50 pixels).
   – Select the desired **Orientation** (default is Landscape).
   – Select the **Printer** and **Paper** size.
   – Adjust **Scaling** (default is Fit to page) and, if available, **color option**.

5. Click **Print and Close**.
   ➤ The printout is sent to the selected printer.
1.6 Types of Stations in the Management Platform

The Desigo CC software has a client-server architecture, in which a server component handles all interactions with the field networks and devices installed on the site, while one or more clients provide the user-facing application that operators interact with.

The computers running the various components of the Desigo CC management-system software are referred to as stations.

Server (required)
The computer that runs the server component of Desigo CC. It hosts all the data of the installation (the project databases) and connects to the field networks and subsystems of the building-control site. Also referred to as the Main Server.
- The Desigo CC client application is also installed on the Server station, so that this computer can function as an all-in-one management station.
- There can only be one Server station.
- The Server station can optionally host an IIS web server.

Client (optional)
An additional, separate computer on which the Desigo CC client application is installed. Also referred to as an Installed Client.
- There can be multiple Client stations, allowing multiple operators to manage and supervise the same site.

FEP (optional)
Front-end processor. An additional, separate computer that is used for load-balancing the network-based processing for a system.
- There can be multiple FEP stations.
- The Desigo CC client application is also installed on the FEP station.

Web Server (optional)
A separate computer hosting an IIS web server component, which enables the functioning of Web Clients and Windows App Clients. This station can be dedicated to that purpose, or it can be optionally configured to also operate as a FEP or Client station.

NOTE:
The IIS web server can also be hosted on the Server station, in which case this separate Web Server station is not needed.

Web Client
A computer that is used to access Desigo CC as a browser-based web application, typically over an intranet. It allows access to local resources only. No software is actually installed on the computer. The first time the user accesses the Web Client, they are required to install the web application certificate.

Web Clients can be anonymous, or identified with a host certificate.
Windows App Client
A computer used to access Desigo CC as a light application, downloaded and installed on-demand directly from the Internet Explorer browser. Once installed, it looks like the standard Desigo CC client software, but allows access to local resources only. Each time the user launches the Windows App Client, a search for system updates is performed. If a new version is available, the user can choose to update it or continue to use the previous version.

Capabilities of Different Station Types

<table>
<thead>
<tr>
<th></th>
<th>Server</th>
<th>Client / FEP</th>
<th>Web Client</th>
<th>Windows App Client</th>
</tr>
</thead>
<tbody>
<tr>
<td>Complete access to management platform resources</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Import/export/upgrade of libraries (including Object Models and Import Rules)</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Text localization import/export</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Closed Mode</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Request/transfer of fire panel ownership</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Auto logoff due to user inactivity</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Multiple monitor support</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Operator switchover</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>

1.7 Client Station Troubleshooting
This section provides general troubleshooting information about client stations.

1.7.1 Client Application Needs to Restart
The Desigo CC management platform continually monitors the reliability and responsiveness of the client application.
If technical problems are detected, the Desigo CC Client application will be automatically stopped and restarted for memory optimization.

▷ A message informs you that Desigo CC will be restarted within 1 minute.

1. Save your work. You can optionally restart Desigo CC before the countdown expires.
   ➤ When Desigo CC starts up again, a message informs you that the client application was restarted due to an unhandled error or low memory problem.

2. Log on again to Desigo CC.
1.7.2 Troubleshooting Logon Problems

User's logon credentials
You can log on to the system as a Desigo CC user or Windows user by providing the username, password and domain name.

System domain

NOTE:
The current version of Desigo CC supports only one domain. This means that you can only log on to the configured default domain. If you belong to a domain different from the default, you can log on only as a Desigo CC user or local user under [station name] [user name].
The default domain name is configuration-dependent. If default domain name is not configured, the default station name and Desigo CC (not Windows user) are available as domain instead.

Invalid username or password
When you log on, if you enter an invalid user name or password a message box informs you that the credentials are invalid, and asks you to retry. After five failed attempts, a message box informs you that you reached the maximum number of allowed attempts and the user authentication will close.

Desigo CC Client cannot start because the Client Profile file was not found
When you log on, if the Client Profile is not found, a message informs you of this issue. Click OK to close the message box. See your System Administrator for assistance.

Desigo CC Client license is not available
When you log on, if no client license is available, a message informs you of this issue and the Desigo CC Client will not start. See your System Administrator for assistance.

1.7.3 Troubleshooting the Web Client and Windows App Client
If there are connectivity problems, a message box may display indicating that the connection to the server was temporarily lost. Proceed as follows to resume your work:

1. Click OK to close the message box.
   - The system automatically logs you off, and the logon dialog box displays again on the screen.

2. Try logging on again.
2 System Manager

This section provides information and instructions for using the System Manager window of Desigo CC.

2.1 Working with System Manager

This section provides step-by-step instructions for some common System Manager tasks. For background information, see System Manager Reference [➙ 42]. Perform the procedures in this section as needed.

2.1.1 Creating Additional System Manager Windows

You can create additional System Manager windows, for example to use on multiple monitors, or to investigate/supervise different aspects of the building control site.

- Do one of the following:
  - From the Desigo CC system menu, select Applications > Start new System Manager.
  - From the expanded Summary bar, click System Manager to open a new System Manager window.

  A new System Manager window, labeled System Manager (2), is created. You can switch between it and other windows from the Windows taskbar or from Active tasks on the system menu.

  You can repeat these steps to create further System Manager windows, which will successively be labeled System Manager (3), System Manager(4), and so forth.

Related Topics
Main Screen Layout Reference [➙ 22]
Summary Bar Reference [➙ 23]
System Manager Reference [➙ 42]

2.1.2 Closing Additional System Manager Windows

1. From the system menu, or from the Windows taskbar, display the window that you want to close, for example, System Manager (2).

2. Click Close in the title bar.

NOTE: You can only close additional System Manager windows in this way. The primary System Manager window (the one labeled System Manager) can only be minimized by clicking Minimize in its title bar.

Related Topics
System Manager Reference [➙ 42]
2.1.3 Changing the Pane Layout of System Manager

You want to adjust or customize the arrangement of the panes in the System Manager window.

1. In the System Manager window header, if the lock pane layout icon is active (undimmed), click it so that it becomes dimmed. Otherwise the pane layout cannot be changed.

2. To switch between the available preset layouts, click the icons in the title bar:
   - Selection, Primary, and Contextual panes. Secondary pane will open when required.
   - Selection and Primary pane, and the left part of the Contextual pane.
   - Selection and Primary pane.
   - Primary and Contextual pane. Secondary pane will open when required.
   - Primary pane only.

   NOTE: Even if the selected layout includes the Secondary pane, the Secondary pane only displays when you make a selection that requires it, and provided the Primary pane is not locked. See Allowing or Preventing Opening of the Secondary Pane [➙ 36].

3. To resize the panes in the current layout, drag the splitter (the dividing line) between them.

4. To expand/collapse a pane, click the button on the splitter. (Click the button again to re-expand a collapsed pane).

5. To close the Secondary pane, click Close in its pane header.

6. To prevent the current layout from being changed, click the lock pane layout icon in the title bar (so that it is undimmed). This disables the function that lets you switch between the preset layouts so that panes can no longer be resized, expanded, collapsed, or closed.

Related Topics
Graphical Elements and Controls [➙ 14]
2.1.4 Allowing or Preventing Opening of the Secondary Pane

Normally, the Secondary pane opens on demand, when you make a selection that requires it. When the Secondary pane opens, it takes up half the space that would otherwise be allotted to the Primary pane.

You want to prevent the Secondary pane from opening, so that the Primary pane will always occupy its full width.

1. To prevent the Secondary pane from opening, click the pushpin icon in the Primary pane header so that it is in the locked position.
   - The Primary pane is locked to full width, and the Secondary pane will not open. Any selections (such as Related Items) that would normally display in the Secondary pane are instead redirected to the Primary pane.

1. To allow the Secondary pane to open again, click the pushpin icon in the Primary pane header so that it is in the unlocked position.
   - The Primary pane width is unlocked, and will resize to accommodate the Secondary pane when a selection is made that displays in the Secondary pane.

Related Topics
Graphical Elements and Controls [➙ 14]

2.1.5 Setting How Objects are Labeled in System Manager

▷ You want to define whether objects in System Manager are labeled with just a name, just a description, or both.

▷ System Browser displays in the Selection pane of System Manager.

1. In System Browser, click the Display Mode drop-down list.

2. Select how you want the objects to be labeled:
   - Show Description: example Air Handler Unit 1
   - Show Description [Name]: example Air Handler Unit 1 [AHU]
   - Show Name: example AHU1
   - Show Name [Description]: example AHU1 [Air Handler Unit 1]

▷ The objects are labeled in the selected way in the System Browser tree, and also throughout the other panes in System Manager.

NOTE: The choice you make here persists across sessions and is specific to the user. It also determines whether you can search for objects in the system tree by name or by description.

Related Topics
Overview of System Browser [➙ 51]

2.1.6 Setting How Selections Propagate to Other Panes

▷ You want to set whether the Primary and Contextual panes will automatically refresh whenever you make a selection in System Browser.

▷ System Browser displays in the Selection pane of System Manager.

● To disable automatic propagation, select the Manual navigation check box.

▷ The next time you click on an object in the tree, the Primary and Contextual panes will not be automatically updated, and you will have to do this manually.
• To enable automatic propagation, deselect the Manual navigation check box.
  ✴ The next time you select an object in the tree, the Primary and Contextual panes will automatically refresh to reflect the new selection.

Related Topics
Manually Propagating a Selection to Other Panes [➡ 37]
System Manager Navigation Workflows [➡ 43]

2.1.7 Manually Propagating a Selection to Other Panes

▷ You made a selection in System Browser with Manual navigation checked, so that the Primary and Contextual panes were not automatically refreshed. You now want to manually propagate this selection.

• To propagate this selection to the Primary and Contextual panes, do one of the following in System Browser:
  – Click the Send button.
  – Right-click on the selection in the tree, and select Send to the Primary Pane.
  – (Only for an individual object) Double-click the object.

▷ The Primary and Contextual panes of System Manager update with content relevant to the selected objects.

1. To propagate this selection to the Secondary pane, do the following:
   a. In the System Manager header, check that the current pane layout includes the Secondary pane:  or .
   b. In the Primary pane header, check that the pushpin icon is in the unlocked position , so that opening of the Secondary pane is allowed.
   c. In System Browser, right-click on the selection in the tree, and select Send to the Secondary Pane.

Related Topics
Setting How Selections Propagate to Other Panes [➡ 36]
Sending a Selection to the Secondary Pane [➡ 37]

2.1.8 Sending a Selection to the Secondary Pane

▷ You want to work with a system object in the Secondary pane so that the current contents of the Primary and Contextual panes will not be changed.

1. In the System Manager window header, check that the current pane layout includes the Secondary pane:  or .
2. In the Primary pane header, check that the pushpin icon is in the unlocked position , so that opening of the Secondary pane is allowed.
3. In System Browser, navigate to the object that you want to work with.
4. Select the Manual navigation check box if you do not want the Primary and Contextual panes to refresh while you are doing this.

5. Right-click the object in the tree and select Send to the Secondary Pane.
   ➔ The content pertaining to the selected object displays only in the Secondary pane, whereas the content of the Primary and Contextual panes is not changed.

Related Topics
Setting How Selections Propagate to Other Panes [➙ 36]

2.1.9 Selecting an Object in System Browser
▷ System Browser displays in the Selection pane of System Manager.

1. In System Browser, from the Views drop-down list, select the view (Application View, Management View, or some other custom-configured view) you want to work with.
   ➔ The System Browser tree updates to display the selected view.

2. Browse the objects in the System Browser tree as you would the folders in a computer. An arrow icon indicates a folder or parent object that contains other objects inside it:
   – Click the side arrow icon ➔ alongside a collapsed node to expand the node and view its children.
   – Click the down arrow icon ▼ alongside an expanded node to collapse it again and hide its children.

3. Select the object you want to work with by clicking its label in the System Browser tree.
   ➔ The selected object displays highlighted in the tree. If the Manual navigation check box is deselected, the Primary and Contextual panes of System Manager are automatically updated to reflect the new selection.

4. If the Manual navigation check box is selected, do one of the following to manually propagate the selection to the Primary and Contextual panes:
   – Double-click the object.
   – Click the Send button.
   – Right-click the selected object and select Send to the Primary Pane.

Related Topics
Overview of System Browser [➙ 51]
Setting How Selections Propagate to Other Panes [➙ 36]
Manually Propagating a Selection to Other Panes [➙ 37]

2.1.10 Selecting Multiple Objects in System Browser
▷ System Browser displays in the Selection pane of System Manager.
▷ You want to make a multiple selection.

1. In System Browser, from the Views drop-down list, select the view (Application View, Management View, or some other custom-configured view) you want to work with.
   ➔ The System Browser tree updates to display the selected view.
2. Do one of the following to find the set of objects you want to select:
   - Navigate to the desired objects in the System Browser tree. Click ▶ to expand a collapsed node and view its children, or click ▼ to collapse an expanded node and hide its children.
   - Run a search by name/description and other criteria such as discipline, type, and so forth. See Searching for Objects [➙ 49].

3. From the System Browser tree, or from the list of search results, select the objects as follows:
   - To select multiple non-contiguous objects, press and hold the CTRL key while clicking the objects.
   - To select multiple contiguous objects, press and hold the SHIFT key while clicking the first and the last object in the range.
   - The selected objects display highlighted in the tree. If the Manual navigation check box is deselected, the Primary and Contextual panes of System Manager are automatically updated to reflect the new selection.

4. If the Manual navigation check box was selected, do one of the following to propagate the selection:
   - Click the Send button or right-click the selection and select Send to the Primary pane.
   - The Primary and Contextual panes of System Manager refresh to reflect the new selection.
   - Right-click the selection and select Send to the Secondary pane.
   - The Secondary pane of System Manager refreshes to reflect the new selection. The Primary and Contextual panes remain unchanged.

Related Topics
Overview of System Browser [➙ 51]

2.1.11 Browsing and Selecting Objects with the Navigation Bar
   - You want to use the Navigation bar’s breadcrumb trail to move around the system tree and select objects. This allows you to make selections even with System Manager layouts that do not include the Selection pane.

1. If the Navigation bar is not already visible, click Open navigation bar in the System Manager window header.
   - The Navigation bar displays along the top of the System Manager window, directly underneath the title bar. The breadcrumb trail shows the full path of your current selection in the system tree. Whenever the current primary selection is changed, the breadcrumb trail refreshes to reflect the new position in the system path.

2. To begin browsing the tree, click an arrow icon ▶ alongside a path element.
   - A drop-down list displays all of the items directly beneath it in the system tree. (For example, clicking the arrow icon ▶ to the right of Applications displays a drop-down list that includes Documents, Graphics, Address Book, and so on.)
3. Click an item in the drop-down list (for example, Documents) to make it the new selection.
   - System Browser, the Primary pane, and the Contextual pane all update to reflect the new selection.
   **NOTE:** The selection made here propagates to the other panes even if you selected Manual navigation in System Browser.

4. Continue moving around the tree in this way until you reach the object you are interested in.
   **NOTE:** From the breadcrumb trail, you can only make single selections that go to the Primary and Contextual panes. To send a selection to the Secondary pane, or to make multiple selections, you must use System Browser.

**Related Topics**
- Revisiting Recent Selections from the Navigation Bar [➙ 40]
- Setting a Favorite Location in System Manager [➙ 41]
- Selecting an Object in System Browser [➙ 38]
- Navigation Bar Reference [➙ 47]

### 2.1.12 Revisiting Recent Selections from the Navigation Bar

The Navigation bar provides a browser-like history of recent selections so that you can easily revisit objects previously displayed in the Primary pane.

1. Click Open navigation bar in the System Manager header.
2. To jump to a specific, previously-visited selection:
   a. Click or press CTRL+H to view the selection history. As a result, a drop-down list of your 20 most recent Primary-pane selections (in descending order from newest to oldest) displays. The one currently displayed in the Primary pane is highlighted with a checkmark.
   b. Click the name of the selection in the list that you want to revisit.
      **NOTE:** The selection displays again in the Primary pane. The Contextual pane, System Browser, and the Navigation bar also refresh accordingly.

3. To move sequentially through the history list of recent selections:
   - Click the Back or Forward buttons, or use the ALT+Left or ALT+Right keyboard shortcuts.

**Related Topics**
- Browsing and Selecting Objects with the Navigation Bar [➙ 39]
- Setting a Favorite Location in System Manager [➙ 41]
- Navigation Bar Reference [➙ 47]
2.1.13 Setting a Favorite Location in System Manager

- You want to bookmark a particular selection as your favorite location, so that it displays as the initial location whenever you open System Manager and that you can easily access by clicking Favorite location in the Navigation bar.

1. Select the object you want to set as the favorite location, so that it displays in the Primary pane.

2. If the Navigation bar is not already visible, click Open navigation bar in the System Manager header.

3. In the Navigation bar, click and hold Favorite location for 2 seconds.
   - A status message indicates that the new favorite location is set and stored in your user profile.

4. To jump to the favorite location at any time, click Favorite location in the Navigation bar or press the ALT+Home keys.
   - The favorite location displays in the Primary pane. The Contextual pane, System Browser, and the Navigation bar all refresh accordingly.

Related Topics
Browsing and Selecting Objects with the Navigation Bar [➙ 39]
Revisiting Recent Selections from the Navigation Bar [➙ 40]
Navigation Bar Reference [➙ 47]

2.1.14 Revisiting Recent Selections from Recently Viewed

The Recently Viewed feature lets you return to a previously visited view in the Primary pane.

1. In the Selection pane, click the Recently Viewed tab.
   - Recently Viewed displays a list of the recently visited views in the Primary pane.

2. Do the following:
   - Click the Links/Thumbnails button to switch between displaying the recent items as snapshots or text links.
   - Click the scroll icons (Newer) (Older) to move backward and forward among the recent views.
   - The selected view displays in the Primary pane, and a new recently visited view item is created and displays in Recently Viewed.

Related Topics
Recently Viewed Reference [➙ 48]
2.2 System Manager Reference

This section provides reference information for using the System Manager window. For related procedures see Working with System Manager [➙ 34].

2.2.1 Overview of System Manager

System Manager is a multi-pane window for navigating, monitoring, and controlling all the components and subsystems of your site. For example, you can inspect properties and states of objects, send commands, browse the architecture of the installation, consult floor plan graphics, and so on. A typical layout has a **Selection** pane on the left where you can locate and select system objects from a hierarchical tree view, and multiple working panes on the right that display object properties, commands, and associated applications based on the current selection.
### Description

**1** Selection pane. Typically contains System Browser, for locating and selecting system objects in a hierarchical tree view. A drop-down menu lets you switch between different tree views (for example, Management View, Application View or other customizable views). Your selection here is propagated to the Primary pane on the right, and to the Contextual pane below it.

At the bottom of this pane, the Recently Viewed stacked tab lets you access the recent views navigation option. This lets you return to a previously visited view in the Primary pane.

**2** Primary pane. Contains one or more tabs associated with the object you selected in the Selection pane. These tabs can include:

- **Textual Viewer**: Displays information about the object such as its path, status, and so on.
- **Default**: If the selected object has an associated default application (for example a graphics viewer, or a tool for reporting), it displays in this tab.

If the selected object has more than one associated application, tabs corresponding to those applications also display (for example, the Graphics Viewer displays in the Default tab while the remote notification tool displays in the RENO Messages tab).

If you have appropriate user rights, a button is available at the top of the pane to switch System Manager from Operating to Engineering mode to perform configuration tasks.

**3** Secondary pane. Opens by default when you click on a related item, so that you can view it without losing the current information on the Primary and Contextual panes.

**4** Contextual pane. Provides additional information, actions, and resources for the object you most recently selected (in the Selection pane, or in one of the other panes). It is divided into two parts:

- **Operation/Extended Operation** tabs (left side): Lets you inspect all the properties of the selected object, and view and execute any commands/actions available for that object.
- **Related Items** tab (middle): Provides links to additional resources, such as reports or alarm-handling procedures that are relevant to the selected object. If you click on a related item it opens by default in the Secondary pane. You can also opt to direct related items to the Primary pane instead.
- **Detailed Log** tab (right side): Lets you view a detailed history log about the selected object, and handle the log data.

### 2.2.2 System Manager Navigation Workflows

You can interact with System Manager to perform actions and change what currently displays in the other panes in a variety of ways. These include:

- Click on an object in the Selection or Secondary pane to propagate its information, properties and commands to the Primary and Contextual panes.
- Click on the secondary header of a pane to select the corresponding object in the Selection pane.
- Right-click on an object (or group of objects) and choose whether to propagate (send) its information to the Primary or Secondary pane.
- Click on an object in the Related Items tab to open it in the Secondary (or Primary) pane.
- Drag-and-drop objects from the Selection or Contextual pane to perform certain tasks.
- Click 🔄 to open the Navigation bar.
Primary Navigation Workflow
The following is a typical workflow that illustrates how the different System Manager panes work together:

1. Select an object in the **Selection** pane (1). See Selecting an Object in System Browser [➙ 38].
   ➔ Information and commands for that object display in the **Primary** pane and in the **Contextual** pane (2). You can immediately monitor and control the selected object.

2. Click the **Primary** pane to select a new object (3).
   ➔ The **Contextual** pane updates to let you monitor and control the new selection.

3. Click one of the links in the **Related Items** list (4) to open it in the **Secondary** (5) (or **Primary**) pane. This provides additional information or resources relevant to the selected object.

4. Continue making selections, in both the **Primary** and **Secondary** pane, to immediately view the associated information and commands in the **Contextual** pane.

*Figure 3: System Manager Main Workflow*

Drag-and-drop Workflow
The following is a typical workflow that illustrates how to associate two system objects using manual selection and drag-and-drop.

1. In the **Selection** pane, select the desired System Browser view (1) (see Selecting Views [➙ 49]). For example, **Application View**.
   ➔ The System Browser tree updates to display the selected view.

2. Navigate the tree to select the object (2) you want to work with, for example **Activity Log**.

3. Select the **Manual Navigation check box** (3) to freeze the **Primary** pane (in this example, **Reports > Activity Log**).

4. Drag and drop the selected object (4) (in this example, **Address Book**) to the reports area.
NOTE: System Browser supports drag-and-drop of single or multiple objects from any of the views—including the Search Result view. You can cancel a dragging operation by pressing the ESC key or by dragging the objects back to the original view (or other no-drop zone) and dropping them.

2.2.3 Operating and Engineering Mode

When you log onto Desigo CC, System Manager starts in Operating mode. This is the mode typically used by operators during the day-to-day running of the management platform. Configuring the system instead requires switching over to Engineering mode.

Operating Mode

In Operating mode, you can monitor and control the facility, for example by verifying site statuses, handling alarms, checking graphics, generating reports, and so on. If you have appropriate user rights, you can also perform some limited configuration tasks (for example, editing graphics, schedules, and so on) in Operating mode.
System Manager Operating mode is indicated by a light blue color.

Depending on the object selected in System Browser, the Primary pane displays only the Textual Viewer tab or the Textual Viewer and other tabs. Each tab gives access to the related operating application.

The Operating button is available only if you have access rights for Engineering mode; otherwise, it does not display. If available, this button lets you toggle System Manager between Operating mode and Engineering mode.

**Engineering Mode**

Engineering mode is a feature of Desigo CC that enables an authorized technician to configure a project. In Engineering mode, the Primary pane of System Manager presents all the tools for configuring the site project, including import/export capabilities.

If you have the appropriate permission, the Primary pane of System Manager displays an operating button that you can use to switch to Engineering mode.

You can click the Engineering button to switch the system back to Operating mode and check whether the configurations you made work correctly.

To fully configure a site project you may also require a special Engineering License, which temporarily gives access to the whole software’s functionality.
2.2.4 Navigation Bar Reference

The Navigation bar displays at the top of System Manager and allows you to navigate the system without having to make selections in System Browser. It contains a set of icons, and a Breadcrumbs path that shows your current location as a series of links separated by arrows.

The Breadcrumbs path in the Navigation bar functions like a condensed version of System Browser, without the search capabilities. The selections you make in the Breadcrumbs area are reflected in System Browser. The opposite is also true: the selections you make in System Browser are reflected in the Breadcrumbs area.

The Back and Forward icons let you quickly return to recently-viewed selections. The History icon displays a list of your 20 most recently viewed selections with the current selection highlighted with a checkmark and displayed in the Primary pane. The Favorite location icon jumps to a user-selectable view; when you set a favorite location the system will store it and use it as the initial selection when you first open System Manager. When switching-over to a new user, that user's Favorite location will be used as the initial selection.

Related Topics
Browsing and Selecting Objects with the Navigation Bar [39]
Revisiting Recent Selections from the Navigation Bar [40]
Setting a Favorite Location in System Manager [41]
## 2.2.5 Recently Viewed Reference

Recently Viewed is a navigation aid located in the Selection pane of the System Manager window. It lets you quickly return to a recently-visited view in the Primary pane.

To access Recently Viewed, click its stacked tab at the bottom of the Selection pane. You will see a history of the 20 most recent views in the Primary pane, displayed as either thumbnails (snapshots) or links (3). Click a thumbnail or link (1) to jump back to that view in the Primary pane, or use scroll icons (Newer) (2) to move backward and forward among the recent views.

### Related Topics

Revisiting Recent Selections from Recently Viewed [➔ 41]
2.3 System Browser
This section provides information and instructions for using the System Browser.

2.3.1 Working with System Browser
This section provides step-by-step instructions for some common System Browser tasks. For background information, see System Browser Reference [➙ 51]. Perform the procedures in this section as needed.

2.3.1.1 Selecting Views
1. From the Views list box, click the drop-down arrow.
2. From the list of available views, select the view you want to display.

2.3.1.2 Searching for Objects
1. In the Search list box, enter the name of the object you want to search for. You can use wildcarding when performing a search.
2. Click the Search icon.

2.3.1.3 Filtering Searches
1. You want to filter a search to limit the results that your search returns, and you have already entered text in the Search list box.
2. Click the Filter icon.
3. In the Type field, click the drop-down arrow and select the object type and subtypes you want to filter by.
4. In the Discipline field, click the drop-down arrow and select the discipline and subdisciplines you want to filter by.
5. In the Other field, click the drop-down arrow and select the settings you want to filter by.
6. In the Alias field, enter the case-sensitive alias you want to filter by.
7. If you want to limit your search to the currently selected node in the tree, select the Search within selection check box.
8. Click Search to begin the search.
   ▶ The search results display in the tree area.

2.3.1.4 Saving Searches
▷ You have performed a search using the appropriate filtering criteria as needed.
1. Click Save Search.
2. In the Save Search field, type a name for your search.
3. Click Save.
   ▶ The system saves the search filtering criteria but not the location in the tree at the time of the save.
2.3.1.5 Choosing a Display Mode

1. In System Browser, click the Display Mode drop-down list.
2. Select the mode you want for displaying objects.
   ➤ The object displays in the new mode throughout the various panes in System Manager.

2.3.1.6 Making a Manually Selected Object the New Primary Selection

➤ The Manual Navigation box is checked, with one or more objects selected.

- Do one of the following:
  - Right-click and select Send to the Primary Pane.
  - Click the Send button.
  - Double-click the object.

NOTE:
Double-clicking works only when selecting a single object.

2.3.1.7 Operating Multiple Objects

Multiple objects can be commanded or engineered using multi-select.
To select a number of non-adjacent objects:
1. Select the first object using the mouse.
2. Press the CTRL key and hold it.
3. Select all other desired objects using the mouse.
To select a range of adjacent objects:
1. Select the beginning of your range of objects using the mouse.
2. Press the SHIFT key and hold it.
3. Select the end of your range of objects using the mouse.

NOTE:
Limitations for selected objects are 250 items for commanding.

Commanding Multiple Objects in the Operation Tab

➤ The objects must be of the same object type, such as analog input. If different object types are selected, in the Operation tab, the message No properties (different properties) displays.

1. In System Browser, select Management View.
2. Select the objects you want to change.
3. In the Operation tab, select the properties that you want to command.
   ➤ If the properties have different values, they are displayed with an asterisk (*) but can be commanded.
4. *(Optional)* Click the icon to display detailed information about the selected data points.

5. Do one of the following:
   - Change the value and click **Send** or **Change**.
   - Click a command button to execute the respective function.

   Only objects properties that have been changed will be logged in the Activity Log database.

---

**2.3.2 System Browser Reference**

This section provides background information for using System Browser. For related procedures, see Working with System Browser [➙ 49].

**2.3.2.1 Overview of System Browser**

System Browser displays objects in the building control system through various views, which you can select from a drop-down list. System Browser also supports searching and filtering of objects, displaying names and descriptions of objects, selecting single and multiple objects, and dragging objects into Trends, Schedules, and Reports. The System Browser hierarchy updates dynamically to reflect changes at the system level.

**Searching and Filtering**

The **Search** area consists of an editable **Search** list box, a **Search** button, a drop-down list arrow, a **Filter Search** icon, and a **Save Search** icon.

Searching helps you quickly find objects in the currently selected view. You can perform searches on either names or descriptions but not on a combination of both names and descriptions. To start a search, you enter a search string in the **Search** list box, using wildcards if desired, and then either click **Search** or press **ENTER**. See the **Wildcards** section for more information about them.

After the search results display, you can save the search by clicking **Save As**, entering a name in the **Save Search** field, and then clicking **Save**. The system saves the search to your own local user profile, and the search then becomes
available only to you. You access saved searches by clicking the drop-down list arrow in the **Search** list box.

Filtering helps you limit the number of objects shown during a search, while also providing an efficient way to find objects without scrolling through the entire tree or without having to remember which node an object belongs to. You access the filtering fields by clicking **Filter Search**. You can then filter the objects by selecting individual or multiple building control disciplines, sub disciplines, types, sub types, or an alias. Additionally, the **Other** drop-down list box allows you to filter objects for out of scan, override protection, and validation profile settings.

Selecting the **Search within selection** check box applies your filter selections only to the current node selection in the System Browser tree. Clicking the **Search** button starts the search and displays the results of your filter selections.

Search results for both the searching and filtering features are sorted by path, using grouping, and by the name within each group. For example, a search for objects located in the east wing of the 92nd floor in your building could produce results similar to the following:

```plaintext
 Willis Tower\Floor 92\East Wing\ 
   EastWingTemp
   EastWingDailyTrend
   EastWingWeeklySchedule
   EastWingGraphic
```

**Wildcards**

Two wildcard characters are supported in System Browser—the asterisk (*) and the question mark (?). Each functions differently. The asterisk wildcard serves as a placeholder for zero or more characters. The question mark wildcard serves as a placeholder for exactly one character only. Therefore, each wildcard serves different purposes.

- **• * (asterisk):** Allows you to add zero or more characters to your search criteria. For example, "a*" matches and displays, "a", "ab", "abc" and "abcd".
  - **• ? (question mark):** Allows you to add one character to your search. For example, "ab?" matches and displays "abc", but does not match or display "a", "ab" and "abcd".

**Display Modes for Objects**

System Browser supports four modes for displaying objects. **Show Description** is the default display mode the first time you log on to the system with new credentials. After you log on, you can select your preferred mode, which the system saves for your next session. The mode you select affects the way the objects appear throughout the various panes in System Manager. The following table summarizes the four modes with display examples:

<table>
<thead>
<tr>
<th>Display Mode</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Description</td>
<td>Air Handler Unit 1</td>
</tr>
<tr>
<td>Show Description [Name]</td>
<td>Air Handler Unit 1 [AHU1]</td>
</tr>
<tr>
<td>Show Name</td>
<td>AHU1</td>
</tr>
<tr>
<td>Show Name [Description]</td>
<td>AHU1 [Air Handler Unit 1]</td>
</tr>
</tbody>
</table>
Views
You can select from different views of the object types in the building control system, depending on how your system is set up. Selecting a view does not change the physical makeup of the system. The views merely represent convenient and different ways of looking at the system. Default views include **Application View** and **Management View**. The currently selected view is saved from session to session. In other words, the view that is selected when you close the software is the view that the system restores the next time you open the control software. Your last highlighted object selection in the System Browser tree, and the state of the expanded and collapsed folders, are not saved and restored from session to session.

Making Object Selections
System Browser offers you the following two methods for making objects the primary selection in System Manager:

- **Automatic Selection** (default): For selecting a single-object, you click the object, and it then automatically becomes the new primary selection in System Manager. For selecting multiple objects, you press and hold the **CTRL** key or the **SHIFT** key while highlighting the objects. Upon releasing either key, the objects become the new primary selection in System Manager.

- **Manual Selection**: First, check the **Manual Navigation** box, then highlight the objects in one of three ways: 1) Clicking the object, 2) Pressing and holding the **CTRL** key while clicking multiple objects, or 3) pressing and holding the **SHIFT** key while clicking the beginning and ending range of objects. To make the highlighted objects the primary selection for System Manager, you can right-click and choose **Send to the Primary Pane**, or click the **Send** button. When selecting a single object, you can also double-click the object to make it the primary selection.

Dragging-and-Dropping
System Browser supports drag-and-drop of single or multiple objects from any of the views—including the **Search Result** view—to Trends, Schedules, and Reports. You can cancel a dragging operation by pressing the **ESC** key or by dragging the objects back to the original view (or another no-drop zone) and then dropping them.
2.3.2.2 System Browser Workspace

System Browser displays objects in the building control system through various views, and also supports searching and filtering.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Views List box</td>
<td>Allows you to select the view of the system by clicking the dropdown arrow.</td>
</tr>
<tr>
<td>2 Search List box</td>
<td>Allows you to search for objects in the currently selected view.</td>
</tr>
<tr>
<td></td>
<td>You can perform searches on either names or descriptions but not on a</td>
</tr>
<tr>
<td></td>
<td>combination of both names and descriptions. The box consists of an editable</td>
</tr>
<tr>
<td></td>
<td>field where you enter search strings, including wildcards. You can perform</td>
</tr>
<tr>
<td></td>
<td>a search by name or description, depending on the setting of the Display</td>
</tr>
<tr>
<td></td>
<td>mode. You start a search by entering text and then either pressing ENTER</td>
</tr>
<tr>
<td></td>
<td>or clicking the Search icon. The matching results display in the list area.</td>
</tr>
<tr>
<td></td>
<td>The dropdown arrow displays a list of your saved searches.</td>
</tr>
<tr>
<td>3 Display Mode List box</td>
<td>Provides four options to display objects: Description, Description + Name,</td>
</tr>
<tr>
<td></td>
<td>Name, and Name + Description. When you choose to display an object’s</td>
</tr>
<tr>
<td></td>
<td>Description + Name, the description appears first, followed by the name.</td>
</tr>
<tr>
<td></td>
<td>When you choose to display an object’s Name + Description, the name appears</td>
</tr>
<tr>
<td></td>
<td>first, followed by the description. The option you select affects the way</td>
</tr>
<tr>
<td></td>
<td>the object displays throughout the various panes in System Manager.</td>
</tr>
</tbody>
</table>
### Manual Navigation check box
One of two methods for making objects the primary selection in System Manager. By default, automatic selection is enabled, which means that any object you select in System Browser automatically becomes the new primary selection for the system. If you want to scroll through the System Browser tree and highlight an object without making it the primary selection, check the **Manual Navigation** box, and then single-click the object. If you then decide that you want to make the highlighted selection the new primary selection, you can do one of the following:

- Right-click and select either **Send to the Primary Pane**, or **Send to the Secondary Pane**.
- Click the **Send** button (sends to **Primary** pane only)
- Double-click (for single-object selection only, and sends to **Primary** pane only)

### System browser tree
Displays system objects in a hierarchy.

### Filtering icon
Displays the **Filtering Search** area, where you can limit your search. You filter the objects by selecting individual or multiple building control disciplines, subdisciplines, types, subtypes, and aliases (which are case sensitive). Additionally, the **Other** drop-down list box allows you to filter for out of scan, override protection, and validation profile settings.

- Clicking the X in the **Alias** field clears only the **Alias** field. Clicking the **Clear** button clears the **Discipline**, **Type**, **Other**, and **Alias** fields.
- Selecting the **Search within selection** check box applies your filter selections only to the current node selection in the System Browser tree.
- Clicking the **Search** button starts the search and displays the results of your filter selections.

### Save icon
Allows you to save a search entry for later use. Saving a search does not save the node location at the time of the save, only the filtering selections. This applies even if you select the **Search within selection** check box. You access saved searches by selecting the drop-down arrow in the Search list box.

### Send button
The **Send** button works in conjunction with the **Manual Navigation** check box. Once you select the check box and highlight an object, click the **Send** button and the object becomes the new primary selection for the system.
2.4 Textual Viewer
This section provides information and instructions for using the Textual Viewer.

2.4.1 Working with Textual Viewer
This section provides step-by-step instructions for some common Textual Viewer tasks. For background information, see Textual Viewer Reference [➙ 57]. Perform the procedures in this section as needed.

2.4.1.1 Customizing Columns
▷ System Manager is in Operating mode.
1. In Textual Viewer, right-click one of the following:
   - Column heading
   - Row
   - Scroll bar within the Primary pane
2. Select Customize columns.
   ◄ The Customize Columns dialog box displays.
3. Do one of the following:
   - To remove columns from the Visible list, select one or more headings, and then click the active arrow to move the headings.
   - To add columns to the Visible list, select one or more headings from the Available list, and then click the active arrow to move the headings.
4. Use the Move up and Move down buttons to arrange the order of the columns.
5. Click OK.

2.4.1.2 Making a New Primary Selection
▷ System Manager is in Operating mode.
▷ Textual Viewer displays more than one object, and you would like to make one of those objects the new primary selection.
   ● In Textual Viewer, double-click the object you want to make the new primary selection.
   ◄ Textual Viewer sends the object to System Browser, and System Browser changes its focus to the object, just as if you had selected the object directly from System Browser. System Browser then refreshes the Textual Viewer, which displays the new primary selection.

2.4.1.3 Rearranging Columns
▷ System Manager is in Operating mode.
▷ Textual Viewer is open, and you would like to rearrange the order of the columns.
1. Select the column you want to move.
2. Drag-and-drop the column onto the desired location.
2.4.1.4 Sorting Objects

- System Manager is in Operating mode.
- You have more than one object displaying in Textual Viewer, and you would like to sort them.

1. In the column you want to sort, click the column heading.
2. Do one of the following:
   - If the column is arranged in alphabetical order and you want to arrange it in reverse alphabetical order, select the column heading. When the up arrow displays, click the column heading again.
   - If the column is in reverse alphabetical order and you want to arrange it in alphabetical order, select the column heading.

The column sorts itself in either an ascending or descending alphabetical order, depending on the order prior to selecting the drop-down arrow.

2.4.2 Textual Viewer Reference

This section provides background information for using Textual Viewer. For related procedures, see Working with Textual Viewer [➙ 56].

2.4.2.1 Overview of Textual Viewer

Textual Viewer displays the details for one or more objects in the building control system. For example, after you select one or more objects from System Browser, Textual Viewer displays their common properties in list form. Your selections can be either implicit or explicit. An implicit selection occurs when you click a parent object that has child objects associated with it. In this case, Textual Viewer displays the parent object in bold, followed by the child objects beneath it. An explicit selection occurs when you click a parent object that does not have child objects associated with it. You can sort the information in the various columns by selecting the column headings, and you can rearrange the order of the columns by dragging them to the desired location. Additionally, you can use the Customize Columns tool to hide or show columns. The tool is available by right-clicking on a column heading, a row, or the scroll bars.

Making a New Primary Selection

Making a new primary selection in Textual Viewer is an efficient alternative to manually scrolling through the System Browser tree to look for an item. It is also quicker than performing a formal search for an object using the Search feature.

Using the Double-Click Function

The double-click function gives you the ability to investigate building control system information in increasing detail. For example, if you select a building in System Browser, Textual Viewer displays it, along with each of the floors of the building. When you double-click one of the floors, Textual Viewer displays the floor, along with the sensors that are installed on that floor. If you then double-click one of the sensors, Textual Viewer displays the sensor. If a graphic is associated with the sensor, a graphic displays. If not, text displays.
### 2.4.2.2 Textual Viewer Workspace

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Object Displays a list of objects in the system. A bolded object indicates</td>
</tr>
<tr>
<td></td>
<td>a parent object with associated children objects.</td>
</tr>
<tr>
<td>2</td>
<td>Title bar Displays the name of the object with the primary selection. If</td>
</tr>
<tr>
<td></td>
<td>you select multiple objects, the name of the first object you selected</td>
</tr>
<tr>
<td></td>
<td>will display. If you select a parent object, you implicitly select the</td>
</tr>
<tr>
<td></td>
<td>children objects belonging to the parent as well. In this case, the</td>
</tr>
<tr>
<td></td>
<td>parent object displays in the title bar.</td>
</tr>
<tr>
<td>3</td>
<td>Path Displays the location of the object in the building control system.</td>
</tr>
<tr>
<td>4</td>
<td>Name Displays the name of the object.</td>
</tr>
<tr>
<td>5</td>
<td>Alias Displays a unique name within the system for an object.</td>
</tr>
<tr>
<td>6</td>
<td>Type Displays the type of object selected such as Smoke Detector, Room,</td>
</tr>
<tr>
<td></td>
<td>Graphic and so on.</td>
</tr>
<tr>
<td>7</td>
<td>Subtype Displays the subtype of object selected such as Multi-state, Binary</td>
</tr>
<tr>
<td></td>
<td>Input, and so on.</td>
</tr>
<tr>
<td>8</td>
<td>Validation Profile Displays one of three scenarios for validation:</td>
</tr>
<tr>
<td></td>
<td>Disabled, Enabled, or Supervised.</td>
</tr>
<tr>
<td>9</td>
<td>Out of Scan Displays False, which means the communications driver is</td>
</tr>
<tr>
<td></td>
<td>reading the object, or True, which means the communications driver is not</td>
</tr>
<tr>
<td></td>
<td>reading the object.</td>
</tr>
<tr>
<td>10</td>
<td>Value Displays the current value of the object.</td>
</tr>
<tr>
<td>11</td>
<td>Image Displays an image associated with the status indicator.</td>
</tr>
<tr>
<td>12</td>
<td>Status Displays the status of the object such as Normal, or the</td>
</tr>
<tr>
<td></td>
<td>consolidated status of the object such as Fire Alarm, Fault, or Technical</td>
</tr>
<tr>
<td></td>
<td>Exclusion.</td>
</tr>
</tbody>
</table>
Customize Columns Dialog Box

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Available Columns</td>
<td>Displays a list of columns not currently shown in <strong>Textual Viewer</strong>.</td>
</tr>
<tr>
<td>2 Movement arrows</td>
<td>Allow you to move columns to control whether they are hidden or shown.</td>
</tr>
<tr>
<td>3 Visible Columns</td>
<td>Displays a list of columns that will show in <strong>Textual Viewer</strong>.</td>
</tr>
</tbody>
</table>
| 4 Selection buttons | **Move Up/Move Down**: Allow you to rearrange the order in which columns display.  
                          **OK**: Allows you to accept the changes you have made.  
                          **Cancel**: Allows you to cancel changes you have made. |
2.5 **Operation/Extended Operation**

This section provides information and instructions for using the Operation and Extended Operation tabs in the Contextual pane of System Manager.

2.5.1 **Working with Operation/Extended Operation**

This section provides step-by-step instructions for some common tasks in the Operation/Extended Operation tabs. For background information, see Operation/Extended Operation Reference [➙ 61].

Perform the procedures in this section as needed.

2.5.1.1 **Commanding Properties**

▶ You have selected the object whose properties you want to command.

1. Click the **Operation** or **Extended Operation** tab.
   ◁ The tab displays properties of the object, their states, and all commands available to you for the properties.

2. Click the command button that displays the command you want to execute.
   ◁ If the command does not have arguments associated with it, the command is sent and the status displays.
   ◁ If the command button has arguments associated with it, go to the next step.

3. Complete the required fields.

4. Click **Send**.
   ◁ The system displays the status of the command.

2.5.1.2 **Commanding Properties for Multiple Objects**

▶ You want to simultaneously command properties for multiple objects of the same type.

1. In **System Browser**, navigate to the locations containing the objects you want to select, and then select them.

2. Click the **Operation** or **Extended Operation** tab.

3. Click the triangular symbol in the lower-right-hand corner on the icon next to the property you want to command.
   ◁ The table row expands to show multiple instances of the property—one for each of the objects selected.

4. Do one of the following:
   - In the top row of the property, enter the value for the property, and then click **Change**.
   - In the top row of the property, click the button that represents the action you want to take—for example, **Command**, **Release**, **Change**, **Out of Svc**, **Enable**, **Ack All**, and so forth. If the action has additional fields, complete them, and then click **Send**.

   ◁ The system displays the status of the command.
2.5.2 Operation/Extended Operation Reference

This section provides background information for using the Operation and Extended Operation tabs. For related procedures, see Working with Operation/Extended Operation [➙ 60].

2.5.2.1 Overview of Operation/Extended Operation

The Operation and Extended Operation tabs allow you to display and change the current state of an object’s properties in your building control system. The Operation tab is designed for the most common daily tasks, and the Extended Operation tab is designed for more detailed tasks. Access to objects is based upon the object privileges and privilege profiles set for you by your system administrator.

Properties and Commanding

You change the current state of a property by commanding it. Once you command a property, the status of the command displays for the selected object. If the command fails, the reason for the failure displays so that you can take further action.

Examples of common commands:
- Acknowledge
- Change command priority
- Coldstart
- Enable/disable
- On/Off
- In service/Out of service
- Override/Release
- Reset value for equipment operating hours
- Set a new point value
- Upload

Display of Properties

Properties display in one of two ways—automatically or manually. They display automatically when a property goes into an off-normal state, and they display manually when you select an objects in the system.

Why Command a Property?

You command a property to change its current state. For example, you might command to initiate an action, enable or disable a property, acknowledge or reset the status of a property, or override or release an override of a control program.

Commanding a property is also useful under these conditions:
- User action is required to manage an emergency
- When an alarm indicates a malfunctioning device
- When performing preventive maintenance
- To save energy
- When managing operating hours totalization

Example of Commanding

At your facility, you want to change the temperature from 68 to 73°F (20 to 22.78°C) in a conference room on your floor. Using your building control software, you send a command to change the Present Value of the Temperature Setpoint object of the room to override the normal system control.
Command Priorities and Priority Arrays

Some objects in your building control system use specialized command priorities to determine whether an operator or a particular control program is in control.

Command Priority
The Present Values of six object types in your building control system are based on a command priority and established in a hierarchy that ranks from highest (1 – Manual Life Safety) to lowest (16 - Available). The six object types are Analog Output, Analog Value, Binary Output, Binary Value, Multi-State Output, and Multi-State Value. The hierarchy helps determine which source has priority over another to change the value of an object. To command one of these object types, you—or an application—must have a command priority equal to or greater than the current command priority of the object.

Command Priority Array
The Command Priority Array displays commands that have been issued at various priority levels. Users and applications can set or relinquish (release) commands for a commandable object. If the Present Value of an object has a Command Priority Array, the appropriate priority level is commanded or relinquished when you execute a command. If the Present Value of an object does not have a Command Priority Array, the system overwrites the present value with the newly commanded value. You can command or relinquish any priority level that you have access to, based on your user privileges.

The following table shows the Command Priority Array:

<table>
<thead>
<tr>
<th>Priority Level</th>
<th>Priority Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Manual Life Safety</td>
</tr>
<tr>
<td>2</td>
<td>Automatic Life Safety</td>
</tr>
<tr>
<td>3</td>
<td>Available</td>
</tr>
<tr>
<td>4</td>
<td>Available</td>
</tr>
<tr>
<td>5</td>
<td>Critical Equipment Control</td>
</tr>
<tr>
<td>6</td>
<td>Minimum On/Off</td>
</tr>
<tr>
<td>7</td>
<td>Available</td>
</tr>
<tr>
<td>8</td>
<td>Manual Operator</td>
</tr>
<tr>
<td>9</td>
<td>Available</td>
</tr>
<tr>
<td>10</td>
<td>Available</td>
</tr>
<tr>
<td>11</td>
<td>Available</td>
</tr>
<tr>
<td>12</td>
<td>Available</td>
</tr>
<tr>
<td>13</td>
<td>Available</td>
</tr>
<tr>
<td>14</td>
<td>Available</td>
</tr>
<tr>
<td>15</td>
<td>Available</td>
</tr>
<tr>
<td>16</td>
<td>Available</td>
</tr>
</tbody>
</table>

Summary Status
In order to simplify the system display and highlight the most important information, the system sometimes combines properties into a single Summary Status property. The Summary Status property displays the highest priority status that is currently active for an object. For example, if an object has an active Fire Alarm and Fire Fault, the Fire Alarm would be displayed in the Summary Status.
Multiple-Object Commanding

With multiple-object commanding, you are not really commanding objects at all. Instead, you are commanding one property type, Present Value for instance, for more than one object of the same type.

If you select multiple objects of the same type, for example, Analog Output, the icon next to the property name in the Operation or Extended Operation tab indicates this with a triangular symbol in the lower right-hand corner. Clicking this symbol expands the table row to show all of the selected objects of the same type that share this property. You can then change (command) all Present Value properties for the selected objects at the same time. You can command a maximum of 250 objects.

In the following graphic, the system indicates that you have selected multiple objects by displaying a triangular symbol in the lower right-hand corner of the Present Value icon.

The following graphic shows that you have clicked the triangular icon. The system now displays two additional rows, which represent two selected objects of the same type.

Propagation

Propagation means relaying Common Status information up the building control system's hierarchical tree. Information that is relayed up the hierarchy as a result of a change in the Common Status of an object is called status propagation.

Propagation is based on the parent-child-grandchild model. Each object in the system can have one or more parent objects and one or more child objects. Each child in the system can simultaneously propagate multiple active Common Status properties to a parent, such as fire alarm, fault, or technical excluded.

The following table shows propagation from two different viewpoints.

<table>
<thead>
<tr>
<th>Logical View of the System</th>
<th>Physical View of the System</th>
</tr>
</thead>
<tbody>
<tr>
<td>Building (parent)</td>
<td>A building node (parent)</td>
</tr>
<tr>
<td>Floor in the building (child)</td>
<td>Field panel (child)</td>
</tr>
<tr>
<td>Room on the floor (grandchild)</td>
<td>Point (grandchild)</td>
</tr>
<tr>
<td>Temperature sensor in the room (great-grandchild)</td>
<td>-</td>
</tr>
</tbody>
</table>
2.5.2.2 Operation/Extended Operation Workspace

The Operation and Extended Operation tabs display the name of the currently selected objects, a list of properties associated with the object, the current value of the properties, and command buttons for initiating commands on commandable properties.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1 Property name | Displays the name of one or more properties associated with the selected objects.  
                  If you select multiple objects of the same type in the system, the icon next to the property name indicates this with a triangular symbol in the lower right-hand corner. Clicking this symbol expands the table row to show all of the selected objects of the same type that share this property. You can then change all properties for the selected objects at the same time. |
| 2 Object name   | The name of the selected object. If you selected more than one object to display, the default object name is Multi-Select. |
| 3 Current value | Displays the current value of each property.                                 |
### 2.6 Related Items

This section provides information and instructions for using the Related Items tab in the Contextual pane of System Manager.

#### 2.6.1 Working with Related Items

This section provides step-by-step instructions for some common tasks in the Related Items tab. For background information, see Related Items Reference [➙ 66].

Perform the procedures in this section as needed.

#### 2.6.1.1 Viewing a Related Item

- You have selected an object with related items.
  - From **Related Items**, click the item you would like to view—for example, click a New Report, a Schedule, a PDF file, or a URL.
  - The management station opens the representation for the selected item in the Secondary Pane (or in the Primary pane if the Primary pane splitting is locked).

#### 2.6.1.2 Viewing Links

- You have selected an object with Related Items displayed as icons.
  - From Related Items, click the Links button.
  - The Related Items display in Links view.
2.6.1.3 Viewing Icons

- You have selected an object with Related Items displayed as links.
  - From Related Items, click the Icons button.
  - The Related Items display in the Icons view.

2.6.1.4 Grouping Items in the List

- You have selected an object with Related Items displayed in a flat list.
  - From Related Items, click the Group button.
  - All related items are grouped according to type—for example, Report, Graphic, Schedule, etc.

2.6.1.5 Ungrouping Items in the List

- You have selected an object with Related Items displayed in Groups view.
  - From Related Items, click the Ungroup button.
  - All items are ungrouped.

2.6.1.6 Creating a New Object

- You have selected an object with links displaying in Related Items.
  - From Related Items, click the type of object you would like to create—for example, New Report.
  - The management station opens a new object type in the Secondary pane.

2.6.2 Related Items Reference

This section provides background information for using the Related Items tab. For related procedures, see Working with Related Items.

2.6.2.1 Overview of Related Items

The Related Items tab displays objects related to the currently selected object. Each related item is assigned a group name that represents the type of the object—for example, graphics, trends, reports, or schedules.

Navigation

You can navigate to a view of each related item by clicking on the item. For instance, if you click a management station object, such as a graphic, Graphics Viewer displays the referenced graphic object. If you click an external item, such as a PDF file, Adobe Reader opens with the referenced file displayed. Other items that you can access include point types, Word documents, Excel documents, and URLs.

Display of Items

The Related Items tab displays the items used for most daily operations. Related Items contains two sets of buttons. You can toggle the first set of buttons, Links and Icons, which allows you to switch between text views or small images of the items in the list. The Links view is more compact than the Icons view, so more related items can be displayed with this view than with the Icons view. The display mode that is currently selected in System Browser determines how text displays in
**Related Items.** For example, text might be displayed as description, name, description plus name, or name plus description.

The second set of buttons, **Group** and **Ungroup**, allows you to switch between categories or flat-list views of the items in the list. The **Group** view shows items arranged by object type (analog input, digital output, schedules, graphics, reports, PDFs, Word files, web links, etc.) and is expanded by default, but which you can collapse as well. When the **Group** view is collapsed, the **Links** and **Icons** views are disabled. The **Ungroup** view displays all related items without displaying their corresponding group names.

If you select one object from System Browser, **Related Items** displays all links associated with that object. If you select two or more objects from System Browser, **Related Items** displays only those links that all selected objects have in common.

For example, you select three objects in System Browser with the following links:

<table>
<thead>
<tr>
<th>Object</th>
<th>Links</th>
</tr>
</thead>
<tbody>
<tr>
<td>EastWingLabTemp</td>
<td>Monthly Energy Consumption Report</td>
</tr>
<tr>
<td></td>
<td>Third Floor Heating/Cooling Schedule</td>
</tr>
<tr>
<td></td>
<td>Third Floor Temperature Trend</td>
</tr>
<tr>
<td>WestWingOfficeTemp</td>
<td>Monthly Energy Consumption Report</td>
</tr>
<tr>
<td></td>
<td>Third Floor Heating/Cooling Schedule</td>
</tr>
<tr>
<td></td>
<td>Third Floor Temperature Trend</td>
</tr>
<tr>
<td>NorthWingOfficeTemp</td>
<td>Monthly Energy Consumption Report</td>
</tr>
<tr>
<td></td>
<td>Third Floor Heating/Cooling Schedule</td>
</tr>
</tbody>
</table>

The result of this selection is that **Related Items** displays only the Monthly Energy Consumption Report and the Third Floor Heating/Cooling Schedule links because they are common to all three objects. The Third Floor Temperature Trend link does not display because it is not common to all three selected objects. To view the Third Floor Temperature Trend link in this example, you would need to select either the EastWingLabTemp object or the WestWingLabTemp object.

While **Related Items** works to retrieve the links for the objects you select, it displays text to indicate the status of the selections.

**APOGEE Field Panel Hyperlinks**

Desigo CC supports both FPWeb UI and APOGEE Editors for viewing and editing APOGEE objects in APOGEE field panels. However, if you are using the newer FPWeb UI Editors to view FLN devices listed in the Hyperlinks group, you must have Firmware Revision 3.4 or later installed in your panels. Otherwise, you will not be able to view the links in the **Secondary Pane**.

**Maintenance of User Preferences**

**Related Items** stores the settings of the **Group** and **Ungroup** views and the **Links** and **Icons** views for each object that you interact with so that you do not need to continually adjust your settings as you navigate from one object to the next.

**Deleting and Re-adding Points**

Be careful about deleting and then re-adding points in your system since this can break the links in **Related Items**.

For example, you select a point on a graphic, and the graphic itself displays as one of the links for that point in **Related Items**. If you delete the point from the field panel, and then re-add it (re-import it using the Auto Discovery feature), the graphic will display the point, but the related items for the point will be lost. If you select the re-added point in System Browser, the graphic will not display.

In the case of graphics, you can restore the broken links using the Graphics Consistency Checker diagnostic tool.

If you delete points relating to camera devices, External Documents, and Management Station Schedules, your links will be permanently lost.
### 2.6.2.2 Related Items Workspace

Related Items allows you to switch between small images and text views of the items in the list, or between categories and flat-list views of the items in the list.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>1</strong> Links/Icons buttons</td>
<td>The <strong>Links</strong> button allows you to view items as text displays. The display mode that is currently selected in System Browser determines how text displays in <strong>Related Items</strong>. For example, text might be displayed as description, name, description plus name, or name plus description. The <strong>Icons</strong> button allows you to view related items as small images.</td>
</tr>
<tr>
<td><strong>2</strong> Group/Ungroup buttons</td>
<td>The <strong>Group</strong> button allows you to group items by object types such as analog inputs, analog outputs, schedules, reports, PDFs, Word files, and Web links. The <strong>Ungroup</strong> button allows you to view items in a flat list without their corresponding category names. Items display icons associated with the object type.</td>
</tr>
</tbody>
</table>
3 Alarms

This section provides information and instructions for handling alarms in Desigo CC.

3.1 Working with Alarms

This section provides step-by-step instructions for some common alarm-handling tasks in Desigo CC. For background information see Event List and Alarms Operation Reference [➙ 92]. Perform the procedures in this section as needed.

3.1.1 Opening and Closing Event List

Opening Event List

▷ The Event List is not visible and you want to display it.

1. On the right-hand side of the Summary bar, click Open Event List.
   ● The Event List displays in the main work area of the system screen.

Closing Event List

▷ The Event List displays in the main work area of the system screen, and you want to close it.

● Do one of the following:
  – On the Summary bar, click Close Event List.
  – On the left side of the Event List header, click .
   ● The Event List is closed, and System Manager displays in its place.

Related Topics

Event List Reference [➙ 96]
Switching Between Active Windows [➙ 27]
Main Screen Layout Reference [➙ 22]

3.1.2 Selecting an Event in Event List (Fast Treatment)

▷ You want to select an event in the list to begin or resume working with it.

   NOTE: In some configurations, certain types of events autoselect when they occur, in which case you will not have to perform this step.

▷ The Event List displays in the main work area of the system screen.

1. From Event List, click the event descriptor of the event that you want to handle.
   ● The event is selected and its event descriptor becomes highlighted:
     - The In process by field updates to indicate you are currently handling this event.
     - The Suggested action field indicates the next action you should take.
     - The Command field shows any available alarm-handling commands that you can send.
     - If any other event was previously selected, it is automatically deselected (suspended).

2. If required, you can send alarm-handling commands. See Sending Alarm-Handling Commands in Fast Treatment or Investigative Treatment [➙ 70].
3.1.3 Selecting Multiple Events in Event List

▷ You want to select multiple events in Event List, to handle them all together.

1. To perform a multiple selection, do one or more of the following:
   - Use **CTRL+A** to select all the events in the list.
   - Hold **CTRL**, and click the event buttons one-by-one, to add events to the selection.
   - Hold **SHIFT** and click the first and last event buttons of a range to add a contiguous set of events to the selection.

2. To remove an event from the selection, press **CTRL** and click its event button.

3. To deselect all the events in the selection, click the event button of any one of the selected events.

▷ A group of events is selected, and their event descriptors display highlighted. Any commands you issue will be sent to all the events for which that command is available.

Next Step:
Sending Alarm-Handling Commands in Fast Treatment or Investigative Treatment [➙ 70]

Related Topics
Event Descriptor Reference [➙ 102]

3.1.4 Sending Alarm-Handling Commands in Fast Treatment or Investigative Treatment

▷ You are handling an event from Event List or from the Investigative Treatment window.

1. *(Optional)* In the Information column, do the following:
   - Click **Show Intervention text** to check for any additional instructions or information concerning this alarm.
   - Click **Log an event note** to enter a note about this event in the history database.

2. Follow the instructions provided in the Suggested action column. These may include:
   - **Acknowledge event.** Click the **✓** icon in the Commands column to send the Acknowledge command.
   - **Wait for condition.** The event cannot be reset until the event source is back to normal. You must correct the situation that caused the alarm, or wait for the event source to return to the Quiet state, before you can finish handling this event.
– Close event. Click the \( \text{\textcircled{R}} \) icon in the \textbf{Commands} column to send the \textit{Reset} command.
– Suspend the event. You finished handling this event, and the event is ready to be cleared from the list. Click the event button again to deselect the event. It will then be removed from Event List.

3. While handling the alarm according to the \textbf{Suggested action}, also check the \textbf{Command} column for any other, optional commands available to you. These may include:

– After you acknowledge an event, if the alarm has caused a field panel to sound an audible alarm in the site, click \textit{Silence} \( \text{\textcircled{B}} \) to silence the panel, or click \textit{Unsilence} \( \text{\textcircled{B}} \) to turn it back.
– If any remote notification is configured for that event, \textit{Start Remote Notifications} or \textit{Stop Remote Notifications} become available.

4. To stop handling the event, click the event button again.

\( \text{\textcircled{R}} \) In investigative treatment, the \textbf{Investigative Treatment} window closes. In fast and investigative treatment, if you finished handling the event (event status=\textit{Closed}), the event is cleared from Event List. Otherwise, the event is deselected but remains in the list. You can resume handling it at any time.

\textbf{Related Topics}

Event Descriptor Reference [\textit{\textbf{102}}]
Interrupting Handling of an Alarm [\textit{\textbf{80}}]
Alarm-Handling Commands Reference [\textit{\textbf{109}}]
Event Status and Suggested Action Reference [\textit{\textbf{110}}]

### 3.1.5 Handling an Event with Investigative Treatment

\textbf{Scenario:} You want to handle an alarm while inspecting the event source as you would in System Manager.

1. From Event List, do one of the following:
   – Double-click the event button of the event.
   – In the \textbf{Information} column of the event, click \textit{Opens related treatment} \( \text{\textcircled{P}} \).

\textbf{NOTE:} If investigative treatment is not available for this alarm, the assisted treatment icon (\( \text{\textcircled{B}} \)) is available instead. See Handling an Event with Assisted Treatment [\textit{\textbf{72}}].

\( \text{\textcircled{R}} \) The dedicated \textbf{Investigative Treatment} window opens. This is a window similar to System Manager, with the alarm’s event descriptor displayed along the top, and the object that caused the alarm already selected in System Browser.

\( \text{\textcircled{R}} \) In Event List the event button for that event is replaced by a blank placeholder to indicate it is under investigative treatment.

2. Use the panes of the \textbf{Investigative Treatment} window to inspect the event source as you would in System Manager.

3. If required, you can send alarm-handling commands. See Sending Alarm-Handling Commands in Fast Treatment or Investigative Treatment [\textit{\textbf{70}}].
3.1.6 Handling an Event with Assisted Treatment

Scenario: You want to handle an alarm using the guided Assisted Treatment feature. An operating procedure was configured for the assisted treatment of that alarm.
Perform the procedures in this section as needed.

3.1.6.1 Starting Assisted Treatment of an Event
1. From Event List, do one of the following:
   - Double-click the event button of the event.
   - In the Information column of the event, click Open related treatment.

   NOTE: If assisted treatment is not available for this alarm, the investigative treatment icon (◫) is available instead. See Handling an Event with Investigative Treatment [➙ 71].
   ➤ The dedicated Assisted Treatment window opens. In Event List, the event button for that event is replaced by a blank placeholder to indicate it is under assisted treatment.
2. If required, you can send alarm-handling commands and complete the steps of an operating procedure. See Sending Alarm-Handling Commands in Assisted Treatment [➙ 72] and Completing an Operating Procedure of Assisted Treatment [➙ 73].

Related Topics
Assisted Treatment Window Reference [➙ 99]
Event Descriptor Reference [➙ 102]
Interrupting Handling of an Alarm [➙ 80]

3.1.6.2 Sending Alarm-Handling Commands in Assisted Treatment
▷ You are handling an event from the Assisted Treatment window.
1. (Optional) In the Information column, do the following:
   - Click Show Intervention text to check for any additional instructions or information concerning this alarm.
   - Click Log an event note to enter a note about this event in the history database.
2. Follow the instructions provided in the Suggested action column. These may include:
   - Acknowledge event. Click the icon in the Commands column to send the Acknowledge command.
   - Complete Operating Procedure. No further commands are available because you must first complete at least the mandatory steps of the
operating procedure. See Completing an Operating Procedure of Assisted Treatment [→ 73].

- Wait for condition. The event cannot be reset until the event source is back to normal. You must correct the situation that caused the alarm, or wait for the event source to return to the Quiet state, before you can finish handling this event.

- Reset event. In the Commands column, click Reset.

- Close event. In the Commands column, click Close.

- Suspend the event. You finished handling this event, and the event is ready to be cleared from the list. Click the event button again to deselect the event. It will then be removed from Event List.

3. While handling the alarm according to the Suggested action, also check the Command column for any other, optional commands available to you. These may include:

- After you acknowledge an event, if the alarm has caused a field panel to sound an audible alarm in the site, click Silence to silence the panel, or click Unsilence to turn it back.

- If any remote notification is configured for that event, Start Remote Notifications or Stop Remote Notifications become available.

4. To stop handling the event click the event button again.

The Assisted Treatment window closes. The event is cleared from Event List.

Related Topics
Event Descriptor Reference [→ 102]
Interrupting Handling of an Alarm [→ 80]
Alarm-Handling Commands Reference [→ 109]
Event Status and Suggested Action Reference [→ 110]

3.1.6.3 Completing an Operating Procedure of Assisted Treatment

▷ You are handling an event from the Assisted Treatment window.

▷ The Suggested action is Complete Operating Procedure, no further commands are available because you must first complete at least the mandatory steps of the operating procedure. Mandatory steps are marked with an exclamation mark !.

1. Move your cursor over a step.

- If it turns into a hand ⌂, it means you can execute that step.

- If it turns into a pointer ⬦, it means that you cannot execute that step. This is usually because a preceding mandatory step needs to be completed first. In this case, try another step.
2. When you find a step you can execute, click it to select it.
   - The step expands and changes to a darker color to indicate that it is being executed. Information and tools for performing that step display in the Default tab. For example, if you selected a document step, the document that you must read will display.

3. Perform the tasks required for the selected step. For detailed instructions see:
   - Executing a Document Step in Assisted Treatment [➙ 75]
   - Executing a Graphic Step in Assisted Treatment [➙ 77]
   - Executing a Remote Notification Step in Assisted Treatment [➙ 76]
   - Executing a Report Step in Assisted Treatment [➙ 79]
   - Executing a Treatment Form Step in Assisted Treatment [➙ 80]
   - Executing an Alarm Printout Step in Assisted Treatment [➙ 78]

4. When you complete the tasks required by the step, the check box alongside the step turns white, indicating that you can check it off. If the check box is gray, it means you cannot check off the step because you have not performed all the actions required to complete the step.

5. Check off the step by clicking the white check box. This marks it as complete.
   - A checkmark displays in place of the check box to indicate the step was completed. An execution status icon underneath it indicates its outcome: success ✓ / failure ❌ / or in progress .

   NOTE: If you see a step that has been automatically checked off, this means it was automatically executed by the system (either immediately when the event occurred, when you initiated alarm handling, or depending on configuration).

6. Repeat the preceding actions until you have completed at least all the mandatory procedure steps. Also complete any non-mandatory steps you want to perform.

7. Some steps are repeatable, and in that case you can select and repeat them, even if they are already checked off. For example, you might want to consult the document in the document step again.

8. Once you have completed the operating procedure, send any further alarm-handling commands that become available to finish handling the alarm. See Sending Alarm-Handling Commands in Assisted Treatment [➙ 72].

Related Topics
Assisted Treatment Window Reference [➙ 99]
3.1.6.4 Executing a Document Step in Assisted Treatment

You are in the Assisted Treatment window and the operating procedure includes a Document step that you want to do.

1. From the Steps list, select the Document step.
   - The contents of the document display in the Default tab.
2. Read the document carefully and follow any instructions.
3. Click Backward or Forward to move through any other documents included in this step.

If a PDF file displays, you can also click Zoom in or Zoom out to quickly zoom in and out the document, or click Print to print the document.

Related Topics
Handling an Event with Assisted Treatment [➙ 72]
Assisted Treatment Window Reference [➙ 99]
Documents Reference [➙ 385]
3.1.6.5 Executing a Remote Notification Step in Assisted Treatment

- You are in the Assisted Treatment window and the operating procedure includes a Remote Notification step that you must execute manually.

1. From the Steps list, click the Remote Notification step.
   - The Message Status list displays in the Default tab.

2. Depending on the type of remote notification, the following commands may become available in the Message Status toolbar:
   - Start RENO procedure. Click to manually start the remote notification or to re-send the remote notification.
   - Stop RENO procedure. Click to abort the remote notification.
   - Stop RENO procedure escalation. Click to stop the escalation of the remote notification for the selected recipient group.

3. (Optional) Select a recipient in the Message Status area to view the text of the message sent in the Message area.

4. Wait for the system to finish sending the notification. Depending on the outcome, the steps status becomes one of the following:
   - Successful, and the remote notification message status is Completed. You can check off the step.
   - Failed, and the remote notification message status is Aborted, Partially failed or No Response. You can check off the step.
   - Failed, and the remote notification message status is Failed. You cannot check off the step.
3.1.6.6 Executing a Graphic Step in Assisted Treatment

You are in the Assisted Treatment window and the operating procedure includes a Graphic step that you want to do.

- From the Steps list, select the Graphic step.
- A graphic of the facility displays in the Default tab.

Related Topics
Graphics Viewer [➙ 115]
Handling an Event with Assisted Treatment [➙ 72]
Assisted Treatment Window Reference [➙ 99]
3.1.6.7 Executing an Alarm Printout Step in Assisted Treatment

You are in the Assisted Treatment window, and the operating procedure includes an Alarm Printout step that you must manually execute.

1. From the Steps checklist, select the Alarm Printout step.
   - The preconfigured alarm report displays in the Default tab. When you select this step for the first time, a new report is generated. On subsequent selection, the same report is reloaded.

2. If the report contains form controls (for example, editable fields or drop-down lists), enter the necessary information and click Save User Input.

3. Click Send to Output.
   - The report is routed to a file, email, or printer, depending on its configured output destination.
   - When you generate an alarm printout, a report, or an alarm-handling form using a virtual printer (for example, a PDF printer), the output files are saved in the following location: C:\GMSProjects\[Customer project]\data\Reporting\Reports.
   - When you complete an assisted procedure of an event, any attachment (such as, alarm printout, report or alarm-handling form) is saved in the following location: C:\GMSProjects\[Customer project]\shared\attachments. The Activity Log report includes a link to these attachments.

Related Topics
Handling an Event with Assisted Treatment [➙ 72]
Assisted Treatment Window Reference [➙ 99]
3.1.6.8 Executing a Report Step in Assisted Treatment

You are in the Assisted Treatment window, and the operating procedure includes a Report step that you must manually execute.

1. From the Steps checklist, select the Report step.
   - The preconfigured report displays in the Default tab. A new report is generated each time that you select this step.

2. If the report contains form controls (for example, editable fields or drop-down lists), enter the necessary information and click Save User Input.

3. Click Send to Output.
   - The report is routed to a file, email, or printer, depending on its configured output destination.
   - When you generate an alarm printout, a report, or an alarm-handling form using a virtual printer (for example, a PDF printer), the output files are saved in the following location: C:\GMSProjects\[Customer project]\data\Reporting\Reports.
   - When you complete an assisted procedure of an event, any attachment (such as, alarm printout, report or alarm-handling form) is saved in the following location: C:\GMSProjects\[Customer project]\shared\attachments. The Activity Log report includes a link to these attachments.

Related Topics
Handling an Event with Assisted Treatment [➙ 72]
Assisted Treatment Window Reference [➙ 99]
3.1.6.9 Executing a Treatment Form Step in Assisted Treatment

You are in the Assisted Treatment window, and the operating procedure includes a Treatment Form step that you must manually execute.

1. From the Steps checklist, select the Treatment Form step.
   - The form that you must complete displays in the Default tab.
2. Complete the form, using the provided controls (for example, editable fields or drop-down lists) to enter the necessary information.
3. Click Save User Input.
4. Click Send to Output.
   - The completed form is routed to a file, email, or printer, depending on its configured output destination.
   - When you generate an alarm printout, a report, or an alarm-handling form using a virtual printer (for example, a PDF printer), the output files are saved in the following location: C:\GMSProjects\[Customer project]\data\Reporting\Reports.
   - When you complete an assisted procedure of an event, any attachment (such as, alarm printout, report or alarm-handling form) is saved in the following location: C:\GMSProjects\[Customer project]\shared\attachments. The Activity Log report includes a link to these attachments.

Related Topics
Handling an Event with Assisted Treatment [➙ 72]
Assisted Treatment Window Reference [➙ 99]

3.1.7 Interrupting Handling of an Alarm

You want to interrupt handling of the current event, for example because a more important one has come in that you want to deal with right away.

1. Do one of the following, depending on where you are handling the alarm:
   - In Event List, click the event button again, or click another event in the list.
     - The event is deselected, and no longer appears highlighted.
   - In the Assisted or Investigative Treatment window, click the event button in the event descriptor along the top of the screen.
     - The Investigative or Assisted Treatment window closes, and the event is deselected in Event List.
Event status remains as it was when you interrupted handling the event.

2. You can go back to handling this event at any time by selecting it again.

Related Topics
Selecting an Event in Event List (Fast Treatment) [➙ 69]
Handling an Event with Investigative Treatment [➙ 71]
Handling an Event with Assisted Treatment [➙ 72]
Event List and Alarms Operation Reference [➙ 92]

3.1.8 Deselecting (Suspending) an Event in Event List

▷ An event is selected. Its event descriptor displays highlighted, and the In process by column indicates you are currently handling this event.

▷ You want to deselect the event to finish or suspend handling it.

● Click the event button, situated at the leftmost end of the event descriptor.

◁ The event is deselected: its event descriptor is no longer highlighted, and the In Process by column is cleared. If multiple events were selected, they will all be deselected.

Related Topics
Selecting an Event in Event List (Fast Treatment) [➙ 69]
Event Descriptor Reference [➙ 102]

3.1.9 Entering an Event Note in the History Database

▷ You want to enter a note about some events in the History Database.

▷ You selected one [➙ 69] or more events you are interested in.

1. In the Information column, click Log an event note.

2. In the Note Editor dialog box, enter the text of the note.

3. Click OK.

▷ The note is stored in the History Database. If you selected multiple events, this note will be logged as applying to all those events. You can generate a report (Activity Log or Event Detail Log) to print any logged event notes.

Related Topics
Event Descriptor Reference [➙ 102]

3.1.10 Viewing the Inline Information Text

▷ You want to view the information text for an event, which provides additional technical information concerning the event.

▷ You selected the event [➙ 69] you are interested in.

1. In the Information column of the event descriptor, click Show information text.

▷ Any technical information available for that event displays. The text provided in the Message text column is also repeated here.

2. Click the icon again to hide the information.
3.1.11 Inspecting the Source of an Event in System Manager

Scenario: From Event List, you want to jump to check the source of an event in System Manager.

1. In the event descriptor of the event you are interested in, click the text in the Source column.
   - The System Manager opens and automatically navigates to the event source. This means that:
     - The event source (the point that issued the alarm) is selected in the current view of System Browser.
     - Textual Viewer or Graphics Viewer tabs display details about the point that issued the alarm.
     - The Operation tab displays the properties of that object, and any commands available for it.

2. To go back to Event List, click Open Event List in the Summary bar.

NOTE: You can similarly jump to inspect the event source in the current view of System Browser also from Investigative Treatment or Assisted Treatment windows. Also, you can similarly jump to inspect event source from the following (optional) columns of the event descriptor: Location, Designation, Source Alias, Source Name, and Source Description. Furthermore, you can similarly jump to inspect event source in a particular System Browser view from the following (optional) columns of the event descriptor: Path [View] and Source Description [View].

3.1.12 Using the Contextual Pane in Event Handling

- You selected the event you are interested in.
- You want to open the Contextual pane in the Event List, Investigative Treatment or Assisted Treatment windows to access properties and commands of a point in alarm without leaving the list.

- To open the Contextual pane, do one of the following:
  - In the Event List header, click the two-pane layout icon.
  - In the Investigative Treatment and Assisted Treatment windows header, click the three-pane, four-pane or five-pane layout icon.
  - The Operation, Extended Operation, and Detailed Log tabs display at the bottom of the window. Information, properties, and commands of the selected event display. From here you can:
    - Inspect the properties of the point in alarm.
    - View and execute any commands/actions available for that object.
    - View a detailed log of the event currently being handled.
  - When you are finished, to hide the Contextual pane, do one of the following:
    - Click the splitter button.
    - In the Event List header, click the single-pane layout icon.
    - In the Investigative Treatment and Assisted Treatment windows header, click the single-pane or the two-pane layout icon.
Related Topics
Event List Reference [➙ 96]
Investigative Treatment Window Reference [➙ 98]
Assisted Treatment Window Reference [➙ 99]

3.1.13 Changing the Sorting of Events

▷ You want to change the default sorting of events in Event List, for example to order them first by Category.

● In Event List, click on the Category column header.

◆ Default event sorting changes according to the applied criterion.

Event sorting is not allowed in UL 864-compliant and ULC S527-compliant fire stations. Danger Management EN, Total Building Solution UL, and Total Building Solution ULC profiles.

3.1.14 Handling Recurrences of an Event

This section contains instructions for handling recurrent events. For background information see Recurring Events Reference [➙ 114].

Perform the procedures in this section as needed.

Recurring events grouped together under a parent event are not allowed in UL 864-compliant and ULC S527-compliant fire stations. This behavior is not allowed also in Danger Management AT, and Total Building Solution NA profiles. In all the above case, events belonging to the same source and category display as individual events in Event List.

3.1.14.1 Expanding or Hiding the Recurrences of an Event

▷ The Counter column in the event descriptor of an event contains a number, which means it is a parent recurring event.

1. To expand the individual recurrences, in Event List, click inside the Counter column of the parent event.

NOTE: Although the Counter column is also visible in the Event Detail bar, Investigative Treatment, and Assisted Treatment windows, you can only expand the individual recurrences of an event within Event List.

◆ All the recurrences of this event display underneath the parent event. The recurrences have smaller event buttons than the parent event, and are sorted most recent on top.

NOTE: While the recurrences are expanded like this you cannot filter Event List. However, you can first filter Event List and then expand the recurrences.

2. To hide the recurrences, click inside the Counter column of the parent event again.
3.1.14.2 Handling all Recurrences Together from a Parent Event

Scenario: You want to handle all the recurrences of an event at the same time by selecting the parent event and sending alarm-handling commands from there. You can do this from Event List, but also from the Event Detail bar, and from the Investigative Treatment or Assisted Treatment windows.

1. Select the parent recurring event by clicking its event button.
   
   **NOTE:** You can also use the CTRL and/or SHIFT keys to select multiple events—but such a selection can only include parent events. You cannot, for example, select a parent event and an individual child recurrence belonging to a different parent event.

2. Send alarm-handling commands from the parent descriptor in the normal way, as described in Sending Alarm-Handling Commands in Fast Treatment or Investigative Treatment [➙ 70].

   ➤ Each alarm-handling command you send from the parent is sent to all the child recurrences as well. For example, if you acknowledge the parent event, all its recurrences are acknowledged as well.

Related Topics
Expanding or Hiding the Recurrences of an Event [➙ 83]
Handling Individual Recurrences of an Event Separately [➙ 84]
Recurring Events Reference [➙ 114]

3.1.14.3 Handling Individual Recurrences of an Event Separately

Scenario: You want to handle one or more individual recurrences of an event separately, rather than handling them all at the same time from the parent event.

1. In Event List, click inside the **Counter** column of the event you want to handle to expand its recurrences.

   ➤ The child recurrences display under the parent event. Note that the topmost child recurrence always corresponds to the parent event.

2. Select the child recurrence that you want to handle by clicking its event button. You can also use the CTRL and/or SHIFT keys to select multiple child recurrences, but they must all belong to the same parent event.

3. Send alarm-handling commands from the child recurrence’s descriptor in the normal way, as described in Sending Alarm-Handling Commands in Fast Treatment or Investigative Treatment [➙ 70].

   ➤ Each alarm-handling command will only be sent to the selected child recurrence.

4. When you finish handling an individual child recurrence (typically, after you send a Reset or Close command), it will be cleared from the list when you deselect it.

   **NOTE:** Since the topmost child recurrence corresponds to the parent event, any commands you send to it will also affect the parent event. If the topmost
child recurrence is cleared from the list, the next most recent child recurrence in the set becomes the topmost one, and the details of the parent event will refresh to show its data.

Related Topics
Expanding or Hiding the Recurrences of an Event [➙ 83]
Handling all Recurrences Together from a Parent Event [➙ 84]
Recurring Events Reference [➙ 114]

3.1.15 Printing the Whole Event List
1. In Event List, right-click and select Print Event List.
2. (Optional) Modify the settings In the Print Preview dialog box.
3. Click Print and Close.
   ✤ The printout is sent to the selected printer. A message box informs you if the print operation fails.

Related Topics
Printouts Reference [➙ 26]

3.1.16 Filtering Event List
Scenario: You want to filter the list of events in Event List, so that it only shows events belonging to a certain category (such as Fault) or events for which a particular command (such as, Acknowledge) is available. Perform the procedures in this section as needed.

NOTE1: You cannot filter Event List in the following cases:
- An event is currently selected for processing. Deselect the event to apply filters. See Deselecting (Suspending) an Event in Event List [➙ 81].
- If the recurrences of an event are expanded. See Expanding or Hiding the Recurrences of an Event [➙ 83].

NOTE 2: Any filters you apply are valid only during the current client session. When you restart the client application, Event List defaults back to all events unfiltered.

3.1.16.1 Filtering Event List by Category with Event Lamps
► The Summary bar contains at least one event lamp (category) for which there are events.
1. In the Summary bar, click the event lamp whose events you want to view.
   ✤ Event List displays a filtered list containing only the events belonging to the category of that event lamp. The event lamp you clicked changes color to indicate a filter is active.
2. Click the same event lamp again to remove the category filter.

Related Topics
Event Lamps Reference [➙ 94]
Event List Reference [➙ 96]
3.1.16.2 Applying a Simple Filter to Event List

▷ You want to filter Event List by a single criterion, for example, category, date/time, discipline, or source status.

1. In the Summary bar, click the filter icon 🔴.
2. Select what you want to filter by (for example, Event Status), and then click the criterion you want to apply (for example, Unprocessed).

▷ Event List is filtered to show only the events that match the criterion. The color of the filter icon changes to red 🔴. The header of the Event List displays the currently applied filter.

NOTE: This type of filter only applies one criterion at a time. If you repeat the above steps to select a different criterion (for example, Source Status=Active, or Date and Time=Last hour) the previously applied filter will be cleared. To apply multiple criteria, see Applying an Advanced Filter to Event List [➙ 86].

Related Topics
Removing Filters from Event List [➙ 86]

3.1.16.3 Removing Filters from Event List

▷ You want to remove all the filters currently applied to Event List.

1. In the Summary bar, click the filter icon 🔴 and select Remove Filter.

▷ Event List displays an unfiltered list, containing all the events. The color of the filter icon changes to gray 🔴.

Related Topics
Applying a Simple Filter to Event List [➙ 86]
Applying an Advanced Filter to Event List [➙ 86]
Event List Reference [➙ 96]

3.1.16.4 Applying an Advanced Filter to Event List

▷ You want to filter Event List by multiple criteria simultaneously.

1. In the Summary bar, click filter 🔴 and select Advanced Filter. The Advanced Filter dialog box displays.
2. If you want to filter by Category, Discipline, Event status, and/or Source status:
   - Select the check box for the criterion you want to apply (for example, Category) then select one or more values (for example, Life Safety and Fault).
   - Repeat the preceding step for any other criteria you want to apply (for example, Discipline).
3. Use the drop-down lists to specify any other filter criteria you want to apply:
   - Location/Designation: Type in some part of the System-Browser path or designation of the event source. For example, Management System.Clients.
Alarms
Working with Alarms

- **Name/Description**: Type in some part of the name or description of the event source. For example, **Main Server**.
- **System** (available only for distributed systems).
- **Date and Time**: Filter based on when the events occurred. For example, **yesterday** or **last quarter hour**.
- **Tag**: Set whether you want to selectively show or hide tagged events.
  NOTE: This criterion is not available for **UL 864-compliant** and **ULC S527-compliant fire stations** and **Total Building Solution NA** profiles.
- **Maintenance**: Set whether to see only **Maintenance** or only **Genuine** events.
- **Show hidden events**: Set whether to show events that were hidden owing to the internal logic of field panels.

4. Click **OK**.

▶ The list of events is filtered accordingly, and you can check what criteria you applied in the Event List header.

**Next Steps:**
If required, proceed to: Saving an Event List Filter for Future Use [➙ 87].

**Related Topics**
Applying a Simple Filter to Event List [➙ 86]
Removing Filters from Event List [➙ 86]

---

3.1.16.5 **Saving an Event List Filter for Future Use**

▶ You applied an Advanced Filter to Event List [➙ 86] and want to save it for future reuse.

1. In the Summary bar, click the filter icon ▼ and select **Advanced Filter**.

▶ The **Advanced Filter** dialog box opens, displaying the currently applied filter criteria.

2. (Optional) Edit any filter criteria.

3. Enter a name in the **Filter name** field.

4. Click **Save**.

▶ The filter is saved. Filters that you save in this way are user-specific, and will not be visible to other users of the system.

**Next Step:**
To reuse the filter, proceed to Applying a Previously Saved Event List Filter [➙ 88].

**Related Topics**
Modifying or Deleting a Saved Event List Filter [➙ 88]
3.1.16.6 Applying a Previously Saved Event List Filter

▷ You previously saved an Event List filter for future use [➙ 87].

1. In the Summary bar, click the filter icon \( \checkmark \) and select Advanced Filter.

2. In the Advanced Filter dialog box, select the filter you want to apply from the Saved filters drop-down list.

3. Click Apply.

▷ Event List is filtered.

Related Topics
Modifying or Deleting a Saved Event List Filter [➙ 88]

3.1.16.7 Modifying or Deleting a Saved Event List Filter

▷ You previously saved an Event List filter for future use [➙ 87].

1. In the Summary bar, click the filter icon \( \checkmark \) and select Advanced Filter.

2. In the Advanced Filter dialog box, select the filter you want to apply from the Saved filters drop-down list.
   - To modify the filter, change the filter criteria and then click Update.
   - To delete the filter, click Delete.

Related Topics
Applying a Previously Saved Event List Filter [➙ 88]

3.1.16.8 Using Tags to Selectively Show or Hide Events

Scenario: Event List includes a column that lets you manually tag individual events. You can then use filters to selectively show or hide events you have tagged in this way.

Any tags you apply are valid only during the current client session. When you restart the client application, Event List defaults back to all events untagged.

Note that applying a tag filter will not remove any other filters you have applied. Filter by tag works in combination with the other filter criteria. For example, if you filter by Category=Fire and then apply a tag filter to Hide tagged events, you will only see events belonging to the Fire category that are not tagged.

Perform the procedures in this section as needed.

Tagging Events in Event List

Scenario: Events are untagged by default. You want to tag some events in Event List, so that you can later selectively show/hide them.

▷ The Tag column displays in Event List. See Customizing the Columns in Event List [➙ 90].

1. Move your cursor over the Tag column that corresponds to one of the following:
   - The event you want to tag.
   - Any parent recurring events you want to tag.
     NOTE: You can also tag individual recurrences of an event.
   - The tag icon \( \checkmark \) appears in the Tag column.
2. Click tag.
   - The event is now tagged, and the tag icon displays in its event descriptor.
   - In case of recurrences of an event, the parent recurring event and all its recurrences are tagged and the Hide tagged events filter applies. If a new recurrence occurs, the parent recurring event shows again and displays only the new recurrence.
   **NOTE:** The Recurring Events counter shows the total number of recurrences, regardless of whether they are tagged.

3. To untag the event, click again.

**NOTE 1:**
You can also use CTRL or SHIFT to select multiple events to tag or untag them all together with a single click. When you select multiple events and you tag or untag an individual event of the selection, all the events selected are tagged or untagged.

**NOTE 2:**
When a tagged event changes its state, it is automatically untagged. If the current filter allows, this event is displayed again.

**Next Step:**
To selectively show/hide the tagged events, proceed to Applying or Removing a Tag Filter in Event List [➙ 89].

**Related Topics**
Filtering Event List [➙ 85]

**Applying or Removing a Tag Filter in Event List**

▷ You previously tagged some events in Event List, and now you want to selectively hide or show the tagged events.

1. To apply a tag filter, do one of the following:
   - Click the filter icon, select Filter by Tag, and click either Hide tagged events or Show tagged events only. (A check mark displays next to whichever option is currently selected).
   - Click the filter icon and click Advanced Filter. In the dialog box, from the Tag drop-down list, select either Hide tagged events or Show tagged events only.
   - The list of events is filtered accordingly. Applying a tag filter does not remove any other filters you have applied. Filter by tag works in combination with the other filter criteria. You can check the currently applied filter criteria in the Event List header.

2. To remove a tag filter, do one of the following:
   - Click the filter icon, select Filter by Tag, and clear both check boxes to show both tagged and untagged events.
   - Click the filter icon and click Advanced Filter. In the dialog box, from the Tag drop-down list, select Show both tagged and untagged events.
The list of events will no longer be filtered by tags, but any other filters you applied will still remain active. (Check the Event List header to see them.)

**Related Topics**
Tagging Events in Event List [➙ 88]
Removing Filters from Event List [➙ 86]
Applying an Advanced Filter to Event List [➙ 86]

### 3.1.16.9 Enabling and Disabling Autoremove Filters When a New Event Comes in

**Scenario:** When you apply filters to Event List, it means you will not see any new incoming events that do not match the current filter criteria. To avoid missing events, you can configure the system to automatically remove all filters whenever a new event comes in.

To enable autoremove:

1. Click the filter icon ▼, and select Autoremove on New Events (if it is not already selected: a checkmark indicates that the option is already active).
   
   ✷ When new events come in any applied filters will be automatically removed.

To disable autoremove:

1. Click the filter icon ▼ and deselect Autoremove on New Events.
   
   ✷ Any applied filters will persist even if new events come in.

**NOTE:**
Autoremove is on by default and it is not allowed to disable it in Danger Management AT and Total Building Solution AT profiles.

### 3.1.17 Customizing the Columns in Event List

**Scenario:** You want to customize what columns display in Event List, change their order, or resize them.

Perform the procedures in this section as needed.

#### 3.1.17.1 Moving or Resizing a Column Directly in Event List

▷ You want to resize a column in Event List, or move it to a different position.

1. To resize a column, drag the edge of its column header in Event List to the desired width.

2. To move a column to a different position, drag-and-drop its column header in Event List to the desired position.

**Related Topics**
Adding, Removing, or Rearranging Columns in Event List [➙ 91]
Restoring the Default Column Settings in Event List [➙ 91]
Event Descriptor Reference [➙ 102]
3.1.17.2 Adding, Removing, or Rearranging Columns in Event List

▷ You want to add or remove columns in Event List or you want to rearrange their order.

1. Right-click on the column headers in Event List, and select **Customize columns**.
   - The **Customize columns** dialog box displays.

2. Do one or more of the following:
   - To add a column to Event List, select it in the **Available columns** list and click **Add**.
   - To remove a column from Event List, select it in the **Visible columns** list and click **Remove**.
   - To reposition a column, select it in the **Visible columns** list and click **Move up** or **Move down**.

3. Click **OK**.
   - Event List displays with the columns as you have customized them.

**Related Topics**
- Moving or Resizing a Column Directly in Event List [➙ 90]
- Restoring the Default Column Settings in Event List [➙ 91]
- Event Descriptor Reference [➙ 102]

3.1.17.3 Restoring the Default Column Settings in Event List

▷ You previously resized, moved, or added/removed columns in Event List and now you want to restore the default settings.

1. Right-click on a column header in Event List.

2. Select **Restore column layout**.
   - Event List displays with the columns back to their default settings.

**Related Topics**
- Moving or Resizing a Column Directly in Event List [➙ 90]
- Adding, Removing, or Rearranging Columns in Event List [➙ 91]
- Event Descriptor Reference [➙ 102]
3.2 Alarms and Event Treatment Reference

This section provides background information on the alarm management feature of Desigo CC.

3.2.1 Event List and Alarms Operation Reference

This section provides background information on alarm-handling. For related procedures, see Working with Alarms [➙ 69].

3.2.1.1 Overview of Event Handling

How Operators are Alerted to Alarms

The system displays all the detected alarms/events in the Event List [➙ 96], with each alarm on a separate row. This is your main starting point for dealing with alarms. In addition:

- The Summary bar along the top of the screen provides an overview of the alarms in the system grouped by category. This lets you keep an eye on alarms even when in some profiles the Event List is closed. A blinking indication signals when there are unprocessed events.
- An audible alert is sounded by the management station when there are unprocessed events.
- In some profiles, the one or two most important alarms are also displayed in an Event Detail bar underneath the Summary bar.

For more information about these user-interface elements, see System Screen Reference [➙ 22].

Methods of Handling an Alarm

- **Fast Treatment.** You can view information about events and send alarm-handling commands from directly inside the Event List. This is the most straightforward method of handling an alarm. You can also send commands in the same way from the Event Detail bar, where available.
  For instructions, see Selecting an Event in Event List (Fast Treatment) [➙ 69].

- **Investigative Treatment.** To handle an event as you would in System Manager, you can open a dedicated window, with the alarm’s event descriptor displays along the top, and the object that caused the alarm already selected in System Browser. This feature enables you to:
  - Investigate the source of the alarm, check or command its properties, and so forth, using all the tools normally available in System Manager.
  - At the same time, you can send alarm-handling commands from the event descriptor at the top of the window, just as you would from inside Event List.

  For instructions see Handling an Event with Investigative Treatment [➙ 71].
• **Assisted Treatment.** If an operating procedure was configured for a particular alarm, the icon \[image\] in the event button indicates that you can open a dedicated window, with the alarm’s event descriptor displayed along the top, that provides a step-by-step checklist of actions you must complete for handling that alarm. For example, these might include printing out a report, completing a form, reading a document, and so on. At the same time, you can send alarm-handling commands from the event descriptor at the top of the window, just as you would from inside Event List. For instructions see Handling an Event with Assisted Treatment [➙ 72].

**Simultaneous Handling of Events by Different Operators**

A Desigo CC installation can have one or more client stations from which operators monitor and respond to alarms.

• At any given time, you can see which operators and stations are handling an event. This information is available in the event button tooltip and in the **In Process by** column of the event descriptor.

• Even if an event is being handled by another operator/station, you can still handle the same event from your own station, using any of the available methods. The only limitation is that:
  – If another operator/station is handling an event using Assisted Treatment, you cannot also initiate Assisted Treatment for that event.
  – However, you can still start Investigative Treatment, or send alarm-handling commands from within Event List.

The system continually updates the list of users who are handling the same event, and removes any users who are disconnected for any reason.

**Visibility of Alarms in the System**

The specific events visible to you depend on your user access rights. This means that the Summary bar, Event Detail bar, and the Event List, **Investigative Treatment**, and **Assisted Treatment** windows display only the alarms coming from the points that you are allowed to see in System Browser. If an alarm is generated by a point not visible to you in System Browser, it does not display on your management station.

**Validation for Event Handling**

Validation might be required for commanding events. This means when an event occurs in order to be able to send alarm handling commands, the operator will be asked to provide a comment (Validation Profile = Enabled) or a comment and a password (Validation Profile = Supervised).

The alarm handling comment that explains the reason for the action is recorded and stored in the **Detail Log** tab.

**Auto-Event Handling**

Desigo CC can be configured to automatically start the alarm handling of certain events when specified conditions occur on the site. In this case, certain actions such as opening Event List or selecting the event might happen automatically, so you will not need to do them manually. For more information, see Event Settings for Event Treatment Reference.

**Activity Log and Event Log**

During event treatment, entries are recorded in the History Database for the following:
Operator’s activities relating to alarm handling (for example, initiating/suspending alarm handling, acknowledging/resetting an event, and so on). This log data is available when you generate an Activity Log report.

Evolution of the events in the system (for example, a new event occurs in the system, an event is acknowledged/reset and so on), and progression through the operating procedure steps in Assisted Treatment (for example, an operating procedure is initiated or closed and so on). This log data is available when you generate an Event Log report.

For background information about Desigo CC activities and events historical data, see Log Viewer Reference.

3.2.1.2 Event Lamps Reference

The events that occur in the building-control system are grouped into categories, which are color-coded by severity. Each alarm category typically corresponds to an event lamp that displays in the Summary bar [23]. The number of lamps and their corresponding categories depends on profiles.

Each event lamp shows the total number of events for that category, and how many of those are unprocessed (not yet acknowledged by the operator). An event lamp will also flash if there are any unprocessed events in its category.

When the Summary bar is collapsed to a slim bar, event information appears in a reduced format (event category abbreviation and the total number of alarms for that category), including also icons for any event timers or applied filters.

![Figure 10: Event Lamp in Collapsed (Slim) Summary Bar](image1)

![Figure 11: Event Lamp in Expanded Summary Bar](image2)

1. **Background color**
   Indicates the category color of the event. For details, see Event Categories Reference.

2. **Event counter**
   Shows the total number of alarms for that category present in Event List (second number), and how many of those are unprocessed (first number).

3. **Event category**
   Descriptive name of the category. For details, see Event Categories Reference.
<table>
<thead>
<tr>
<th>Event Lamp Display</th>
<th>Background Color and Behavior</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Life Safety</td>
<td>Solid gray.</td>
<td>No events for that category.</td>
</tr>
<tr>
<td>3/7 Life Safety</td>
<td>Flashes from gray to the category color.</td>
<td>New events for that category have occurred in the system, and are still unprocessed.</td>
</tr>
<tr>
<td>3/7 Life Safety</td>
<td>Flashes from gray to the dark category color.</td>
<td>Filter by category activated. New events for that category have occurred in the system, and are still unprocessed.</td>
</tr>
<tr>
<td>3/7 Life Safety</td>
<td>Solid category color and not flashing.</td>
<td>There are no unprocessed events for that category. <strong>NOTE:</strong> In Client Profiles where recurring events [➙ 114] are grouped under a parent container, the event lamp stops flashing when there are no unprocessed events in the event container.</td>
</tr>
<tr>
<td>3/7 Life Safety</td>
<td>Solid dark category color and not flashing.</td>
<td>Filter by category activated. There are no unprocessed events for that category.</td>
</tr>
</tbody>
</table>

When you move the cursor over an event lamp, a tooltip provides the following information:

- Total number of events for this category
- Number of unprocessed (unacknowledged) events for this category
- Number of events for this category that have been acknowledged
3.2.1.3 **Event List Reference**

The Event List displays all the detected alarms with each alarm in a separate row. This window is your main starting point for dealing with alarms.

When opened, the Event List displays in the main work area of the user interface (see System Screen Reference [➙ 22]). When it is closed, depending on the profile Event List may be either entirely hidden or collapsed to a vertical bar down the left side of the screen.

For related procedures see Working with Alarms [➙ 69].

The display of Event List is limited to 10000 event lines; if such limit is exceeded, the status bar of Event List will indicate the display limit and the total number of events detected (for example, 10000 of 50000).

![Figure 12: Event List Workspace](image-url)
Summary bar

Contains a set of event lamps that provide an overview of the events in the system. For details see Event Lamps Reference [➙ 94] and Summary Bar Reference [➙ 23].

Event Detail bar

In some configurations, prominently displays events that require immediate attention across the top of the screen.

Title bar

Depending on what you select, the title bar of the Event List shows:

- Event List, if no event is selected in the list.
- Event location, if a single event is selected in the list.
- Number of events being processed, if multiple events are selected in the list.
- Details of the applied filter, if a filter is applied to the events, and no event is being processed.

It also contains some icons to open/close the Contextual pane (6), lock the layout and, restore down the window (depending on Client Profile).

Event button

Graphic indicator of an event in the system. For details see Event Button Reference [➙ 106].

Event descriptor

Contains the event button, event details and alarm-handling commands for the event currently being processed. For details see Event Descriptor Reference [➙ 102].

Contextual pane

Hidden by default. When open, it provides additional information, actions, and resources about the point in alarm. The following tabs are available:

- **Operation/Extended Operation**: Lets you inspect all the properties of the point in alarm, and view and execute any commands/actions available for that object. If you selected multiple events, these tabs display only the properties common to all the events, properties having different values are marked with an asterisk.
- **Detailed Log** tab: Lets you view a detailed log of the currently selected event.

A contextual menu becomes available when you right-click the Event List column headers, and provides you with options to customize the columns that display in Event List, and to print out the whole list of events.

See Customizing the Columns in Event List [➙ 90] and Printing the Whole Event List [➙ 85].

Events in Distributed Systems

In distributed systems, to view the total number of events for an individual system, check—in the Extended Operation tab—the Event Count property of its Main Server.
3.2.1.4 Investigative Treatment Window Reference

1. Summary bar
Contains a set of event lamps that provide an overview of the events in the system. For details see Event Lamps Reference [➙ 94] and Summary Bar Reference [➙ 23].

2. Event Detail bar
In some configurations, prominently displays events that require immediate attention across the top of the screen.

3. Title bar
Shows the name of the Assisted Treatment window. It also contains some icons to open/close the Contextual pane (7), lock the layout and, restore down the window.

4. Event descriptor
Contains the event button, event details and alarm-handling commands for the event currently being processed. For details see Event Descriptor Reference [➙ 102]. The background color reflects the event category color, but in a darker shade.

5. Selection pane
Contains System Browser which displays the highlighted event source.

6. Primary pane
Contains the system application (for example, Graphics Viewer) associated with the event source currently highlighted in System Browser.
7 Contextual pane

Displays by default and provides additional information, actions, and resources about the point in alarm. The following tabs are available:

- **Operation/Extended Operation**: Lets you inspect all the properties of the point in alarm, and view and execute any commands/actions available for that object.
- **Detailed Log**: Lets you view a detailed log of the currently selected event.
- **Related Items**: Provides links to additional resources (for example, reports or alarm-handling procedures) that are relevant to the point in alarm. If you click a related item it opens by default in the Secondary pane.

3.2.1.5 Assisted Treatment Window Reference

![Figure 14: Assisted Treatment Workspace](image)

1 Summary bar

Contains a set of event lamps that provide an overview of the events in the system. For details see Event Lamps Reference [➙ 94] and Summary Bar Reference [➙ 23].

2 Event Detail bar

In some configurations, prominently displays events that require immediate attention across the top of the screen.

3 Title bar

Shows the name of the Assisted Treatment window. It also contains some icons to open/close the Contextual pane (7), lock the layout and, restore down the window.
4 Event descriptor
Contains the event button, event details and alarm-handling commands for the event currently being processed. For details see Event Descriptor Reference [➙ 102]. The background color reflects the event category color, but in a darker shade. The icon in the event button indicates that the event is being processed by assisted treatment.

5 Selection pane
Contains the list of operating procedure steps you must perform to process the event. See Completing an Operating Procedure of Assisted Treatment [➙ 73].

6 Primary pane
The Default tab contains the system application associated with the currently selected step in the procedure.

7 Contextual pane
Hidden by default. When open, it provides additional information, actions, and resources about the point in alarm. The following tabs are available:
- **Operation/Extended Operation**: Lets you inspect all the properties of the point in alarm, and view and execute any commands/actions available for that object.
- **Detailed Log**: Lets you view a detailed log of the currently selected event.
- **Related Items**: Provides links to additional resources (for example, reports or alarm-handling procedures) that are relevant to the point in alarm. If you click a related item it opens by default in the Secondary pane.

### Availability of Assisted Treatment
- **Assisted Treatment** is covered by a license. Check that the Assisted Treatment option license is installed in the system (in the Management View of System Browser, at the following path: Project > Management System > Servers > Main Server > Licenses); otherwise you will not be able to initiate Assisted Treatment and execute any operating procedures that have been configured; you can use the other alarm-handling methods provided by the system (Fast Treatment and Investigative Treatment). If the license is installed but later expires or is lost for any reason, Assisted Treatment is available only for those events that were already undergoing Assisted Treatment, and that have an associated operating procedure. If a new event occurs, Fast Treatment and Investigative Treatment will remain available.
- In addition to the license, the availability of Assisted Treatment depends:
  - On your user group rights. If you have no appropriate access permission, you cannot initiate Assisted Treatment.
  - On the system configuration (that is, on whether an assisted procedure has been configured for handling a particular type of alarm. If there is no such procedure configured, Investigative Treatment is available instead.

### Steps Workspace
When you open the **Assisted Treatment** window, the **Selection** pane on the left lists the steps of the guided procedure you must follow to handle the event. This list helps you select and carry out the steps in the correct sequence, which depends on how procedure was configured. Additionally, depending on configuration, a step can be:
- Automatic or manual
- Mandatory or optional
- Repeatable or not repeatable

Figure 15: Steps Workspace

1. Symbol that indicates a mandatory step.
2. Step identifier. This number may or may not correspond to the execution order.
3. Briefly describes the type step.
4. Depending on the step's configuration, you will see a white or gray check box:
   - A tooltip tells you that you cannot check off the step because you have not done all the actions required to complete the step (for example, complete a remote notification procedure or fill out and save an event treatment report).
   - A tooltip tells you that you can check off the step to mark it as completed.

   Once you check off a step as executed, a checkmark icon displays in the place of the check box, to indicate that the step has been completed.

5. Graphically indicates the step's execution status as follows:
   - in progress
   - successfully executed
   - failed

6. Graphically indicates that the step is selected and the relevant application for performing that step is available in the Default tab of the Primary pane.

- Each step has the same color as the event's category. When you select a step, it expands and changes to a darker color to indicate that it is being executed. Once you complete a step, a graphic icon indicates the execution outcome of that step (successful or failed).
- You must execute the first mandatory step before the following mandatory steps can be selected and executed.
- Whether the steps must be executed sequentially, or may instead be freely executed in any order, depends on how the assisted-procedure was configured.

- When you move your cursor over a step during the execution of an assisted procedure:
  - If it turns into hand, this means that you can execute the step.
  - If it turns into arrow, this means that you cannot execute the step because it is locked. This may happen if a preceding mandatory step has not been executed yet, or during the execution of sequential steps.

- Once you have completed all the actions required by a step, the gray check box turns white and you can mark that step as completed.

The system provides the following details of a step in a tooltip: name, execution type (mandatory or optional), type (automatic or manual), state (unknown, successful, or failed), and notes (error message, if any). Also, once a step is executed, the name of the operator who executed the step displays in the tooltip. If a step fails, an error message displays in the tooltip or in the window status bar.

### 3.2.1.6 Event Descriptor Reference

The event descriptor is the individual row in Event List, that contains all the details about an event (for example, its cause, path, source, date and time, category, discipline, event status, source status, suggested action, available command, and so on). Each event descriptor also has an event button on the left-hand side that graphically summarizes some of the most important information about that alarm.

<table>
<thead>
<tr>
<th>Cause</th>
<th>Path</th>
<th>Source</th>
<th>Creator</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>(0)</td>
<td>Project, Field Networks, Secret Network, Hardware</td>
<td>Simulator Device 5600</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>(0)</td>
<td>Project, Field Networks, Secret Network, Hardware</td>
<td>Simulator Device 5600</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>(0)</td>
<td>Project, Field Networks, Secret Network, Hardware</td>
<td>Simulator Device 5600</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>(0)</td>
<td>Project, Field Networks, Secret Network, Hardware</td>
<td>Simulator Device 5600</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>(0)</td>
<td>Project, Field Networks, Secret Network, Hardware</td>
<td>Simulator Device 5600</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>(0)</td>
<td>Project, Field Networks, Secret Network, Hardware</td>
<td>Simulator Device 5600</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Fault (INACTIVE)</td>
<td>Project, Field Networks, Secret Network, Hardware</td>
<td>Binary Output 1</td>
<td>11</td>
<td>✗</td>
</tr>
<tr>
<td>Station not reachable</td>
<td>Project, Management System, Clients</td>
<td>Baviera</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The event descriptor is your starting point for handling an alarm. You can send alarm-handling commands from directly inside the event descriptor by clicking the available command/button.

The exact appearance of the event descriptor depends on the profiles.

Also, what columns display in the event descriptor and their order may vary depending on column customization. See Customizing the Columns in Event List [➙ 90] for instructions.

Note that:
- Any changes you make to the columns in Event List will also apply to the Event Detail bar and to the Investigative Treatment and Assisted Treatment windows.
- Changes to column settings will be automatically saved when you exit the Desigo CC client application, and so will persist across sessions. Note that column settings are specific to the user profile. This means that different users can have different column settings.

### Event List Columns

- **Event button**
  - Situated on the leftmost end of each event descriptor. Graphically summarizes that particular alarm. For details see Event Button Reference [➙ 106].
NOTE:
You cannot move, resize, or remove the Event button column.

**Cause**
Description of the event followed by the condition (either numeric value or descriptive text) that caused the event. For example, Temperature too high (39°C), Fault (INACTIVE), and so on. This description changes when the event source passes from the Active to the Quiet state.

**Path**
Indicates the entire System Browser path of the object in alarm. The path is expressed using names or descriptions, depending on the Display mode as well as the view selected in the System Browser drop-down list.
For BACnet Event Enrollment (EE) events, it displays the [name of the field networks] + [name of the network] the EE event belongs.
The following optional columns may also be available, for indicating the object’s path in other ways:
- **Location**: Concatenation of descriptions relating to the event source. (It follows the view selected in System Browser.)
- **Designation**: Concatenation of names relating to the event source. (It follows the view selected in System Browser.)
- **Path [View]**: Indicates the full path of the object in alarm in a specified System Browser view as follows:
  - Path [Management View]
  - Path [Application View]
  - Path [Logical View]
  - Path [Physical View]
  - Path [user view]
Depending on the System Browser views that are configured, multiple such columns may be available. How the path is expressed depends on the Display mode.

**Message text**
Text that consists of one of the following:
- For driver alarms, the most recent message that has come from the field panel at any alarm transitions.
- For workstation alarms, blank or the event cause.
The same data also displays in the Information column.
| Source     | Indicates the object in alarm. Whether the source name or description displays depends on the current display mode. See Setting How Objects are Labeled in System Manager [➙ 36]. For workstation-based alarms, [object name].[property name] displays in this column. How driver-based alarms display - [object name] or [object name].[property name] - depends on the specific driver. For BACnet Event Enrollment (EE) events, the source text includes the EE instance that generated the event followed by the original source in parentheses. The following optional columns may also be available, for indicating the event source in other ways: |
| Source Alias | Indicates a customer-assigned name used to identify the technical equipment within the building/facility. |
| Source Name  | Indicates the object in alarm using its name. |
| Source Description | Indicates the object in alarm using its description. |
| Source Description [view] | Indicates the object in alarm using its description in a specified System Browser view. Depending on the System Browser views that are configured, multiple such columns may be available: |
| Source [Management View] |
| Source [Application View] |
| Source [Logical View] |
| Source [Physical View] |
| Source [user view] |
| In any type of Source column, you can click the [source] text to jump to the event source in System Manager. See Inspecting the Source of an Event in System Manager [➙ 82]. |
| Counter    | Counter for recurring events. See Recurring Events Reference [➙ 114]. This column does not appear in the Investigative Treatment and Assisted Treatment windows. |
| The Counter column is not available in UL 864-compliant and ULC S527-compliant fire stations, Danger Management AT, and Total Building Solution AT profiles. |
| Commands   | Available alarm handling commands for this event. You can directly click the command icon/button to send the corresponding command. See Alarm-Handling Commands Reference [➙ 109]. |
| NOTE:     | You cannot remove or resize the Commands column. |
Information becomes visible only when the event descriptor is selected:

- **History Database**: Displays the History Database dialog box for that Event ID, where you can add a note for the event. See Entering an Event Note in the History Database [➙ 81].

- **Message Text**: Displays the information text, which indicates technical information about a field point. It also displays the same information shown in the Message Text column. The intervention text may or may not be available to you. See Viewing the Inline Information Text [➙ 81].

- **Investigative Treatment** or **Assisted Treatment**: See Handling an Event with Investigative Treatment [➙ 71] and Handling an Event with Assisted Treatment [➙ 72].

**NOTE:**
You cannot resize the Information column.

**Event Status**: Describes the status of the event. For example: Unprocessed, Ready to be reset, and so on. See Event Status and Suggested Action Reference [➙ 110].

**Source Status**: Describes the status of the event source: Active (event source is in an off-normal condition) or Quiet (event source is back to normal).

**Date/Time**: Date and time when the event occurred. Typically, event time displays with resolution hh:mm:ss. However, in special cases, it will display with resolution hh:mm:ss:ms.

**ID**: Unique number that identifies the event. This number has an upper limit. The numbering restarts when this limit is reached.

**In Process by**: Indicates which user is processing an event. Depending on the type of Desigo CC client you're working one of the following may display:

- **installed Client**: [computer name]/[full name of the logged-on user]
  If the computer/user data was not specified in the configuration, [localhost]+[user’s short name] displays instead.

- **Web Client or Web App Client**: Web Client/[Operator’s full name].

Furthermore, for recurrences of the same event, this column displays the entire list of computer/users that are processing that event.

Recurring events are not allowed in UL 864-compliant and ULC SS27-compliant fire stations, Danger Management AT, and Total Building Solution NA profiles.

**Suggested action**: Describes the next action the operator should take for handling the event. See Event Status and Suggested Action Reference [➙ 110].

**Category**: Describes the event category. See Event Categories Reference.

**Discipline**: Describes the discipline to which the event belongs. See Event Disciplines Reference [➙ 109].
Tag

Lets you tag/untag events, so that you can selectively show/hide them in Event List. See Using Tags to Selectively Show or Hide Events [➙ 88]. This button will be visible but inactive in the Event Detail bar, and the Tag column will not appear in Investigative/Assisted Treatment.

3.2.1.7 Event Button Reference

An event button is a graphic indicator that displays on the left side of an alarm’s event descriptor [➙ 102]. It graphically summarizes some of the most important information about that alarm.

An event button flashes until you acknowledge its associated alarm.

In some profiles, when the Event List is closed the event buttons still remain visible (as an Event bar) on the left-hand side of the screen.

1  Discipline icon  Discipline of the event source. For more details, see Event Disciplines Reference [➙ 109].

2  Main background color of the button  Event category. For more details, see Event Categories Reference.

3  Assisted Treatment icon  This icon is available for an event that can be handled in assisted treatment. For more details, see Overview of Event Handling [➙ 92].

4  Bar along the right hand side of the button  The background color indicates the source status, whether the event source is:
   ● Active (bar matches the background color).
   ● Quiet (bar is gray).

5  Suggested action icon 1)  Next action to be taken. For more details, see Event Status and Suggested Action Reference [➙ 110].

<table>
<thead>
<tr>
<th>Button</th>
<th>Event Status</th>
<th>Source Status</th>
<th>Suggested Action</th>
<th>Additional Information</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Image" /></td>
<td>Unprocessed</td>
<td>Active</td>
<td>Acknowledge event</td>
<td>The event is unselected and not yet acknowledged or you already selected the event but you must still acknowledge it. The event button is flashing. The event lamp in the Summary bar corresponding to this category will also flash.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Image" /></td>
<td>Unprocessed</td>
<td>Quiet</td>
<td>Acknowledge event</td>
<td>The event source is back to normal.</td>
</tr>
</tbody>
</table>
### 3.2.1.8 Event Categories Reference

The events that occur in the building control system are grouped into categories, which are color-coded by severity.

The specific category names and colors employed are dependent on configuration. For a key to the category names, colors, and their meanings, refer to the appropriate table for your system configuration.

#### Event Categories in Building Automation EN Profile

<table>
<thead>
<tr>
<th>Category Name</th>
<th>Color</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Emergency</td>
<td>Red</td>
<td>Events relating to an immediate threat to life, safety, or health created by Emergency call.</td>
</tr>
<tr>
<td>Life Safety</td>
<td>Red</td>
<td>Events relating to an immediate threat to life, safety, or health created by the system.</td>
</tr>
<tr>
<td>High</td>
<td>Dark orange</td>
<td>Events relating to a major threat to technical plant.</td>
</tr>
<tr>
<td>Medium</td>
<td>Orange</td>
<td>Events relating to improper operation, major occupant discomfort.</td>
</tr>
<tr>
<td>Low</td>
<td>Yellow</td>
<td>Events relating to general improper operation, minor occupant discomfort.</td>
</tr>
<tr>
<td>Fault</td>
<td>Yellow</td>
<td>Events relating to technical equipment failure.</td>
</tr>
<tr>
<td>Information</td>
<td>Gray</td>
<td>Events relating to remarkable information, status, or operation.</td>
</tr>
</tbody>
</table>
### Event Categories in Total Building Solution AT Profile

<table>
<thead>
<tr>
<th>English Text</th>
<th>German Text</th>
<th>Color</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fire Alarm</td>
<td>Brandalarme</td>
<td>Red</td>
<td>Events related to an immediate threat to life, safety or health, created by Emergency call.</td>
</tr>
<tr>
<td>Fire Fault</td>
<td>Brandstörungen</td>
<td>Yellow</td>
<td>Events related to an immediate threat to life, safety or health, created by system.</td>
</tr>
<tr>
<td>Fire Control</td>
<td>Brandsteuerungen</td>
<td>Green</td>
<td>Events related as an immediate threat to property or may become life-threatening.</td>
</tr>
<tr>
<td>Fire Isolation</td>
<td>Brandabschaltungen</td>
<td>Orange</td>
<td>Events related as a major threat to technical plant.</td>
</tr>
<tr>
<td>High</td>
<td>Hoch</td>
<td>Red</td>
<td>Events related to improper operation, major occupant discomfort.</td>
</tr>
<tr>
<td>Medium</td>
<td>Mittel</td>
<td>Dark orange</td>
<td>Events related to general improper operation, minor occupant discomfort.</td>
</tr>
<tr>
<td>Low</td>
<td>Niedrig</td>
<td>Orange</td>
<td>Events related to a technical equipment failure.</td>
</tr>
<tr>
<td>Fault</td>
<td>Störungen</td>
<td>Yellow</td>
<td>Events related to manual operation that might cause operational risk.</td>
</tr>
<tr>
<td>Isolation</td>
<td>Schaltungen</td>
<td>Gray</td>
<td>Events that are reminders that something in the system is not normal, and the situation may have an impact on the operator’s decisions.</td>
</tr>
<tr>
<td>Information</td>
<td>Meldungen</td>
<td>Bright blue</td>
<td>Events related to remarkable information, status, or operation.</td>
</tr>
</tbody>
</table>

### Event Categories in Total Building Solution EN Profile

<table>
<thead>
<tr>
<th>Category Name</th>
<th>Color</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Emergency</td>
<td>Red</td>
<td>Events relating to an immediate threat to life, safety, or health created by Emergency call.</td>
</tr>
<tr>
<td>Life Safety</td>
<td>Red</td>
<td>Events relating to an immediate threat to life, safety, or health created by system.</td>
</tr>
<tr>
<td>Danger</td>
<td>Magenta</td>
<td>Events relating to an immediate threat to property or may become life-threatening.</td>
</tr>
<tr>
<td>High</td>
<td>Dark orange</td>
<td>Events relating to a major threat to technical plant.</td>
</tr>
<tr>
<td>Medium</td>
<td>Orange</td>
<td>Events relating to improper operation, major occupant discomfort.</td>
</tr>
<tr>
<td>Low</td>
<td>Yellow</td>
<td>Events relating to general improper operation, minor occupant discomfort.</td>
</tr>
<tr>
<td>Fault</td>
<td>Yellow</td>
<td>Events relating to technical equipment failure.</td>
</tr>
<tr>
<td>Exclusion</td>
<td>Orange</td>
<td>Events relating to manual operation that might cause operational risk.</td>
</tr>
<tr>
<td>Anomaly</td>
<td>Bright blue</td>
<td>Events that are reminders of something that is not normal in the system, and the situation may have an impact on the operator’s decisions.</td>
</tr>
<tr>
<td>Information</td>
<td>Gray</td>
<td>Events relating to remarkable information, status, or operation.</td>
</tr>
</tbody>
</table>
3.2.1.9 Event Disciplines Reference

<table>
<thead>
<tr>
<th>Icon (examples)</th>
<th>Discipline</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Building Automation icon" /></td>
<td>Building Automation</td>
</tr>
<tr>
<td><img src="image" alt="Building Infrastructure icon" /></td>
<td>Building Infrastructure</td>
</tr>
<tr>
<td><img src="image" alt="Energy Management icon" /></td>
<td>Energy Management</td>
</tr>
<tr>
<td><img src="image" alt="Fire icon" /></td>
<td>Fire</td>
</tr>
<tr>
<td><img src="image" alt="Management System icon" /></td>
<td>Management System</td>
</tr>
<tr>
<td><img src="image" alt="Notification icon" /></td>
<td>Notification</td>
</tr>
<tr>
<td><img src="image" alt="Security icon" /></td>
<td>Security</td>
</tr>
</tbody>
</table>

3.2.1.10 Alarm-Handling Commands Reference

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Acknowledgment" /></td>
<td>Acknowledge the event</td>
<td>Available when event status = Unprocessed and suggested action = Acknowledge event.</td>
</tr>
</tbody>
</table>
| ![Reset](image) | Reset the event | In Fast/Investigative treatment: available when event status = Ready to be closed and suggested action = Close event.  
In Assisted treatment: available when event status = Ready to be reset and suggested action = Reset event. |
| ![Close](image) | Close the event | Only for Assisted treatment. Available when event status = Ready to be closed and suggested action = Close event. |
| ![Start Remote Notifications](image) | Start Remote Notifications | Available only if a Remote Notification that can be sent/stopped by the operator was configured for the event. Operator must have application rights to start/stop remote notifications. |
| ![Stop Remote Notifications](image) | Stop Remote Notifications |  |
| ![Silence the field panel](image) | Silence the field panel | Available only where these commands have been configured for the field panel and event status is one of the following: Unprocessed, Waiting for condition, or Ready to be closed. |
| ![Unsilence the field panel](image) | Unsilence the field panel |  |
Visibility of Alarms and Commands

- You cannot handle events generated by field points for which you do not have proper user privileges. Such alarms and the related commands will not be visible to you in Event List.
- While handling events, your ability to acknowledge, reset and/or silence/unsilence an individual field point/panel (sending an individual command) or all the panels belonging to the same network (sending block commands) depends on configuration.
- If you try to send block commands while an event filter is active, a message displays asking you to remove the filter. Deactivate the filter and send the (block) command.
- To execute Acknowledge, Reset, or Silence/Unsilence, you must have proper user privileges, or the client station you’re working on must be the owner of the field panel.

### 3.2.1.11 Event Status and Suggested Action Reference

<table>
<thead>
<tr>
<th>Event Status</th>
<th>Suggested Action</th>
<th>Icon in event button</th>
<th>Fast / Investigative Treatment</th>
<th>Assisted Treatment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unprocessed</td>
<td>Acknowledge event</td>
<td>![Acknowledged Icon]</td>
<td>The event is new and still unprocessed. This means that you either did not yet select the event, or that you selected it but did not acknowledge it yet.</td>
<td></td>
</tr>
<tr>
<td>Waiting for condition</td>
<td>Wait for condition</td>
<td>![Waiting Icon]</td>
<td>You acknowledged the event, but cannot reset it yet.</td>
<td>-</td>
</tr>
<tr>
<td>Ready to be reset</td>
<td>Reset event</td>
<td>![Reset Icon]</td>
<td>Not applicable</td>
<td>In Assisted Treatment, you selected an event and the source status is back in normal condition. The Reset command is available.</td>
</tr>
<tr>
<td>Ready to be closed</td>
<td>Reset event</td>
<td>![Reset Icon]</td>
<td>You selected an event and the Reset command is available.</td>
<td>You reset an event, and all the mandatory steps of the assisted procedure were executed. The Close command is available.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- Complete Operating Procedure
Acknowledgment Models for Station-based Alarms

The following acknowledgment models are for station-based alarms:

- ACK and Reset required
- No Reset (ACK only required)
- No ACK, No Reset

### Fast/Investigative Treatment Workflow

<table>
<thead>
<tr>
<th>Acknowledgment Model</th>
<th>Scenario</th>
<th>Event Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACK and Reset required</td>
<td>• Alarm handling started (and at least one alarm-handling command sent)</td>
<td>Unprocessed Waiting for condition Ready to be closed Closed</td>
</tr>
<tr>
<td></td>
<td>• Event source back to Quiet</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Alarm handling not started yet (no alarm-handling command sent yet)</td>
<td>Unprocessed Ready to be closed Closed</td>
</tr>
<tr>
<td></td>
<td>• Event source back to Quiet</td>
<td></td>
</tr>
<tr>
<td>No Reset (ACK only required)</td>
<td>• Alarm handling started (and at least one alarm-handling command sent)</td>
<td>Unprocessed Waiting for condition Closed</td>
</tr>
<tr>
<td></td>
<td>or not started yet (no treatment command sent yet)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Event source back to Quiet</td>
<td></td>
</tr>
<tr>
<td>No ACK, No Reset</td>
<td>• Alarm handling started (and at least one alarm-handling command sent)</td>
<td>Waiting for condition Closed</td>
</tr>
<tr>
<td></td>
<td>or not started yet (no alarm-handling command sent yet)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Event source back to Quiet</td>
<td></td>
</tr>
</tbody>
</table>

### Assisted Treatment (with Mandatory Steps) Workflow

<table>
<thead>
<tr>
<th>Acknowledgment Model</th>
<th>Scenario</th>
<th>Event Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACK and Reset required</td>
<td>• Alarm handling started (and at least one alarm-handling command sent)</td>
<td>Unprocessed Waiting for condition Ready to be reset Waiting for condition (due to mandatory steps) Ready to be closed Closed</td>
</tr>
<tr>
<td></td>
<td>• Event source back to Quiet</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Alarm handling not started yet (and no alarm-handling command sent yet)</td>
<td>Unprocessed Ready to be reset Waiting for condition (due to mandatory steps) Ready to be closed Closed</td>
</tr>
<tr>
<td></td>
<td>• Event source back to Quiet</td>
<td></td>
</tr>
</tbody>
</table>
### Assisted Treatment (Without Mandatory Steps) Workflow

<table>
<thead>
<tr>
<th>Acknowledgment Model</th>
<th>Scenario</th>
<th>Event Status</th>
</tr>
</thead>
</table>
| **ACK and Reset required** | • Alarm handling started (and at least one alarm-handling command sent)  
• Event source back to Quiet | Unprocessed  
Waiting for condition  
Waiting for condition (due to mandatory steps)  
Ready to be closed  
Closed |
|                            | • Alarm handling not started yet (and no alarm-handling command sent yet)  
• Event source back to Quiet | Unprocessed  
Waiting for condition (due to mandatory steps)  
Ready to be closed  
Closed |
| **No Reset (ACK only required)** | • Alarm handling started (and at least one alarm-handling command sent)  
• Event source back to Quiet | Unprocessed  
Waiting for condition  
Ready to be closed  
Closed |
|                            | • Alarm handling not started yet (and no alarm-handling command sent yet)  
• Event source back to Quiet | Unprocessed  
Ready to be closed  
Closed |
| **No ACK, No Reset**       | • Alarm handling started (and at least one alarm-handling command sent)  
• Event source back to Quiet | Unprocessed  
Waiting for condition  
Ready to be closed  
Closed |
|                            | • Alarm handling not started yet (and no alarm-handling command sent yet)  
• Event source back to Quiet | Waiting for condition  
Ready to be closed  
Closed |
3.2.1.12 Event Sorting Reference

- If there are no arrows in any of the column headers, it means the default Event List sorting is applied.
- In some Client Profiles:
  - A small up or down arrow in one of the column headers in Event List indicates that a non-default sorting order was applied.
  - In the case of recurring events, the sorting only applies to the parent event. Any individual recurrences of an event are always sorted by date and time in ascending order, under the parent, and you cannot change this order. For more information see Recurring Events Reference [➙ 114].
- The default event sorting applied to the different Client Profiles is listed in the table below. Profiles that allow the default event sorting to be changed are marked with an asterisk (*). For instructions, see Changing the Sorting of Events [➙ 83].

<table>
<thead>
<tr>
<th>Profiles</th>
<th>By default, events in Event List are sorted by applying the following criteria in turn:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Building Automation EN*</td>
<td>1. <strong>Event status</strong>: unprocessed (to be Ack) events grouped on top, then unreset events, then events that are waiting for condition</td>
</tr>
<tr>
<td>Building Automation NA*</td>
<td>2. <strong>Category</strong>: most severe on top, for example, <strong>Life Safety</strong> before <strong>Fault</strong></td>
</tr>
<tr>
<td>Danger Management EN</td>
<td>3. <strong>Date/time</strong>: most recent event on top</td>
</tr>
<tr>
<td>Total Building Solution EN*</td>
<td>With this sorting, all events to be acknowledged will be grouped at the top. Within the ‘to be acknowledged’ group, events will be grouped by category. Finally, within a group of ‘to be acknowledged’ events belonging to the same category, the most recent ones will display on top.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Profiles</th>
<th><strong>Date/time</strong>: most recent event on top</th>
</tr>
</thead>
<tbody>
<tr>
<td>Danger Management AT*</td>
<td></td>
</tr>
<tr>
<td>Total Building Solution AT*</td>
<td></td>
</tr>
<tr>
<td>Danger Management UL</td>
<td>1. <strong>Event status</strong>: unprocessed (to be Ack) events grouped on top, then unreset events, then events that are waiting for condition</td>
</tr>
<tr>
<td>Danger Management ULC</td>
<td>2. <strong>Category</strong>: most severe on top, for example, <strong>Life Safety</strong> (or <strong>Fire Alarm</strong> in ULC) before <strong>Fault</strong></td>
</tr>
<tr>
<td>Total Building Solution UL</td>
<td>IN before OUT events relating to the start of the alarm condition, then events relating to the end of the alarm condition.</td>
</tr>
<tr>
<td>Total Building Solution ULC</td>
<td>3. <strong>Date/time</strong>: oldest event on top</td>
</tr>
<tr>
<td></td>
<td>With this sorting, all the ‘to be acknowledged’ events will be grouped at the top. Within the ‘to be acknowledged’ group, events will be grouped by category, IN before OUT. Finally, within a group of ‘to be acknowledged’ events belonging to the same category and IN before OUT, the oldest ones will display on top.</td>
</tr>
</tbody>
</table>
3.2.1.13 Recurring Events Reference

A recurring event occurs when the same event source repeatedly generates the same alarm condition. More specifically, this happens when the same property of a field point continuously switches between the active and quiet states. For related procedures, see Handling Recurrences of an Event [➙ 83].

If allowed by the Client Profile, in Event List, recurring events are grouped together under a parent event, which acts as a container for them. The parent event has a Counter field in its event descriptor that indicates the total number of occurrences. This counter automatically increments whenever the same event recurs again.

Recurring events grouped together under a parent event are not allowed in UL 864-compliant and ULC S527-compliant fire stations. This behavior is not allowed also in Danger Management AT, and Total Building Solution NA profiles. In all the above case, events belonging to the same source and category display as individual events in Event List.

Information Contained in the Parent Recurrent Event

The parent event descriptor always displays the most recent recurrence of the event, (which also corresponds with the topmost recurrence of the set), along with the following summary information:

- **Event Status** of the most important recurrence (priority order is Unprocessed, Waiting for condition, then Ready to be closed)
- **Source Status** of the most recent recurrence
- **ID** of the event identified by [...] indicating the range between the first and the last recurrence (for example, 3201…3245)
- **Counter** indicating the total number of times this event has recurred.

Children of a Recurring Event

You can expand a recurring event by clicking its Counter field. See Expanding or Hiding the Recurrences of an Event [➙ 83].

The children of a recurring event display under the parent event. The children are always sorted by date and time in ascending order, irrespective of what sorting is applied to Event List. See Event Sorting Reference [➙ 113].

Tags and Filters Applied to Recurring Events

When you apply tags or filters to Event List:

- Tagging/untagging a parent event affects all its child recurrences.
- You can also separately tag/untag an individual child recurrence.
- If you tag a recurring event (parent plus all its children) and apply a Hide tagged events filter, a new recurrence of that event will cause only the parent event to display again, along with the new recurrence. (The other recurrences will remain hidden).
- The Counter field in the parent event always shows the total number of recurrences, irrespective of whether they are tagged, untagged, or filtered.
- When filtering recurring events, the filter applies only to the parent event, with the exception of the Filter by Tag that also applies to any child recurrences.

Assisted or Investigative Treatment of Recurring Events

You can start Investigative/Assisted treatment of a recurring event in the same way that you would for a non-recurring event. See Handling an Event with Investigative Treatment [➙ 71] and Handling an Event with Assisted Treatment [➙ 72].

In the case of Assisted Treatment, depending on configuration you may be able to follow an assisted procedure for each child recurrence separately, or there may be a single assisted procedure that applies to the entire set of recurrences.
4 Graphics Viewer

This section provides information and instructions for using the Graphics Viewer application in Desigo CC.

4.1 Working with Graphics Viewer

This section provides step-by-step instructions for performing common Graphics Viewer tasks. For background information, see Graphics Viewer Reference [➙ 123].

Perform the procedures in this section as needed.

4.1.1 Commanding Off-Normal Properties

▷ You have a graphic open in Graphics Viewer, and one or more objects have properties in an off-normal state. The system has displayed the objects and the icons of the properties that are in an off-normal state. You want to view or command these off-normal properties.

1. Navigate to the Status and Commands window associated with the object you want to command.

2. Click the expander to display the list of property information for the object.
   ◀ The system displays a list of the object’s properties, their current state, and all commands available for this object.

3. Click the command button that displays the command you want to execute.
   ◀ If the command does not have arguments associated with it, the command is sent and the status displays.

4. (Optional) If the command button has arguments associated with it, proceed to Step 5.

5. (Optional) Complete the required fields.

6. Click Send.
   ◀ The system displays the status of the command.

4.1.2 Commanding Properties in Graphics Viewer

▷ You have a graphic open in Graphics Viewer, and you want to command the properties of an object in the graphic.

1. Right-click the object, and select Status and Commands.
   ◀ The system displays a list of the object’s properties, their current state, value, status, and all commands available to you for this object, based on your system privileges and the configuration settings for the object.
   ◀ If you select multiple properties to command, the selected properties display an icon with a triangular symbol in the lower right-hand corner.

2. If you selected multiple properties in the step above, click the triangular symbol on the icon next to the property you want to command. Otherwise, proceed to Step 3.
   ◀ The table row of the proper expands to show multiple instances of the property—one for each of the objects selected.
3. Click the command button that displays the command you want to execute.
   ➔ If the command does not have arguments associated with it, the command is sent and the status displays.

4. *(Optional)* If the command button has arguments associated with it, proceed to Step 5.

5. *(Optional)* Complete the required fields if any are associated with the command.

6. Click **Send**.
   ➔ The system displays the status of the command.

### 4.1.3 Creating a Graphic

▷ System Manager is in **Operating** mode.

1. In System Browser, select **Application View**.

2. Select **Application > Graphics**.

3. In the **Graphics Viewer**, click the **Operating** button to switch to **Engineering** mode.

4. Click **New** and select **New Template Graphic**.
   ➔ A blank, tabbed graphic template displays in the Graphics Editor work area.

5. Create and design the graphic as necessary.

6. Click **Save As**.
   ➔ The **Save As** dialog box displays.

7. Do one of the following:

#### Saving a Graphic

1. Select the **Graphics** folder where you want to save the graphic.

2. Enter a name for your graphic.

3. Click **Save**.
   ➔ The graphic is saved to **GMSProjects > [Name of Your Project] > Graphics** folder or sub-folder you may have selected.

**NOTE:** The graphic is saved in both a .CCG and a .PNG file format.

#### Saving a Graphic Template

1. Navigate to the **Libraries** folder that contains the Graphics Template folder where you want to save the graphic template.

2. Enter a name for your graphic template.

3. Click **Save**.
   ➔ The template is saved in a CCT and .PNG file format.

### 4.1.4 Creating a Graphics Sub-Folder

You want to create a Graphics sub-folder in System Browser and in your project's Graphics folder.

▷ System Manager is in **Engineering** mode.

▷ The **Graphics Editor** is displayed in the in the **Graphics** tab of the work area.
1. In System Browser, select **Application View**.

2. Select **Application > Graphics** or an existing sub-folder as the location for your new graphics folder.

3. Click **New** and select **New Folder**.

4. In the **Create New Folder** dialog box, type a name for the new folder.

5. Click **OK**.
   - The folder is available in System Browser.

### 4.1.5 Deleting a Graphic Item

You want to delete a graphic item, a graphic or a folder, from the **Graphics** folder.

**NOTE:**
You can only delete an empty folder, not a folder that contains any graphical objects.

- System Manager is in **Engineering** mode.
- The Graphics Editor is displayed.

1. In System Browser, select **Application View**.

2. Select **Applications > Graphics > [graphic or graphic folder]**.

3. Click **Delete**.
   - A confirmation message displays.

4. Click **Yes**.
   - The graphic item is deleted.

### 4.1.6 Disabling Point Centered Display Mode

- System Manager is in **Engineering** mode.

1. In System Browser, select **Application View**.

2. Select **Application > Graphics**.

3. Click **Point Centered Display mode**.

4. Select **None**.
   - **Point Centered Display mode** is disabled.

**Related Topics**
Point Centered Display Mode [➙ 125]

### 4.1.7 Displaying a Graphic

- System Manager is in **Operating** mode.

1. In System Browser, select **Application View**.

2. Select **Applications > Graphics > [graphic]**.

3. The selected graphic displays in the **Graphics Viewer**.
4.1.8 Displaying and Hiding Coverage Area

- A graphic is displayed in the Graphics Viewer and you want to display the coverage area for the cameras or any monitoring device on the graphic. The coverage area shows the objects on your graphic that are within the viewing or monitoring range of a camera or device.
- System Manager is in Operating mode.

1. In System Browser, select Application View.
2. Select Applications > Graphics.
3. Click Coverage Area. All configured coverage areas on the graphic display.
4. To view the data points from all the objects in the coverage area that are monitored by the camera or device, move your cursor over the coverage area. The tooltip displays a list of monitored objects.
5. To hide the coverage area, click Coverage Area. The coverage area is toggled to hide the coverage area from displaying on the graphic.

4.1.9 Displaying Properties

- You have an object in the System Browser and you want to display the associated properties.
- You have manually displayed the Status and Commands window for an object on a graphic.
- A graphic has an object in an off normal state and the associated Status and Commands window has automatically displayed.
- From System Browser, you have selected the object you want to command.

1. From the Status and Commands window, navigate the property you want to command. If there are more than four properties displayed in the window, you may have to scroll to locate the property. The system displays a list of the object's properties, their current state, value, status, and all commands available to you for this object, based on your system privileges and the configuration settings for the object.
2. Complete the required fields and click the associated command button that displays the command you want to execute. Depending on the command type, the command is sent, updated, or acknowledged and the status displays.
3. Observe the status of the command.

4.1.10 Dragging Object Properties from the Graphics Viewer

Referenced properties of an object or symbol on a graphic in the Graphics Viewer can easily be dragged over to another graphic in the Graphics Editor or any other view or pane in that accepts a drag source.

NOTE:

To select multiple objects, nodes, or properties, click CTRL and then click each item you want to drag over to the Graphics Editor.
A graphic is displayed in the Graphics Viewer.

If you are dragging an object or symbol to the Graphics Editor, you must have another System Manager pane open. See, Launching a New System Manager.

1. Hover over an element or symbol in the Graphics Viewer. A red border displays around the highlighted object.

2. Click and drag.
   - The cursor changes to \( \text{\texttt{\textbullet\textbullet\textbullet}} \).

3. Release the mouse button when the cursor changes to \( \text{\texttt{\textbullet\textbullet\textbullet}} \) over the intended drop target.
   - The data from the object is copied to the area or field.

4.1.11 Editing a Graphic

- System Manager is in Operating mode.

1. In System Browser, select Application View.
2. Select Applications > Graphics > [graphic].
3. Click Edit \( \text{\texttt{\textbullet\textbullet\textbullet}} \).
   - The Graphics Editor displays.
4. Make modifications to the graphic.
5. Click Save As \( \text{\texttt{\textbullet\textbullet\textbullet}} \).
6. In the Save As dialog box, do the following:
   - Select a destination folder.
   - Enter a name.
   - Click Save.
   - The edited graphic is saved.

4.1.12 Enabling Point Centered Display Mode

- System Manager is in Operating mode.

1. In System Browser, select Application View.
2. Select Applications > Graphics.
3. Select the point object.
4. Click Point Centered Display mode \( \text{\texttt{\textbullet\textbullet\textbullet}} \) and select one of the following options:
   - Point: Point Centered Display mode is enabled for the point object to display in the center of the pane or canvas.
   - Group – Point Centered Display mode is enabled for point objects to display in the center of the pane or canvas.
   - A checkmark displays next to the selected mode and the Point Centered Display mode is set on the canvas.

4.1.13 Navigating to a Linked Element

If configured, an element on a graphic can be used as direct navigation to an internal or external link.
You have an element on a graphic that if selected links to an internal or external element.

1. *(Optional)* Move your cursor over the element to display the tooltip and view the linked path and descriptive text about the linked element.

2. Click or double-click the element.
   - If the link is an internal Desigo CC link, the linked item becomes the primary selection.
   - If the link is external, the document, website, or application displays.

### 4.1.14 Navigating to the Graphics Library Browser from System Browser

- System Manager is in **Operating** mode.

1. In System Browser, select **Management View**.
2. Select **Project > System Settings > Libraries**.
3. Click any of your graphic symbol folders.
   - The Graphics Library Browser displays.

### 4.1.15 Printing from the Graphics Viewer

- System Manager is in **Operating** mode.

1. In System Browser, select **Application View**.
2. Select **Applications > Graphics > [graphic]**.
3. Do one of the following.
   - Click **Print**.
     a. In the **Print** dialog box, select the printer.
     b. Select **Print**.
   - Click **Page setup**.
     a. In the **Page setup** window, configure the settings as necessary. For more information, see **Page Setup View**.
     b. Click **Print**.
     c. In the **Print** dialog box, select the printer.
     d. Select **Print**.
   - The graphic is printed.

### 4.1.16 Selecting Objects from System Browser

- System Manager is in **Operating** mode.

1. In System Browser, select **Application View**.
2. Select **Applications > Graphics > [graphic object]**.
   - **Graphics Viewer** displays the graphic object. To select objects within **Graphics Viewer**, see Selecting Objects within Graphics Viewer [→ 121].
4.1.17 Selecting Objects within Graphics Viewer

You have a graphic open, and you would like to view the properties of an object on the graphic.

System Manager is in Operating mode.

1. In System Browser, select Application View.
2. Select Applications > Graphics > [graphic].
3. Click the object. You can also select multiple objects by holding down the CTRL key while clicking on more than one object.
   - The object becomes the focus, and the object properties display in Property Viewer.

**NOTE 1:** When you select a graphics object from System Browser, the Graphics Viewer displays the representative graphic. The selected object is considered the primary selection. The object also displays in the Property Viewer.

**NOTE 2:** If you click another object in the graphic, that object becomes the secondary selection. As a result, Property Viewer changes its display to correspond to the new selection. System Browser, however, still displays the original, primary selection to show your starting point.

**NOTE 3:** Double-clicking another object on the graphic makes that object the new primary selection in the Graphics Viewer and System Browser, while the object remains the secondary selection in the Property Viewer.

4.1.18 Using the Depths Navigation View

You want to view a specific depth associated with a graphic, and, optionally, filter the view of the depth by its associated layers.

System Manager is in Operating mode.

1. In System Browser, select Application View.
2. Select Applications > Graphics > [graphic].
3. Click DepthsNavigation View and select the depth you want to view.
   - The Graphic and the Navigation View displays a list of all layers associated with the depth.
4. (Optional) Select the Discipline radial button, and from the drop-down menu select a discipline, or select <All> to view all layers.
   - The graphic updates and only displays the layers associated with the selected discipline.
   - The list of layers in the Navigation View is grayed-out, and only the layers associated with the selected depth are check-marked.
5. (Optional) Select the Layers radial button, and from the list of layers check-mark each layer you want to include in the graphic view, or uncheck a layer to remove it from view. As you make your selections the graphic view is automatically updated.
   - The graphic is updated.
4.1.19 Working with the Aerial View

- You have a graphic open and would like to display the Aerial View.
- System Manager is in Operating mode.

1. In System Browser, select Application View.
2. Select Applications > Graphics > [graphic].
3. Click Aerial View.
   - The Aerial View displays.
4. Do one of the following:
   - Click a specific area to adjust the view. The clicked area is the center.
   - Click and drag the mouse to draw a rectangle around the specific area of the graphic you want to focus on.
   - The graphic is resized and refocused around the area you clicked or drew.

4.1.20 Zooming in the Graphics Viewer

The zoom factor of a graphic can be changed using one of the following methods:

- System Manager is in Operating mode.

1. In System Browser, select Application View.
2. Select Applications > Graphics > [graphic].
3. You have the following zoom options available to you:
   - Click Default View 100% to display the active graphic at 100% magnification.
   - Click Scale to fit so that the entire graphic and all the objects on the graphic are visible.
   - Click Zoom In (+20) or Zoom Out (-20) to zoom in or out, accordingly, by a factor of 20% with each click of the icon.
   - Click Zoom View, and from the Zoom View pane, click and drag the Zoom Slider to either increase or decrease magnification of the active elements.
   - Click Zoom to select from a list of pre-defined zoom factors.
   - Click Zoom Real to zoom in and out, using your mouse wheel.
4.2 Graphics Viewer Reference

This section provides background information for using the Graphics Viewer. For related procedures, see Working with Graphics Viewer.

4.2.1 Overview of Graphics Viewer

The Graphics Viewer allows you to display and view graphics in your facility. While viewing your graphics, you can do the following in the Graphics Viewer:

- Increase or decrease them in size
- Pan them
- Scale them to
  - predefined viewports
  - predefined zoom steps
  - full size
  - 1:1 resolution
- View them in part or as a whole using the viewport rectangle
- Navigate and filter the view by depth, layer, and discipline using the Graphic Navigation view
- View them from above using the Aerial view
- Mouse-over elements or objects on the graphic to view tooltip information
- View related properties
- View changing property values of system objects on a graphic
- View the objects in a camera’s coverage area
- Navigate and display graphics in the Related Items tab related to the selected object in System Browser
- Acknowledge and command objects on a graphic using the Status and Commands window
- Access the Graphics Editor to edit objects on a graphic
- Access the Graphics Editor to create a new graphic
4.2.1.1 About Tooltips

Tooltips are customizable properties that display as a yellow text box when you mouse-over an element or object on the active graphic. The text box for a tooltip contains descriptive text, the current value of the graphic object, and the names of the associated objects based on the view selected in System Browser.

When you move your cursor over an object or element on the active graphic, an associated tooltip displays.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Static tooltip</td>
</tr>
<tr>
<td>2</td>
<td>Dynamic tooltip</td>
</tr>
<tr>
<td>3</td>
<td>Static link reference and link description</td>
</tr>
<tr>
<td>4</td>
<td>Dynamic link reference and link description</td>
</tr>
<tr>
<td>5</td>
<td>Data point references</td>
</tr>
</tbody>
</table>

4.2.1.2 Graphics Related Folders

Graphics related folders are displayed in the System Browser’s Application View as well as the Management View. There are three types of graphic folders: Graphic, Symbols, and Graphic Templates.

- **Application View > Graphics**: Displays all graphics (*.CCG) files.
- **Management View > Project* > System Settings > Libraries > [Appropriate Sub-Library] > Symbols**: Displays all the related symbols (.CCS) files associated with the selected library.
- **Management View > Project* > System Settings > Libraries > [Appropriate Sub-Library] > Graphic Templates** – Displays all the related symbols (*.CCT) files associated with the selected library.

*If your System Browser display mode is set to Show Name, you will see ManagementView instead of Project.*

4.2.1.3 Graphics Viewer: Operating and Engineering Mode

<table>
<thead>
<tr>
<th>Graphics Viewer: Operating and Engineering Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graphics Viewer window mode</td>
</tr>
<tr>
<td>Operating</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Engineering</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>
4.2.1.4 Point Centered Display Mode

Point Centered Display mode ensures that a selected data point or group of data points will always be centered in the Graphics Viewer. For example, you might be required to put a data point in this mode if you are monitoring a fire system in a chemical manufacturing facility with key sensors that must always be viewed. Enabling Point Centered Display mode in such a scenario ensures that the data point does not blend in with and become lost among surrounding graphics. Or, you might be required to put the Graphics Viewer in this mode, if, for example, you are monitoring a fire system in a pharmaceutical manufacturing facility with key areas that must always be viewed. You can also enable the Group Center mode, to ensure that the parent and all children of the selected point are always selected; therefore, the group of points does not blend in with and become lost among any surrounding graphics. In Group mode, siblings are all data points with the same parent as the selected data point. Those siblings are retrieved from the currently selected view when the selection in the System Browser changes. This mean that selecting the same data point in different views, such as Logical or Management View, could return different siblings.

To implement the feature, you select a data point object in System Browser. The System Manager application then opens the Graphics Viewer and displays the point's default graphic view, depth, and graphic associated with it. You then select the Point Centered Display mode button from the Graphics Viewer toolbar to center the point in the viewport. The feature is disabled by selecting the button again.

While in Point Centered Display mode, you cannot pan the object. However, you can select any zoom factor without affecting centering in the viewport or you can select another symbol to shift the focus to another object or symbol.

4.2.1.5 Status and Commands Overview

The Status and Commands window displays on a graphic, and allows you to display and change the current state of an object’s properties in your building control system. Access to objects is based upon the object privileges and privilege profiles set by the system administrator.

Display of Properties on a Graphic

Properties display on a graphic in one of two ways—automatically or manually.

- They display automatically when a property goes into an off-normal state. The Status and Commands window displays the icons associated with the properties in an off-normal state on the graphic. You expand the icon view to display the detailed property information and the command options.
- The Status and Commands window displays manually when you right-click an object in a graphic that has data points associated with it. You can display multiple Status and Commands windows in Graphics.

When a Status and Command window displays on the graphic, a connection line displays between the window and its associated objects on the canvas. The connection line between the Status and Commands window and the objects remains intact, even when the window is moved around on the canvas.

Properties and commands also display in the Operation and Extended Operation tabs for the selected object.

For more information on commanding properties and priority arrays, see Command Priorities and Priority Arrays.

Summary Status

In order to simplify the system display and highlight the most important information, the system sometimes combines properties into a Summary Status property. The Summary Status displays the highest priority status that is currently active for an object. For example, if an object has an active Fire Alarm and Fire Fault, the Fire Alarm displays in the Summary Status.
More about the Status and Commands Window
The Status and Commands window is a floating view that displays over an object on the canvas, and can be moved around in the Graphics Viewer. The Status and Commands window displays a connection line to its associated objects on the canvas. The connection point of the connection line, anchors itself in the following manner:

- Non-engineered elements: The connection point aligns itself to the center of the element.
- Symbols: The connection point aligns itself to the center of the first element in the symbol, according to the element tree.
- Customized Connection Point: You can create a connection point location by drawing an ellipse where you want to anchor the connection point for the symbol. In the Ellipse Descriptor field, you can enter text stating it is an Anchor for the Connection Point. To hide the ellipse from view, either cover it up by another element (preferred method) or disable the Visible property for the element in the Property tree. In both cases, make sure that the ellipse is the first element in the Symbols element tree in the Element view.

For graphics and graphic templates only, you can specify the maximum number of connection lines to display. The default value of 65535 is used when the property Graphics > Max Connection Lines is left blank, in which case under normal circumstances all lines display with the Status and Commands window. If the actual number of connection lines associated with a Status and Commands window exceeds the number of connection lines specified in this property, then none of the lines display.

Drag-and-Drop
The Status and Commands window is a drag source for data point properties. When the Status and Commands window is expanded, you can drag a data point or one of its properties from the window to any of the drop targets in the Graphics Editor or other applications. You cannot drag-and-drop virtual data point properties, such as those properties that display No Properties or Not Available.

- Evaluation Editor: When you drop a data point property in the Expression field of the Graphics Editor’s Evaluation Editor, the current value of the property displays in the Result field for the element’s property.
- Ribbon: When you drop a data point property onto the ribbon, all the graphics associated with that data point display as tabbed graphics in the work area.
- Graphic Canvas: When you drop a data point property onto the canvas, the associated data point symbol displays on the graphic.

For a list of the drop sources in the Graphics Editor, see the Table of Graphics Drop Targets.

4.2.1.6 Viewing a Coverage Area
Desigo CC allows you to manually associate objects to one another. For example, you can associate a fire detector (or any other object type) to a video camera or to a document. Then, whenever the fire detector is selected in the System Browser tree, the related video camera or document displays in the Related Items tab. The Coverage Area feature provides a graphical way to achieve the same result.

Desigo CC graphics can contain cameras or monitoring devices to which objects, such as fire sensors, ceiling sprinklers, temperature sensors, etc. are associated. For example, you have a graphic of an office space that includes a camera that is monitoring the fire sensors in that room. In this example, the fire sensors monitored by the camera, are in the coverage area of the device.

The coverage area contains the monitored objects. When you move your cursor over the coverage area, a tooltip displays the coverage area’s object reference with the total number of monitored objects. If you move your cursor over an object in the
coverage area, a tooltip displays the object’s name or description. The background color of the coverage area varies depending on the configuration of the project. When you initially load a graphic, the coverage area of a camera is not visible in the Graphics Viewer. You must toggle the Coverage Area icon from the Graphics Viewer toolbar to view the coverage area of any monitoring devices on the graphic.

The Operation and Extended Operation tabs display the device properties when the coverage area is visible. The Related Items tab lists any coverage areas that are associated with the graphic under the heading that is named after the type of the monitoring object. For example, if the monitoring object is a camera, the heading displays Camera in the Related Items tab.

4.2.1.7 Viewing Graphic Objects

The Graphics Viewer allows you to display dynamic graphics of your building control system. Within System Manager, you navigate the various views of System Browser to select the objects you want to display in the Graphics Viewer. System Browser displays only the objects in the system that you have access to, based on your user profile and privileges.

Primary and Secondary Selections

When you select a graphics object from System Browser, the Graphics Viewer displays the representative graphic. The selected object is considered the primary selection. The object properties also display in the Operation or Extended Operation tab. The graphic that has the primary selection displays the name of the graphic and the object name according to your Display selection in the System Browser.

Additionally, the properties of the primary selection display in the Operation or Extended Operation, and the Detailed Log tabs. The Related Items tab displays objects related to the currently selected object. Each related item is assigned a group name that represents the object's type, for example, graphics, trends, reports, or schedules.
If you click a symbol on a graphic or, the referenced object of the symbol becomes the secondary selection, while the primary selection remains the same in System Browser. The following figure illustrates the primary selection in System Browser, Analog Output 1.

In the **Graphics Viewer**, the **Operation** tab changes its display to correspond to the new, secondary selection. System Browser displays the original, primary selection, to show your starting point.
When you select an object from System Browse that is associated with a graphic, the Graphics Viewer displays the representative graphic and the object’s associated symbol on the graphic is selected. As a result, the Operation tab displays the object properties to correspond to the selection. Double-clicking a symbol on a graphic makes the referenced object associated with the symbol the primary selection in System Browser and all workflows update accordingly.

4.2.1.8 Zooming and Panning

The Graphics Viewer supports zooming and panning within the active graphic. Zooming allows you to magnify or reduce the graphic image, and panning allows you to move the graphic around on the canvas. In Zooming mode, you can click and drag a rubber band rectangle around any area of the graphic. The rectangle represents the area that will be zoomed to full view once you release the mouse button. Pressing the ESC key cancels the rubber band rectangle function.

4.2.1.9 Scopes and Data Point Access

Assigning Scopes to Graphic Objects

Scope is a grouping of system objects, or nodes with specific scope definitions used for the purpose of assigning access rights. You can create scopes and assign access rights to any of the graphic nodes in the Graphics system tree. For more information, see Scopes.

You can apply scopes to the following graphic nodes:

- Graphics
- Symbols
- Templates
- Manual and Automatic Pages
Data Point Access Privileges

Data points are integrated into a graphic by associating them with elements. These data points and elements can be evaluated by creating expressions that result in a graphic that allows you to view dynamic values of a facility, building, or piece of equipment. Data points therefore always display using the elements they are associated with.

Depending on your access rights which are set in the System Manager certain data points can be inaccessible. In this case, if one or more data points associated with an element is inaccessible, then the associated element will not display in the graphic while in Runtime mode or in the Graphics Viewer. However, the parent of an element, such as a symbol instance or a group, and any other associated children (elements), are not affected and will display on the graphic. This is considered the Hide-Rule for data points in a graphic.

The Hide-Rule does not apply to Object References and Link References since there are no COV subscriptions involved in these scenarios.

When a data point with an existing address is subscribed for COV’s, the data point’s status and value are updated automatically in the Value Simulator. If the status for the data point displays General Access Denied, the data point is inaccessible and therefore not readable for COV subscriptions.

4.2.2 Graphics Viewer Workspace

The components that make up the Graphics Viewer consist of a toolbar, two views for navigating the active graphic, keyboard and mouse shortcuts, and tooltips. Review the following topics as needed:

4.2.2.1 Graphics Viewer Toolbar

The Graphics Viewer toolbar allows you to navigate to and work with graphic pages displayed in the Graphics Viewer. Use your cursor to select a toolbar button.

<table>
<thead>
<tr>
<th>Graphics Viewer Toolbar Operating Mode</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Edit</td>
<td>Allows you to toggle between the Graphics Viewer and the Graphics Editor.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>NOTE:</strong> Only displays if a Graphics Editor license is detected.</td>
</tr>
<tr>
<td></td>
<td>Next Related Item</td>
<td>Allows you to scroll to and display the next graphical related item</td>
</tr>
<tr>
<td></td>
<td></td>
<td>associated with the selected datapoint in System Browser. Only enabled if</td>
</tr>
<tr>
<td></td>
<td></td>
<td>the datapoint has more than one related graphical item.</td>
</tr>
<tr>
<td></td>
<td>Previous Related Item</td>
<td>Allows you to scroll to and display the previous graphical related item</td>
</tr>
<tr>
<td></td>
<td></td>
<td>associated with the selected datapoint in System Browser. Only enabled if</td>
</tr>
<tr>
<td></td>
<td></td>
<td>the datapoint has more than one related graphical item.</td>
</tr>
<tr>
<td></td>
<td>Zoom In (+20%)</td>
<td>Allows you to zoom in by + 20% on the active graphic with each mouse click.</td>
</tr>
<tr>
<td></td>
<td>Zoom Out (-20%)</td>
<td>Allows you to zoom out by - 20% on the active graphic with each mouse click.</td>
</tr>
<tr>
<td></td>
<td>100%</td>
<td>Displays the active graphic at 100% magnification.</td>
</tr>
<tr>
<td></td>
<td>Home</td>
<td>Returns the view of the displayed graphic to the state when the primary</td>
</tr>
<tr>
<td></td>
<td></td>
<td>selection changed. For example, if the Next/Previous buttons have been used,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>selecting Home loads the first graphical related item,</td>
</tr>
<tr>
<td>Mode</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>-----------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>Zoom View</td>
<td>Displays the Zoom view and allows you to zoom in on the active graphic by adjusting the slider.</td>
<td></td>
</tr>
<tr>
<td>Aerial View</td>
<td>Switches between Aerial View being visible or hidden in the Graphics Viewer area.</td>
<td></td>
</tr>
<tr>
<td>Zoom Real</td>
<td>Allows you to zoom in on the active graphic. To activate, click the icon. To de-activate, left-click anywhere on the graphic.</td>
<td></td>
</tr>
<tr>
<td>Scale to fit</td>
<td>Scales the graphic to fit in the viewing area. Once selected, the graphic resizes itself according to window size. Selecting the button, changing the Zoom selection, or loading another graphic, disables the feature.</td>
<td></td>
</tr>
<tr>
<td>Point Centered display mode</td>
<td>Moves the selected point to the center of the graphic.</td>
<td></td>
</tr>
<tr>
<td>Fit to Secondary Selection</td>
<td>Allows you to calculate the depth and the viewport from the current selection.</td>
<td></td>
</tr>
<tr>
<td>Depths Navigation View</td>
<td>Switches between Depths Navigation view being visible or hidden in the Graphics Viewer area. This view allows you to view a graphic content by depth, and by layer, or by discipline associated with a layer.</td>
<td></td>
</tr>
<tr>
<td>Show Status and Commands pane</td>
<td>Allows you to enable or disable the Status and Commands window from displaying.</td>
<td></td>
</tr>
<tr>
<td>Coverage Area mode</td>
<td>When this icon is enabled, it allows you to view the coverage areas on the graphic. When disabled, no coverage areas display on the graphic.</td>
<td></td>
</tr>
<tr>
<td>Page setup</td>
<td>Displays the Page setup view for the current graphic.</td>
<td></td>
</tr>
<tr>
<td>Print</td>
<td>Displays the Print dialog box to print the current graphic.</td>
<td></td>
</tr>
</tbody>
</table>
4.2.2.2 Views

The Graphics Viewer provides you with two floating views, the Aerial View and the Graphic Navigation View, to help you navigate the active graphic. Both views can be resized and toggled to display or not, using the Graphics Viewer toolbar.

Aerial View

The Aerial View provides you with a bird's-eye view of the active graphic at all times. The viewport rectangle, a rectangular shaped border within the Aerial View, provides a visual representation of the region that has the current focus. You can also draw a viewport rectangle in the area you would like to zoom in on, or click and drag the viewport to move to another location on the graphic.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Viewport Rectangle</td>
<td>Allows you to view graphics in part or as a whole.</td>
</tr>
</tbody>
</table>
Navigation View

The **Graphic Navigation View** allows you to customize and navigate through views of the active graphic by selecting a depth and then filtering, by discipline or by layer, which of the associated layers to display. If you choose to filter the layers by discipline, only the layers designated with that discipline display in the graphic view. Otherwise, if you filter on layers only, all the layers of the selected depth display in the **Graphic Navigation View**, and you can manually choose which layers will be visible in the current view of the graphic.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Selected Depth</td>
<td>Displays the active depth. Use the drop-down menu to select from a list of available depths.</td>
</tr>
<tr>
<td>2 Filtering</td>
<td>Allows you to select how to filter the layers associated with the selected depth. You can filter the layers by <strong>Discipline</strong> or by <strong>Layers</strong>.</td>
</tr>
<tr>
<td>3 Discipline Selection</td>
<td>Displays the discipline used to filter the associated layers with. Use the drop-down menu to choose from a list of available disciplines. The active graphic will only display layers designated with the selected discipline. This section is only active if you have selected to filter the depth by <strong>Discipline</strong>.</td>
</tr>
<tr>
<td>4 Layer Selection</td>
<td>Displays the list of available layers associated with the selected depth. If a layer is checked, the associated layer displays in the current graphic view. If unchecked, the layer does not display. This section is only active if you have selected to filter the selected depth of the graphic by <strong>Layer</strong>.</td>
</tr>
</tbody>
</table>
4.2.2.3 Status and Commands Window

The Status and Commands window displays the following information about an object, its properties, and its status.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Icon</td>
<td>Displays the icon associated with the property type.</td>
</tr>
<tr>
<td>2 Object path and object name</td>
<td>The path and the name of the object.</td>
</tr>
<tr>
<td>3 Property name</td>
<td>Displays the name of one or more properties associated with the object the selected objects.</td>
</tr>
<tr>
<td></td>
<td>If you select multiple objects of the same type in the system, the icon next to the property name indicates this with a triangular symbol in the lower right-hand corner. Clicking this symbol expands the table row to show all of the selected objects of the same type that share this property. You can then change all properties for the selected objects at the same time.</td>
</tr>
<tr>
<td>4 Current value</td>
<td>Displays the current value of each property.</td>
</tr>
<tr>
<td>5 Argument area and Progress/Result area</td>
<td>When you initiate a command that requires additional arguments, the required argument fields display for you to enter one or more arguments prior to sending the command. You must complete all required arguments before sending the command. An argument field that displays a red border around it means that the value for that property is invalid. You will need to enter a valid value before commanding the property. Displays the progress and then the result of a command, once you execute a command. During the command, the Progress/Result field displays Command in Progress, along with information about how many objects have been commanded and how many will be commanded all together. After a command execution is complete, successful commands display Success. Failed commands display the reason the command failed and, if you executed multiple commands, the number of failed commands.</td>
</tr>
</tbody>
</table>
### Command area
Displays the name of a command that you can initiate. If a command button has a triangle in the lower right-hand corner, the command has multiple buttons or options, and clicking on the triangle displays the options. Some commands are sent immediately after you initiate them by clicking on the Command button. Others require you to enter arguments before they can be sent. When a command requires arguments (additional fields requiring information to continue with the command), the property row will expand after you click the command button. You then complete the additional fields and click the appropriate button (Send, Command, etc.).

Some object properties support grouping of command buttons under a single command button with a drop-down list of your choices. The button you choose from the drop-down list becomes the new commandable button in the group.

The Send button displays only for commands that require additional arguments. Clicking the Send button sends a command after you have entered all required arguments.

**Command Types:**

**Multiple Option Selection:**

![Multiple Option Selection Diagram]

Visual display of associated properties. Each slot represents a property option. If a property is selected, it is shaded. Moving your cursor over the slot allows you to view the property option; clicking on the slot allows you to select the option.

### Expand/Collapse button
Allows you to expand, collapse, or close the window:
- Expands the Status and Commands window when icons display off-normal properties.
- Minimizes a Status and Commands window so that only the icons of the off-normal properties display.

Closes a Status and Commands window completely, if there are no properties in an off-normal state.

### Scroll-view indicator
Indicates whether more buttons are available, yet not visible, and where the buttons are displayed.

When you move the mouse over the scroll-view indicator, East-West cursor displays, and allows you to scroll through the commands.

- More command buttons are to the right of the last displayed button.
- More buttons are to the left of the first displayed button.
- There are more buttons on either side of the visible buttons.

### Scrollbar
Displays when the window has run out of space, and allows you to scroll through the active properties.
4.2.2.4 Status and Commands Connection Lines
Visibility of the connection line and its connection point are controlled as follows:
- A connection line and its connection point are only visible if the element is visible.
- An element is only visible when the layer is visible that contains the element.
- A layer is only visible if a depth is visible that contains that particular layer.
- A Status and Commands window is only displayed when there is at least one connection to an element.

4.2.2.5 Keyboard Shortcuts
Below is a list of available keyboard shortcuts you can apply to the active graphic or one of its children. A graphic is made active by clicking on the graphic. You can use a set of keyboard shortcuts to view the active graphic in the Graphics Viewer. Before applying any of the shortcuts, make sure the appropriate graphic is active by clicking on it.

<table>
<thead>
<tr>
<th>Press...</th>
<th>To ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTRL+A</td>
<td>Select all elements</td>
</tr>
<tr>
<td>HOME</td>
<td>Scroll to the left</td>
</tr>
<tr>
<td>END</td>
<td>Scroll to the right</td>
</tr>
<tr>
<td>CTRL+HOME</td>
<td>Scroll to the top</td>
</tr>
<tr>
<td>CTRL+END</td>
<td>Scroll to the bottom</td>
</tr>
<tr>
<td>PAGE UP</td>
<td>Scroll up</td>
</tr>
<tr>
<td>PAGE DOWN</td>
<td>Scroll down</td>
</tr>
</tbody>
</table>
| UP, LEFT, DOWN, RIGHT ARROWS | If not in Panning mode: Move selected elements by 1 pixel.  
|                       | If in Panning mode: Pan the view by 1 pixel.  
|                       | If modifying a line/polyline node: Move the node by 1 pixel. |
| CTRL+UP, CTRL+LEFT, CTRL+DOWN, CTRL+RIGHT ARROWS | If not in Panning mode: Move selected elements by the grid pixels.  
|                       | If in Panning mode: Pan the view by the grid pixels.  
|                       | If modifying a line/polyline node: Move the node by the grid pixels. |
| CTRL+0                | Zoom = 100%                                 |
| SPACEBAR              | Activate Quick Panning mode. The previous tool mode is restored when the key is released. |
| MINUS SIGN            | Zoom out (-20%)                             |
4.2.2.6 Mouse Functions

The following mouse functions are available in the active graphic once you have activated Zoom mode, either by clicking one of the zoom buttons on the toolbar or by pressing the Z-Key. You can use mouse button-wheel shortcuts to view the active graphic in the Graphics Viewer. Before applying any of the shortcuts, make sure the appropriate graphic is active by clicking on it.

<table>
<thead>
<tr>
<th>Click...</th>
<th>To ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTRL +MOUSE WHEEL</td>
<td>Zoom in and out (+ or - 20%)</td>
</tr>
<tr>
<td>LEFT MOUSE BUTTON</td>
<td>Zoom in (+20%)</td>
</tr>
<tr>
<td>RIGHT MOUSE BUTTON</td>
<td>Zoom out (-20%)</td>
</tr>
</tbody>
</table>

**Z-key**
Activates Quick Zoom mode. Cursor changes to the magnifying glass and allows you to draw a viewport directly on the active graphic. The previous tool mode is restored when the key is released.

**F5**
Refresh. All views are refreshed. All open graphics are reloaded.

**F12**
Toggle the Aerial View on/off
5 Remote Notifications

This section provides instructions and background information for using Remote Notifications: in Desigo CC.

5.1 Working with Remote Notifications

This section provides step-by-step instructions for some common Remote Notifications tasks. For background information, see Remote Notifications Reference [➙ 143].
Perform the procedures in this section as needed.

5.1.1 Sending a ‘New’ (Operator-Issued) Remote Notification

Scenario: You want to quickly alert all the facility operators of an event that has occurred, but no alarm-triggered remote notification was configured for that event. In this example you will directly send a notification to the recipients in the Operators group.

- An Operators recipient group was created in the Desigo CC Address Book.
- The communication services used by the recipients in the Operators group (in this example, email and SMS) are configured.
- System Manager is in a layout that includes the Contextual pane, and the Primary pane is unlocked.

1. In Related Items, click New Remote Notification (icon or link).
2. In the Address Book area, in the Filter drop-down list, select Groups.
3. Drag-and-drop the Operators group from the Address Book area to the Recipient/Members list on the left.
   ➤ The Operators group is added to the Recipient/Members list, with the total number of contacts in that group.
4. Compose the notification messages for email and SMS as follows:
   a. In the Device drop-down list, select E-Mail. Drag-and-drop any automatic tags you want to use from the Message Tags list into the Subject and Body fields. You can also directly enter text. The subject line cannot be empty.
   b. In the Device drop-down list, select SMS. Drag-and-drop any automatic tags you want to use from the Message Tags list into the Body field. You can also directly enter text. The maximum message length is 480 characters (divided into three messages). Longer text messages will be cut off.
5. Click Send this message．
6. The message is sent immediately and the user interface in the Secondary pane switches to the Message Status list, from where you can monitor the progress of the remote notification, and see its outcome.
7. If you want to compose another notification, click Back to configuration．
8. From here you can edit the previously sent notification, or click Clear all message data to reset all the fields and start over.
5.1.2 Monitoring the Progress and Outcomes of Sent Notifications

Scenario: You want to check the outcome of a previously-sent remote notification. The system provides a Message Status list where you can review all the remote notifications sent out (whether alarm-triggered or operator-issued), and check on the progress, details, and outcome of each one.

▷ System Manager is in Operating mode.

1. In System Browser, select Application View.

2. Select Applications > Remote Notifications.

   ◂ The RENO Messages tab displays. The Message Status list shows a list of all the notifications (alarm-triggered or operator-issued) that have been sent out from the management platform.
   
   NOTE: If no remote notifications have been sent out, the RENO Messages tab does not display.

3. Each notification displays on a separate (expandable) row. The topmost row shows a compact notification summary with the most important information about the notification, and an indication of its overall outcome. For example, Failed, Completed, Partially Failed, No Response.

4. Click ▶ alongside a notification to expand it and display further details about it:
   - Procedure data summary (only for alarm-triggered notifications): provides more information about the event that triggered the notification.
   - Recipients summary: lists the [recipient groups] of the notification. Alongside each group is a Status that indicates the progress/outcome of notifying that group.

5. Expand a recipient group to see more details (how many group members have responded so far, whether the group timeout is expired, and so on), the list of individual contacts in that group, and its escalation list (if configured). Alongside each contact is a Status that indicates the progress/outcome of notifying that person.

6. Expand an individual contact to see the person’s preferred and fallback devices (for example, an email address, or a mobile phone number).
   - Select a device to see the text of the notification message sent to that contact in the Message panel on the right.

Next Steps:
If required, proceed to:
- Re-Sending a Remote Notification from the Message Status List [→ 140]
- Stopping a Remote Notification from the Message Status List [→ 141]
5.1.3 Re-Sending a Remote Notification from the Message Status List

Scenario: You want to re-send a remote notification that was previously not completed successfully (for example, its overall outcome was Failed or Aborted).

▷ System Manager is in Operating mode.

1. In System Browser, select Application View.
2. Select Applications > Remote Notifications.
   ▷ The RENO Messages tab displays. The Message Status list shows a list of all the notifications (alarm-triggered or operator-issued) that have been sent out from the management platform.
   
   NOTE: If no remote notifications have been sent out, the RENO Messages tab does not display.

3. In the Message Status list, select the remote notification that you want to re-send. (For example, test – Alarm ID: 29 – Automatic).
4. Click Start RENO procedure.
   ▷ The system starts re-sending the notification. While sending is in progress, the icon is dimmed.

Next Step:
If required, proceed to Monitoring the Progress and Outcomes of Sent Notifications [➡ 139].

Related Topics
Remote Notifications Message Status List [➡ 144]

5.1.4 Starting a Remote Notification from Event List

Scenario: An event has occurred that triggered an alarm-triggered remote notification. The notification has Starting Mode = Manual, which means operator intervention is required for the system to start sending out the preconfigured messages.

▷ Event List displays on the screen.

▷ An event has occurred for which the Start Remote Notifications command is available for the event.

1. In Event List, select the event that triggered the notification.

2. Click Start Remote Notifications for the event.
   ▷ The system starts sending the notification messages preconfigured for this event. The Stop Remote Notifications command is available for the event.
Next Steps:
If required, proceed to:

- Monitoring the Progress and Outcomes of Sent Notifications [→ 139]
- Stopping a Remote Notification from Event List [→ 141]

Related Topics
Remote Notifications Reference [→ 143]

5.1.5 Stopping a Remote Notification from Event List

Scenario: Sending of a remote notification is in progress. The notification was configured with **Starting Mode = Manual** and **Can be stopped = Yes**. You now want to interrupt (halt) sending of the messages.

▷ You previously started a remote notification from Event List, and the **Stop Remote Notifications** command is available for the event.

1. In Event List, click **Stop Remote Notifications** for the event.

▷ The system stops sending the notification messages preconfigured for this event. The **Start Remote Notifications** command is available for the event.

Next Steps:
If required, proceed to:

- Monitoring the Progress and Outcomes of Sent Notifications [→ 139]
- Starting a Remote Notification from Event List [→ 140]

Related Topics
Remote Notifications Reference [→ 143]

5.1.6 Stopping a Remote Notification from the Message Status List

Scenario: You want to interrupt sending of a remote notification that is currently in progress.

▷ System Manager is in **Operating** mode.

▷ You are displaying the **Message Status** list.

- In the **Message Status** list, select the remote notification that is currently being sent (its overall outcome will display as **Running**).

▷ The **Stop RENO procedure** icon is enabled if the notification can be stopped.

1. Click **Stop RENO procedure**.

▷ The system stops sending the remote notification messages. The overall outcome of the notification becomes **Aborted**. The status of any pending recipients becomes **Cancelled**.

Next Step:
If required, proceed to Halting the Escalation of a Remote Notification [→ 142].
5.1.7 Halting the Escalation of a Remote Notification

Scenario: Sending of a remote notification is in progress. You want to halt its escalation, so that the message is not sent to the escalation recipients.

▷ System Manager is in Operating mode.
▷ You are displaying the Message Status list.

1. In the Message Status list, select the remote notification that is currently being sent (its overall outcome will display as Running).

2. Expand the notification (click ➔) to view its details.

3. Expand Recipients to see the groups to which that notification is addressed.

4. Select the group for which you want to stop the escalation.
   - The Stop RENO procedure escalation icon is enabled if the escalation for this group has not started yet.

5. Click Stop RENO procedure escalation.
   - The escalation for the selected group is now disabled. If the group does not reach its threshold of required responses, any escalation does not start. The status of the group and the recipients involved becomes Stop.

6. Repeat Steps 4 and 5 above for any other recipient groups of the notification.

Related Topics
Monitoring the Progress and Outcomes of Sent Notifications [➙ 139]
Remote Notifications Message Status List [➙ 144]

5.1.8 Disabling an Alarm-Triggered Remote Notification

Scenario: You want to disable one of the alarm-triggered remote notifications configured in the system. This will prevent the notification messages from being dispatched when the triggering event occurs, while still retaining that notification within the system.

▷ System Manager is in a layout that includes the Contextual pane.

1. In System Browser, select Application View.

2. Select Applications> Remote Notifications > [Remote Notification to be disabled].
   - In the Operation tab, the IsEnabled property (Enabled/Disabled) of the notification displays.

3. Click Disable.
   - The IsEnabled property (Enabled/Disabled) updates accordingly.
NOTE:
When you disable a remote notification, the management platform generates an event. This event is automatically cleared when you re-enable the remote notification.

Related Topics
Remote Notifications Reference [➙ 143]

5.2 Remote Notifications Reference
This section provides background information on the remote notifications feature of Desigo CC and communication services (email, SMS, pager).

5.2.1 Overview of Remote Notifications
The management platform has the capability to send out remote notification (RENO) messages—delivered, for example, using email, SMS or pagers—to one or more groups of contacts (recipients).

Remote notifications can be of two types:
● Alarm-triggered notifications: Messages preconfigured in the system to be sent out when certain alarms occur in the building control site.
● New (operator issued) notifications: Messages composed and sent on the initiative of the operator. These operator-issued notifications are not tied to any triggering event, and can be sent out at any time in Operating mode. For instructions, see Working with Remote Notifications [➙ 138].

Operators can interact with remote notifications in the following ways:
● Start, Stop, or Resend a Remote Notification (Alarm-Triggered or Operator-Issued)
● Monitor the Progress and Outcome of Sent Notifications (Alarm-Triggered or Operator-Issued)
● Enable or Disable an Alarm-Triggered Remote Notification

Location of Remote Notifications
Alarm-triggered remote notification objects are located under Applications > Remote Notifications in the Application View of System Browser.

Recipients of a Remote Notification
Remote Notifications (whether alarm-triggered or operator-issued) can be addressed to one or more recipient groups (for example, supervisors, operators) selected from the system Address Book [➙ 378]. These recipients do not necessarily have to be Desigo CC users.
● For each individual contact, the Address Book stores a preferred device (email address, mobile phone number, or pager number) that can be used to contact that person, and optionally also a fallback device.
● The system will attempt to send the notification to all the members of each recipient group, using the preferred and (if available) fallback devices configured in the address book. (It will try the preferred device first and, if that fails, it will try the fallback device).

Replies from Recipients and Escalation Rules
Depending on how a remote notification is configured, it may or may not require a response from the recipients of the message.
How Recipients can Reply to a Remote Notification

When the recipients receive a remote notification message (via email, SMS, or pager) they can acknowledge the notification by replying to the message in the following ways.

- **Email:** reply to the email message without adding any additional text.
- **SMS:** reply to the SMS in one of the following ways:
  - Paste and send back the received text message, including the numeric code at the end of the received text message.
  - Send a text message that contains the numeric code included at the end of the received text message.
- **Pager:** notification acknowledge is not supported.

**NOTE:**

Replying to a remote notification message only acknowledges the notification. It is not the same thing as acknowledging the event, which is instead done by sending an **Acknowledge** command from Event List (see Working with Alarms [→ 69]).

Remote Notification Event Log

When working with remote notifications, entries are recorded in the History Database tracking the progress of remote notifications (such as, remote notification devices status error, remote notification creation/deletion or start/stop, and so on).

5.2.2 RENO Messages Reference

In **Operating** mode, when you work with remote notifications, the **RENO Messages** tab displays. For related procedures, see Working with Remote Notifications [→ 138].

5.2.2.1 Remote Notifications Message Status List

The system provides a **Message Status** list where operators can review all the remote notifications sent out (whether alarm-triggered or operator-issued), and check on the progress, details, and outcome of each one. From here, it is also possible to resend notifications, and if desired abort or halt the escalation of ongoing ones.

Accessing the Message Status List

In some cases the message status list displays automatically, for example, after you send an operator-issued notification. You can also access it manually in a variety of ways.

**Cases where the Message Status list opens automatically:**

- After sending an operator-issued remote notification the **Message Status** list displays in the **Secondary** pane.
- When performing the RENO step in an assisted treatment procedure the **Message Status** list displays in the **Assisted Treatment** window.

**Ways to manually access the Message Status list** (System Manager must be in **Operating** mode):

- View all remote notification sent:
  - In System Browser, select **Application View**.
  - Select **Applications > Remote Notifications**.
- View all operator-issued (new) remote notifications sent:
  - In System Browser, select **Management View**.
Remote Notifications

Select Project > System Settings > Related Items Templates > New Remote Notification

- View the remote notifications triggered by a point currently in alarm:
  - Select the point in alarm in System Browser. (You can do this by double-clicking the event source in the event descriptor of the alarm that triggered the notification.)

**Figure 16: Message Status List in the Primary Pane**

**Figure 17: Message Status List in the Secondary Pane**

**Information Provided in the Message Status List**

In the Message Status list, each notification displays on a separate (expandable) row. The topmost row shows a compact notification summary with the most important information about the notification. See the tables below for a detailed key to the information provided in the Message Status panel.
## Compact Notification Summary
*(information in unexpanded/topmost row)*

<table>
<thead>
<tr>
<th>Type of sending</th>
<th>For alarm-triggered notifications, can be automatic or manual depending on configuration. See General Settings of a Remote Notification. For operator-issued notifications is always manual.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date and time</td>
<td>Full date and time when the notification was sent.</td>
</tr>
<tr>
<td>Name</td>
<td>Name assigned to the alarm-triggered notification in the System Browser tree.</td>
</tr>
<tr>
<td>Alarm ID</td>
<td>Event ID of the alarm that triggered the notification.</td>
</tr>
</tbody>
</table>
| Overall RENO outcome | **Initialized.** The system is preparing to send the remote notification messages.  
**Running.** The remote notification is in progress. The system has started sending messages to recipients.  
**Completed.** The remote notification was successful. Depending on configuration, this may mean only that the messages were successfully sent, or also that the required responses from recipients were received.  
**Partially failed.** The remote notification was successfully sent, but at least one recipient group failed to meet its response threshold.  
**No response.** The remote notification messages were sent, but none of the recipient groups met its response threshold.  
**Failed.** The system was unable to send the notification messages.  
**Aborted.** The operator stopped the remote notification, or halted its escalation. |

## Procedure Data Summary
*(displays for alarm-triggered remote notifications only)*

<table>
<thead>
<tr>
<th>Type</th>
<th>Type of message sending (Manual/Automatic).</th>
</tr>
</thead>
<tbody>
<tr>
<td>Starting in</td>
<td>For automatic notifications, the time left before the remote notification message is sent (delay).</td>
</tr>
</tbody>
</table>
| Trigger | Details about the condition that triggered the notification:  
**Trigger:** Type of trigger (for example, Alarm)  
**Category:** Event category  
**Date:** Date the alarm occurred  
**Time:** time the alarm occurred  
**Alarm ID:** Event identifier (for example, Alarm ID 44)  
**Point state:** Point state that triggered the notification (Genuine, or All, or Maintenance). |
| Source | Details about the source of the event that triggered the notification:  
**Source:** Field object in alarm  
**Location:** Path of the field object in the System Browser tree  
**Discipline:** Event discipline  
**Sub-discipline**  
**Type**  
**Sub-type** |
## Recipients Summary

The first level of the recipients’ summary shows a list of the recipient groups configured for the remote notification. You can expand each recipient group to see further details about that group and its members.

### Information shown for each recipient group:

- **[group name]** – **[group threshold/replies/timeout]** - **[group status]** - **[list of group members]** – **[escalation summary]**

<table>
<thead>
<tr>
<th>Group name</th>
<th>Name of the recipient group (for example, supervisors or administrators), selected from system address book, to which the notification was addressed.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group replies</td>
<td>How many group members have replied so far to the notification.</td>
</tr>
<tr>
<td>Group threshold</td>
<td>The minimum required number of replies required for this group. For example, Replies: 1/2 means that at least one of the two recipients belonging to the group must reply for this message to be considered acknowledged.</td>
</tr>
<tr>
<td>Group timeout</td>
<td>The time limit for receiving the required number of replies from this group. (Processing displays in the interval of time before the timeout expires.) <strong>NOTE:</strong> When many clients and many remote notification messages are involved, the system ensures that all the timers are aligned.</td>
</tr>
<tr>
<td>Group Status</td>
<td>Notification status of the group as a whole (see <strong>Status</strong>, below, for a key to the possible values).</td>
</tr>
</tbody>
</table>
| List of group members | List of the individual contacts in the group. You can expand each individual contact to display that person’s:  
  - name  
  - preferred (PR) and fallback (FB) devices  
  - individual notification status (see **Status**, below, for a key to possible values)  
  **Cancelled** is the status that displays when you stop the escalation. |
| Escalation         | An additional summary that displays only if the group has escalation rules. See below for details.                                     |

## Escalation Summary

The escalation summary under a group displays only if the group has escalation rules configured.

### Information shown for the group’s escalation:

- **[escalation threshold/replies]** – **[escalation status]** - **[list of escalation recipients]**

<table>
<thead>
<tr>
<th>Escalation replies</th>
<th>How many escalation recipients have replied within their individual timeout.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Escalation threshold</td>
<td>The minimum required number of replies required from escalation recipients.</td>
</tr>
<tr>
<td>Escalation Status</td>
<td>Outcome of the escalation as a whole (see <strong>Status</strong>, below for a key to possible values).</td>
</tr>
</tbody>
</table>
| List of escalation recipients | List of the individual contacts configured as escalation recipients for this group. You can expand each contact to see that person’s:  
  - Name  
  - Preferred (PR) and fallback (FB) devices  
  - Timeout for replying. (**Pending** is indicated in the interval of time before timeout expires.)  
  - individual notification status (see **Status**, below, for a key to possible values)  
  Click a PR or FB device to see the actual message sent in the panel on the right. |
<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Empty</td>
<td>The remote notification has not started yet.</td>
</tr>
<tr>
<td>Running</td>
<td>The remote notification is in progress.</td>
</tr>
<tr>
<td>Pending</td>
<td>The message has been sent to the designated recipients and the system is awaiting a reply (the timeout for a response has not yet elapsed).</td>
</tr>
<tr>
<td>Acknowledged</td>
<td>The designated recipients replied within the timeout. In the case of a group it mean that the group reached its response threshold within the timeout.</td>
</tr>
<tr>
<td>Not reachable</td>
<td>The system failed to send the message to both the preferred and fallback device.</td>
</tr>
<tr>
<td>Timed out</td>
<td>The system did not receive the replies at all. In particular:</td>
</tr>
<tr>
<td></td>
<td>• For an individual contact: the person did not reply within the timeout.</td>
</tr>
<tr>
<td></td>
<td>• For a group: the group failed to reach its response threshold within the timeout.</td>
</tr>
<tr>
<td>Cancelled</td>
<td>The operator stopped the remote notification.</td>
</tr>
<tr>
<td>Stop</td>
<td>The operator halted the escalation of the remote notification.</td>
</tr>
</tbody>
</table>
### 5.2.2.2 RENO Messages Toolbar Controls

In **Operating** mode, when you work with remote notifications, the **RENO Messages** toolbar is available. It allows you to start, stop, and clear remote notifications.

<table>
<thead>
<tr>
<th></th>
<th>Alarm-based notifications</th>
<th>New notifications</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Start RENO procedure</strong></td>
<td>Start sending or re-sending the currently selected remote notification. The icon is dimmed while sending is in progress.</td>
<td>Start re-sending the new (operator-issued) notification.</td>
</tr>
<tr>
<td><strong>Stop RENO procedure</strong></td>
<td>Stop the remote notification that is currently in progress. If successful, the remote notification overall outcome becomes <strong>Aborted</strong>; the status of pending recipients becomes <strong>Cancelled</strong>. Notifications can only be stopped if they are configured as <strong>Can be stopped</strong> (see General Settings of a Remote Notification). Remote notifications with manual sending can be stopped while they are in progress. Notifications with automatic sending can only be stopped during the time delay before they start.</td>
<td>Stop monitoring the message status of new (operator-issued) notification.</td>
</tr>
<tr>
<td><strong>Stop RENO procedure escalation</strong></td>
<td>Stop the escalation for the currently selected recipient group: If the group does not reach its threshold of required responses, any escalation does not start. The status of the groups and recipients involved becomes <strong>Stop</strong>. If there is more than one recipient group with an escalation list, to stop all escalations you must select each group in turn and repeat this step to disable its escalation. This command is not available if an escalation has already started.</td>
<td></td>
</tr>
<tr>
<td><strong>Clear manual procedure</strong></td>
<td>n.a.</td>
<td>Only available for new (operator-issued) remote notifications in the <strong>Secondary</strong> pane. Remove the selected notification from the list.</td>
</tr>
<tr>
<td><strong>Back to configuration</strong></td>
<td>n.a</td>
<td>Only available for new (operator-issued). Go back and compose another message.</td>
</tr>
</tbody>
</table>
## 5.2.2.3 Message Status Summary

<table>
<thead>
<tr>
<th>Situation</th>
<th>Status</th>
<th>Remote notification outcome</th>
<th>Groups</th>
<th>Recipients</th>
</tr>
</thead>
<tbody>
<tr>
<td>The remote notification is initialized, but has not yet started.</td>
<td></td>
<td>Initialized</td>
<td></td>
<td></td>
</tr>
<tr>
<td>The remote notification is automatic and time-delayed, and the operator stops it before it starts.</td>
<td></td>
<td>Aborted</td>
<td>Cancelled</td>
<td>Cancelled</td>
</tr>
<tr>
<td>The remote notification has started (regardless of whether it is automatic or manual).</td>
<td>Running</td>
<td>Pending</td>
<td></td>
<td>Acknowledged</td>
</tr>
<tr>
<td>Some recipients have replied and other replies are pending (the system is still waiting for them to reply because they have not yet timed out).</td>
<td>Running</td>
<td>Processing</td>
<td></td>
<td>Pending</td>
</tr>
<tr>
<td>No group has yet reached its response threshold.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>No group timeout has yet expired.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>The system is evaluating the final outcome of the notification.</td>
<td></td>
<td>Running</td>
<td></td>
<td>Acknowledged</td>
</tr>
<tr>
<td>No escalation for a group is pending.</td>
<td></td>
<td></td>
<td></td>
<td>Pending</td>
</tr>
<tr>
<td>Some recipients have replied and other replies are pending. An escalation threshold (either first or second level) for a group has been reached within the timeout.</td>
<td>Running</td>
<td>Acknowledged</td>
<td></td>
<td>Acknowledged</td>
</tr>
<tr>
<td>Other escalation groups are still pending.</td>
<td></td>
<td></td>
<td></td>
<td>Pending</td>
</tr>
<tr>
<td>Some recipients have replied, some are still pending, and others have timed out.</td>
<td>Running</td>
<td>Timed out</td>
<td></td>
<td>Acknowledged</td>
</tr>
<tr>
<td>The groups’ thresholds have not been reached.</td>
<td></td>
<td></td>
<td></td>
<td>Timed out</td>
</tr>
<tr>
<td>The groups’ timeouts are expired.</td>
<td></td>
<td></td>
<td></td>
<td>Pending</td>
</tr>
<tr>
<td>Some second-level recipients did not reply and it is no longer possible to reach the groups thresholds.</td>
<td>Running</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Other escalation groups are still pending.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>No replies are required for a group and its recipients.</td>
<td></td>
<td>Running</td>
<td></td>
<td>Sent</td>
</tr>
</tbody>
</table>


<table>
<thead>
<tr>
<th>Status Description</th>
<th>Aborted</th>
<th>Cancelled</th>
<th>Acknowledged</th>
</tr>
</thead>
<tbody>
<tr>
<td>The operator has stopped the manual remote notification.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>The status of the recipients that replied does not change.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>The status of the recipients that did not reply within the timeout does not change.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>The status of the recipients that replied after the remote notification is aborted changes to Acknowledged.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>No replies are required for a group and the related recipients.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Some recipients have replied; other recipients have timed out, and others still need to reply.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>All the groups have reached their response thresholds.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Some recipients have replied, other recipients have timed out, and others need to reply.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>At least one group did not reach its threshold within the timeout.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>No escalation group is pending.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>No replies are required for a group and its recipients.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>The system successfully sent at least one message to the mail server but none of the recipient groups reached their reply threshold (different from 0).</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>No escalation group is pending.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>For any reason, the system fails in sending all the messages to the mail server.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>One or more recipients have replied after the timeout.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Status Description</th>
<th>Completed</th>
<th>Acknowledged</th>
<th>Acknowledged</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Status Description</th>
<th>Partially failed</th>
<th>Acknowledged</th>
<th>Acknowledged</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Status Description</th>
<th>No Response</th>
<th>Timed out</th>
<th>Timed out</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>Acknowledged</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Status Description</th>
<th>Failed</th>
<th>Not Reachable</th>
<th>Not Reachable</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Status Description</th>
<th>Completed</th>
<th>Acknowledged</th>
<th>Acknowledged after timeout</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Partially failed</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Failed</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Sent</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
5.2.3 New Remote Notification in the Secondary Pane

You can open RENO Message in the Secondary pane, and can switch to the New Remote Notification workspace. Here you can compose a message, define the recipients, and send an operator-issued remote notification, that is, one that is not triggered by an alarm.

![New Remote Notification in the Secondary Pane](image)

**Figure 18: New Remote Notification – Edit Mode**

New Remote Notification Toolbar Controls

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send this message</td>
<td>Send a new operator-issued remote notification.</td>
</tr>
<tr>
<td>Clear all message</td>
<td>Clear all fields for the current new operator-issued remote notification</td>
</tr>
<tr>
<td>data</td>
<td></td>
</tr>
</tbody>
</table>

---

**Siemens**
**Building Technologies**
**User Guide Version 3.0**
**A6V10415471**
**2017-11-30**
6 Schedules

This section provides background information and instructions for using BACnet schedules, management station schedules and the Timeline Viewer in Desigo CC.

6.1 Working with Schedules

This section provides step-by-step instructions for using BACnet schedules, management station schedules and the Timeline Viewer. For background information, see Schedules Reference [➙ 165].

Perform the workflows in this section as needed.

6.1.1 Working with BACnet Schedules

This section provides step-by-step instructions for using BACnet Schedules. For background information, see BACnet Schedules Reference [➙ 165].

Perform the procedures in this section as needed.

6.1.1.1 Adding a BACnet Calendar

▷ System Manager is in Operating mode.

1. In System Browser, select Application View.
2. Select Schedules > BACnetCalendars.
3. Select the Scheduler tab.
4. Click Save  
5. Complete the Name field.
6. From the Field Device drop-down list, select the panel you want this calendar associated with.
7. Click OK.

6.1.1.2 Adding a BACnet Schedule

▷ System Manager is in Operating mode.

1. In System Browser, select Application View.
2. Select Schedules > BACnetSchedules.
3. Select the Setup tab.
4. Select the Default value and the Data type and complete the remaining fields.
5. From System Browser, drag objects that you want associated with the schedule into the Outputs tab.
6. Complete the resulting display of fields as needed.
7. Click Save  
8. In the Create New Object dialog box, do the following:
   a. From the Field Device drop-down list, select the panel you want this schedule associated with.
   b. Enter a name and description.
   c. Click OK.
6.1.1.3 Adding a Command

- System Manager is in Operating mode.
- 1. In System Browser, select Application View.
- 2. Select Application View > Schedules > BACnetCommands.
- 3. From the Text Group drop-down list, select the text group you want associated with this command.
- 4. In the Command Table Action List, click New.
- 5. Highlight the text in the new action list, and enter a name.
- 6. From System Browser, drag the desired object to the action list.
- 7. Complete the resulting fields.
- 8. Click Save.
- 9. Complete the Name field.
- 10. From the Field Device drop-down list, select the panel you want this command associated with.
- 11. Click OK.

6.1.1.4 Adding a Weekly Schedule Entry

- System Manager is in Operating mode.
- 1. In System Browser, select Application View.
- 2. Select Schedules > BACnetSchedules.
- 3. Open the schedule to which you want to add a new weekly schedule entry.
- 4. Right-click in the schedule area, and click Add New Weekly Schedule Entry.
- 5. In the Schedule Entries tab, complete the fields.
- 6. Click Save.
- 7. Click OK.

6.1.1.5 Adding an Exception

- System Manager is in Operating mode.
- 1. In System Browser, select Application View.
- 2. Select Schedules > BACnetSchedules.
- 3. Open the schedule to which you want to add an exception.
- 4. Right-click in the schedule area, and click Add New Exception.
- 5. In the Exceptions tab, complete the fields.
- 6. Click Save.
6.1.1.6 Adding an Exception Entry

- System Manager is in Operating mode.
  1. In System Browser, select Application View.
  2. Select Schedules > BACnetSchedules.
  3. Open the schedule you want to add an exception entry to.
  4. Right-click the exception to which you want to add an entry.
  5. Click Add New Exception Entry.
  6. In the Schedule entries section, complete the fields.
  7. Click Save.

6.1.1.7 Copying a BACnet Calendar

- System Manager is in Operating mode.
  1. In System Browser, select Application View.
  2. Select Schedules > BACnetCalendars.
  3. Open the calendar you want to copy.
  4. Click Save As.
  5. In the Save Object As dialog box, enter a name.
  6. From the Field Device drop-down list, select the panel you want this calendar associated with.
  7. Click OK.

6.1.1.8 Copying a BACnet Schedule

- System Manager is in Operating mode.
  1. In System Browser, select Application View.
  2. Select Schedules > BACnetSchedules.
  3. Open the schedule you want to copy.
  4. Click Save As.
  5. In the Save Object As dialog box, enter a name.
  6. From the Field Device drop-down list, select the panel you want this schedule associated with.
  7. Click OK.

6.1.1.9 Copying a Command

- System Manager is in Operating mode.
  1. In System Browser, select Application View.
  2. Select Schedules > BACnetCommands.
  3. Open the command you want to copy.
  4. From the Scheduler toolbar, click Save As.
5. In the **Save Object As** dialog box, enter a name.
6. From the **Field Device** drop-down list, select the panel you want this command associated with.
7. Click **OK**.

### 6.1.1.10 Deleting a BACnet Calendar

- System Manager is in **Operating** mode.
1. In System Browser, select **Application View**.
2. Select **Schedules > BACnetCalendars**.
3. Open the calendar you want to delete.
4. From the **Scheduler** toolbar, click **Delete**.
5. Click **OK**.

### 6.1.1.11 Deleting a BACnet Schedule

- System Manager is in **Operating** mode.
1. In System Browser, select **Application View**.
2. Select **Schedules > BACnetSchedules**.
3. Open the schedule you want to delete.
4. On the **Scheduler** toolbar, click **Delete**.
5. Click **OK**.

### 6.1.1.12 Deleting a Command

- System Manager is in **Operating** mode.
1. In System Browser, select **Application View**.
2. Select **Schedules > BACnetCommands**.
3. Select the command you want to delete.
4. Click **Delete**.
5. Click **OK**.

### 6.1.1.13 Deleting a Weekly Schedule Entry

- System Manager is in **Operating** mode.
1. In System Browser, select **Application View**.
2. Select **Schedules > BACnetSchedules**.
3. Open the schedule with the weekly schedule entry you want to delete.
4. Click in the schedule area.
5. In the **Schedule Entries** tab, locate the entry you want to delete and click **Delete**.

**NOTE:** You cannot delete the entry for the beginning and end of day. You can
delete default entries at other times, as long as there are still entries at beginning and end of day. You can also replace the entry at beginning or end of day with a non-default entry.

6. Click **Save**.

### 6.1.1.14 Deleting an Exception

- **System Manager is in Operating mode.**
- 1. In System Browser, select **Application View**.
- 2. Select **Schedules > BACnetSchedules**.
- 3. Open the schedule.
- 4. Right-click the exception you want to delete.
  - **NOTE:** Exceptions are highlighted with a red bar on the left side of the entry.
- 5. Click **Delete Exception**.
- 6. Click **Save**.

### 6.1.1.15 Deleting an Exception Entry

- **System Manager is in Operating mode.**
- 1. In System Browser, select **Application View**.
- 2. Select **Schedules > BACnetSchedules**.
- 3. Open the schedule.
- 4. Right-click the exception entry you want to delete.
  - **NOTE:** Exception entries are highlighted with a red bar on the left side of the entry.
- 5. Click **Delete Exception**.
- 6. Click **Save**.

### 6.1.1.16 Modifying a BACnet Calendar

- **System Manager is in Operating mode.**
- 1. In System Browser, select **Application View**.
- 2. Select **Schedules > BACnetCalendars**.
- 3. Open the calendar you want to update.
- 4. To modify start dates, end dates, or recurrence settings, select a calendar entry from the **Calendar Entries** section, and then select the settings you want.
  - **NOTE:** If you use wildcards for date ranges (the **Advanced** check box), make sure to read your vendor's field panel documentation since the implementation of this feature is vendor-specific.
1. To delete a calendar entry, click the Delete icon associated with the entry.
   **NOTE:** Do not click the Delete icon from the Scheduler toolbar, or you will delete the entire calendar.

2. To add a calendar entry, click the New+ button, and then select the settings you want.

3. Click Save.

### 6.1.1.17 Modifying a Command

- System Manager is in **Operating** mode.
  1. In System Browser, select **Application View**.
  2. Select **Schedules > BACnetCommands**.
  3. Open the command you want to modify.
  4. Make changes to the **Text Group** and the **Applied Schedules** sections, and to the states in the **Command Table Action List**.
  5. Click Save.

### 6.1.1.18 Modifying a Weekly Schedule Entry

- System Manager is in **Operating** mode.
  1. In System Browser, select **Application View**.
  2. Select **Schedules > BACnetSchedules**.
  3. Open the schedule you want to modify.
  4. Select the weekly schedule you want to modify.
    **NOTE:** Weekly schedules are highlighted with a blue bar on the left side of the entry.
  5. In the **Schedule Entries** tab, modify the **Time** and **Value** fields.
  6. Click Save.

### 6.1.1.19 Modifying an Exception

- System Manager is in **Operating** mode.
  1. In System Browser, select **Application View**.
  2. Select **Schedules > BACnetSchedules**.
  3. Open the schedule with the exception you want to modify.
  4. In the schedule area, click the exception you want to modify.
    **NOTE:** Exceptions are highlighted with a red bar on the left side of the entry.
  5. In the **Exceptions** tab, modify the fields as needed.
    **NOTE:** If you use wildcards for date ranges (the **Advanced** check box), make sure to read your vendor’s field panel documentation since the implementation of this feature is vendor-specific.
  6. Click Save.
6.1.1.20 Modifying an Exception Entry

- System Manager is in Operating mode.

1. In System Browser, select Application View.
2. Select Schedules > BACnetSchedules.
3. Open the schedule you want to modify.
4. In the schedule area, select the exception entry you want to modify.
   NOTE: Exception entries are highlighted with a red bar on the left side of the entry.
5. In the Exceptions tab, modify the fields as needed.
   NOTE: If you use wildcards for date ranges, make sure to read your vendor’s field panel documentation since the implementation of this feature is vendor-specific.
6. Click Save.

6.1.2 Working with Management Station Schedules

This section provides step-by-step instructions for using management station schedules. For background information, see Management Station Schedules Reference [➙ 171].

Perform the procedures in this section as needed.

6.1.2.1 Adding a Management Station Calendar

1. In System Browser, select Application View > Schedules > Management Station Calendars.
2. From the Scheduler toolbar, click Save.
3. Complete the Name and Description fields.
4. Click OK.

6.1.2.2 Adding a Management Station Schedule

- System Manager is in Operating mode.

1. In System Browser, select Application View.
2. Select Schedules > Management Station Schedules.
   - The Scheduler displays.
3. From the Setup tab, complete the following:
   a. From the Start Date drop-down list, select the start date for the schedule. Selecting the Any date check box defaults to the current date.
   b. From the End Date drop-down list, select the end date for the schedule. Selecting the Any date check box defaults to an infinite date.
4. Click the Outputs tab, and then drag objects from System Browser you want associated with the schedule.
6. Click **Save**.

6. In the **Create New Object** dialog box, do the following:
   a. Complete the **Name** and **Description** fields.
   b. Click **OK**.

   The new object displays in System Browser.

### 6.1.2.3 Adding a Weekly Schedule Entry

1. In System Browser, select **Application View > Schedules > Management Station Schedules**.

2. Open the schedule to which you want to add a new weekly schedule entry.

3. Right-click in the schedule area.

4. Click **Add New Weekly Schedule Entry**.

5. In the **Schedule Entries** tab, complete the **Time** and **Value** fields.

6. Click **Save** to save the changes to the current schedule.

### 6.1.2.4 Adding an Exception

1. In System Browser, select **Application View > Schedules > Management Station Schedules**.

2. Open the schedule to which you want to add an exception.

3. Right-click in the schedule area.

4. Click **Add New Exception**.

5. In the **Exceptions** tab, select the exception type, start and end dates, and the range you want.

   **NOTE:** Before the exception block can appear in the daily or weekly view, you must create at least one Time and Value pair, and one of the values must be ON.

6. Click the **Save** icon to save the changes to the current schedule.

### 6.1.2.5 Adding an Exception Entry

1. In System Browser, select **Application View > Schedules > Management Station Schedules**.

2. Open the schedule to which you want to add an exception entry.

3. Click the **Exceptions** tab.

4. In the **Schedule entries** section, click **New**.

5. Complete the **Time** and **Value** fields.

6. Click **Save**.
6.1.2.6 Copying a Management Station Calendar
1. In System Browser, select Application View > Schedules > Management Station Calendars.
2. Open the calendar you want to copy.
3. Click Save As.
4. Complete the Name and Description fields.
5. Click OK.

6.1.2.7 Copying a Management Station Schedule
1. In System Browser, select Application View > Schedules > Management Station Schedules.
2. Open the schedule you want to copy.
3. Click Save As.
4. Complete the Name and Description fields.
5. Click OK.

6.1.2.8 Deleting a Management Station Calendar
1. In System Browser, select Application View > Schedules > Management Station Calendars.
2. Open the calendar you want to delete.
3. From the Scheduler toolbar, click Delete.
4. Click OK.

6.1.2.9 Deleting a Management Station Schedule
1. In System Browser, select Application View > Schedules > Management Station Schedules.
2. Open the schedule you want to delete.
3. From the Scheduler toolbar, click Delete.
4. Click OK.

6.1.2.10 Deleting a Weekly Schedule Entry
1. In System Browser, select Application View > Schedules > Management Station Schedules.
2. Open the schedule with the weekly schedule entry you want to delete.
3. In the schedule area, click the weekly schedule that contains the entry you want to delete.
   Details display in the Schedule Entries tab.
4. In the Schedule Entries tab, locate the entry you want to delete and click **Delete**.

   **NOTE:** You cannot delete default values.

5. Click **Save**.

6.1.2.11 Deleting an Exception

   1. In System Browser, select **Application View > Schedules > Management Station Schedules**.
   2. Open the schedule with the exception you want to delete.
   3. In the schedule area, right-click the exception you want to delete.
      **NOTE:** Exceptions are highlighted with a red bar on the left side of the entry.
   4. Click **Delete Exception**.
   5. Click **Save**.

6.1.2.12 Deleting an Exception Entry

   1. In System Browser, select **Application View > Schedules > Management Station Schedules**.
   2. Open the schedule with the exception entry you want to delete.
   3. Click the **Exceptions** tab.
   4. From the list of exceptions, select the exception you want to delete, and then click **Delete**.
   5. Click **Save**.

6.1.2.13 Modifying a Management Station Calendar

   1. In System Browser, select **Application View > Schedules > Management Station Calendars**.
   2. Open the calendar you want to update.
   3. To modify start dates, end dates, or recurrence settings, select a calendar entry from the **Calendar Entries** section, and then select the settings you want.
   4. To delete a calendar entry, click **Delete**.
      **NOTE:** Do not click the Delete icon from the Scheduler toolbar, or you will delete the entire calendar.
   5. Click **Save**.
6.1.2.14 Modifying a Weekly Schedule Entry

1. In System Browser, select Application View > Schedules > Management Station Schedules.
2. Open the schedule you want to modify.
3. In the schedule area, click the weekly schedule you want to modify. Schedules are highlighted with a blue bar on the side of the entry.
4. In the Schedule Entries tab, modify the Time and Value fields as needed. 
   **NOTE:** You can also drag the blocks up and down in the daily and weekly views to adjust the time. For more information, see Management Station Schedule Workspace [➙ 172].
5. Click Save.

6.1.2.15 Modifying an Exception

1. In System Browser, select Application View > Schedules > Management Station Schedules.
2. Open the schedule with the exception you want to modify.
3. In the schedule area, click the exception you want to modify. 
   **NOTE:** Exceptions are highlighted in red.
4. In the Exceptions tab, modify the fields as needed.
5. Click Save.

6.1.2.16 Modifying an Exception Entry

1. In System Browser, select Application View > Schedules > Management Station Schedules.
2. Open the schedule you want to modify.
3. Click the Exceptions tab.
4. From the list of exceptions, select the exception you want to modify.
5. Make your changes in the Exception Period and Exception Times sections.
6. Click Save.

6.1.3 Working with Timeline Viewer

This section provides step-by-step instructions for using the Timeline Viewer. For background information, see Timeline Viewer Reference [➔ 175]. Perform the procedures in this section as needed.

6.1.3.1 Adding a Schedule to the Timeline Viewer

1. Timeline Viewer is open and displaying one or more schedules.
2. Navigate to the schedule you want to add.
3. Drag-and-drop the schedule into the Timeline Viewer.

   The system adds the schedule.
6.1.3.2 Bringing the Current Day into View

- Using the Time Range scrollbar, you have scrolled away from the current day and would like to return to it quickly.

1. From the Timeline toolbar, select Show Today.

   NOTE: Selecting the Show Today icon does not affect any preset time period you have chosen.

6.1.3.3 Changing the Preset Time Span

1. From the Timeline toolbar, click Preset time spans.
2. Select the time span you want to display in the viewer.

   The Timeline Viewer displays the new selection.

6.1.3.4 Displaying the Timeline Viewer

- System Manager is in Operating mode
1. In System Browser, select Application View from the Views drop-down list.
2. Do one of the following:
   - Click Schedules > BACnet Schedules.
   - Click Schedules > Management Station Schedules.
3. Select the schedules you want to display.
4. Click the Timeline tab.

   The Timeline Viewer displays the selected schedules.

6.1.3.5 Zooming In

- You want to decrease the viewable span of the Timeline.
1. From the Timeline toolbar, click Zoom In.

   NOTE: Each time you click the icon, the Timeline decreases to the next preset time period.

6.1.3.6 Zooming Out

- You want to increase the viewable span of the Timeline.
1. From the Timeline toolbar, click Zoom Out.

   NOTE: Each time you click the icon, the Timeline increases to the next preset time period.
6.2 Schedules Reference

The Schedules component of the management platform enables you to:

- Set up schedules to automate the operation of the building control site: Schedules are defined on a weekly and daily basis. You can specify a different hourly timetable for each day of the week. For example, you could schedule a heating system to work from 9 a.m. to 6 p.m. on Mondays and Fridays and from 8 a.m. to 8 p.m. on Tuesdays, Wednesdays, and Thursdays.

- Set up exception calendars, which can be associated to schedules: Calendars define dates (or date ranges) during which a schedule does not apply. For example, you could create a holiday calendar that overrides the regular heating schedule to reduce energy costs. When you create a calendar, you can choose specific dates (January 15), a date range (August 1 – 31), or a week and a day you want the exception to run (third week of the month, on Wednesday). Then you can associate one or more schedules with the calendar.

You can configure schedules and calendars to execute:

- Centrally, on the management platform
- Locally, directly on the BACnet field panel

You can set up multiple schedules and exception calendars to run at the same time.

6.2.1 BACnet Schedules Reference

This section provides background information for using BACnet schedules. For related procedures, see Working with BACnet Schedules [➙ 153].

6.2.1.1 Overview of BACnet Scheduling

You use BACnet scheduling to automatically command points at prescribed time intervals. You can create daily or weekly schedules for BACnet field panels. Each BACnet panel stores its own calendar and schedule objects, and a BACnet panel can store and run multiple calendars or schedules at the same time. Because BACnet schedules reside in and are executed by field panels, they run even if the management station they are associated with is not running. BACnet schedules handle only BACnet objects (management station schedules can handle both BACnet and non-BACnet object types).

You can also configure commands to control BACnet objects related to your schedules. For example, you want to create a command that turns lights on and maintains room temperature at 72°F (22.22°C) when the room is occupied. When the room is unoccupied, the command would turn lights off and maintain the room temperature at 65°F (18.33°C). In this scenario, you could create a command with
an entry for Occupied/Unoccupied, save it, and then drag it from System Browser to a schedule of your choice. The schedule will determine what time the command executes, the start and end dates, and the frequency of repetition.

BACnet calendars allow you to override a scheduled event. In this sense, you can consider them as exception schedules, consisting of dates only. When you create a calendar, you can choose specific dates (January 15), a date range (August 1 – 31), or a week and a day you want the exception to run (third week of the month, on Wednesday). All calendars are associated with a schedule. If you want to reduce energy costs in your building during company holidays, for example, you could create a holiday calendar. On these days, your calendar might command the system to reduce the output of heating or cooling systems when the building is unoccupied.

**More About BACnet Schedules**

Schedules consist of a name and description, a toolbar for working with the schedule, a date picker, several tabs (Schedule Entries, Outputs, Exceptions, and Setup), and schedule details.

**More about Views**

Even though you can schedule entries from the weekly view, the weekly view shows only the resulting schedule and not the details of the schedule. For more flexibility in visualizing and creating schedule entries, you can use the detail column of the daily view instead.

**Default Date**

By default, every new schedule begins with the current date and never ends. Once a new schedule is opened, you can choose the start and end date for the schedule.

**Default State**

By default, the system automatically creates weekly schedule entries for the default state, which you can modify. The Release (NULL) check box allows you to bypass the established priority and return an object to its default value. For example, to return control to lower priority commands, check the Release (NULL) check box for the schedule default, and then create a schedule entry with the Default check box checked. This will write BACnet null to the priority slot for the schedule, returning control to the system.

**Default Schedule Behavior**

When you select a BACnet schedule from System Browser, the Date Picker defaults to the current date, and the Schedule Entries tab becomes active.

**About Priorities**

The Present Value of some object types is based on a command priority and established in a hierarchy that ranks from highest (1 – Manual Life Safety) to lowest (16 - Available). The hierarchy determines which source has priority over another to change the value of an object. To command one of these object types, you—or an application—must have a command priority equal to or greater than the current command priority of the object. Typically, PPCL is set to priority 16, and schedules are set to priority 15.
6.2.1.2 BACnet Schedule Workspace
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Schedule Name</td>
<td>Displays the name of the schedule.</td>
</tr>
</tbody>
</table>
| 2 Scheduler Toolbar | Includes the following icons:  
**New**: Opens a New BACnet Schedule, New Management Station Schedule, New BACnet Calendar, New Management Station Calendar, or New BACnet Command Table.  
**Save**: Saves the schedule to the system.  
**Save As**: Allows you to save another instance of the schedule with a different name and description.  
**Delete**: Deletes the schedule from the system. |
| 3 Tabs | Displays four tabs: Schedule Entries, Outputs, Exceptions, and Setup.  
**Schedule Entries**: Displays a list of entries for the selected date.  
**Outputs**: Outputs are objects associated with the schedule. You can drag-and-drop objects to any tab to add them to the schedule. Dropping them on a tab other than the Outputs tab makes the Outputs tab active. Selecting an object in this section sends data about the object to the Operation and Extended Operation tabs, where you can view additional information about the object and make changes to it. Double-clicking an output makes it the new primary selection.  
**Exceptions**: Displays a list of exceptions for the selected date and allows you to set the precedence of the exception, the exception period, and detailed settings for day, month, year, and the recurrence pattern. For calendar exceptions, you can choose a calendar object from a drop-down list. Adding an exception makes the Exceptions tab active. You can create an exception by right-clicking the schedule or by clicking the New button in the Exceptions tab.  
**Setup**: Displays common schedule information such as the Present Value of an object, the type of object, the default value for the object, a Release (NULL) check box, and the data type of the schedule outputs for this schedule. The Release (NULL) check box allows you to bypass the established priority and return an object to its default value. Within this tab, you can also select the command priority. The Present Value of some object types is based on a command priority and established in a hierarchy that ranks from highest (1 – Manual Life Safety) to lowest (16 – Available). The hierarchy determines which source has priority over another to change the value of an object. To command one of these object types, you—or an application—must have a command priority equal to or greater than the current command priority of the object. Typically, PPCL is set to priority 16, and schedules are set to priority 15. The schedule range displays a predetermined range for an object type. The first object dropped in the Schedule Output section for that type determines the range that is displayed. For example, for an analog output such as a room temperature set point, you might see a range of 68 – 75 degrees Fahrenheit (20.56 – 23.89 degrees Celsius). |
| 4 Tabs | Allows you to select a day to view or create schedule entries. When first displayed or refreshed, the current day is selected by default. |
| 5 Schedule | When first displayed or refreshed, the current day is selected by default.  
**Day tab**: Displays a schedule for the day selected in the Date Picker. Clicking the Detail check box reveals calendar entries, weekly schedule entries, and exception schedule entries. The Day tab also displays a horizontal time bar indicating the current time.  
**Week tab**: Displays the weekly schedule. You can click any day of the week to view details. This tab also displays a horizontal time bar indicating the current time. |
6.2.1.3 BACnet Calendar Workspace

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 New+ Button</td>
<td>Opens a new calendar entry.</td>
</tr>
<tr>
<td>2 Applied Schedules</td>
<td>Displays a list of schedules referencing the calendar. Clicking a schedule in this section sends data about the object to either the Operation or Extended Operations tabs.</td>
</tr>
</tbody>
</table>
| 3 Scheduler Toolbar| Includes the following icons:
- **New**: Opens a new BACnet Schedule, new Management Station Schedule, new BACnet Calendar, new Management Station Calendar or new BACnet Command Table.
- **Save**: Saves the calendar to the system.
- **Save As**: Saves another instance of the calendar with a different name and description.
- **Delete**: Deletes the calendar from the system. |
| 4 Calendar Name    | Displays the name of the calendar. |
| 5 Date Picker      | Displays a monthly calendar with entry dates highlighted. When first displayed or refreshed, the current day is selected by default. |
| 6 Calendar Entries | Displays a list of entries representing a specific date, date range, or days of the week. The Advanced check box provides detailed settings for day, month, year, and the recurrence pattern. |
### 6.2.1.4 BACnet Command Workspace

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 New+ Button</td>
<td>Opens a new command table.</td>
</tr>
<tr>
<td>2 Scheduler Toolbar</td>
<td>Includes the following icons:</td>
</tr>
<tr>
<td></td>
<td><strong>New+</strong>: Opens a New BACnet Schedule, New Management Station Schedule, New BACnet Calendar, New Management Station Calendar, New BACnet Command Table, or New Management Station trigger.</td>
</tr>
<tr>
<td></td>
<td><strong>Save</strong>: Saves the command object to the system.</td>
</tr>
<tr>
<td></td>
<td><strong>Save As</strong>: Allows you to save another instance of the command object with a different name and description.</td>
</tr>
<tr>
<td></td>
<td><strong>Delete</strong>: Deletes the command object from the system.</td>
</tr>
<tr>
<td>3 Command Name</td>
<td>Displays the name of the command.</td>
</tr>
<tr>
<td>4 Command Attributes</td>
<td>Displays the command object attribute, the panel it is associated with, the text group associated with the object, and the schedules controlling the command.</td>
</tr>
<tr>
<td>5 Command Table Action List</td>
<td>Displays command tables with additional detail when you select an entry row. The Move Up and Move Down arrows allow you to re-order entries within a command table. Further detail can be displayed by clicking the Advanced button.</td>
</tr>
</tbody>
</table>
6.2.2 Management Station Schedules Reference

This section provides background information for using management station schedules. For related procedures, see Working with Management Station Schedules [➙ 159].

6.2.2.1 Overview of Management Station Schedules and Calendars

You can create daily or weekly schedules for your management stations, and a management station can run multiple calendars or schedules at the same time. Management station schedules and calendars run only if the management station is running.

You can also create exceptions to schedules. When a management station exception is ON, it overrides the weekly schedule. When the exception is OFF, control returns to the weekly schedule.

Additionally, management station schedules can process both BACnet and non-BACnet object types (BACnet schedules process only BACnet object types).

Management station schedules have only one binary output (value active or inactive). You can assign several objects to that output. For each assigned object, you can select the mode of action for the output value.

More About Management Station Schedules

Schedules consist of a name and description, a toolbar for working with the schedule, a date picker, several tabs (Schedule Entries, Outputs, Exceptions, and Setup), daily and weekly views, and schedule details.

More about Views

Even though you can schedule entries from the weekly view, the weekly view shows only the resulting schedule and not the details of the schedule. For more flexibility in visualizing and creating schedule entries, use the Schedule Entries tab instead.

Default Date

By default, every new schedule begins with the current date and never ends. Once a new schedule is opened, you can choose the start and end date for the schedule.

Default Schedule Behavior

When you select a management station schedule from System Browser, the Date Picker defaults to the current date, and the Schedule Entries tab becomes active.

By default, the Scheduler initiates events scheduled in the management station one second prior to the scheduled time. For example, if you set the value of an output to change at 08:00:00, the logviewer will reflect a change at 07:59:59.

More About Management Station Calendars

Calendars allow you to override scheduled switch commands. In this sense, you can consider calendars as exception schedules, consisting of dates only. When you create a calendar, you can choose specific dates (January 15), a date range (August 1 – 31), or a week and a day you want the exception to run (third week of the month, on Wednesday). All calendars are associated with a schedule. For example, if you want to reduce energy costs in your building during company holidays, you can create a schedule with a calendar reference exception that commands equipment into holiday mode.
6.2.2.2 Management Station Schedule Workspace

Diagram of the Management Station Schedule Workspace with labels 1 to 6.
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Schedule Name</td>
<td>Displays the name of the schedule.</td>
</tr>
</tbody>
</table>
| 2 Scheduler Toolbar  | Includes the following icons:  
|                      | **New**: Opens a New BACnet Schedule, New Management Station Schedule, New BACnet Calendar, New Management Station Calendar, or New BACnet Command Table.  
|                      | **Save**: Saves the schedule to the system.                                                                                                 |
|                      | **Save As**: Allows you to save another instance of the schedule with a different name and description.                                            |
|                      | **Delete**: Deletes the schedule from the system.                                                                                           |
| 3 Tabs               | Displays four tabs: **Schedule Entries**, **Outputs**, **Exceptions**, and **Setup**.                                                           |
|                      | **Schedule Entries**: Displays a list of entries for the selected date and associated ON and OFF values.                                        |
|                      | **Outputs**: Outputs are objects associated with the schedule. You can drag-and-drop objects to any tab to add them to the schedule. Dropping them on a tab other than the Outputs tab makes the Outputs tab active. Selecting an object in this section sends data about the object to the Operation/Extended Operation tabs, where you can view additional information about the object and make changes to it. Double-clicking an output makes it the new primary selection.  
|                      | **Exceptions**: Displays a list of exceptions for the selected date and allows you to set the exception period, including a recurrence pattern. For calendar exceptions, you can choose a calendar object from a drop-down list. This tab also displays schedule entries and ON and OFF values. Adding an exception makes the Exceptions tab active. You can create an exception by right-clicking the schedule or by clicking the New button in the Exceptions tab.  
|                      | **Setup**: Allows you to set the start date for the schedule. Selecting the Any date check box defaults to the current date. The Setup tab also allows you to set the end date for the schedule. Selecting the Any date check box defaults to an infinite date. |
| 4 Date Picker        | Allows you to select a day to view or create schedule entries. When first displayed or refreshed, the current day is selected by default.             |
| 5 Schedule           | When first displayed or refreshed, the current day is selected by default.  
|                      | **Day Tab**: Shows a schedule for the day selected in the Date Picker. Checking the Detail check box reveals calendar entries, weekly schedule entries, and exception schedule entries. The Day tab also displays a horizontal time bar indicating the current time.  
|                      | **Week Tab**: Displays the weekly schedule. You can click any day of the week to view details. The Week tab also displays a horizontal time bar indicating the current time. |
| 6 Current Time Indicator | Displays a light-blue bar corresponding to the time of day.                                                                                 |
### 6.2.2.3 Management Station Calendar Workspace

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 New+ Button</td>
<td>Opens a new calendar entry.</td>
</tr>
<tr>
<td>2 Applied Schedules</td>
<td>Displays a list of schedules referencing the calendar.</td>
</tr>
</tbody>
</table>
| 3 Scheduler Toolbar | Includes the following icons:  
New: Opens a New BACnet Schedule, New Management Station Schedule, New BACnet Calendar, New Management Station Calendar, or New BACnet Command Table.  
Save: Saves the calendar to the system.  
Save As: Allows you to save another instance of the calendar with a different name and description.  
Delete: Deletes the calendar from the system. |
| 4 Calendar Name  | Displays the name of the calendar. |
| 5 Date Picker    | Displays a monthly calendar with entry dates highlighted. When first displayed or refreshed, the current day is selected by default. |
| 6 Calendar Entries | Displays a list of entries representing start and end dates and recurrence patterns. |
6.2.3 Timeline Viewer Reference

This section provides background information for using Timeline Viewer. For related procedures, see Working with Timeline Viewer [➙ 163].

6.2.3.1 Overview of Timeline Viewer

Timeline Viewer allows you to view the details of multiple management station and field panel schedules simultaneously, spanning a range of time. To do this, System Manager must be in Operating mode.

Adding Schedules

For automatic navigation, you select the schedules you want to view from System Browser, and the Timeline tab displays them by default. For manual navigation, you select the schedules you want to view from System Browser, and then click the Send button to have them display in the Timeline tab. While in manual navigation, you can also drag and drop schedules in the tab. Schedule names in the Timeline Viewer display in the same order as the schedules in System Browser.

Preset Time Periods

You can click the Zoom to Preset Time Period icon on the Timeline Viewer toolbar to select how much of the timeline is visible at once. The choices are 12 hours, 1 day, 3 days, 1 week, 2 weeks, or 1 month.

The Timeline Viewer accepts a maximum of 50 schedules. The fewer schedules you view, the more options you have with the preset time periods. The more schedules you view, the fewer options you have with the preset time periods.

Viewing Details in the Timeline Viewer

By moving your cursor over an entry in the Timeline Viewer, you can view schedule details, but you cannot edit them. Double-clicking a schedule’s details, however, sends the selection to the Default tab where you can edit the schedule.

Color Indicators

A gray interval indicates that nothing has been scheduled for that period, and the schedule is in its default mode of operation. Other colors in the intervals indicate that something has been scheduled.

- If colors are assigned to the schedule from the text table, they will appear in the Timeline Viewer.
- If colors are not assigned to the schedule from the text table, they will default to blue.

Interval Types

Intervals are classified as one of four types:

- Default—not scheduled intervals (gray)
- Normal—scheduled intervals (solid colors)
- Exception—scheduled overrides to the normal schedule intervals (color-coded hatch marks)
- Inactive—not active interval (gray hatch marks)

Time Range Scrollbar

The Time Range scrollbar offers another way to control the displayed time span of schedules. The shorter the time span—one day, for instance—the more detail you can view. The longer the time span—one month, for instance—the less detail you can view.

The Time Range scrollbar contains a repeat function to make working with time ranges easier. Clicking to the left or right of the slider on the scrollbar moves it in the selected direction for the corresponding time range.
### 6.2.3.2 Timeline Viewer Workspace

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time Range Scrollbar</td>
<td>Allows you to control the date range of schedules.</td>
</tr>
<tr>
<td>Schedule Name</td>
<td>Displays the name of the schedule with schedule details appearing on the row below it.</td>
</tr>
<tr>
<td>Schedule Details</td>
<td>Hovering on an interval displays a tool tip with schedule details. Intervals also use color coding and hatch marks to provide basic information at a glance. Schedule details are view only.</td>
</tr>
<tr>
<td>Timeline Toolbar</td>
<td>Includes the following time-adjustment controls:</td>
</tr>
<tr>
<td></td>
<td><strong>Show Today:</strong> Allows you to return to today’s date and does not affect any preset time period you have chosen.</td>
</tr>
<tr>
<td></td>
<td><strong>Preset Time Periods:</strong> Allows you to choose one of six viewing options: 12 hours, 1 day, 3 days, 1 week, 2 weeks, or 1 month.</td>
</tr>
<tr>
<td></td>
<td><strong>Zoom In:</strong> Allows you to decrease the viewable span of the timeline (decrease the preset time periods).</td>
</tr>
<tr>
<td></td>
<td><strong>Zoom Out:</strong> Allows you to increase the viewable span of the timeline (increase the preset time periods).</td>
</tr>
<tr>
<td>Date</td>
<td>Displays the date you are currently viewing. The date changes when you use either the <strong>Preset Time Spans</strong> or the <strong>Time Range scrollbar</strong>.</td>
</tr>
</tbody>
</table>
7 Trends
This section provides background information and instructions for using the Trends application in Desigo CC.

7.1 Working with Trends
This section provides step-by-step instructions for using the Trends application. For background information, see Trends Reference [➙ 204].
Perform the procedures in this section as needed.

7.1.1 Defining Trend Views
You need a Trend View definition to graphically record data. The Trend View definition includes all properties required for graphically displaying the Trend View and the series. Measured value data belonging to the given series such as time/date, value or period are saved in the Trendlog object and can only be displayed in the Trend View definition. In case of a distributed environment, you can create a Trend View Definition with objects from multiple systems.

Steps
The following illustration shows a general workflow to creating a Trendlog. For more information, see the detailed workflows in the following chapters.
1. In System Browser, select **Application View**.
2. Select **Applications > Trends > Trend View Definitions**.
3. Click **New**  > **New Trend** .
4. In System Browser, select **Management View**.
5. Select **Project > Field Networks > [Network Type] > Hardware > [Device]**.
6. Select the corresponding data point (do not click the data point) and drag-and-drop the selected data point to the Trend application.
7. Click **Save**.

**NOTE:** The values display in the Trend View as soon as the data point value changes.

8. Select the **Trend View Definitions** folder.

9. Complete the **Name** field for the Trend View and click **OK**.

### 7.1.1.1 Creating Trend View Definition

A Trend View definition normally is customized only once in a project. This ensures that all Trend Views that are created look the same (see User Default table).

1. In System Browser, select **Application View**.

2. Select **Applications > Trends**.

3. Click **New > New Trend**.  
   → The Trend application opens.

4. Click **Properties**.

5. Select the **Chart Properties** and edit the Trend View properties (see Trend View Properties).

**NOTE:** Only the grid and background properties are part of the user default.

6. Click **Save as user default**.

   → These settings now apply to all new Trend Views. You can, however, adapt the Trend View definition as needed.

<table>
<thead>
<tr>
<th>Saved as User Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
</tr>
<tr>
<td>----</td>
</tr>
<tr>
<td>X</td>
</tr>
<tr>
<td>X</td>
</tr>
<tr>
<td>X</td>
</tr>
<tr>
<td>X</td>
</tr>
<tr>
<td>X</td>
</tr>
<tr>
<td>X</td>
</tr>
<tr>
<td>X</td>
</tr>
</tbody>
</table>

**Related Topics**

Trend View Properties [➙ 223]

### 7.1.1.2 Creating New Trend Folder

1. In System Browser, select **Application View**.

2. Select **Trends > Trend View Definitions**.

3. Click **New > New Folder**.

4. Enter the appropriate information in the **Name** and **Description** fields.

5. Click **OK**.

   → A new folder is created under Trends > Trend View Definitions.
7.1.1.3 Creating New Trend View from System Browser

- You are in System Browser, and the Trend application is closed.

1. In System Browser, select Application View.
2. Select Trends > Trend View Definitions.
   - The Trend application opens.
4. In System Browser, select Management View.
5. Select Project > Field Networks > [Network Type] > Hardware > [Device].
6. In System Browser, select the corresponding data point (do not click the data point).
7. Drag-and-drop to the selected data point to the Trend application.

NOTES:
- Data trending continues as long as the VL attribute for the data point is enabled (see Object Configurator).
- To display a change of value on a binary value, an additional dotted zero line is displayed at State 1 or One.
8. Change the Trend View properties.
9. Change the series properties.
10. Click Save As.
    - The Save As dialog box opens.
11. Select the desired folder to save the Trend View.
12. Enter a name and description for the new Trend View.
13. Click OK.
   - An online Trendlog object is created for each data point in Application View > Trends > Online Log Objects.

NOTE:
Select the Manual navigation check box and the corresponding data points if you want to assign several data points to the Trend View at the same time. You can now assign them to the Trend View by dragging and dropping them.
7.1.1.4 Creating and Saving New Trend View

1. In System Browser, select Application View.
2. Select Applications > Trends.
3. Click New and then New Trend.
4. Select one of the following:
   - Offline Trend-Log Object in the folder Offline Log Objects.
   - Online Trend-Log Object in the folder Online Log Objects.
5. Click or drag-and-drop to add the Trendlog object to the new Trend View.
6. Repeat Steps 1 through 5 for additional Trendlog objects that you want to display in this Trend View.
7. Change the Trend View properties.
8. Change the properties for each series.
9. Click Save and select the folder Trend View Definitions or a subfolder.
   - The Trend View definition is saved.

NOTE:
Please read the appropriate workflows to edit the properties for the Trend View or a series.

7.1.1.5 Creating New Trend View from Related Items

1. Select the symbol New Trend under Related Items.
   - Trend View opens a secondary view.
2. Change the Trend View properties.
3. Change the properties for each series.
4. Click Save As.
   - The Save As dialog box opens.
5. Select the folder to save the Trend View.
6. Complete the Name and Description fields for the new Trend View.
7. Click OK.
   - The Trend View is saved.

7.1.1.6 Defining Chart Properties

- A Trend View is open.
1. Click Properties.
2. Click the Chart Properties tab.
3. In the Configure group box, do the following:
7. From the Grid drop-down list, select the corresponding background grid for the Trend View.
8. From the Background drop-down list, select the corresponding background color for the trend view or click More color to define a customized color.

4. In the Titles group box, do the following:
    – Complete the Name field for your Trend View.
    – Complete the Title field for the left Trend View border.
    – Complete the Title field for the right Trend View border.

5. Click Save .
   The edited properties are saved to the Trend database.

Related Topics
Chart [➙ 223]

7.1.1.7 Defining Axis Properties
    A Trend View is open.
1. Click Properties .
2. Click the Axis Properties tab.
3. Enter a title for the:
    – Left axis property.
    – Right axis property.
    – X-axis property.
4. Click Save .
   The edited properties display in the Trend View.

Related Topics
Axis [➙ 224]

7.1.1.8 Positioning Legend
    A Trend View is open.
1. Click Properties .
2. Click the Legend Properties tab.
3. Select the appropriate position (top, bottom, left, right) from the Legend drop-down list.
4. Click Save .
   The legend is positioned as selected in the current Trend View.

Related Topics
Legends [➙ 225]
7.1.1.9 Defining Line Properties

▷ A Trend View is open.

1. Select the series for editing from the legend for the Trend View.

2. Click Properties 🛠.

3. Click the Series Properties tab.

4. Select Visible and enable it.

5. Select the appropriate type from the Series line type drop-down list.

6. Select the appropriate style from the Series line style drop-down list.

7. Select the appropriate color from the Series stroke color drop-down list.

8. Select the appropriate line thickness from the Series stroke thickness drop-down list.

9. Click Save 🟢.

▷ The edited properties are saved for the particular Trend View to the Trend database.

<table>
<thead>
<tr>
<th>Line Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line type</td>
</tr>
<tr>
<td>![Line Type Icon]</td>
</tr>
</tbody>
</table>

NOTE:
Do not select too thick a line if you want to display the Trend curve with marker. The marker will disappear behind a thick line.

Related Topics
Series [➙ 225]

7.1.1.10 Displaying Markers

You want to further emphasize the measurement time using a symbol 🟢

▷ A Trend View is open.

▷ The Show quality icons property must be selected.

1. Select the series for editing from the legend for the Trend View.

2. Click Properties 🛠.
3. Click the **Series Properties** tab.
4. Select the **Show markers** check box.
   - Select the corresponding type from the **Marker style** drop-down list.
   - Select the appropriate size from the **Marker size** drop-down list.
5. Click **Save**.
   - The edited properties are saved to the Trend database.
6. Click **Stop** to stop the new data updates in the trend view.
   - The markers display on the trend view.

**NOTE:**
Be careful not to select too thick a line if you want to display markers. The marker disappears behind a thick line. You can see the markers only when you stop the trend view.

### Related Topics
Displaying Quality Attributes [➙ 219]
Series [➙ 225]

#### 7.1.1.11 Displaying Measured Values in Trend View
You want to also display the measured value for the data point at the time of the measured value.

- A Trend View is open.
- The **Show quality icons** property must be selected.
1. Select the series for editing from the legend for the Trend View.
2. Click **Properties**.
3. Click the **Series Properties** tab.
4. Select the **Show Values** check box.
5. Click **Save**.
   - The current measured values are updated in the chart each time a data point's measured value changes.
6. Click **Stop** to stop the new data updates in the Trend View.
   - The measured values display on the Trend View.
7.1.1.12 Displaying Quality Attributes

You want to also display the quality attribute for the data point at the time of the measured value.

1. A Trend View is open.
2. Select the series for editing from the legend for the Trend View.
3. Click Properties.
4. Click the Series Properties tab.
5. Select the Show quality icons check box.
6. Click Save.
7. Click Stop.

Interventions or states that are not normal display with the corresponding quality attribute.

For example, ⚠ (see Quality Attributes)

NOTE 1:
The quality attributes are hidden when you re-click Run and the trend series is updated.

NOTE 2:
You must select Advanced display if chart stopped in the Chart Properties tab (acts on all series) if you want to display quality attributes during update. If there are too many symbols, the update to the Trend View can take some time.

NOTE 3:
With the reduced display ▲, not all quality attributes can display. In order to display all quality attributes, limit the time period.

Related Topics
Series [➙ 225]
Quality Attributes [➙ 219]
### 7.1.1.13 Positioning the Y-Axis

A Trend View is open.

1. Select the series for editing from the legend for the Trend View.
2. Click **Properties**.
3. Click the **Series Properties** tab.
4. In the drop-down list, select **Y-axis position**.
5. Click **Save**.

The Y-axis displays either on the left or right side of the chart.

**NOTE:**
The position is set and cannot be changed for digital and multistate data types.

**Related Topics**
Series [➙ 225]

### 7.1.1.14 Editing Background or Line Colors

A Trend View is open.

1. Click **Properties**.
2. Do one of the following:
   - Click the **Chart Properties** tab to change the background color.
   - Click the **Series Properties** tab to change the line color for a series.
3. Then select the appropriate series from the legend.
4. Select the **Colors** drop-down list.
5. Select one or the predefined colors or click **More colors**.
6. Select the color:
   - Click the predefined color pattern (small squares) or drag the slider (right-click) until you reach the desired color. Click the large square for color selection.
   - Click the **Color Picker** and drag the cursor to the desired location on the screen.
7. Click **Save**.

The edited color properties are assumed.

**Related Topics**
Chart [➙ 223]
Series [➙ 225]

### 7.1.1.15 Showing, Hiding and Arranging Columns

Define the custom table view for series information and position the column correctly.
The Trend View is open.
1. Right-click the legend header.
2. Enable the required column.
   - The selected column is added to the legend view.
3. Click and hold down the left mouse button on the column header.
4. Move the column to the desired location and release the mouse button.
5. Point to the separator line and adapt the column width.
6. Click Save.

**NOTE:**
Changes to this legend view are not saved to the Trend View definition.

### 7.1.1.16 Deleting Trend View

- A Trend View is open or a Trend View is selected via System Browser.
1. Click Delete.
2. Click Yes to delete the Trend View.
   - The Trend View is permanently deleted from the Trend View Definitions folder.
   - The Trendlog objects in the Trend View are not deleted. No recorded data is lost.

### 7.1.2 Working with Offline Trend Log Objects

#### 7.1.2.1 Creating Offline Trendlog Object

- The device supports the creating of offline Trendlog objects without an engineering tool.
- You are in System Browser, and Trend is closed.
1. In System Browser, select the corresponding data point.
2. Select Related Items tab and click New Trend.
   - The Secondary pane opens.
3. On the data point, right-click and select Create Trendlog Object in BACnet Device.
NOTE: The Create Trendlog Object in BACnet Device option is not available if you select an object which is not of type BACnet.

4. In the Create BACnet Trendlog Object dialog box:
   - Enter a unique Trendlog Object Name.
   - Select the Device where you store the offline Trendlog object.
   - Enter the Buffer size from 0–500.
   - Select the Logging Type:
     - Polled: The data entry is polled periodically as per the settings in Logging interval, Align intervals, and Interval offset.
     - COV: The data entry is carried out when the trended property is changed.
     - Trigger: Triggered when Trigger = On, a data entry is made for the data series.
     - Empty: Default initiated by device.
   NOTE: If a particular device does not support a certain initial Logging Type value, then the default value is used.
   When the Logging Type is polled, enter the Log Interval cycle time (seconds) used to log values of an external data source in the trend log buffer.

5. Click OK.
   ⇒ The offline Trendlog object is created.

6. Click OK.
   ⇒ The offline Trendlog object is saved and visible in System Browser after 10 – 60 seconds in the folder Trends > Offline Log Objects > [own path structure].

7.1.2.2 Creating Offline Trendlog Multiple Object

▷ The device supports creating offline Trendlog multiple objects without an engineering tool.

1. In System Browser, select the first corresponding data point.

2. Select Related Items tab and click New Trend.
   ⇒ The Secondary pane opens.

3. In System Browser, select further data points and add those with drag-and-drop to the Trend View.

4. Select all these data points, right-click and select Create Trendlog Multiple Object in BACnet Device.
   NOTE: The Create Trendlog Multiple Object in BACnet Device option is not available if you select an object which is not of type BACnet.

5. In the Create BACnet Trendlog Object dialog box:
   - Complete the Name field for the offline Trendlog multiple object.
   - Select the device where you store the offline Trendlog multiple object.
   - Enter the buffer size from 0–500. The buffer space used per value is the same for all data formats.
   - Select the Logging Type:
     - Polled: The data entry is polled periodically as per the settings in Logging interval, Align intervals, and Interval offset.
     - Trigger: Triggered when Trigger = On, a data entry is made for the data series.
     - Empty: Default initiated by device.
   NOTE: If a particular device does not support a certain initial Logging Type value, then the default value is used.
When the **Logging Type** is polled, enter the **Log Interval** cycle time (seconds) used to log values of an external data source in the trend log buffer.

6. Click **OK**.
   - The offline Trendlog multiple object is created.

7. Click **OK**.
   - The offline Trendlog multiple object is saved and visible in System Browser after 10 – 60 seconds in the folder **Trends > Offline Log Objects > [own path structure]**.

**NOTE:**
In case of a distributed system, a Trend log multiple object cannot have objects from multiple systems. Also, a Trend log or Trend log multiple object can be created only on that system to which the selected trended object belongs.

### 7.1.2.3 Uploading Trend Data using System Browser

- The Trends application is open.

1. In System Browser, select **Trends > Offline Log Objects** and then select one or more trend log objects or trend log multiple objects.
   - The properties of the trend log objects or trend log multiple objects display in the **Extended Operation** tab.

**NOTE:** If you select more than one trend log objects or trend log multiple objects, the properties display, only if the selected trend log objects or trend log multiple objects are of the same type. For example, if you have selected two or more trend log objects or trend log multiple objects, their properties display. However, if you have selected a combination of trend log objects and trend log multiple objects, then their properties will not display as they are of different types.

2. Click the **Extended Operation** tab.

3. Perform any one of the following steps:
   - To upload the trend data related to all the trend log objects or trend log multiple objects, navigate to the **Log Enable** property and click **Collect**.
   - To upload the trend data related to a specific trend log object or trend log multiple object, expand the **Log Enable** property and click **Collect**.

   - The offline trend data from the trend log objects or trend log multiple objects is uploaded to the management station.

### 7.1.2.4 Uploading Trend Data using Legend

- A Trend View is open with offline trendlog objects or trendlog multiple objects or both.

1. In the legend, select one or more trended objects whose associated trend data you want to upload to the management station.

2. Right-click the selected trended object and then select **Display Trendlog Object in Contextual Pane**.

3. Click the **Extended Operation** tab.
   - The properties of the associated trend log object display.

**NOTE:** You can view the properties of only those trend log object that are
of the same type. For example, if you have selected 2 Analog Input objects, that are associated with 2 individual trend log objects, the properties of the trend log objects display in the Contextual pane. However, if one trended object is associated with a trend log object and another with a trend log multiple object, then the properties do not display as these objects are of different types.

4. Perform any one of the following steps:
   - To upload the trend data related to all the trend log objects or trend log multiple objects, navigate to the Log Enable property and click Collect.
   - To upload the trend data related to a specific trend log object or trend log multiple object, expand the Log Enable property and click Collect.

   ➤ The offline trend data from the trend log objects or trend log multiple objects is uploaded to the management station.

7.1.2.5 Automating Execution for Uploading Trendlog Data

You can create an automated Trendlog data upload using the Macro and Reaction Editor functions.

Uploading Trendlog Data using a Macro

➤ The offline Trendlog or Trendlog multiple is created.

1. In System Browser, select Application View.
2. Select Applications > Logics > Macros and select the Macro tab.
3. Click New and select New Macro.
4. In the New Object dialog box enter a name and description.
5. Click OK.
   ➤ The new macro appears in the Macro tab.
7. Select Applications > Trends > Offline Log Objects > [Network name] > Hardware > [Automation station].
8. Drag-and-drop the Trendlog objects in the macro configuration area.
9. In the Command column, select Collect.
10. Repeat Steps 8 and 9 for each Trendlog object or select multiple Trendlog objects in System Browser.
11. Enter the initial delay in the Initial Delay column (in seconds) for a cascade Trendlog data upload.
    NOTE: This cascade procedure avoids an overload of network traffic.
12. Click Save.
   ➤ The macro is defined and the Trendlog objects are assigned.

Uploading Trendlog Data using Reactions

1. In System Browser, select Application View.
2. Select Applications > Logics > Reactions.
   ➤ The Reaction editor opens.
3. Select Triggers > Time & Organization Mode expander and click Add.
4. Click anywhere on the row.
   ✩ The fields to set the execution time opens.
5. Set the date, day and time to execute the macro.
6. In System Browser, select Applications > Logics > Macros > [MyMacro Trendlog upload] and drag-and-drop the object to the Output expander section.
7. Click Save As.
8. Enter a name and description.
9. Click OK.
   ✩ The reaction for Trendlog upload is defined.

7.1.2.6 Assigning or Replacing a New Trendlog Reference
A new object reference can be added to available offline trendlog objects as needed. In this case, the collected data must first be backed up (uploaded); only then can the new object reference be assigned. Data that is not uploaded in advance can no longer be restored after being assigned anew. This applies to trendlog and trendlog multiple objects.
   ✩ You have set the display level for the Record count property as this property is not visible in the Extended Operation tab for BACnet trendlog objects. For information on setting the display levels see, Defining Properties.
   ✩ You have configured the Reset command for the Record count property. For information on configuring commands, see Command Configuration.
1. In System Browser, select Application View.
2. Select Applications > Trends > Offline Log Objects > [Network name] > Hardware > [Automation station] > [Offline Trendlog object].
3. Click the Extended Operation tab.
4. Navigate to the Log Enable property and click Collect.
   NOTE: The current offline Trendlog data is uploaded to the management station before you reset the collected data.
5. Click Disable to disable the Log Enable property.
6. Navigate to the Record count property and click Reset.
7. Click the BACnet Editor tab and open the Trended Properties expander.
8. In the System Browser, select the Manual navigation check box, and then drag-and-drop the required data point to the Trended Properties expander.
9. Select the property you want to record and click Send.
10. Select Applications > Trends > Offline Log Objects > [Network name] > Hardware > [Automation station] > [Offline Trendlog object].
11. Click the Extended Operation tab.
12. Navigate to the Log Enable property and click Enable.
   ✩ The Trendlog object is new configured and is ready to collect data.
NOTE: An entry in the Event list displays if a trendlog object has an invalid address. The message can be suppressed by:
- Setting the Log Enable property to Disable.
- Clearing the BACnet reference.

7.1.2.7 Deleting Offline Trendlog Objects
1. In System Browser, select Application View.
2. Select Trends > Offline Log Objects > [Trendlog Object].
3. Select the offline Trendlog object in the data point legend.
4. Right-click and select Delete Trendlog Object in BACnet Device.
5. Click Yes.
   ☞ The Trendlog object is deleted and removed from System Browser.

7.1.3 Analyzing Trend Data
You can analyze the collected values by using a number of tools such as time range scrollbars, context menus with predefined times, absolute/related time entries or zoom functions.

In order to perform the required analysis, you must ensure that the trend view is open. Perform the following steps to open a trend view.

1. In System Browser, select Application View.
2. Select Applications > Trends > Trend View Definitions > [Name of folder structure] > [Name of Trend View].
   ☞ The Trend View opens.

7.1.3.1 Switching between Automatic and Stop Mode
Automatic mode normally is used to analyze trend data (continuous scrolling of the graphic curves). The latest data is automatically retrieved from the system. You can change to Manual mode for a detailed analysis (scrolling off). In this case, the data is no longer updated automatically.

1. Click Stop.
   ☞ This stops automatic data updates and suppresses the symbol to update Trend View.
2. Define the desired date range using the slider or time bar.
3. Click Refresh when the symbol is available and you want to upload the latest data from the History Database.
4. Click Run to update data on a continuous basis.
7.1.3.2 Selecting the Time Range using the Time Range Scrollbar

Setting Time Range and Time Window
You want to define the visible time range as well as the corresponding time window for a Trend View.

▷ You are in an active Trend View.

1. In the Trend View, navigate to the left or right slider (dark grey area) of the time range slider.
   ● The shape of the mouse pointer changes ⬅️ and the tooltip displays.

2. Drag the Time Range slider to the left or right until you have reached the desired time range.
   ● The time range change continuously displays.
   ● The Trend View displays the selected time range.

3. Navigate to the Time Range slider (light grey area).

4. Drag it to the desired time/data range.
   ● The time range is displayed with the corresponding data period in the Trend View.

Repeat Functions
- Click the Time Range scrollbar to the left or right of the Time Range slider. The Time Range slider moves in the corresponding direction per the time range defined in the Time Range slider.
- Click the left or right arrow on the Time Range scrollbar. The Time Range slider moves in the corresponding direction at a 1:10 ratio for the selected time range.

NOTE:
Data is compressed for display purposes only if you select a large time range or very large number of measured values. All data is displayed for smaller time ranges.

Related Topics
Time Range Scrollbar [➙ 213]

7.1.3.3 Selecting Absolute Time Range
You want to define the time window with a precise start and stop date.

▷ You are in an active Trend View.

1. Right-click the Time Range bar.

2. Click Select range.
   ● The Select Date/Time dialog box displays.

3. From the Selection type drop-down list, select Absolute.

4. Click the displayed Start time.
   ● The Calendar dialog box opens.

5. Enter the desired start date in the Calendar dialog field.
Select month and year with the symbols.
Click the appropriate date,

6. Click the displayed time at **Start time** and enter the desired start time.

7. Click the displayed **End time**.
   - The **Calendar** dialog box opens.

8. Click the displayed time at **End time** and enter the desired end data in the **Calendar** dialog box.
   - Select month and year with the symbols.
   - Click the appropriate date,

9. Click the displayed time at **End time** and enter the desired stop time.

10. Click **OK**.
    - The **Select Date/Time** dialog box closes and the Trend View displays the defined time range.

### 7.1.3.4 Selecting Relative Time Range from a Start Date

You want to define a time window from a certain start date with a set time range.

- You are in an active Trend View.

1. Right-click the Time Range bar.

2. Click **Select range**.
   - The **Select Date/Time** window displays.

3. Select the **Relative** option in the **Selection type** drop-down list.

4. In the **Interval** text field, enter a time range from 1 to X and select the corresponding time unit in the drop-down list.

5. From the **Start/end time** drop-down list, select **Starting**.

6. Click the displayed date and enter the desired start date in the **Calendar** dialog box.
   - Select month and year with the symbols.
   - Click the appropriate date.

7. Click the displayed time and enter the desired start time.

8. Click **OK**.
    - The **Select Date/Time** dialog box closes and the Trend View displays the defined time range.

### 7.1.3.5 Selecting Relative Time Range from a Stop Date

You want to define a time window from a certain end date with a set time range.

- You are in an active Trend View.

1. Right-click the Time Range bar.

2. Click **Select range**.
   - The **Select Date/Time** window displays.

3. From the **Selection type** drop-down list, select **Relative**.
4. In the **Interval** text field, enter a time range from 1 to X and select the corresponding time unit in the drop-down list.

5. From the **Start/end time** drop-down list, select **Ending**.

6. Click the displayed date and enter the desired stop date in the **Calendar** dialog box.
   - Select **Month/Year** with the symbols.
   - Click the appropriate **Date**.

7. Click the displayed time and enter the desired stop time.

8. Click **OK**.
   - The **Select Date/Time** dialog box closes and the Trend View displays the defined time range.

### 7.1.3.6 Selecting Relative Time Range from a Current Date

You want to define a time window from the current date with a set time range.

1. Right-click the Time Range bar.
2. Click **Select range**.
   - The **Select Date/Time** window displays.
3. From the **Selection type** drop-down list, select **Relative**.
4. In the **Interval** text field, enter a time range from 1 to X and select the corresponding time unit in the drop-down list.
5. Select the **Ending now** option in the **Start/end time** drop-down list.
6. Click **Now**.
7. Click **OK**.
   - The **Select Date/Time** dialog box closes and the Trend View displays the defined time range.

### 7.1.3.7 Selecting Time Range from Predefined Time Ranges

Select the visible time range based on predefined time ranges.

1. Move the mouse cursor to the Time Range slider (light grey area).
2. Right-click the Time Range slider.
   - Predefined time ranges display.
3. Select the desired time range.
   - The time range displays with the corresponding data period in the Trend View.

**NOTE:**
The display calculation is always based on current visible date range. Depending on the position of the current Trend View, the starting point may not be at the start of the day.
Start/Stop Range

▷ You are in an active Trend View.

1. In the Trend View, point the mouse to the left or right end point (dark grey area) for the Time Range slider.
   ➔ The mouse pointer changes shape and the tooltip displays.

2. Right-click the Time Range slider.
   ➔ Predefined time ranges display.

3. Select the desired time range.
   ➔ The time range displays with the corresponding data period in the Trend View. The display calculation is always based on current visible date range as displayed in the tooltip.

7.1.3.8 Using Compare View

The compare view is ideal for extended data analysis with time offset.

▷ You are in a Trend View and Manual mode is on.
▷ The Property window of the Trend View is closed.
▷ The time period for display is defined using the time range scrollbar (for example, 12 hours).

1. Click Stop .
2. Click Compare View .
   ➔ The same Trend View displays a second time.
3. Define the appropriate time/date range with the scrollbar.
4. Select time offset Forward or Backward.
5. Do one of the following:
   – Click one of the predefined offset buttons, for example 1 hour.
   – Select your own range by selecting the dark button, for example, 3 hours, and select the time offset.
   ➔ Compare view displays with the corresponding time offset and measured values.

7.1.3.9 Using Mouse Zoom

The zoom function allows you to select a time range in the currently selected Trend View (applies as well for the comparison view) by zooming in on the X-axis and Y-axis.

▷ You are in an active Trend View and in Stop mode.

1. Click Zoom .
2. Navigate to the left zoom starting range.
   ➔ The point changes shape and the tooltip displays the current position.
3. Drag the pointer to the right zoom end range.
   - The selected zoom range displays in the Trend View.

4. Click **Zoom**.
   - The original time range, prior to the zoom in, displays, even if you zoom multiple times.

### 7.1.3.10 Selecting Table View
Switching between graphic and table allows for efficiently analyzing data.

1. A Trend View is open.
   - Click **Stop**.
     - The automatic data update is stopped.

2. Click table view.
   - The table opens in default view. Click the time stamp header to sort the rows by ascending or descending order.

3. Click to show or hide interpolated values.
   - Interpolated values are displayed in light-grey.

4. Click table view again.
   - The graphical Trend View re-displays.

5. Click **Run** to start the automatic data update.

**NOTE 1:** When you use **Export** in the table view, the exported data range depends on the time setting in the graphical view.

**NOTE 2:** Interpolated values are not exported to an export file.

**NOTE 3:** The priority displays in the table if a subsystem supports information on BACnet write priority (1-16).

### 7.1.3.11 Temporarily Highlighting Data Series
During analysis, it is helpful to temporarily bring a certain series in the Trend View to improve the readability of the trend curve.

1. You are in Trend View and multiple trend curves are displayed.
   - Drag the pointer to the trend curve you want to bring forth.
     - All non-selected trend curves are reduced in their display intensity.
     - The measured value, as well as time and date, are displayed in tooltip at the pointer position.
     - The quality attribute is brought forwards only when one trend curve is visible.

2. Drag the pointer to once again view all trend curves.

### 7.1.3.12 Temporarily Hiding Data Series
You can temporarily or permanently hide multiple series to increase the readability of the Trend View.

1. You are in Trend View and multiple trend curves are displayed.
Trends
Working with Trends

1. Click Properties 🌟.
   - The menu bar displays above the Trend View.
2. Select the series you want to hide in Legend.
3. Click Series Properties.
4. Clear the Visible check box.
   - The menu bar is hidden.
   - The series is hidden in the Trend View.
   - The Trend data is still recorded for this series, but is no longer displayed.
5. Click Save 🗒.

Repeat Steps 2 through 4 for each additional series you want to hide.

NOTE:
As an alternative, you can click either 🎈 or 🎁 in the legend. This allows you to show or hide each individual trend curve.

7.1.3.13 Removing Data Series from Trend View

You are in Trend View and multiple trend curves are displayed.

1. Select the series you want to hide in Legend.
2. Clear the check box in the Remove column.
   - The Remove Trend Series dialog box displays.
3. On the Stop trending this object on the Management Platform check box, select:
   - Cleared: The selected series is deleted from Trend View. The Trendlog object is still available in the Online Log Objects folder. All data continues to be recorded (Subscribe=On).
   - Selected: The series and the associated Trendlog object are deleted. The Trendlog object is removed from the Online Log Objects folder. All recorded data remains available, but no new data is recorded (Subscribe = Off). The previously logged data is still available if you reuse the same data point in the Trend View. However, there is a gap in the data between delete and re-generation.
4. Click OK.
   - The trend series is removed from the current Trend View.
5. Click Save 🗒.

NOTE:
When an object is deleted, no warning displays if a Trendlog object is used in several Trend Views! All associated data is lost in the associated Trend Views.

7.1.4 Printing Trend Data

You can print the trend data from the Reports application or from the Trends application.
7.1.4.1 Printing Trend Data from Reports

- You have selected an existing Report Definition in System Browser > Reports or you have created a Report Definition.
- One or more local printers are configured in the System.

1. Click the Home tab.
2. Do one of the following:
   - From the Insert group box, click the Plot group box, and select a Trends plot and drag-and-drop it onto the selected Report Definition.
     
     NOTE: The cursor changes and indicates the selected plot name.
   - Right-click the Report Definition and select the required type of plot from the Insert Plot option.
   - Drag-and-drop the desired Trend View Definition from System Browser on the Report Definition. The Name filter of the inserted plot is set to the dropped Trend View.
     
     The plot placeholder is added to the Report Definition. By default, the plot is left-aligned.
     
     NOTE: In Run mode, this plot image is replaced by the actual data retrieved from the Report service.
3. Click the Settings tab.
4. From the Report Output group box, click Dialog Launcher.
   
   The Report Output Definition dialog box displays.
5. Select PDF in the Report format list.
6. Select Printer in the Destination types list and specify the other printer details.
7. Click Add.
   
   The selected format and destination are added to the Output Definition list.
8. Click OK.
   
   The configured Report Output Definitions display in the Report Output group box and the report is printed in the PDF format on automatic execution.

Related Topics
Generating a Report Automatically [➙ 251]

7.1.4.2 Printing Trend Data from Trends

- A Trend View is open.
- You must define the Print in color setting in advance if you want to print in color.

1. Select the time range to print using the time range scrollbar. The time range displayed on the screen is printed.
2. Click Print.
3. Select or clear the Fit to page check box. Select the corresponding option in the toolbar if Fit to page is not selected.
4. Define print properties for:
   
   - Margins (top, bottom, left and right).
   - Printer.
   - Orientation (portrait or landscape).
7 Trends
Working with Trends

– Paper size.

5. Click Print and Close to print, or click Close.

7.1.5 Manual Correction Application

7.1.5.1 Accessing the Manual Correction Application From System Browser

1. In System Browser, select Application View.
3. Drag the object whose property details are to be displayed from System Browser to the Manual Correction tab.
4. Select the trended object from the Trended Object drop-down list and the corresponding property whose details are to be viewed from the Trended Properties drop-down list.
5. Specify the time range for which you want to view the details by specifying the date and time in the Time filter section. By default, the time range is defined for a 24-hour time period.
6. Click Run.
   ➤ The date/time, value, unit, and status of the selected trended property displays in the Filtered Data section in a column pattern in a grid.

**NOTE:**
You can fetch the latest data from the database by modifying the time period in the Time filter.

7.1.5.2 Accessing the Manual Correction Application From Related Items

1. In System Browser select the trended object whose property details are to be displayed in the Manual Correction application.
   ➤ A Manual Correction link displays below the Trends group in the Related Items tab.
   **NOTE:** If you select more than one trended object in the System Browser, then the Manual Correction link does not display in the Related Items tab.
2. Click the Manual Correction link.
   ➤ The Manual Correction application displays in the Secondary pane and the trended object you selected displays in the Trended Object field in the Object filter section.
3. Select the corresponding property whose details are to be viewed from the Trended Properties drop-down list.
4. Specify the time range for which you want to view the details by specifying the date and time in the **Time** filter section. By default, the time range is defined for a 24-hour time period.

5. Click **Run**.  

The date/time, value, unit, and status of the selected trended property displays in the **Filtered Data** section in a column pattern in a grid.

---

**NOTE:**  
You can fetch the latest data from the database by modifying the time period in the Time filter.

---

### 7.1.5.3 Sorting Data Values

- The information of the selected trended property displays in the **Filtered Data** section.  
- Perform any of the following steps to sort the column data:  
  a) To sort a column data in the ascending order, click the column header.  
  b) To change the sorting order to descending, click the column header twice.  

The data displays in the sorted order.

---

**NOTE:**  
The values in the **Unit** column cannot be sorted.

---

### 7.1.5.4 Adding Trend Entries

- The Manual Correction application displays and the information of the selected trended property displays in the **Filtered Data** section.

1. Click **Add**.  

**NOTE:** You can also add a new row by right clicking on the row and selecting **Add Trend Entry** from the options.  

The **Add Trend Entry** dialog box displays.

2. Complete the **Date** and **Time**, **Value**, and **Comment** fields.

3. Click **OK**.

4. Modify the Time filter to a range in which the date and time of the value to be added is present.

5. Click **Run**.  

The **Filtered Data** section refreshes and a new row with the specified values is added to the grid.  

**NOTE:** The comments entered are logged in the activity log.

---

### 7.1.5.5 Editing Trend Entries

- The Manual Correction application displays and the information of the selected trended property displays in the **Filtered Data** section.

---
1. Select the data entry row to be modified in the **Filtered Data** section and click **Edit**.  
   ➤ The **Edit Trend Entry** dialog box displays.

2. Modify the value and add comments.  
   **NOTE**: The comments entered are logged in the activity log.

3. Click **OK**.

4. Click **Run**.  
   ➤ The **Filtered Data** section refreshes to display the updated value for the selected row.  
   **NOTE**: You can also modify a row by right clicking the row and selecting **Edit Trend Entry** from the options.

### 7.1.5.6 Deleting Trend Entries

➤ The Manual Correction application displays and the information of the selected trended property displays in the **Filtered Data** section.

1. Select the entry to be deleted. To select multiple entries press **SHIFT** or **CTRL** depending on whether you want to select entries that are listed next to each other or away from each other.

2. Press **Delete**.  
   ➤ The **Delete Trend Entry** dialog box displays.

3. Enter a comment and click **OK**.

4. Click **Run**.  
   ➤ The entries are deleted.

### 7.1.5.7 Filtering Data Values

You can filter the values displayed in the **Filtered Data** section by applying custom, selection, and Time filters.

**Custom Filter**: A custom filter allows you to define a filter expression from which you can filter data according to your specific requirements. You can apply the custom filter on the **Time** and **Value** columns in the **Filtered Data** section using the **Custom Filter** dialog box.

**Time Filter**: A Time filter allows you to filter data on the basis of past number of hours or minutes with reference to the value of hours or minutes present in the **To** field in the **Time Filter** section in the Manual Correction Workspace. You can apply the Time filter on the **Time** column. When you apply the Time filter on the displayed data, the **Filtered Data** section refreshes to display only those records matching the specified time period.

**Selection Filter**: A selection filter allows you to specify a filtering condition on the **Status** column. You can select a value displayed in the selection filter to display the matching records in the **Filtered Data** section.

**NOTE**: You can remove the filter applied on a column by clicking the inverted triangle icon and selecting the **Remove Filter** option from the menu options.
Applying the Custom Filter

You can apply the custom filter on the Time and Value columns.

- The information of the selected trended property displays in the Filtered Data section.

1. Navigate to the Time or Value column on which you want to apply the custom filter.

2. Click the inverted triangle icon and select Custom Filter from the menu options.

   - The Custom Filter dialog box displays.

3. Perform any one of the following steps:

   - To apply the custom filter to the Time column – Select the appropriate operator and the date/time values. You must ensure that the value of the custom filter must be within the value range specified in the Time filter section. For example, if the value specified in the Time filter section is from 10.00 a.m. to 6.00 p.m., then the value specified in the custom filter must be within this range.

   - To apply the custom filter on the Value column – Select the appropriate operator and specify the value in the text field.

4. Click OK.

   - The Filtered Data section refreshes to display the information matching the custom filter criteria.

Applying the Selection Filter

You can apply the Selection filter on the Status column.

- The information of the selected trended property displays in the Filtered Data section.

1. Navigate to the Status column on which you want to apply the selection filter and click the inverted triangle icon.

2. From the menu options, select the value corresponding to the status on which you want to filter the information and click OK.

   NOTE: For a quick retrieval of the values in the options list, enter the text that closely matches the required status in the text field. The options list displays the matching value.

   - The Filtered Data section refreshes to display the information matching the selected status.

Applying the Time Filter

- The information of the selected trended property displays in the Filtered Data section.

1. Navigate to the Time column and click the inverted triangle icon.

2. From the menu options that display, position your mouse pointer over Time Filter.

   - A sub-menu with the Hours and Minutes options displays.

3. Depending on the filtering criteria to be applied, perform any of the following steps:

   - To filter data on the basis of number of hours - Position your mouse pointer over the Hours option and then select the last ‘X’ (where x stands for a
number) number of hours for which you want to display the data. The last ‘X’ number of hours is with reference to the value of the hour present in the To field in the Time Filter section. For example, if the value in the To field is “5/17/2016 05:23:19 PM”, and you select the Last 1 Hour option, then the data for the 04:00:00.000 PM to 04:59:59.999 PM time period will display.

To filter data on the basis of number of minutes – Position your mouse pointer over the Minutes option and then select the last ‘X’ (where x stands for a number) number of minutes for which you want to display the data. The last ‘X’ number of minutes is with reference to the value of minutes present in the To field in the Time Filter section. For example, if the value in the To field is 5/17/2016 05:23:19 PM, and you select the Last 60 Minutes option, then the data for the 04:23:00.000 PM to 05:22:59.999 PM time period will display.

The Filtered Data section refreshes to display the information matching the specified Time filter criteria.

7.2 Trends Reference
The Trends application in Desigo CC allows you to create online trends in the management station and offline trend log objects (dynamic objects) in the automation station.

This section provides the general reference information on Trends. For procedures on creating and configuring trends, and working with the trend data, see Working with Trends [➙ 177].

7.2.1 Overview of Trends Application
The Trends application allows you to create online trends in the management station and offline trend log objects (dynamic objects) in the automation station.

The Trends application contains a workspace with specific properties, such as name, gridlines or scaling, as well as data point references, such as properties. Trendlog objects contain measured values that are displayed in a common time range and saved to the trend database.

Regardless of the trend data, Trend Views can be saved, queried, deleted, and edited, as well as saved under a new name. You can use Trend Views in two ways in the management station:

- During operation, trend data recorded in real-time and saved to the trend database (management station is online).
- Trend data are recorded in the automation station (management station is offline) and periodically loaded to the management station trend database.

You can display the trend data in the Trend Viewer any time, even if the management station is not connected to the site (no real-time data available).

Methods to Record Data
There are three methods to configure online and offline Trendlog objects to record data:

- Change-of-Value (COV)
  This method allows you to record new data when the data point value is changed. No value is recorded or transmitted if the value does not change over an extended period of time. Database acquisition of several data points in a Trend View is asynchronous.

- Interval-based (offline trend only)
  This method allows you to record current data as soon as the timestamp is reached. The data values are recorded without impacting a defined COV property.
7.2.2 Trends in Distributed Systems

When working with trends in a distributed environment, you must understand the details of the following applicable conditions:

- **System Name column** - A column named **System Name** has been added as an additional column to the Trends application. It displays the name of the system to which the source object belongs. You can select this column by right-clicking the column header on the legend and selecting **System Name** from the menu options.

- A Trend log multiple object cannot have objects from multiple systems.

- A Trend log or Trend log multiple object can be created only on that system where the selected trended object belongs.

- You can create a Trend View Definition with objects from multiple systems.

7.2.3 Online and Offline Trends

**Online Trend**

Real-time values from online trend records of your plant display graphically in a Trend View. The data values are sent to the Trend application upon each change of value. The measured values are temporary and can be stored continuously in the Trend database (online Trendlog object) for later queries. Online trends can be used for real-time visualization of one or more process variables, usually for analysis or diagnosis.

You can create the online trend if the room temperature is too low and record data for specified period and analyze measured values in a trend curve directly on the management station.

**Record Online Trend Data**

Trend data are uploaded continuously to the management station and are not saved in the automation station.
NOTE:
An uninterrupted site connection with the management station is required. Measured values may be irretrievably lost when the site is interrupted during data recording. Therefore, online trend is not well suited for long-term secure data recording.

Offline Trend
Offline trend data is used for long-term storage and retrieval of historical data for the analysis of entire plants or single processes. With offline trend, data is recorded directly in the automation station. You can retrieve data as needed or automation stations can automatically upload the data. The data recording can be prepared in advance using the engineering tool or you can create a Trendlog object from the management station in the automation station (must be supported by the subsystem).

You can create an offline trend to assign the outside temperature to the Trendlog object in the automation station if you want to calculate energy consumption and need the outside air temperature series for measured values. You can then manually or automatically (periodically) upload the recorded temperature data to store in the management station.

<table>
<thead>
<tr>
<th>Phase 1: Record Offline Trend Data</th>
<th>Trend data is saved locally to the Trendlog object in the automation station.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trend Log Object</td>
<td>Automation Station</td>
</tr>
<tr>
<td>64°F</td>
<td></td>
</tr>
<tr>
<td>Phase 2: Upload Offline Trend Data</td>
<td>Trend data is uploaded if:</td>
</tr>
<tr>
<td></td>
<td>• The maximum buffer size is reached.</td>
</tr>
<tr>
<td></td>
<td>• The number of defined entries is reached.</td>
</tr>
<tr>
<td></td>
<td>• Manually triggered by the management station.</td>
</tr>
<tr>
<td>Trend Log Object</td>
<td>Automation Station</td>
</tr>
<tr>
<td>64°F</td>
<td>Management Station</td>
</tr>
<tr>
<td>Trend DB</td>
<td>64°F</td>
</tr>
</tbody>
</table>

7.2.4 Trend Data Storage
Recorded trend data can be stored in three different locations:
- Offline Trendlog Objects: Offline trend data is saved in the automation station.
- Online Trendlog Objects: Contains the online trend data recorded and saved in the management station.
- Archived Trend Database (not in version 2.0): Contains all recorded Trend data moved previously to the archive database.

Offline Trendlog Objects
Offline trend data can be recorded and saved by Trendlog objects within the automation and control system even when the management station is not connected. The recorded data can then be saved in the trend database. Offline trend data can be retrieved and displayed in the trends.
Online Trendlog Objects
Data recorded by online trending and saved to the trend database (for example, using save continuously) can be retrieved and displayed in the trends. Online Trendlog objects record data also when the Trend View is closed.

Database Storage Capacity
In the database, 10 GB is saved for the SQL Server Express and 250 GB of historical data for SQL-Server. Once 90% of the database size is reached, 10% of the oldest data entries are deleted. This 10% of data always refers to the entire time axis for the collected data. Therefore, it cannot be exactly determined how many entries or the database size that is actually deleted. Additional incoming entries are rejected if the 10% of data entries cannot be deleted before reaching 98% of the database size.

The data amount is comprised of the following:
- System activities
- Alarm messages
- Trend data

Change to Daylight Savings Time
- Date and time data is saved in UTC format. Entries are in double for one hour when setting back to normal time. In this case, the curve displays using both values. When switching to daylight savings time, no value displays in this hour and the displayed line is straight between the two measured values.
- A system message Anomaly is generated when changing times that must be acknowledged.
7.2.5 Trends Workspace

Trends are divided into the following main elements:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 System Browser</td>
<td>Displays available Trendlog objects, as well as created Trend Views.</td>
</tr>
<tr>
<td>2 Configuration Toolbar</td>
<td>Displays buttons for commonly used commands (New, Save, Print, zoom).</td>
</tr>
<tr>
<td>3 Compare view</td>
<td>Allows you to compare measured values from the same Trend View.</td>
</tr>
<tr>
<td>4 Trend View</td>
<td>The range which can be displayed and processed for online and offline trend data in chart form. These Trend Views are saved independently of the trend data.</td>
</tr>
<tr>
<td>5 Key</td>
<td>Displays information on data points that are displayed graphically in the Trend View.</td>
</tr>
</tbody>
</table>
7.2.5.1 System Browser

All Trendlog objects or Trend View definitions display hierarchically in the System Browser in a tree structure. Click or drag-and-drop to temporarily view Trendlog objects in a Trend View or configure a specific object and save it in a Trend View.

![System Browser](image)

**Offline Trend**

Lists all available offline Trendlog objects available in the automation station for a project.

**Online Trend**

Lists all available online Trendlog objects. An online Trendlog object is created when you define a series and save it in a Trend View definition. However, this Trendlog object is available only on the management station. No Trendlog object is created in the automation station.

**Trend View Definition**

The Trend View definition includes all properties required for graphical displaying of the Trend View and the series:

- Background colors
- Series column order
- Series reference

**NOTE:**

The Trend View definition does not contain process values, but only one reference to the corresponding series (Trendlog objects).
7.2.5.2 Toolbar

You can perform some commands directly in Trend View. This allows you to optimally process the data in Trend View.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Trend</td>
<td>Opens a new Trend View.</td>
</tr>
<tr>
<td>New Folder</td>
<td>Creates a new folder.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the current Trend View.</td>
</tr>
<tr>
<td>Save</td>
<td>Saves the current Trend View. Note: This command is not available until you modify the current trend view.</td>
</tr>
<tr>
<td>Save As</td>
<td>Saves the Trend View under a new name.</td>
</tr>
<tr>
<td>Save as user default</td>
<td>Saves the Trend View definition as a new user default.</td>
</tr>
<tr>
<td>Properties</td>
<td>Opens the properties dialog box for chart, axes, legends, and series.</td>
</tr>
<tr>
<td>Stop</td>
<td>Stops trend logging.</td>
</tr>
<tr>
<td>Run</td>
<td>Starts trend logging.</td>
</tr>
<tr>
<td>Refresh</td>
<td>Refreshes the Trend View.</td>
</tr>
<tr>
<td>Compare view</td>
<td>Opens the same Trend View a second time. Note: In order to enable this button, you must hide the Trend View properties and stop the Trend View.</td>
</tr>
<tr>
<td>Zoom</td>
<td>Allows you select a time range in the currently selected Trend View by effectively zooming in on the X-axis and Y-axis.</td>
</tr>
<tr>
<td>Time bar</td>
<td>Shows/hides the time bar.</td>
</tr>
<tr>
<td>Table view</td>
<td>Switches from graphical Trend View to a table view. Note: In order to enable this button, you must stop the Trend View.</td>
</tr>
<tr>
<td>Export</td>
<td>Exports the Trend View Definition and saves it in a CSV file format.</td>
</tr>
<tr>
<td>Print</td>
<td>Prints the Trend View.</td>
</tr>
</tbody>
</table>

Time Bar Scrollbar

The Time bar consists of a vertical bar and a time/date field. The time bar can be dragged anywhere on the time axis. The data legend below the Trend View shows the value and state for a point. The last recorded value is displayed to the left of the time bar.
7.2.5.3 **Compare View**

You can link the same or another Trend View for data analysis that applies the same X-axis for the time range to both Trend Views. The current lower Trend View serves as the basis for the upper Trend View. Any changes to the time range in the current Trend View are reflected in the comparative Trend View. Predefined buttons allow you to offset the comparative Trend View to the current Trend View by the selected value.

**NOTE:**
In order to view the trend data in a compare view, you must stop the Trend View and hide its properties.

### Compare View Workspace

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Current Trend View</td>
</tr>
<tr>
<td>2</td>
<td>Compare View</td>
</tr>
<tr>
<td>3</td>
<td>Time bar with time displayed in the compare view</td>
</tr>
<tr>
<td>4</td>
<td>No offset</td>
</tr>
<tr>
<td>5</td>
<td>Predefined offset buttons</td>
</tr>
<tr>
<td>6</td>
<td>Freely definable offset range (range, unit)</td>
</tr>
<tr>
<td>7</td>
<td>1x forward or 1x back for the selected offset range</td>
</tr>
<tr>
<td>8</td>
<td>Freely definable offset range in hours, days, weeks, years</td>
</tr>
<tr>
<td>9</td>
<td>Data Point Key</td>
</tr>
</tbody>
</table>

### Same Trend View

This type of comparison is especially useful when analyzing the data for individual components, such as a room temperature for a room. The time offset allows you to easily check how the corresponding measured value behaves at the same time of day.
NOTE 1:
The legend displays the last left measured value in the time bar.

NOTE 2:
In the legend, the displayed value is not displayed based on the intersection of the time bar and trend curve. Instead, the time/date display is based on the time bar position.

### 7.2.5.4 Trend View

The Trend View consists of a chart area where series are viewed and manipulated. All the main elements such as the axes, scaling, titles and colors can be configured in Trend View properties (by taking over defaults or changing the current Trend View).

#### Trend View Workspace

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
</tr>
<tr>
<td>2, 11</td>
</tr>
<tr>
<td>3, 12</td>
</tr>
<tr>
<td>4</td>
</tr>
<tr>
<td>5</td>
</tr>
<tr>
<td>6</td>
</tr>
<tr>
<td>7</td>
</tr>
</tbody>
</table>
**Time Range Scrollbar**

In every Trend View, there are two time ranges of interest for analysis:

- Data displayed in the time range of the current chart (which is displayed directly on the screen).
- Data in the time range of all available data.

Use the time range scrollbar to set the appropriate data range for your analysis.

<table>
<thead>
<tr>
<th>Time Range</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1, 6</td>
<td>Repeat button left/right. The displayed timeline moves to the left or right if you click the button at a ratio of 1:10 of the entered timeline. The corresponding repeat value displays with a tooltip.</td>
</tr>
<tr>
<td>2</td>
<td>Value range for all stored data.</td>
</tr>
<tr>
<td>3, 5</td>
<td>Context menu: First/last time range for current Trend View.</td>
</tr>
<tr>
<td>4</td>
<td>Context menu: Time range for current Trend View.</td>
</tr>
<tr>
<td>7, 8</td>
<td>Tooltip: Repeat value.</td>
</tr>
<tr>
<td>9</td>
<td>Direct time selection for a freely definable time and date range.</td>
</tr>
<tr>
<td>10</td>
<td>Tooltip: Time and date of the oldest displayed data.</td>
</tr>
</tbody>
</table>
### Direct Time Selection

Right-click the Time Range scrollbar to select the time directly. The exact time range can be entered as:

- **Absolute Time Range**
- **Relative Time Range**
- **Enter time range for trend.**

#### Absolute Time Range

The absolute time range is suitable for displaying the data for a known time range. To display the Trend View, you can directly define the start and stop times using a calendar entry as well as the corresponding time entry.

#### Relative Time Range

The relative time range is determined by a selectable time range (for example, 2 weeks) and depends on the current time. You can set the **Interval** (in [x] seconds, minutes, hours, days, weeks, months and years) to display the data within the optimum time range.

---

<table>
<thead>
<tr>
<th>11, 13</th>
<th>Timeline slide left/right. Click the end of the time range slider (dark grey area) and pull the slider to the desired time/date position, which the tooltip continuously displays. The range of the time window is changed at the same time you slide the end points.</th>
</tr>
</thead>
<tbody>
<tr>
<td>12</td>
<td>Time range slider time window for the displayed window. Using the mouse, click the end of the time range slider (dark grey area) and pull the slider to the desired time/date position, which the tooltip continuously displays. The entered time window range is constant for the function.</td>
</tr>
<tr>
<td>14</td>
<td>Tooltip: Time range of the displayed data.</td>
</tr>
<tr>
<td>15</td>
<td>Tooltip: Time and date of the oldest displayed data.</td>
</tr>
</tbody>
</table>
Recorded Time Range

Select Full View to display the recorded data. Only the Trend View to the date of the last save is displayed when the current date does not match the date of the last save.
Context Menu

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide this column.</td>
<td>Hides the selected column.</td>
</tr>
<tr>
<td>Visible columns</td>
<td>Shows/hides columns.</td>
</tr>
<tr>
<td></td>
<td>• Trended Object Name</td>
</tr>
<tr>
<td></td>
<td>• Trended Property Name</td>
</tr>
<tr>
<td></td>
<td>• Trended Log Object Name</td>
</tr>
<tr>
<td></td>
<td>• Alias</td>
</tr>
<tr>
<td></td>
<td>• Unit</td>
</tr>
<tr>
<td></td>
<td>• Value</td>
</tr>
<tr>
<td></td>
<td>• Time</td>
</tr>
<tr>
<td></td>
<td>• Date</td>
</tr>
<tr>
<td></td>
<td>• Y-Axis Attachment</td>
</tr>
<tr>
<td></td>
<td>• Remove</td>
</tr>
<tr>
<td></td>
<td>• Visibility</td>
</tr>
<tr>
<td></td>
<td>• System Name</td>
</tr>
</tbody>
</table>
### Context Menu 2

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Trended Object in <strong>Contextual Pane</strong></td>
<td>Displays object properties in <strong>Operation</strong> tab.</td>
</tr>
<tr>
<td>Display Trendlog Object in <strong>Contextual Pane</strong></td>
<td>Displays object properties in <strong>Operation</strong> tab.</td>
</tr>
<tr>
<td>Create Trendlog Object in BACnet Device</td>
<td>Creates a Trendlog object on the device.</td>
</tr>
<tr>
<td>Create Trendlog Multiple Object in BACnet Device</td>
<td>Creates a Trendlog multiple object on the device.</td>
</tr>
<tr>
<td>Delete the trendlog object on the BACnet device</td>
<td>Deletes a Trendlog object on the device.</td>
</tr>
<tr>
<td>Remove</td>
<td>Removes a series from the Trend View.</td>
</tr>
</tbody>
</table>

### Context Menu 3

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Range…</td>
<td>User-defined range:</td>
</tr>
<tr>
<td></td>
<td>● Selection type</td>
</tr>
<tr>
<td></td>
<td>● Date</td>
</tr>
<tr>
<td></td>
<td>● Time</td>
</tr>
</tbody>
</table>

### Context Menu 4

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>First 1</td>
<td>Minute, hour, day, week, month, or year.</td>
</tr>
<tr>
<td>Full View</td>
<td>Entire date range.</td>
</tr>
<tr>
<td>Select Range…</td>
<td>User-defined range.</td>
</tr>
</tbody>
</table>

### Context Menu 5

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>One</td>
<td>Minute, hour, day, week, month, or year.</td>
</tr>
<tr>
<td>Full View</td>
<td>Entire date range.</td>
</tr>
<tr>
<td>Select Range…</td>
<td>User-defined range.</td>
</tr>
</tbody>
</table>

### Context Menu 6

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>First</td>
<td>Minute, hour, day, week, month, or year.</td>
</tr>
<tr>
<td>Full View</td>
<td>Entire date range.</td>
</tr>
<tr>
<td>Select Range…</td>
<td>User-defined range.</td>
</tr>
</tbody>
</table>
7.2.5.5 Data Point Key

The legend for the series contains information on the given data point in the Trend View.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trended Object</td>
<td>Displays the object names for the Trendlog object.</td>
</tr>
<tr>
<td>Trended Property</td>
<td>Displays the trended property name for the object.</td>
</tr>
<tr>
<td>Alias</td>
<td>Displays the alias name for the object.</td>
</tr>
<tr>
<td>Unit</td>
<td>Physical unit for the data point.</td>
</tr>
<tr>
<td>Value</td>
<td>Displays the last displayed current value (unless the time bar is in use. In this case, the value is displayed at the intersection).</td>
</tr>
<tr>
<td>Time</td>
<td>Displays the time for the most recent value (unless the time bar is used; in this case, the value is displayed at the intersection).</td>
</tr>
<tr>
<td>Date</td>
<td>Displays the date for the most recent value (unless the time bar is used; in this case, the value is displayed at the intersection).</td>
</tr>
<tr>
<td>Reduced</td>
<td>When this symbol displays, not all values for this series are displayed in the Trend View (dependent on the displayed time period) (see Reduced Display).</td>
</tr>
</tbody>
</table>

**NOTE:**
Use the context menu to hide columns by pointing to the column (Hide Column) or show/hide individual columns (Visible Columns). Column order and width is adjustable with the exception of the first column (colors, cannot be adjusted, moved or hidden).

That most recent value displays in the time bar. In this case, the value or the information displays at the intersection.

**Reduced Display**

Displays a maximum of two values per interval. The interval is calculated based on the set sample rate for the Trend View (Trend Chart Properties).

- 1 interval = Max. displayed samples per series/2.
  - Example 1: 100/2 = 50 intervals
  - Example 2: 400/2 = 200 intervals

A reduced display can also occur with just a few values, for example, when the values are recorded within a short interval. With the reduced display, minimum and maximum values always display.
Quality attributes:
With the reduced display, not all quality attributes can be displayed. In order to display all quality attributes, limit the time period.

### 7.2.5.6 Quality Attributes

The Trend View can display a number of state attributes, referred to as quality attributes, along with the trend data. These enable you to identify problems with the data point being recorded, and assist with the diagnosis of plant conditions. The following table describes these quality attributes:

<table>
<thead>
<tr>
<th>Quality Attributes</th>
<th>Symbol</th>
<th>BACnet</th>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DRIVER_FAILED (Bit=1)</td>
<td></td>
<td>No connection</td>
<td></td>
<td>Indicates that no connection exists to the logged data point.</td>
</tr>
<tr>
<td>DRIVER_FAILED (Bit=0)</td>
<td></td>
<td>Connected</td>
<td></td>
<td>Indicates that the connection exists to the data point.</td>
</tr>
<tr>
<td>ERROR_IN_LOG</td>
<td></td>
<td>Error</td>
<td></td>
<td>Indicates an error in the Trendlog object.</td>
</tr>
<tr>
<td>T_LOG_ENABLE (Bit=0)</td>
<td></td>
<td>Trend disabled</td>
<td></td>
<td>Indicates that the Trendlog object is disabled.</td>
</tr>
<tr>
<td>T_PURGED</td>
<td></td>
<td>Buffer deleted</td>
<td></td>
<td>Indicates that the buffer in the Trendlog object is deleted.</td>
</tr>
<tr>
<td>T_ROLLOVER</td>
<td></td>
<td>Buffer full</td>
<td></td>
<td>Indicates that the Trendlog buffer is full.</td>
</tr>
<tr>
<td>T_TIME_SHIFT</td>
<td></td>
<td>Time change</td>
<td></td>
<td>Indicates that the time in the automation station was changed</td>
</tr>
<tr>
<td>LOG_INTERRUPTED</td>
<td></td>
<td>Power fail</td>
<td></td>
<td>Indicates that the automation station has been set to state Log_interrupted in the trend buffer (for example: in the event of a power outage, application program stop, change of data point log type). This may cause trend data from not being logged.</td>
</tr>
<tr>
<td>OUT_OF_SERVICE (Bit=1)</td>
<td></td>
<td>Out of Service switched on</td>
<td></td>
<td>Indicates that the Out of Service property is switched on.</td>
</tr>
<tr>
<td>OUT_OF_SERVICE (Bit=0)</td>
<td></td>
<td>Out of Service is normal</td>
<td></td>
<td>Indicates that the Out of Service property is switched off.</td>
</tr>
<tr>
<td>FAULT (Bit=1)</td>
<td></td>
<td>Trendlog object error</td>
<td></td>
<td>Indicates that a data point error exists in the Trendlog object (values may not be usable for follow-on evaluation).</td>
</tr>
<tr>
<td>FAULT (Bit=0)</td>
<td></td>
<td>Return from Trendlog error</td>
<td></td>
<td>Indicates that the data point error returns to the normal state.</td>
</tr>
</tbody>
</table>
Only the highest priority displays in the Trend View if several states are active. The priority sequence in the previous quality attributes table is read in descending order (highest to lowest priority). With reduced display, not all quality attributes display. In order to display all quality attributes, limit the time period.

**NOTE:**
Quality attributes can only be evaluated if this function supports the corresponding subsystem. An alarm setup on the management station does not possess quality attributes. Therefore, an alarm cannot display an alarm bell in the Trend View.

### 7.2.5.7 Table View

The table view offers a view that differs from the standard view where curves are displayed as series. In order to view the trend data in a table view, you must stop the Trend View.

The table view displays each series as a column in the data grid. The first column (right) shows the time stamp. The column displays by merging all time stamps for all values in each series. It is displayed at an accuracy of 1 second.
Figure 19:

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>3</td>
</tr>
<tr>
<td>4</td>
</tr>
<tr>
<td>5</td>
</tr>
<tr>
<td>6</td>
</tr>
<tr>
<td>7</td>
</tr>
</tbody>
</table>

There are two display types in table view:
- **Normal view:** The corresponding cell has a value or is empty.
- **Interpolated view:** The corresponding cell is empty and shows a linear interpolated value based on previous current and subsequent current selection.

**NOTE:**
The table view only shows values as per the graphical time range. These values are exported during data export.
7.2.5.8 Print Preview Dialog Box

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>3</td>
</tr>
<tr>
<td>4</td>
</tr>
<tr>
<td>5</td>
</tr>
</tbody>
</table>

![Print Preview Dialog Box Diagram](image)
Select paper format (portrait or landscape).

Select **Fit to page** to display the selected area on a page. You can modify print options on the toolbar if **Fit to page** is cleared.

Closes the **Print** dialog box without printing.

Prints the document and closes the **Print** dialog box.

### 7.2.6 Trend View Properties

You can enter the following settings in Trend View properties to define the display for the graphical curve:

- Chart
- Axis
- Legend
- Series

#### 7.2.6.1 Chart

You can define the following Chart properties:

- Grid
- Background color
- Trend View title
- Display quality attributes
- Number of maximum series values in Trend View
### 7.2.6.2 Axis

You can enter the following settings in the Axis properties:

- **Left axis**
- **X-axis**
- **Right axis**

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Properties</td>
<td>Axis Properties</td>
</tr>
<tr>
<td>Title Y Left</td>
<td><strong>Title Y Left</strong>: Displays the title on the left side of the Trend View. <strong>Auto Scale</strong>: A minimum and maximum range must be defined if auto scale is disabled.</td>
</tr>
<tr>
<td>Title X</td>
<td><strong>Title X</strong>: Displays the title below the Trend View. <strong>X Axis Properties</strong>:</td>
</tr>
<tr>
<td>Title Y Right</td>
<td><strong>Title Y Right</strong>: Displays the title on the right side of the Trend View. <strong>Auto Scale</strong>: A minimum and maximum range must be defined if auto scale is disabled.</td>
</tr>
</tbody>
</table>

**Related Topics**

Data Point Key [→ 218]
General
Each chart can display a left and right Y-axis independent of each other. Series can be selectively assigned and scaled to either axis, by default or manually.
Scaling is set to automatic by default. This means that the range is defined by the highest amplitude of all displayed series, with analog data types attached to the left axis and digital data types to the right axis.
When a single Trend View contains several digital data types, these are shown one above the other with an offset.
The X-axis is always the time-related axis and the chart display is calculated according to the selected time range.

7.2.6.3 Legends

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Legend</td>
<td>The position can be left, right, above, or below the Trend View. Under a comparison view, the legend always displays on the right.</td>
</tr>
</tbody>
</table>

7.2.6.4 Series
Series properties, you define the individual series for the corresponding properties in Trend View.
- Line properties
  - Data series type
  - Data series form
  - Data series color
- Displaying Markers
  - Marker type
  - Marker size
- Y-axis position
- Display values
- Displaying Quality Attributes
## Series Properties Workspace

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line Properties</td>
<td>Defines the appropriate property type, form and color, as well as the property for the series (see the Table Line Properties below).</td>
</tr>
<tr>
<td>Visible</td>
<td>Displays the trend curve if this check box is selected.</td>
</tr>
<tr>
<td>Show Markers</td>
<td>Defines the corresponding property type, and size, as well as the corresponding property for the series. The markers are only displayed in the trend curve if this check box is selected. The X-axis is always the time axis. The diagram display is calculated to correspond to the selected time line.</td>
</tr>
<tr>
<td>Show Values</td>
<td>Displays numerically each measured value for the read value if this check box is selected. Values may overlap (unreadable) in the Trend View for intensive measured recorded values or a time range that is too large. In this case, select a smaller time range or switch to display values.</td>
</tr>
<tr>
<td>Show Quality Icons</td>
<td>The Trend View can display a number of state attributes, referred to as quality attributes, along with the trend data. These enable you to identify problems with the data point being recorded, and assist with the diagnosis of plant conditions.</td>
</tr>
</tbody>
</table>

### Line Properties

<table>
<thead>
<tr>
<th>Line type</th>
<th>Line style</th>
<th>Stroke color</th>
<th>Stroke thickness</th>
<th>Marker style</th>
<th>Marker thickness</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>1-6</td>
<td></td>
<td>1-10</td>
</tr>
</tbody>
</table>

## Related Topics

Quality Attributes [219]
7.2.6.5 Colors

You can assign a color to the Trend View (background color) or to each individual series (line). You can choose between:

- Predefined set of colors.
- Custom colors.

Colors Workspace

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>3</td>
</tr>
<tr>
<td>4</td>
</tr>
<tr>
<td>5</td>
</tr>
<tr>
<td>6</td>
</tr>
<tr>
<td>7</td>
</tr>
<tr>
<td>8</td>
</tr>
<tr>
<td>9</td>
</tr>
</tbody>
</table>
7.2.7 Offline Trendlog Objects

Offline trend data can be recorded and saved by Trendlog objects within the automation and control system even when the management station is not connected. The recorded data can then be saved in the trend database. Offline trend data can be retrieved and displayed in the Trend View.

Creating or Deleting BACnet Trendlog Objects Online

Creating and deleting BACnet objects online provides greater flexibility for adapting projects during operation. In other words, you can create and delete BACnet objects without engineering tools from the applicable manufacturer. The corresponding BACnet function must be supported by the automation station from the given manufacturer.

![Diagram of Offline Trendlog Object](image)

Figure 20: Offline Trendlog Object

**NOTE:**

Trendlog or Trendlog multiple objects that are created permanently with the engineering tool cannot be deleted from the management station.

**NOTICE**

**Validated Projects**

Specific critical environments (for example, pharmaceutical installations and processed) require a high degree of safety and traceability of all operational workflows and user activities. A validated plant can lose its validity or must be revalidated by adding or losing BACnet objects. Therefore, do not use this function, or do not enable it in the application rights.
7.2.8 Uploading Offline Trendlog Data Manually

Offline trend data is regulated and uploaded to the management station from the device. You can manually upload the data stored on the device to conduct analysis using the most current data.

You can upload trend data by selecting trend log objects from System Browser or from the legend.

The following images depict the trend view before and after the upload of data.

**Figure 21: Trend View Prior to Uploading the Data**

- Red curve: Offline trend data is not yet updated.
- Blue curve: Online Trend data

**Figure 22: Trend View after Uploading the Data**

- Red curve: Updated Offline Trend data
- Blue curve: Online Trend data
Related Topics
Uploading Trend Data using System Browser [➙ 189]
Uploading Trend Data using Legend [➙ 189]

7.2.9 Manual Correction Application
The Manual Correction application allows you to add, modify, and delete values of trended properties of trended objects that are logged in online as well as offline trends. The application displays date/time, value, status, and unit information of the trended data in a column pattern in a grid. The trend information pertaining to only a single trended property displays in the grid.

By default, the data is displayed for a time period of one day. However, you can select the desired time range to fetch the latest data. You can apply further sorting and filtering on the displayed data to get a more precise data set.

7.2.10 Manual Correction Workspace
This section gives an overview of the Manual Correction workspace.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Manual Correction Snap-in Toolbar</td>
</tr>
<tr>
<td>2</td>
<td>Trended Object</td>
</tr>
<tr>
<td>3</td>
<td>Trended Properties</td>
</tr>
<tr>
<td>4</td>
<td>Time Filter</td>
</tr>
<tr>
<td>5</td>
<td>Filtered Data</td>
</tr>
</tbody>
</table>
7.2.11 Manual Correction Toolbar

The Manual Correction Application toolbar allows you to perform the following operations:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run</td>
<td>Displays the data for the selected trended object property.</td>
</tr>
<tr>
<td>Add</td>
<td>Displays the Add Trend Entry dialog box to add new entries to the grid. This button is disabled when you select multiple entries in the grid.</td>
</tr>
<tr>
<td>Edit</td>
<td>Displays the Edit Trend Entry dialog box with the details of the selected entry to be modified.</td>
</tr>
<tr>
<td>Delete</td>
<td>Displays the Delete Trend Entry dialog box for deleting the selected entry or entries from the grid.</td>
</tr>
</tbody>
</table>

7.2.12 Filtered Data Section

The Filtered Data section displays the following information of the trended data in a columnar pattern in a grid.

<table>
<thead>
<tr>
<th>Time</th>
<th>Value</th>
<th>Unit</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>5/17/2016 11:34:59.858 AM</td>
<td>52.0 °F</td>
<td>Good</td>
<td></td>
</tr>
<tr>
<td>5/17/2016 11:34:59.359 AM</td>
<td>51.0 °F</td>
<td>Good</td>
<td></td>
</tr>
<tr>
<td>5/17/2016 11:34:58.858 AM</td>
<td>50.0 °F</td>
<td>Good</td>
<td></td>
</tr>
<tr>
<td>5/17/2016 11:34:58.358 AM</td>
<td>49.0 °F</td>
<td>Good</td>
<td></td>
</tr>
<tr>
<td>5/17/2016 11:34:57.858 AM</td>
<td>48.0 °F</td>
<td>Good</td>
<td></td>
</tr>
<tr>
<td>5/17/2016 11:34:57.358 AM</td>
<td>47.0 °F</td>
<td>Good</td>
<td></td>
</tr>
<tr>
<td>5/17/2016 11:34:56.858 AM</td>
<td>46.0 °F</td>
<td>Good</td>
<td></td>
</tr>
<tr>
<td>5/17/2016 11:34:56.358 AM</td>
<td>45.0 °F</td>
<td>Good</td>
<td></td>
</tr>
<tr>
<td>5/17/2016 11:34:55.858 AM</td>
<td>44.0 °F</td>
<td>Good</td>
<td></td>
</tr>
<tr>
<td>5/17/2016 11:34:55.358 AM</td>
<td>43.0 °F</td>
<td>Good</td>
<td></td>
</tr>
<tr>
<td>5/17/2016 11:34:54.858 AM</td>
<td>42.0 °F</td>
<td>Good</td>
<td></td>
</tr>
<tr>
<td>5/17/2016 11:34:54.358 AM</td>
<td>41.0 °F</td>
<td>Good</td>
<td></td>
</tr>
<tr>
<td>5/17/2016 11:34:53.858 AM</td>
<td>40.0 °F</td>
<td>Good</td>
<td></td>
</tr>
<tr>
<td>5/17/2016 11:34:53.358 AM</td>
<td>39.0 °F</td>
<td>Good</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Description</td>
<td></td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>-------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Time</strong></td>
<td>Date/Time of the property value of the object.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Value</strong></td>
<td>Value of the trended property of the object.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Unit</strong></td>
<td>Unit of the trended property</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| **Status** | Displays either of the following values:  
| | Good – Value of displayed data is good.  
| | Bad – Value of displayed data is bad as per IOWA standards.  
| | Added – Displayed value is added by user.  
| | Corrected – Displayed value is modified by user. |
8 Reports
This section provides background information and instructions for using the Reports application in Desigo CC.

8.1 Working with Reports
This section provides step-by-step instructions for using Reports. For background information, see Reports Reference [➔ 268]. Perform the procedures in this section as needed.

8.1.1 Creating a New Report Definition
1. In System Browser, select Application View.
2. Select Application View > Applications > Reports. Reports displays.

8.1.2 Creating and Deleting Reports Folders
Creating Reports folders in System Browser allows you to organize Report Definitions.
1. In System Browser, select Applications > Reports or one of its subfolders. Reports displays.
2. Do one of the following:
   - To create a new Reports folder:
     a. Click New.
     b. Select New Folder.
     c. In the New Object dialog box, enter a name and description.
     d. Click OK. The new Reports folder is saved.
   - To delete a Reports folder:
     a. Select the folder you want to delete.
     b. Click Delete. The Reports folder is deleted.

NOTE: Deleting a folder deletes the contents as well.
8.1.3 Configuring a Report Definition
You can configure a Report Definition by inserting elements, applying filters, setting page layout, and/or formatting elements.

8.1.3.1 Inserting a Table
1. In System Browser, select Application View.
2. Select Applications > Reports or one of its subfolders.
3. Click the Home tab.
4. Do one of the following:
   - From the Insert group box on the Home tab, click the Table group box, select a table, such as Objects, Active Events or Activities, and drag-and-drop it in the Report Definition. The cursor shape changes and indicates the selected table name.
   - Right-click the Report Definition and from the Insert Table option, select the table type.
   - Drag-and-drop the desired system object from System Browser onto the Report Definition. The Name filter of the inserted table is set to the dropped system object.

\(\Rightarrow\) The table is added to the Report Definition.

**NOTE 1:**
You cannot insert tables in the header or footer section.

**NOTE 2:**
If you right-click a table in the Report Definition, you can move, set a position, and perform various column operations like adding, deleting, reordering, and sorting, applying font and changing color, applying filters, and deleting the table.

Adding a Column

\(\Rightarrow\) You have added a table in a Report Definition.
1. Select a table in the Report Definition.
2. Right-click the table and select Select Columns.
   **NOTE:** The layout and content of the Select Columns dialog box varies according to the type of table selected.
   \(\Rightarrow\) The Select Columns dialog box displays.
3. Select the check box preceding each column to add it to the table. In case of a property, you must first expand it, and then check the columns.
   **NOTE:** For an Objects table: Select the object related to the Objects table from the Type drop-down list. The columns related to the object type selected are filtered and displayed in the Available Columns list.
   If you select a column that belongs to a property, then the column is added in the Property column format, such as High Limit.ActivityLog.
   \(\Rightarrow\) The checked columns are added to the Selected Columns list.
4. Click OK.
   \(\Rightarrow\) The columns are added to the table in order of their presence in the Selected Columns list.
Reordering a Column

➢ You have added a table with multiple columns in the selected Report Definition.
1. Select a table in the Report Definition.
2. Right-click the table and select Select Columns.
   ➢ The Select Columns dialog box displays with the available columns in the table.
3. Select the required column in the Selected Columns list.
4. Click Move Up or Move Down to reorder the column.
5. Click OK.
   ➢ The column in the table is arranged accordingly.

Removing a Column

➢ You have added a table in a Report Definition.
➢ The table must contain at least one column.
1. Select a table in the Report Definition.
2. Right-click the table and select Select Columns.
   ➢ The Select Columns dialog box displays with the available columns of table.
3. Select the required column in the Selected Columns list, and click Remove.
4. Click OK.
   ➢ The column is removed from the table.

NOTE:
You can also remove the default columns of a table.

Customizing a Column Header

You can customize the column heading in tables as per your requirement using the Select Columns dialog box. These customized headings appear in the report definition and also in the generated report output. In case of Trends table, in addition to customizing the column headings, you can also customize the column header for the trended objects hierarchy from the Trended Objects tab in the Select Columns dialog box.

Perform the following steps to customize a column header.

➢ You have added the table whose column headers are to be customized to the report definition.
➢ You have selected the columns to be displayed in the table.
1. Select the table in the report definition.
2. Right click and select Select Columns.
   ➢ The Select Columns dialog box displays.
3. In the **Selected Columns** section, select the column whose header is to be customized.

4. Double-click the column header or press **F2** to enter a new column header.

   - The modified column header displays in the table in the report definition.
   
   **NOTE:** When you modify a column header for the first time, the same name displays as the header in all the languages configured in your system. On subsequent edits, the name is updated for only the default language in which you are currently logged in.

### Sorting a Column

- You have added a table with multiple columns to a Report Definition.

  + Do one of the following:
    - To sort a column data in ascending order, click the column header of a table.
    - To change the sort order to descending, click the same column header again.
    - To sort the data on multiple columns, press **CTRL** and click the column headers.

   **NOTE:** Remove the priority of the prioritized columns for multiple sorted columns by single clicking any column header.

   - The data is sorted, and a priority is assigned to the columns if sorting is done on more than one column.

### Deleting a Table

- At least one table is added in the selected Report Definition.

  1. In the Report Definition, select the table you want to delete.

     - The border color changes to indicate table selection.

  2. Right-click the table and select **Delete**, or press **DEL**.

     - A confirmation message displays.

  3. Click **Yes**.

     - The table is deleted from the Report Definition.

### 8.1.3.2 Inserting a Plot

- You have selected an existing Report Definition in **System Browser > Reports** or you have created a Report Definition and now want to configure it.

  1. Click the **Home** tab.

  2. Do one of the following:
From the **Insert** group box, click the **Plot** group box, and select any plot (Trends, Graphics), and drag-and-drop it onto the selected Report Definition.

**NOTE:** The cursor changes and indicates the selected plot name.

- Right-click the Report Definition and select the required type of plot from the **Insert Plot** option.

- Drag-and-drop the desired **Trend View Definition/Graphics View Port** from System Browser onto the Report Definition. The Name filter of the inserted plot is set to the dropped Trend View Definition or Graphics View Port.

    The plot placeholder is added to the Report Definition. By default, the plot is left-aligned.

**NOTE:** In Run mode, this plot image is replaced by the actual data retrieved from the Report service.

---

**NOTE 1:**
You cannot insert a plot in the header/footer section.

**NOTE 2:**
You cannot apply font types, size, and color on a plot.

**NOTE 3:**
If you select a plot in the Report Definition and right-click, you can move, set position, apply filters, and delete the plot.

---

### Deleting a Plot

- At least one plot is inserted in a Report Definition that you have selected.

1. From the Report Definition, select the plot you want to delete.
   - The border color changes to indicate the plot selection.

2. Either right-click the plot and select **Delete**, or press **DEL**.
   - A message displays.

3. Click **Yes**.
   - The plot is deleted from the Report Definition.

---

### 8.1.3.3 Inserting Text (Label)

1. Do one of the following:
   - Click the **Home** tab.
   - Select **Insert > Text > Blank**. Drag-and-drop it either in the Report Definition or in the header or footer section.
   - Right-click the Report Definition or the header or footer section where you want to insert the text label, and select the **Insert Label** option.
     - A blank label is inserted.

2. Type the desired text.
   - The text is entered.

### Deleting Text

- You have inserted a label.

1. Select the **label** you want to delete.
   - The border color changes to indicate that the label is selected.
2. Either right-click the label and select **Delete**, or press the **DEL** key.
   ✤ A confirmation message displays.

3. Click **Yes** to confirm.
   ✤ The selected label is deleted.

### 8.1.3.4 Inserting a Keyword

1. Click the **Home** tab.

2. Do one of the following:
   - From the **Insert** group box, select a keyword from the **Keyword** group box and drag-and-drop it in the header/footer section or anywhere in the Report Definition.
   - In the Report Definition, place the cursor where you want to insert the keyword, right-click and select the required keyword from the **Insert Keyword** option.
   - From the **Insert** group box, insert a blank text and then do one of the following:
     - Select a keyword from the **Keyword** group box and drag-and-drop it onto the blank text.
     - Right-click the blank text and select the required keyword from the **Insert Keyword** option.
   ✤ The keyword is inserted.

---

#### NOTE 1:
If no text or keyword is added to a label in **Edit** mode, then a blank label displays in **Run Mode**.

#### NOTE 2:
To delete a keyword, you must delete the label containing that keyword.

#### NOTE 3:
Content-specific keywords, such as Content Type, Name filter or Record Count, cannot be inserted in the header/footer section of a Report Definition.

---

### Deleting a Keyword

➤ You have at least one label in the selected Report Definition.

1. Select the label that contains the keyword you want to delete.
   **NOTE:** To delete a keyword you must delete the label.
   ✤ The border color changes to indicate that the label is selected.

2. Either right-click the label and select **Delete**, or press **DEL**.
   ✤ A confirmation message displays.

3. Click **Yes**.
   ✤ The selected label and keyword are deleted.

### 8.1.3.5 Inserting a Logo

➤ You have added at least one logo to the **Logo** group box.

1. Click the **Home** tab.

2. Do one of the following:
– From the **Insert** group box, click the **Logo** group box and select a logo, and then drag-and-drop it on the Report Definition where you want to insert it.
– In the Report Definition, place the cursor where you want to insert the logo, right-click and select the required logo from the **Insert Logo** option.

\[ \text{The logo is inserted in the Report Definition.} \]

**NOTE 1:**
To insert a logo in the header/footer section of a Report Definition, delete any existing label.

**NOTE 2:**
You can change the position of the logo in the Report Definition by using the **Move** buttons (up, down, top, bottom) in the **Placement** group box of the **Layout** tab, or by right-clicking a logo in the Report Definition, and selecting **Move**.

**Adding a Logo**

1. Click the **Home** tab.
2. From the **Insert** group box, click the **Logo** group box and select **Manage Logo**.
   \[ \text{The Manage Logo dialog box displays.} \]
3. Click **Browse**.
4. Select an image file, preferably in the format: .bmp, .jpeg, .png, or .gif. You must ensure that the size of the image file does not exceed 1MB.
5. Click **Open**.
   \[ \text{The Select logo to upload field displays the file path. You cannot edit this field. The image file name is saved as the logo name.} \]
6. Click **Upload**.
   \[ \text{The image is added to the Available Logos list.} \]

**NOTE:**
The logo file is saved under: [drive]\GMSProjects[project]\data\Reporting\Logos.

**Deleting Logos**

\[ \text{You have inserted a logo in a Report Definition.} \]
1. Select the logo you want to delete.
2. Either right-click the logo and select **Delete**, or press the **DEL** key.
   \[ \text{A confirmation message displays.} \]
3. Click **Yes** to confirm.
   \[ \text{The logo is deleted from the Report Definition.} \]
8.1.3.6 Configuring Form Controls
You can configure form controls in reports.

Inserting an Editable Field
1. Click the Home tab.
2. Do one of the following:
   - From the Insert group box, click the Form Controls group box, select the Editable Field control and drag-and-drop it in the Report Definition or in the header/footer section.
   - Right-click the Report Definition or the header/footer section, where you want to insert the editable field, and then select the Insert Editable Field option.

   ➤ The editable field is added.

**NOTE:**
To insert the editable field in the header/footer section of a Report Definition, delete any existing label.

Inserting a Custom Text Selection Control
1. Click the Home tab.
2. Do one of the following:
   - From the Insert group box on the Home tab, click the Form Controls group box, select the Custom Text Selection control and drag-and-drop it in the Report Definition or in the header/footer section.
   - Right-click the Report Definition or the header/footer section, where you want to insert the Custom Text Selection control, and then select Insert Custom Text Selection.

   ➤ The Custom Text Selection control is added.

Adding Entries to the Custom Text Selection Control
The Custom Text Selection control is added to the Report Definition or in the header/footer section.
1. Do one of the following:
   - Click the control and enter text.
2. Click Add.
   ✤ The text entry is added to the control.

Modifying Entries in the Custom Text Selection Control
▷ The Custom Text Selection control has one or more text entries.
1. Select the text entry you want to modify from the list.
2. Do one of the following:
   - Click the control and modify the text.
3. Click Update.
   ✤ The text entry is modified.

Deleting Entries from the Custom Text Selection Control
▷ The Custom Text Selection control has one or more entries in it.
1. From the list of entries, click Delete next to the text entry you want to delete.
   ✤ The deleted entry no longer displays.

Inserting the Text Group Selection Control
1. Click the Home tab.
2. Do one of the following:
   - From the Insert group box on the Home tab, click the Form Controls group box, select the Text Group Selection control, and drag-and-drop it in the Report Definition or in the header/footer section.
   - Right-click the Report Definition or the header/footer section, where you want to insert the Text Group Selection control, and then select Insert Text Group Selection.
   ✤ The Text Group Selection control is added.

Adding a Text Group to the Text Group Selection Control
▷ The Text Group Selection control is added to the Report Definition or in the header/footer section.
- Navigate to the Libraries node in the System Browser and drag-and-drop a text group node to the Text Group Selection control.
   ✤ The text group is added to the Text Group Selection control. The name of the text group displays on the control. If you want to view the complete hierarchy of the text group, move your cursor over it. The hierarchy displays in a tool tip.

Inserting the Comments table
▷ You have selected an existing Report Definition or you have created a Report Definition and now want to configure it.
1. Click the Home tab.

2. Do one of the following:
   - From the Insert group box on the Home tab, click the Form Controls group box, select the Comments table and drag-and-drop it onto the Report Definition.
   - Right-click the Report Definition and select Insert Comments Table.

   ➔ The Comments table with a single row is added to the Report Definition.

### 8.1.3.7 Applying a Name Filter

▶ You have created a Report Definition and inserted a table or plot.

1. Select a table or plot in the Report Definition.

2. Do one of the following:
   - Click Dialog Launcher in the Name Filter group box.
   - Right-click the selected table or plot and select Name Filter from Filters.
   - Double-click inside the Name Filter group box.

   ➔ The Name Filter dialog box displays.

3. Select the Name or Description. The default selection is Name. The selection is the same as in the Display Mode List Box in the System Browser.

4. To set the Name filter, do one of the following:
   - In the Name Filter text box, type the complete path of the object for which you want to apply the Name filter according to the System Browser Name. For example:

     NOTE: Adding a ".*" at the end of the name or selecting the Children check box enables the children option. For a plot, you can apply only one Name filter and the Children check box is unavailable.
   - Drag-and-drop a System Browser object onto the selected table or plot and the Name filter is set to the hierarchy of the dropped object. You can view and modify it using the Name filter dialog box.

     NOTE: When you drag-and-drop an object for the first time onto a table, the default filter "*:*" is replaced by the hierarchy of the dragged and dropped object.

5. Click New.

   ➔ The Name filter is added to the Name Filter list.

6. Click OK.

   ➔ The Name filter is added to the Name Filter group box.

---

**NOTE:**

You can apply multiple Name filters on all tables except for a Trends table. For BACnet tables, applying multiple Name filters is possible, but the Children check box is unavailable.
Editing a Name Filter

▷ You have already applied \[\rightarrow 242\] a Name filter for a table or plot in a Report Definition.

1. Open the **Name Filter** dialog box.

2. In the **Name Filter** list, select the Name filter you want to edit.
   ⊳ The selected Name filter displays in the Name filter text box.

3. In the **Name Filter** text box, type in your modifications.

4. Click **Accept**.
   ⊳ The updated Name filter displays in the **Name Filter** list.

5. Click **OK**.
   ⊳ The updated Name filter displays in the **Name Filter** group box.

Deleting a Name Filter

▷ You have already applied \[\rightarrow 242\] a Name Filter to a table or plot.

1. In the **Name Filter** list, select the Name filters to be deleted.

2. Click **Delete** or press **DEL**.
   ⊳ The deleted Name filter is removed from the **Name Filter** list.

3. Click **OK**.
   ⊳ The Name filter is deleted from the **Name Filter** group box.

8.1.3.8 Applying a Condition Filter

▷ You have inserted a table in a Report Definition.

1. Select a table.

2. Do one of the following:
   - Click **Dialog Launcher** in the **Condition Filter** group box.
   - Right-click the selected table and select **Condition Filter** from **Filters**.
   - Double-click inside the **Condition Filter** group box.
   ⊳ The **Condition Filter** dialog box displays.

3. Select a column from the **Available columns** list.
   **NOTE:** For Objects Table: A **Type** drop-down list displays. Select an object from the list and click the **Load** button to populate the **Available columns** list.
   ⊳ The operators and values associated with the selected column display in the **Operator and Values** list.

4. Select the required **Operator** and **Value** from the respective lists. If values are not displayed for the selected column, type in the value. To apply parentheses, select a filter expression and click \( ( ) \). The parentheses are applied at the start and end of the filter expression.
   **NOTE:** You have to specify time related values in a 24-hour clock format. For example, to specify the Source Time as 2.00 PM, type 14.00.
   ⊳ Use AND, OR, ( ) to form the Filter expression.
5. (Optional) For Objects table only, specify the acceptable age of the data on which the filter is applied by selecting the Read data from field system older than option.
   ➤ The value entered is compared with the age of the data in the cache. If the data in the cache is older than the value entered, it is retrieved from the field system; otherwise data from the cache is used for filtering.

6. Click Add.
   ➤ The filter expression formed displays in the Filter expression field.

7. Click OK.
   ➤ The filter expression is displayed in the Condition Filter group box.

Modifying a Condition Filter
▶ One or more Condition filter expressions are added to the Condition Filter group box.

1. Open the Condition Filter dialog box.
   ➤ The Condition filter expression displays in the Filter expression field. Clicking the filter expression displays the column, operator, and value in their respective lists.

2. Modify the Condition filter expression as required.

3. Click Update.
   ➤ The updated filter expression is added to the Condition Filter group box.

NOTE:
If you enter an invalid filter expression, an error message displays below the Filter expression field in red and the invalid part of the filter expression is highlighted in red. To correct the error, place the cursor over the error message below the Filter expression field. A tooltip displays the possible solution.

Deleting a Condition Filter
▶ You have applied a Condition filter to a table.

1. Open the Condition Filter dialog box.

2. Delete the Condition filter expression from the Filter expression field.

3. Click OK.
   ➤ The Condition filter is deleted from the table.

8.1.3.9 Applying a Time Filter
▶ You have inserted a table in a Report Definition.

1. Select a table.

2. Do one of the following:
   - Click Dialog Launcher in the Time Filter group box.
   - Right-click the selected table and select Time Filter from Filters.
   - Double-click inside the Time Filter group box.
   ➤ The Time Filter dialog box displays.
3. For Events and Event Details table only, select the column on which you want to apply the time filter from the Select Column drop-down list.

4. Select the appropriate values for Date/Time type: Exact, Custom, or Relative.

5. Click OK.

   NOTE: By default, the Unlimited option is selected.

   ✷ The Time filter is added in the Time Filter group box.

8.1.3.10 Applying a Row Filter

▷ You have selected a table in a Report Definition for which you want to apply a row filter.

● Select the Row filter check box and enter the desired number of rows to be displayed in the report output.

   ✷ The configured number of rows are displayed for the table in Run mode.

8.1.3.11 Applying the Graphics Filter

▷ You have added a graphics plot to the Report Definition.

1. Assign the name filter of the object whose graphics and view ports you want to display in the report output.

2. Select the All Related Graphics check box from the Graphics group box in the Filter tab.

   ✷ All the graphics and view ports related to the object display in Run mode.

8.1.3.12 Setting Page Layout

The following sections allow you to set the layout of a report definition.

Setting Orientation

1. Click the Layout tab.

   ✷ The Page Setup group box displays.

2. Click the Orientation menu.

   ✷ The Portrait and Landscape submenu displays.

3. Select Landscape or Portrait. By default, Landscape is selected.

   ✷ The report’s orientation changes based on your selection.

Setting Page Size

1. Click the Layout tab.

   ✷ The Page Setup group box displays.

2. Click the Page Size menu.


   NOTE: Selecting the More Sizes option displays the Width and Height (in cm or inch – location dependent) of the selected page size. These fields are read-only.
3. Select the page size of your choice.
   ⇢ The page size of the Report Definition changes accordingly.

**Setting Page Margins**

1. Click the **Layout** tab.
   ⇢ The **Page Setup** group box displays.

2. Click the **Margin** menu.
   ⇢ A list of preconfigured margins display such as Normal, Narrow, Moderate, Wide, and More Margins. You can specify the top, bottom, left and right margins of a page as well as the header and footer margins by selecting the **More Margins** option.

3. Select the margin of your choice.
   ⇢ The margin of the report changes.

**NOTE 1:**
In the **Page Setup** dialog box, all fields in the **Margins** section accept only integer and floating point values.

**NOTE 2:**
A negative value entered highlights the text field in red. Placing the cursor over the field displays a tooltip informing you that one or more margins are set outside the printable area of the page.

**NOTE 3:**
If the difference between the top margin and header margin is zero or a negative value, then the header height is set to a default value of 5 units (mm or inch – location dependent).

**Setting a Header/Footer**

The header and footer are positioned at the top and bottom of the page and provide information about the page, such as page number, page title, date/time, and so on.

1. Click the **Layout** tab.
   ⇢ The **Page Setup** group box displays.

2. Click **Dialog Launcher**.
   ⇢ The **Page Setup** dialog box opens.

3. Do one of the following:
   - To view the header/footer along with the page, check the **Show header** and **Show footer** options.
   - To hide a header/footer on a page, uncheck the **Show header** and **Show footer** options.

   **NOTE:** You can also define the top header and bottom footer margins by changing the top margin and bottom margin values respectively.

**NOTE:**
By default, the **Show header** and **Show footer** check boxes are selected and the margin from top and bottom are set to 1 unit (cm or inch – location dependent).
Enabling/Disabling Auto Scaling

1. Click the **Layout** tab.
   - The **Scaling** group box displays.

2. Select the **Auto scaling** check box. By default, the auto scaling mechanism is enabled.

### 8.1.3.13 Formatting Report Elements

You can format report elements for an enhanced appearance by performing the following procedures:

### Adjusting a Report Element Position

1. Select a report element in a Report Definition.
   - The menus in the **Position** group box become available.

2. You can adjust the position of the report element by doing one of the following:
   - Use the **Position** group box.
   - Click **Dialog Launcher** or right-click and select **Position** to open the **Position** dialog box.

3. To set the alignment, click the required alignment type.

4. To set the indentation, type the values in the **Left** or **Right** field (for Left and Right Indentation respectively). If center alignment is selected, then both these fields are unavailable.

5. To set the spacing, type values in the **Before** and **After** fields.

6. To set the width, first select the **Width** check box and then type in the value in the **Width** field.

7. To set the height, first select the **Height** check box and then type in the value in the **Height** field. The height option is unavailable for labels.

8. Click **OK**.

---

**NOTE 1:**
All fields in the **Position** group box and **Position** dialog box accept only integer and floating point values.

**NOTE 2:**
A negative value entered highlights the text field in red. Placing the cursor over this field informs you that the value must be greater than or equal to 0.

**NOTE 3:**
For logos and plots, the width-height aspect ratio is maintained, so that if you change one the other gets adjusted automatically as per the aspect ratio. While inserting logos the original aspect ratio of the image is maintained.
Customizing a Font
1. Select a label or a table in a Report Definition.
2. Click the Layout tab.
   ⇒ The Font group box displays.
3. Do one of the following to apply a font, font style, or font size.
   - Click the drop-down arrow in the Font group box.
   - Right-click the report element, and select Font.
   ⇒ The Font dialog box displays.
4. Select the font type, font size, and font style as desired.
5. (Optional) Select the Underline check box to apply it to the label. The Underline option is unavailable when you select a table in the Report Definition.
6. Click OK.

Applying Color
1. Select a label or a table in a Report Definition.
2. Click Color.
3. Do one of the following:
   - Select a predefined color (in square boxes).
   - Click the More Color option and select a custom color in the More Color dialog box.
4. Click OK.

8.1.4 Saving a Report Definition
▷ You have configured a Report Definition and want to save it.
1. Click Save.
2. In the Save Object As dialog box:
   a. Select a destination folder in which to save the Report Definition.
   b. Enter a name and description.
   c. Click OK.
   ⇒ The Report Definition is saved.

8.1.5 Creating a New Report Definition from an Existing One
▷ You have made modifications to an existing report definition and want to save it as a new Report Definition.
▷ The modified Report Definition displays.
1. Click Save As.
2. In the Save Object As dialog box, select the destination folder in which to save the Report Definition.
   a. Enter a name and definition.
   b. Click OK to confirm.
   ⇒ The Report Definition is saved.
8.1.6 Modifying a Report Definition

1. In System Browser, select Application View.
2. Select Applications > Reports.
3. Select a Report Definition and make the necessary configuration changes.
4. Do one of the following:
   - Click Save to replace the Report Definition with the changes.
   - Click Save As to create a new Report Definition.
5. In the Save Object As dialog box:
   a. Select the destination folder for saving the Report Definition.
   b. Enter a name and description.
   c. Click OK.
   ➤ The Report Definition is saved.

NOTE:
You cannot save a Report Definition with invalid columns. For more information see Validating a Report Definition [➙ 324].

8.1.7 Saving a Report Definition as the Default Template

1. In System Browser, select Application View.
2. Select Applications > Reports.
   ➤ Reports displays.
3. Click New and select New Report, or open an existing Report Definition.
4. (Optional) Configure or modify the Report Definition.
5. Click Save as default. When you save an existing Report Definition as a default template, a message displays informing you all elements are removed from the Report Definition; Text (Labels), Keywords, and Logos remain in the header/footer section.
   ➤ The Report Definition is saved as a default template.
NOTE:  
There can only be one default template. You can create a new one or use the one provided by the system. When you create a new template, the existing default template is overwritten. In case of a Distributed Environment, the default template is system-specific.  
The template may contain generic and content-specific keywords. Creating a new Report Definition displays generic keywords, but not the content-specific keywords. The applicable content-specific keywords are automatically inserted above an inserted table and/or plot; however certain keywords are not applicable for certain types of tables/plots. For example, if the default template contains the content-specific keyword Time Range and you insert the Active Events table in the Report Definition, the Time Range keyword will not be inserted above the Active Events table in the Report Definition as the Time filter is not applicable for the Active Events table.  
While creating a template, you can configure it in multiple languages by clicking the Settings tab and selecting the Language for Labels group box. When you create a new report based on this template, the language of the logged-in user is selected automatically and the Report Definition contents are added to this definition.

8.1.8 Generating a Report Manually using Run or Run as

▷ At least one Report Definition is available under System Browser > Reports.
   1. In System Browser, select Application View.
   2. Select Applications > Reports.
      ☝ Reports opens.
   3. Locate and select the Report Definition you want to execute.
      ☝ The Report Definition displays in Edit mode.
   4. Click one of the following:
      - Run ☝ to run the Report Definition according to your login language.
      - Run As ☝ to run the Report Definition according to the selected language. Localized data is retrieved and loaded in the cells of a table/plot in the report.
      ☝ The report execution status displays in the Report Management section below the report definition. On successful report execution, the generated report displays in Run mode.

NOTE:

After running a Report Definition, should you decide to change some definition parameters, click Edit ☝ to toggle from Run mode to Edit mode in order to make your configuration changes.
8.1.9 Generating a Report Manually from Related Items Tab

1. Select an object from System Browser. This object is set as the name filter for the report definition you want to execute.

2. In the Related Items tab, select an icon/link for the Report Definition. For example, Object Status. You must import the report that you want to execute. 
   NOTE: Do not select an icon/link for New Report as this opens a new Report Definition.

   The selected report displays in the Secondary pane in Run mode. The selected object is set as the name filter for the tables and plots present in the report. The report execution status displays in the Report Management section. On successful report execution, the generated report displays information related to the selected object.

NOTE 1:
If the selected report in the Related Items tab is a related report for the selected System Browser object, then data is retrieved according to the Name filters set for report elements. However, if the selected report in the Related Items tab is a Show in Related Items report, the Name filter configured for all the reporting elements in the generated report is replaced by the path of the selected object in the System Browser.

NOTE 2:
After running a Report Definition, should you decide to change some definition parameters, click Edit to toggle from Run mode to Edit mode in order to make your configuration changes.

8.1.10 Generating a Report Automatically

There is at least one Report Definition available under System Browser > Reports, for which a Report Output Definition is configured.

1. In System Browser, select Application View.

2. Select Reports and the Report Definition you want to execute.

   The Report Definition opens.

3. Do one of the following:
   – Click the Extended Operations tab, and then click Execute.
   – Create a macro for a report definition and click Execute.

   The report executes in the background when triggered. There is no visual indication that the report is being generated. On successful execution, the report is routed to the destination configured in the Report Output Definition such as email, printer, or folder.
### 8.1.11 Viewing Data of Deleted Objects

You can view the data related to deleted objects from the Orphans, Orphan Activities, Orphan Events, and Orphan Trends tables. This data relates to the activity records, event records, or trend records of deleted objects. To view these tables, you must enable the `View Orphan Logs` application right from the `Security` node in the `Management View`. In order to view the data of such objects, perform the following steps:

1. Create a new report definition and add the `Orphans` table to it.
2. Add a condition filter to this table and set the value of the `Orphan Type` column to either of the following:
   a) Objects
   b) Trends
3. Run the report definition.
   - The details of all the deleted objects display.
4. Generate an Excel or PDF output by clicking `Create and view Excel` or `Create and view PDF`.
5. Depending on the type of data (Objects or Trends) to be displayed for the deleted objects, perform the following steps:
   a. To view activity related information of deleted objects, insert the `Orphan Activities` table.
   b. To view the event related information of deleted objects, insert the `Orphan Events` table.
   c. To view the trended information of deleted objects, insert the `Orphan Trends` table.
6. Navigate to the location where you have saved the Excel or PDF file, and then copy the `Object Identifier` of the deleted object whose data should display.
7. Add a condition filter to either the Orphan Activities, Orphan Events, or Orphan Trends tables and set the value of the `Object Identifier` column to the value you copied from the generated Excel or PDF file.
8. Run the report definition.
   - The details of the deleted objects display depending on the value of the specified Object Identifier.

### 8.1.12 Printing Automatically Generated Reports

1. In System Browser, select `Application View`.
2. Select `Applications > Reports`.
3. Click the `Settings` tab.
4. From the `Report Output` group box, click `Dialog Launcher`.
   - The `Report Output Definition` dialog box displays.
5. In the **Report format** list, select **PDF**.
6. In the **Destination types** list, select **Printer** and specify the other printer details.
7. Click **Add**.
   - The selected format and destination are added to the **Output Definition** list.
8. Click **OK**.
   - The configured **Report Output Definitions** display.

**Related Topics**
Generating a Report Automatically [→ 251]

### 8.1.13 Printing Manually Generated Reports

- For reports generated in either of the following ways:
  - **Using Run or Run as:** You have selected an existing Report Definition under **System Browser > Reports** or created, configured, and saved a Report Definition. The report is generated using **Run** or **Run as** and it displays in **Run** mode.
  - **From the Related Items** tab: You have selected the report to be generated from the **Related Items** tab and it displays in **Run** mode.

1. In System Browser, select **Application View**.
2. Select **Applications > Reports**.
3. Click **Create and View PDF**.
   - The PDF output displays.
4. Click **Print**.
   - The **Print** dialog box displays.
5. Select the configured printer and click **Print**.

**Related Topics**
Generating a Report Manually using Run or Run as [→ 250]
Generating a Report Manually from Related Items Tab [→ 251]

### 8.1.14 Working with Reports in Run Mode

You can perform the following activities with Reports in the **Run** mode.

### 8.1.14.1 Adding Comments to the Comments Table

- The report displays in **Run** mode and has a comments table.
  - Enter the comments in the **Comments** column and press **ENTER**. Press **ALT + ENTER** to add a new line.
    - The **Creation date**, **User** and **Management Station** columns are automatically filled in with their respective read-only values.
8.1.14.2 Modifying Comments in the Comments Table

- The report displays in Run mode and has a comments table with comments added. You can edit only your own comments.

1. Click **Edit** next to the row with your comments.
   - The comments cell in that row can be edited.

2. Make the required updates and press **ENTER**.
   - The comments are updated.

8.1.14.3 Deleting Comments from the Comments Table

- The report displays in Run mode and has a comments table with comments added. You can delete only your own comments.

1. Click **Delete** next to the row with your comments.
   - The comments are deleted.

8.1.14.4 Selecting Rows in Tables

You can select single or multiple rows in a reports table in the Run mode. The information of the object or objects in the selected row or rows displays. Additionally, any related items of the objects also display in the **Related Items** tab. In Trends tables, you can select only one cell and the information of the object in the selected cell displays in the **Extended Operation** tab.
8.1.15 Generating a PDF Document

- You have run a Report Definition and it displays in Run mode.

1. Click Create and view PDF.
   - The PDF file opens in the PDF viewer.
   - When a PDF document exceeds the page limit of 500 pages, it splits into two documents.
   - After clicking Create and view PDF on the generated report, you can save, print, zoom in, and zoom out of the PDF file.
   - From the Report Management section, you can:
     - Click Stop to stop creating the PDF document and a consecutive PDF split document.
     - Click Delete to delete each entry.

8.1.16 Generating an Excel Document without a Template

- You have run a Report Definition and it displays in Run mode.
- Microsoft Excel 2007 or later is installed on your system.

1. Click Create and view Excel.
   - An Excel file is created and stored under the following temporary path [Drive]\Users\[UserID]\AppData\Local\Temp\temp\GMS. A dialog box displays, asks you if you want to save a permanent copy of this file.

**NOTE 1:**
The Excel creation progress for all the split Excel documents displays under the same Report Snapshot in the Report Management section.

**NOTE 2:**
From the Report Management section, you can do one of the following:
- Click Stop to stop creating a Excel document and a consecutive Excel split document.
- Click Delete to delete each entry.

**NOTE 3:**
If you have Internet Explorer 10.0 or higher, the Excel file opens outside the Reports Workspace.

8.1.17 Generating an Excel Document with a Template

- You have created a report definition, run it, and it displays in Run mode.
- Microsoft Excel 2007 or later is installed on your system.

1. Click Create and view Excel.
   - An Excel file is created and stored at the following temporary location on your machine [Drive]\Users\[UserID]\AppData\Local\Temp\temp\GMS. A dialog box displays asking you to save a copy of this file on your machine, open the file from the temporary location, or cancel the procedure to open or save the file.
2. Open the Excel file by clicking **Open** in the dialog box.
   **NOTE:** If you are opening the file from the temporary location, you must first ensure that you save a copy of this file at a different location on your machine and proceed with the further steps on the saved copy.

3. Open the worksheet with the table information in the saved copy of the Excel file and select a row with data.

4. From the Insert menu, select the **PivotTable** option.
   - The **Create PivotTable** dialog box displays.

5. Select the **Select a table or range** option and specify the table details.

6. Select the **New Worksheet** option in the **Choose where you want the PivotTable report to be placed** section and click **OK**.
   - A new worksheet is added to the Excel document with the PivotTable options.

7. From the **PivotTable Field List**, select the columns to be added to the PivotTable.
   - The selected columns are added to the worksheet.

8. (Optional) Re-organize the columns as per your requirement in the **Drag fields between areas below** section in the PivotTable Field List.
   - Any changes you make in this section, reflect in the worksheet.

9. Select any row from the PivotTable, right click, and then select **PivotTable Options**.
   - The **PivotTable Options** dialog box displays.

10. Select the **Data** tab.

11. In the PivotTable Data section, clear the **Save source data with file** check box and select the **Refresh data when opening the file** check box.

12. Click **OK**.

13. Delete all the sheets in the Excel document, except the sheet having the PivotTable configuration.

   - The saved Excel document is a template that contains the PivotTable.

15. Select the Report Definition you created.

16. From the **Extended Operation** tab, specify the path of the template in the **Excel Output Template** field and click **Set**. By default, the **Excel Output Template** field does not display in the **Extended Operation** tab. In order to display this field, you must select the **DL3 display level check box** for the **Template Path** property in the **Report Definition Object Model**.
   **NOTE:** The template path is the path of the Server machine. A Process Monitor User must have access to the folder in which the template file is present for the PivotTable to display.

17. Run the report.
   - The generated report displays in the **Run** mode.
18. Click Create and view Excel.

19. Click Open.

The Excel document displays. The first worksheet displays information on the PivotTable and the details of other tables in the Report display in the other sheets.

8.1.18 Routing Reports

You can route reports to folders, email recipients as an attachment, and to local printers. Reports can be routed in the PDF, XLS, CSV, and XML formats. In case of XML formats, the reports can be routed only if you have the relevant license.

In order to route reports, you must perform the following steps:
1. Configure report destination types, such as email recipients.
2. Configure a Report Output Definition in which you specify the report output file format and destination.
3. Run a Report Definition using one of the following:
   - The Execute command button from the Extended Operation tab.
   - Create a macro for a report definition and execute.

Related Topics
Generating a Report Automatically [➙ 251]
Executing a Macro from the Operation Tab [➙ 364]

8.1.18.1 Configuring Report Destination Types

You must configure the following destination types to route report outputs:
- Report output folders to save a file in a specific location
- Contact list of recipients to send an email
- Server printer to send a PDF to print out

NOTE:
Contact lists and server printers are configured outside of the Reports workspace. If no contacts or printers are configured in Desigo CC, the corresponding drop-down lists in Reports are empty.

Related Topics
Creating Email Recipients for Reports in the Address Book [➙ 376]

Configuring a Report Output Folder

1. In System Browser, select Application View.
2. Select Applications > Reports.
3. Click the Settings tab.
4. Click Dialog Launcher.
   - The Report Output Definition dialog box displays.
5. Select File as the Destination Type.
6. Click Configure Folders.
   - The Report Output Folders Configuration dialog box displays.
7. In the **Folder Alias** field, type a name for the **Report Output** folder.

8. Click **Browse** to select a destination folder. To route report documents to a network folder, see the note below.
   - The selected destination path displays in the **Folder Path** field.

9. *(Optional)* In the **Folder Description** field, type the folder description.

10. Click **New**.
   - The output folder is added to the **List of Folders for the Report Output** section.

11. Click **Close**.
   - The configured output folders display in the **File** drop-down list of the **Report Output Definition** dialog box.

**NOTE:**
To route report documents to a network folder, you must do the following:
- Share and map the network folder on the client computer.
- Provide full permissions to Process Monitor User on shared and mapped folder.

### Modifying a Report Output Folder

- In the **Report Output Folders Configuration** dialog box, there is at least one output folder in the **List of Folders for Report Output**.

1. From the list, select an output folder.
   - The **Folder Alias**, **Folder Path**, and **Folder Description** fields are populated with pre-configured data.

2. Modify the fields as necessary.
   **NOTE:** Modifying the **Folder Alias** field adds a new entry in the **List of Folders for Report Output**.

3. Click **Change**.
   - The output folder is modified.

4. Click **Close**.
   - The modified output folders displays in the **File** drop-down list of the **Report Output Definition** dialog box.

### Deleting a Report Output Folder

- In the **Report Output Folders Configuration** dialog box, there is at least one output folder in the **List of Folders for Report Output**.

1. From the list, select an output folder.

2. Click **Delete**.
   - A message will prompt you to confirm your action, and the output folder entry is deleted from the **List of Folders for Report Output**.
8.1.18.2 Configuring a Report Output Definition

A Report Output Definition specifies the file format (PDF, XLS, CSV, or XML) in which the report output can be generated. The XML option is available only if you have the relevant license. The XML format does not contain information that is present in the header and footer section of the report.

By configuring the report output definition, you can also specify the destination (File, Email, or Printer) to which you want to route the report output.

Configuring the File Destination Type

▷ You have configured the report output folders.

1. In System Browser, select Application View.
2. Select Applications > Reports.
3. Click the Settings tab.
4. From the Report Output group box, click Dialog Launcher .
   ➞ The Report Output Definition dialog box displays.
5. Select the required report format (PDF, XLS, CSV, or XML) in the Report format list.
6. Select File in the Destination types list.
7. From the File drop-down list, select the destination folder where you want to save the file.
   ➞ The File drop-down list displays all the report output folders that you have configured.
8. Select Enter custom file name to add the file name. The default option is Use report name as file name.
9. Do one of the following:
   - Select the Append date/time to file name check box to add the date and time to the file name when saved.
   
   **NOTE:** The Create new/overwrite existing file and Append data options become unavailable when you select the Append date/time to file name check box.
   - Select the Append data option button to append data in the same folder but creating new document with incremental number.
   - Select Create new/overwrite existing file to create a new file or overwrite the existing file with the same file name.
10. Click Add.
    ➞ The selected format, destination, and file name are added to the Output Definition list.
11. Click OK.
    ➞ Configured Report Output Definitions display in the Report Output group box.

**NOTE 1:**
When executed (using the Execute button or macros and reactions), the file is created and saved at the configured destination with the name entered in the File Name field.

**NOTE 2:**
In a CSV file, numeric values display in an exponential format.
Related Topics
Configuring a Report Output Folder [➙ 257]

Configuring the Email Destination Type
▷ You have configured the mail server or have verified that it has been configured.
1. In System Browser, select Application View.
2. Select Applications > Reports.
3. Click the Settings tab.
4. From the Report Output group box, click Dialog Launcher.
   ▷ The Report Output Definition dialog box displays.
5. Select the required format (PDF, XLS, or CSV) in the Report format list.
6. Select Email in the Destination types list.
7. Click Select Contacts.
   ▷ The E-Mail Contacts dialog box displays all the configured contacts.
8. Select the required contacts by selecting the check box preceding each contact.
9. Click OK.
   ▷ The selected contacts are displayed in the Destination field in the Report Output Definition dialog box. A semicolon (;) separates multiple contacts.
10. In the Report Output Definition dialog box, do one of the following:
    - Select All documents in one email.
    - Select Document(s) per mail and configure the number of documents to be sent.
      The default option is one document per email.
11. Select the Enter custom file name option to add the file name. The default is Use report name as file name.
12. Select the Append date/time to file name check box to add the date and time to the file name when saved.
13. Click Add.
   ▷ The selected format, destination, and file name are added to the Output Definition list.
14. Click OK.
   ▷ The configured Report Output Definitions display in the Report Output group box.

Configuring the Printer Destination Type
▷ One or more local printers are configured.
1. In System Browser, select Application View.
2. Select Applications > Reports.
3. Click the Settings tab.

5. Select PDF in the Report format list. NOTE: The destination type Printer is not available for XLS or CSV printing.

6. Select Printer in the Destination types list.

7. Select the required printer from Printer drop-down list.

8. Select the option to print either All or First number of pages. NOTE 1: By default, the first 100 pages are printed. You can edit the default and add the number of pages to be printed.

NOTE 2: Content that is printed depends on the sorting you applied on the table.

9. Click Add. The selected format and destination are added to the Output Definition list.

10. Click OK. The configured Report Output Definitions display in the Report Output group box. When executed, the file is sent to the configured printer for printing.

Modifying a Report Output Definition

1. Select an existing Report Output Definition from the Output Definition list of the Report Output Definition dialog box.

2. Modify the Report format, Destination type, and/or Destination. The Change button becomes available.

3. Click Change. The Report Output Definition is modified.

Deleting a Report Output Definition

1. Select a Report Output Definition from the Output Definition list of the Report Output Definition dialog box.

2. Click Delete. The selected Report Output Definition is deleted.

8.1.19 Exporting a Report Definition

1. In System Browser, select Application View.

2. Select Applications > Reports > Report Definitions or the folders containing Report Definitions.

3. Click Export.

4. In the Browse for Folder dialog box, select a destination.

5. Click OK. A confirmation message displays and the Report Definitions or folders are exported to the selected location.
**NOTE 1:**
You can export multiple Report Definitions or multiple folders; however, you cannot export a Report Definition and a folder at the same time.

**NOTE 2:**
If the Report Definitions selected for export contain logo image files, such as .jpg, or .bmp, they are also exported to the selected location.

**NOTE 3:**
If a Report Definition file name contains special characters (such as \, <, >, |), they are replaced with an underscore (_) when the export file is created.

**NOTE 4:**
If the Report Definition has a name filter that contains a wild card in the system name, then the system name are not removed during export. However, if the system name does not contain a wild card character, then during export the system name is removed from the name filter.

---

### 8.1.20 Importing a Report Definition

- You have exported Report Definitions or a folder containing Report Definitions to a specified location.
- You have selected a report folder for importing into System Browser.

1. In System Browser, select **Application View**.
2. Select **Applications > Reports > [Report folder]**.
3. Click **Import**.  
   - The **Open** dialog box displays.
4. Browse for the folder where the exported .xml files or logo files were created and saved after exporting a Report Definition.
   If you import a Report Definition with the same name that already exists under the folder selected for import, the existing Report Definitions with the same names are overwritten.
5. Select single or multiple .xml and any associated logo files (.jpeg, .gif, .png, and so on).
   - Use the **CTRL** key to select multiple files.
   - If you import logo files, these are stored at the default logo storage location: `[drive]\GMSProjects\[project]\data\Reporting\Logos`.
   - If you do not select associated logo files while importing, then the imported Report Definition displays a **No Parking** symbol in place of a logo.
6. Click **Open**.
   - On successful import, the selected Report Definitions are imported in the selected folder in the System Browser.

**NOTE:**
You can import pre-configured Report Definitions and associated logo files under `\GMSMainProject\Data\Reporting`. 
8.1.21 Deleting a Report Definition

▷ At least one Report Definition is available under System Browser > Reports.
1. In System Browser, select Application View.
2. Select Applications > Reports > Report Definitions > [report definition].
3. Click Delete.
   ➔ A confirmation message displays.
4. Click OK.
   ➔ The selected Report Definition is deleted.
   ● If a Report Definition is deleted, but a report snapshot related to this definition exists in the Report Management section, you can do the following:
   ● Display the report data by selecting this report snapshot.
   ● Generate PDF/Excel documents using this snapshot.
   ● Run this report and generate additional snapshots. You can switch back to Edit mode, make changes in the Report Definition, and save and create a new Report Definition at the specified location in System Browser.
   ● Delete the snapshot using the Delete button available in the Report Management section.

8.1.22 Aborting a Running Report Definition

▷ You want to stop a running Report Definition.
1. In System Browser, select Application View.
2. Select Applications > Reports.
3. Click Stop.
   ➔ A report is populated with the data gathered before the report execution was stopped.

NOTE:
You can stop creating a PDF or XLS document in the same way.
8.1.23 Working with Reports and Operators

This section provides information on some of the important reports along with information on their constraints.

8.1.23.1 Configuring an Objects Report

1. Create a new report definition with the objects table inserted.
   - The Objects table is inserted with the following default set of columns—Object Description, Object Designation, Function, Discipline, Type, Subtype, Main Value.

2. Right-click the table and select Select Columns.
   - The Select Columns dialog box displays.

3. In the Type filter field, enter the object type description.
   - The Type drop-down list displays the object types.

4. On the Type drop-down list, select the object type.

5. Click Load.
   - The columns are listed in the Available columns list.

6. Select the property and/or attribute to display as columns in the table.
   - The list of selected columns displays in the Selected Columns list.
   - NOTE: To remove columns that you do not want displayed in the table, click .

7. Click OK.
   - The Objects table displays.

8. Configure a name filter for your report by dragging-and-dropping the required objects from the System Browser to the Objects table in the Report Definition. In order to get the desired results, you must assign the objects for which columns are configured in your report.

9. (Optional) Configure a Condition filter for your report.

10. Right-click the Objects table, point to Filters and select Condition Filter.
    - The Condition Filter dialog box displays.

11. Perform the following steps to apply the Condition filter:
    a. Enter BACnet in the Type filter field to display all BACnet related objects in the Type drop-down list.
    b. Select the BACnet Analog Output Object from the Type drop-down list.
    c. Click the Load button. All the common columns and columns specific to the selected object display in the Available columns list.
    d. Select the column on which you want to add the condition filter. In this case, select [Current_Priority].
    e. Select = in the Operator list.
    f. In the Values text field, enter "Priority - 16".
    g. Click Add.
    h. Click OK.
    - The Condition filter is added to the table.
12. Run the report to view the data.
   ◦ If you have applied the condition filter, the details of all analog output objects with Current Priority set to 16 display. If no Condition filter is specified, then the details of all the analog output objects display.

13. Save the report definition if the configuration of columns and name filter is sufficient.
   **NOTE:** You can enhance the report configuration at any time in the future by adding/removing columns or by setting additional objects as name filter or by removing existing objects from the name filter.

**Related Topics**
Select Columns Dialog Box [➙ 284]
Condition Filter [➙ 293]

### 8.1.23.2 Configuring an Activities Report

1. Create a new Report Definition with the Activities table inserted.
   ◦ The Activities table contains the following default set of columns—Source Time, Object Description, Object Designation, Action, Log Type, Previous Value, Value, Status, User Name, Management Station, Message Text, and Attachment.

2. *(Optional)* Add any extra columns to the table from the Select Columns dialog box. To display this dialog box, right-click the table and select Select Columns.

3. From the System Browser, drag-and-drop the analog input object whose value you want monitored, to the Activities table. This object acts as the name filter.

4. Right-click the Activities table and select Filters > Condition Filter.
   ◦ The Condition Filter dialog box displays.

5. Perform the following steps to apply the condition filter:
   a. Select Value from the Available Columns list.
   b. Select > from the Operators list.
   c. Enter 100 in the Values text field.
   d. Click Add. The expression displays in the Filter Expression field.
   e. Click OK.
   ◦ The Condition filter is added to the table.
   **NOTE:** When you are creating a Condition filter, the syntax of the property values depends on the data type of the property. For more information, see Condition Filter Syntax in Condition Filter.

6. Specify the time period by adding the Time filter to the Report Definition. Perform the following steps to add the Time filter:
   a. Right-click the Activities table, point to Filters and select Time Filter. The Time Filter dialog box displays.
   b. Select the Relative option.
   c. Select the Last or Current Period option, depending on the data requirement for the last 24-hour period or current 24-hour period. For more information regarding setting the time period, see Time Filter. In this example, since data is required for the last 24-hours, you must select Last and specify 24-hours.
   d. Click OK.
7. Run the report to view the data.
   ➢ The report displays the data for analog input object where value is greater than 100 in the last 24-hours.

8. (Optional) Click **Save**.

### 8.1.23.3 Viewing Event Details using Assisted Treatment

➤ You have created and configured an Operating Procedure template.

➤ Ensure that the Operational Status property for the Operating Procedure template is set to **Enabled**.

➤ An Alarm step is added to the Operating Procedure template and an Event Details report is associated with the step. The step is configured as per the required settings.

1. Double-click the event in the Event bar.
   ➢ The Event Details report displays in Assisted Treatment. Information related to the event time, category, cause, ID, object description and designation displays in the report.

2. Click **+** before the event entry.
   ➢ Additional information related to the event such as Time, Action, User Name, Management Station, Attachment, Value, and Previous Value display as child records.

3. Perform the required steps to treat the event from the **Contextual** pane.

4. Click **Send to Output**.
   ➢ The report is routed to the configured destination.

### 8.1.23.4 Viewing Event Details for specific events using Reports

1. Create a new report definition with the Event Details table inserted.
   ➢ The Event Details table is inserted with the following default set of columns — Event Time, Event Category, Event Cause, Event ID, Object Description, and Object Designation.

2. (Optional) Add any extra columns to the parent table from the **Parent** tab in the **Select Columns** dialog box. You can add the extra columns to the child table from the **Child** tab. To display this dialog box, you must right-click the table and select **Select Columns**.

3. From System Browser, drag-and-drop the analog output object (For example, Analog Output 1) whose event details are to be monitored to the Event Details table. This object acts as the name filter.

4. Right-click the **Event Details** table, point to **Filters** and select **Condition Filter**.
   ➢ The **Condition Filter** dialog box displays.

5. Perform the following steps to apply the Condition filter:
   a. From the **Available Columns** list, select **Event Category**.
   b. From the **Operators** list, select **=**.
   c. From the **Values** list, select **Fault**, press **CTRL**, and then select **Life Safety**.
   d. Click **Add**. The expression displays in the **Filter Expression** field.
   e. Click **OK**.

   ➢ The Condition filter is added to the table.
   **NOTE**: When you are creating a Condition filter, the syntax of the property values depends on the data type of the property.
6. Specify the time period by adding the Time filter to the report definition. Perform the following steps to add the Time filter.
   a. Right-click the Event Details table, point to Filters and select Time Filter. The Time Filter dialog box displays.
   b. Select Relative.
   c. Select either the Last or Current Period option, depending on the data requirement for the last 24 hour period or current 24 hour period. For more information regarding setting the time period, see Time Filter. In this case, as we want the data for the current 24-hour period, select Current Period and specify 24 hours.
   d. Click OK

7. Run the report to view the data.
   - The report displays the details of any Fault or Life Safety events that occurred on the Analog Output 1 object in the current 24-hour period.

8. Save the report definition if the data matches your requirements.
   **NOTE**: You can enhance the report configuration at any time in the future by adding/removing columns or by setting additional objects as name filter, removing existing objects from the name filter, or by modifying the Condition filter, Time filter criteria.

### 8.1.23.5 Viewing Event Details using Investigative Treatment

- Ensure that any operating procedure templates are disabled.
- Ensure that a report containing the Event Details table is available and the Show in Related Items checkbox is selected for this report or the HQ_EventDetailsLog report is imported.

1. Double-click the event in the Event bar.
   - The event details display in the Related Items tab.

2. Perform the required steps to treat the event.

3. Select the report containing the Event Details table from the Related Items tab.
   - The report executes in the Secondary pane and the information related to the event time, category, cause, ID, object description, and designation displays in the report.

4. Click + before the event entry.
   - Information related to the event treatment such as Time, Action, User Name, Management Station, Attachment, Value, and Previous Value display as child records.

### 8.1.23.6 Configuring a Trends Plot

- You have created a Trend View Definition with the Analog Input object.

1. Create a new report definition with a Trends Plot inserted.
   - A Trends Plot is inserted in the report definition.

2. From the System Browser, drag-and-drop the Trend View Definition to the Trends Plot. This acts as a name filter to the plot.

3. Specify the time period by adding a Time filter to the plot. Perform the following steps to add the Time filter:
   a. Right-click the Trends Plot, point to Filters and select Time Filter.
   b. In the Time Filter dialog box, select the Relative option.
   c. Select the Last or Current Period option, depending on the data requirement
for the last 10 hours or current 10 hours. In this case, we will obtain the data for the current 10 hours by selecting **Current Period** and specifying 10 hours.

d. Click **OK**.

4. Run the report to view the data.

   ⊳ The report displays the graphical representation of the data for the current 10 hour period.

5. Save the report definition.

   **NOTE**: You can enhance the report configuration at any time, in the future, by changing the Name and Time filters.

### 8.1.23.7 Working with the In Operator

▶ A generated Objects report displays.

1. From the **Select Columns** dialog box select the **Related Items Type** column.

   ⊳ The Objects report displays with the **Related Items Type** column added to it.

2. Perform the following steps to add a Condition filter with the In operator:

   a) From the **Condition Filter** dialog box, select **Related Items Type** in the **Available Columns** list.

   b) Select **In (→)** from the **Operators** list.

   c) In the **Values** text field, type **Graphics**.

   d) Click **Add**.

   ⊳ The Condition filter is added to the table and displays in the **Filter Expression** field below the **Add** button.

3. Click **OK**.

4. Run the report.

   ⊳ The generated report displays the data for only those objects that have a graphic linked to them.

### 8.2 Reports Reference

The main function of the Reports application in Desigo CC is to collect data from the runtime system and allow you to present this data in a customized manner. This section provides the general reference information on Reports. For procedures on creating and configuring reports, see Working with Reports [➙ 233].
8.2.1 Overview of Reports

A report is a formatted and organized presentation of data. The Reports application lets you configure and produce a variety of reports on the functioning of the management platform.

To compose a report, you configure a Report Definition that specifies:

- The elements that you want to include in the report, such as tables, plots, logos, form controls or text, and their layout.
- Appropriate filters: Name, Condition, Time, and/or Row to populate the elements of the report with information. For example, if you want a report on a room's activity data over the past month, you could define a Name filter as well as Time filter in an activities table.
- The formatting you want to apply to the report elements, and the page layout.

You can also configure a Report Output Definition to specify the type of output (PDF or XLS), and the output destination (file, email, or printer).

Once you configure a Report Definition, you can save it for later use, run it, or schedule the report to be run at a specified time.

You can use reports as a reference or as a troubleshooting mechanism. Reports are helpful during system operation. For example, you can:

- View a mixed report containing:
  - A table displaying details of all active events for a floor of a building
  - A table displaying a history report of events
  - A trends plot displaying the temperature variations gathered from temperature sensors
- Export trend data for statistical analysis to:
  - An XLS file
  - A CSV file (according to the EMC requirement)
- Schedule production of a report using macros and reactions
- Send a report to someone using email, to a printer as a .pdf, or to a folder as a file

You can also export and import Report Definitions and logos.

Pre-configured Report Definitions and associated logo files are available at:

`...\GMSProjects\GMSMainProject\Data\Reporting`

**NOTE:**

You cannot use trend plots and trend tables in reports for operating procedures, because these elements do not display any data when the report is executed from Assisted Treatment.

The Reports application is covered by the Report Editing and Report Viewing licenses. Following is the list of activities that you can or cannot perform depending on the license type:
### Reports for Operating Procedures

Reports configured in operating procedure steps allow you to view and enter Event Treatment related information when executed for a selected event from Assisted Treatment. In addition to the existing reporting elements, you can add form controls to these reports. You create and configure a report for operating procedure steps in the same way as you would create and configure any report. When executed in the context of the selected event, the report displays the event treatment related information and allows you to enter information in the form controls.

**NOTE:**
You cannot use trend plots and trend tables in reports for operating procedures as these elements do not display any data when the report is executed from Assisted Treatment.

You can enter information in the following scenarios:

- The event is treated for the first time; the operating procedure step is configured as repeatable and is in progress.
- You re-select the same event, for a repeatable step that is not yet complete.

If you re-select the same event with a non-repeatable step that is complete, you cannot perform activities such as editing information, sorting entries in tables, or resizing columns. You can only view and route the information to a file, email, or printer as configured in the report definition.

Information entered in the form controls can be viewed by users on different client computers for the same step in the same event. However, it can be edited only if the step is configured to be repeatable.

**Related Topics**
Executing a Report Step in Assisted Treatment [➔ 79]

### 8.2.2 Reports in Distributed Systems

When working with reports in a distributed environment, you must understand the details of the following additions, modifications, and applicable conditions.

**Additions**

- **System Name** column - This column displays the name of the system to which the source object belongs. It must be added to the Report Definition using the **Select Columns** dialog box.
- **System Name** keyword - A keyword **System Name** displays the name of the system on which the current report is located.
Modifications

- **View-Specific Columns** - The column names of the view-specific columns such as Object Designation or Object Location in a distributed system depend on the presence of the views in a single system or multiple systems. Consider the following examples in which three systems are configured in a distributed system (System 1, System 2, and System 3).
  - A User-Defined View (UserView1) is present in System 1. In this case, the name of the Object Designation column will be Object Designation [System1.UserView1].
  - A User-Defined View (UserView1) is present in System 1 and System 2. A second User-Defined View (UserView2) is present in System 3. In this case, the name of the Object Designation column will be Object Designation [MultiSystem.UserView1] and Object Designation [System 3/UserView2].

- **Format for Name filter** - When Activities, Events, Active Events, BACnet Alarm Summary, BACnet Enrollment Summary, BACnet Event Information, or an Objects table are inserted in the Report Definition, a valid Name filter “CurrentSystemName.*:*” is added by default, where CurrentSystemName is the name of the system in which report definition is created or opened. This default Name filter can be replaced with a “*” to retrieve the data from all the views of all the configured systems in a distributed environment. You can add Name filters from the Name Filter dialog box.

- **Using Wildcard Characters in Name Filters** - To display the details of all the Analog Output objects of all system devices present in all the configured systems in a distributed environment, specify the following Name filter in the report definition, “*.ManagementView:ManagementView.FieldNetworks.*.AO*”. When you run the report, the details of all the Analog Output objects belonging to all the devices in all the systems configured in a distributed environment will display.

Conditions

- **Object Models of Current System Displayed** - The **Type** drop down list in the **Select Columns** dialog box and **Condition Filter** dialog box for the Objects table only displays the object models of the current system on which the report is configured.

- **Objects Report Configuration** – An Objects report needs to be configured on the system where the required sub system is installed. You can run this report on any other system by using export and import functionality of Reports. However, any changes to this report must be done in the system on which it was originally configured.

- **System-Specific Default Template** - The default report template will be specific to the system on which it is created.

- **Show in Related Items Reports** - In case of a distributed environment, the display of the Show in Related Items Reports in the Related Items tab depends on the following scenarios. For both these scenarios, we assume that there are two systems, System 1 and System 2 configured for the distributed environment.
  
  **Scenario 1:**
  If you select one or more than one object from System 1, only the Show in Related Items Reports of System 1 will display in the Related Items tab.
  Inversely, if you select one or more than one object from System 2, only the Show in Related Items Reports of System 2 will display in the Related Items tab.
  
  **Scenario 2:**
  If you select a combination of objects from both System 1 and System 2, then the Show in Related Items Reports associated with either of the systems will not display in the Related Items tab.
### 8.2.3 Reports Workspace

This section gives an overview of the Reports workspace.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 System Browser</td>
<td>Displays all the saved Report Definitions in Application View &gt; Applications &gt; Reports.</td>
</tr>
<tr>
<td>2 Reports Toolbar</td>
<td>Contains icons for performing various actions in Reports. Reports toolbar for operating procedures - Displays only when the report is executed for a selected event from Assisted Treatment. Contains icons for saving user input and routing information.</td>
</tr>
<tr>
<td>3 Reports Ribbon</td>
<td>Contains several tabs and group boxes to help you define a Report Definition. The tabs available on the ribbon are: Home, Filter, Layout, Data, and Settings. NOTE: The Reports ribbon is only visible when you create a new Report Definition or select an existing one.</td>
</tr>
<tr>
<td>4 Report Definition</td>
<td>Displays the following: Edit mode: Workspace where you configure a Report Definition. Run mode: Workspace where you view an executed report.</td>
</tr>
<tr>
<td>5 Report Management Section</td>
<td>Displays a report snapshot and documents for the executed reports. NOTE: This section does not display when the report is executed for a selected event from Assisted Treatment.</td>
</tr>
<tr>
<td>6 Extended Operation Tab</td>
<td>Displays the properties of the selected Report Definition. The Execute button allows you to run a Report Definition. NOTE: You must configure a Report Output Definition for the selected Report Definition.</td>
</tr>
<tr>
<td>7 Related Items Tab</td>
<td>Displays the following: New Report: Opens a new Report Definition for configuration. Related Report: Displays the names of the reports related to the selected System Browser object. Show-in-Related Items Report: Displays the name of the reports that has the Show In Related Items check box selected.</td>
</tr>
</tbody>
</table>
### 8.2.4 Reports Toolbar

The Reports toolbar contains icons that help you perform reporting operations quickly. This toolbar is present in both Edit mode and Run mode.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Opens a sub-menu where you can select: New Report and New Folder.</td>
</tr>
<tr>
<td>Delete</td>
<td>Removes the current Report Definition or Report folder and deletes its entire configuration from System Browser.</td>
</tr>
<tr>
<td>Save</td>
<td>Saves the configuration of the currently selected Report Definition or saves a newly created and configured Report Definition. <strong>NOTE:</strong> This command is dimmed until you modify the current Report Definition.</td>
</tr>
<tr>
<td>Save As</td>
<td>Saves the configuration of the currently selected Report Definition as a new Report Definition, or saves a newly created and configured Report Definition.</td>
</tr>
<tr>
<td>Save as Default</td>
<td>Saves the selected Report Definition as the default report template.</td>
</tr>
<tr>
<td>Properties</td>
<td>Shows or hides the Reports ribbon in Edit mode.</td>
</tr>
<tr>
<td>Run</td>
<td>Auto-closes Edit mode and executes the current Report Definition in Run mode. <strong>NOTE:</strong> You can run up to five reports simultaneously; an error message displays for any subsequent clicks of the Run or Run As icon.</td>
</tr>
<tr>
<td>Run As</td>
<td>Opens a sub-menu where you can select a language from a list of languages supported in Desigo CC. Languages currently supported for report execution are: en-US, fr-CA.</td>
</tr>
<tr>
<td>Stop</td>
<td>Stops report execution of the selected Report. This command is available only while the report is running. <strong>NOTE:</strong> You can also stop the report execution using the Stop button that becomes available in the Report Management section while the report is running.</td>
</tr>
<tr>
<td>Edit</td>
<td>Opens the Report Definition in Edit mode. In this mode you can design the layout of a report. This command is available only in Run mode.</td>
</tr>
<tr>
<td>Create and view PDF</td>
<td>Starts creating PDF document for the current Report snapshot. The maximum number of pages in one PDF document is 500. When the number of pages exceeds 500, the PDF document splits into two. This process goes on until all the data in that specific report snapshot is moved to the document. The PDF creation progress for all the split PDF documents displays under the same Report snapshot in the Report Management section. When successfully created, the PDF displays in Adobe Reader in Reports. This command is available only in Run mode.</td>
</tr>
<tr>
<td>Create and view Excel</td>
<td>Starts creating Excel document for the current Report snapshot. The maximum number of rows in an Excel document is 1,048,575 (Excel limit). When the number of rows exceeds this limit, the Excel document splits into two. The process of the Excel creation for all the split Excel documents displays under the same Report snapshot in the Report Management section. When successfully created, the Excel document displays in MS Excel in Reports. This command is available only in Run mode.</td>
</tr>
<tr>
<td>Report Management</td>
<td>Shows or hides the Report Management section.</td>
</tr>
<tr>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Export</td>
<td>Exports the Report Definitions as an .xml file to a selected location.</td>
</tr>
<tr>
<td>Import</td>
<td>Imports the Report Definitions and logos.</td>
</tr>
<tr>
<td>Save PDF as</td>
<td>Saves the PDF report output.</td>
</tr>
<tr>
<td>ZoomIn (+10%)</td>
<td>Allows you to zoom in the view of the PDF document by +10% with each mouse click.</td>
</tr>
<tr>
<td>ZoomOut (-10%)</td>
<td>Allows you to zoom out the view of the PDF document by -10% with each mouse click.</td>
</tr>
<tr>
<td>Print</td>
<td>Prints the PDF document.</td>
</tr>
</tbody>
</table>

**Reports Toolbar For Operating Procedures**

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save User Input</td>
<td>Saves the Event Treatment related information you entered in the report for operating procedures, when it is executed for a selected event from Assisted Treatment. You can view the saved information if you re-select the same step in the same event. Additionally, users on other client computers can also view this information for the same step in the same event. If you move to another step or event or exit the current step without saving the information, a save confirmation message displays. <strong>NOTE</strong>: This command is available only if the report contains form controls.</td>
<td></td>
</tr>
<tr>
<td>Send to Output</td>
<td>Routes the report for operating procedures to a file, email, or printer according to the Report Output configuration settings. <strong>NOTE</strong>: If you have not specified the report output configuration settings, the information is routed to the path specified in the location supervised folder in System Browser: Management View &gt; Management System &gt; Servers &gt; Main Server &gt; Report Manager &gt; Report Default Folder.</td>
<td></td>
</tr>
</tbody>
</table>
8.2.5 Reports Ribbon — Home Tab

The Home tab is the main tab of the Reports ribbon.

8.2.5.1 Insert Group Box

Table Group Box

Tables in a Report Definition can contain a huge number of records which cannot be viewed at the same time.

It is recommended that you have a maximum of ten tables in a single report. If you need more than ten tables, you must create multiple reports.

Reporting incorporates a paging mechanism that optimizes the number of records that display in a table. The configured height of a table in the Layout tab determines the number of records that display.

The Table group box contains the following different tables.
### Table Summary

<table>
<thead>
<tr>
<th>Table Type</th>
<th>Default Columns</th>
<th>Additional Columns</th>
<th>Support/Limitations</th>
</tr>
</thead>
</table>
| Objects Table and its extensions: Schedule and Related Items | - Default columns displayed are:  
  - Object Description  
  - Object Designation  
  - Function  
  - Discipline  
  - Subdiscipline  
  - Type  
  - Subtype  
  - Main Value  
- Columns specific to scheduling objects are:  
  - Weekly schedule  
  - Exceptions  
  - Commanded objects  
  - Effective Period | - Supports the following additional columns  
  - Alias  
  - Default Property  
  - Object Designation [Application View]  
  - Object Designation [Current View]  
  - Object Designation [Management View]  
  - Object Identifier [Internal]  
  - Object Location  
  - Object Location [Application View]  
  - Object Location [Current View]  
  - Object Location [Management View] | - Does not support the Time filter  
- The values of filters applied on the Alias column are case sensitive. |
| | - Columns specific to Related Items objects are:  
  - Related Items  
  - Related Items Type |  |  |

For more information on the Objects table and its configurations, see Objects Report.
<table>
<thead>
<tr>
<th>Active Events</th>
<th>Supports the following additional columns</th>
<th>Does not support the Time filter</th>
</tr>
</thead>
<tbody>
<tr>
<td>- Category</td>
<td>- Alias</td>
<td>- The values of filters applied on the Alias column are case sensitive.</td>
</tr>
<tr>
<td>- Cause</td>
<td>- Available Commands</td>
<td></td>
</tr>
<tr>
<td>- State</td>
<td>- Customer Text</td>
<td></td>
</tr>
<tr>
<td>- Object</td>
<td>- Event ID</td>
<td></td>
</tr>
<tr>
<td>Designation</td>
<td>- In process by</td>
<td></td>
</tr>
<tr>
<td>- Object</td>
<td>- Intervention Text</td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td>- Is Maintenance</td>
<td></td>
</tr>
<tr>
<td>- Discipline</td>
<td>- Location</td>
<td></td>
</tr>
<tr>
<td>- Subdiscipline</td>
<td>Name</td>
<td></td>
</tr>
<tr>
<td>- Creation Date</td>
<td>Object Designation</td>
<td></td>
</tr>
<tr>
<td>Time</td>
<td>[Application View]</td>
<td></td>
</tr>
<tr>
<td>- Object Property</td>
<td>- Object Designation</td>
<td></td>
</tr>
<tr>
<td>- Source Status</td>
<td>[Current View]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>[Management View]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>[Application View]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>[Current View]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>[Application View]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>[Current View]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>[Application View]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>[Current View]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>[Application View]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>[Current View]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>[Application View]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>[Current View]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>[Application View]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>[Current View]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>[Application View]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>[Current View]</td>
<td></td>
</tr>
<tr>
<td>Activities</td>
<td>Supports the following additional columns</td>
<td></td>
</tr>
<tr>
<td>------------</td>
<td>-------------------------------------------</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Alias [Associated Object]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Alias [Object]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Associated Object Description</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Associated Object Designation</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Associated Object Location</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Associated Object Name</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Associated Object Name [Internal]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Discipline</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- DPEName 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- DPEName 2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Error</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Object Designation</td>
<td></td>
</tr>
<tr>
<td></td>
<td>[Application View]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Object Designation</td>
<td></td>
</tr>
<tr>
<td></td>
<td>[Current View]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Object Designation</td>
<td></td>
</tr>
<tr>
<td></td>
<td>[Management View]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Object Identifier</td>
<td></td>
</tr>
<tr>
<td></td>
<td>[Internal]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Object Location</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Object Location</td>
<td></td>
</tr>
<tr>
<td></td>
<td>[Application View]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Object Location</td>
<td></td>
</tr>
<tr>
<td></td>
<td>[Current View]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Object Location</td>
<td></td>
</tr>
<tr>
<td></td>
<td>[Management View]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Object Name</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Object Property</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Previous Quality</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Quality</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Subdiscipline</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Subtype</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Type</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Unit</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- System Name</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Validation Profile</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Audit Trail</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Object Version</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Comment</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Reference Time</td>
<td></td>
</tr>
</tbody>
</table>

- Supports: Name, Condition, Time, and Row filter.

For more information on the Activities table, its constraints, and configurations, see Activities Report.
| Events | • Event Time  
|• Event State  
|• Event Category  
|• Event Cause  
|• Event ID  
|• Object Description  
|• Object Designation  
|• User Name  

| • Supports the following additional columns  
| - Alias [Object]  
| - Alias [Observer]  
| - Discipline  
| - DPEObserver  
| - Event Message Text  
| - Event Mode  
| - Event Source  
| - Event Value  
| - Event Went  
| - Event Details  
| - Category Priority  
| - Object Designation  
| [Application View]  
| - Object Designation  
| [Current View]  
| - Object Designation  
| [Management View]  
| - Object Identifier  
| [Internal]  
| - Object Location  
| - Object Location  
| [Application View]  
| - Object Location  
| [Current View]  
| - Object Location  
| [Management View]  
| - Object Name  
| - Object Property  
| - Observer Description  
| - Observer Designation  
| - Observer Location  
| - Observer Name  
| - Observer Identifier  
| [Internal]  
| - Subdiscipline  
| - Subtype  
| - Transition Time  
| - Type  
| - Unit  
| - Went Text  
| - System Name  
| - Validation Profile  
| - Object Version | • Supports: Name, Condition, Time, and Row filter.  
• For more information on the Events table and its constraints, see Events Report.  
• The values of filters applied on the Alias [Object] column are case sensitive. |
<table>
<thead>
<tr>
<th>Event Details</th>
<th>Default columns displayed in the Parent table are:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>- Event Time</td>
</tr>
<tr>
<td></td>
<td>- Event Category</td>
</tr>
<tr>
<td></td>
<td>- Event Cause</td>
</tr>
<tr>
<td></td>
<td>- Event ID</td>
</tr>
<tr>
<td></td>
<td>- Object Description</td>
</tr>
<tr>
<td></td>
<td>- Object Designation</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Event Details</th>
<th>Supports the following additional columns</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>- Alias [Object]</td>
</tr>
<tr>
<td></td>
<td>- Alias [Observer]</td>
</tr>
<tr>
<td></td>
<td>- Discipline</td>
</tr>
<tr>
<td></td>
<td>- DPEObserver</td>
</tr>
<tr>
<td></td>
<td>- Event Message Text</td>
</tr>
<tr>
<td></td>
<td>- Event Mode</td>
</tr>
<tr>
<td></td>
<td>- Event Source</td>
</tr>
<tr>
<td></td>
<td>- Event Value</td>
</tr>
<tr>
<td></td>
<td>- Event Want</td>
</tr>
<tr>
<td></td>
<td>- Event Details</td>
</tr>
<tr>
<td></td>
<td>- Category Priority</td>
</tr>
<tr>
<td></td>
<td>- Object Designation</td>
</tr>
<tr>
<td></td>
<td>[Application View]</td>
</tr>
<tr>
<td></td>
<td>- Object Designation</td>
</tr>
<tr>
<td></td>
<td>[Current View]</td>
</tr>
<tr>
<td></td>
<td>- Object Designation</td>
</tr>
<tr>
<td></td>
<td>[Management View]</td>
</tr>
<tr>
<td></td>
<td>- Object Identifier [Internal]</td>
</tr>
<tr>
<td></td>
<td>- Object Location</td>
</tr>
<tr>
<td></td>
<td>- Object Location</td>
</tr>
<tr>
<td></td>
<td>[Application View]</td>
</tr>
<tr>
<td></td>
<td>- Object Location</td>
</tr>
<tr>
<td></td>
<td>[Current View]</td>
</tr>
<tr>
<td></td>
<td>- Object Location</td>
</tr>
<tr>
<td></td>
<td>[Management View]</td>
</tr>
<tr>
<td></td>
<td>- Object Name</td>
</tr>
<tr>
<td></td>
<td>- Object Property</td>
</tr>
<tr>
<td></td>
<td>- Observer Description</td>
</tr>
<tr>
<td></td>
<td>- Observer Designation</td>
</tr>
<tr>
<td></td>
<td>- Observer Location</td>
</tr>
<tr>
<td></td>
<td>- Observer Name</td>
</tr>
<tr>
<td></td>
<td>- Observer Identifier [Internal]</td>
</tr>
<tr>
<td></td>
<td>- Subdiscipline</td>
</tr>
<tr>
<td></td>
<td>- Subtype</td>
</tr>
<tr>
<td></td>
<td>- Type</td>
</tr>
<tr>
<td></td>
<td>- System Name</td>
</tr>
<tr>
<td></td>
<td>- Validation Profile</td>
</tr>
<tr>
<td></td>
<td>- Object Version</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Event Details</th>
<th>Supports: Name, Condition, Time, and Row filter.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Supports child records.</td>
</tr>
<tr>
<td></td>
<td>Child rows show data of the system related to the event. These are:</td>
</tr>
<tr>
<td></td>
<td>- State transitions of the corresponding event.</td>
</tr>
<tr>
<td></td>
<td>- Activity Log data related to the point which caused the event.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Event Details</th>
<th>The following are the columns of a child (nested) table:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>- Time Value</td>
</tr>
<tr>
<td></td>
<td>- Previous Value</td>
</tr>
<tr>
<td></td>
<td>- User Name</td>
</tr>
<tr>
<td></td>
<td>- Management Station</td>
</tr>
<tr>
<td></td>
<td>- Action</td>
</tr>
<tr>
<td></td>
<td>- Attachment</td>
</tr>
<tr>
<td></td>
<td>- Object Property</td>
</tr>
<tr>
<td></td>
<td>- Unit</td>
</tr>
<tr>
<td></td>
<td>- Validation Profile</td>
</tr>
<tr>
<td></td>
<td>- Audit Trail</td>
</tr>
<tr>
<td></td>
<td>- Object Version</td>
</tr>
<tr>
<td></td>
<td>- Comment</td>
</tr>
<tr>
<td></td>
<td>- Reference Time</td>
</tr>
<tr>
<td></td>
<td>- Event Details</td>
</tr>
<tr>
<td></td>
<td>- Category Priority</td>
</tr>
</tbody>
</table>

**NOTE:** These columns are added to the table in Run mode. In Edit mode, they are not visible, but can be selected or removed by clicking the Child tab in the Select Column dialog box.

<table>
<thead>
<tr>
<th>Event Details</th>
<th>The values of filters applied on the Alias [Object] column are case sensitive.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Event Details</th>
<th>For more information on the Event Details table, its constraints, and configurations, see Event Details Report.</th>
</tr>
</thead>
<tbody>
<tr>
<td>BACnet Event Information</td>
<td>Supports the following additional columns:</td>
</tr>
<tr>
<td>--------------------------</td>
<td>---------------------------------------------</td>
</tr>
<tr>
<td>Event Stamp Fault</td>
<td>- Event Stamp Off-Normal</td>
</tr>
<tr>
<td>Event Enable</td>
<td>- Event Stamp Normal</td>
</tr>
<tr>
<td>Acked Transitions</td>
<td>- Event Priority Off-Normal</td>
</tr>
<tr>
<td>Device Description</td>
<td>- Notify Type</td>
</tr>
<tr>
<td></td>
<td>- Alarm State</td>
</tr>
<tr>
<td></td>
<td>- Object ID</td>
</tr>
<tr>
<td></td>
<td>- Event Priority Normal</td>
</tr>
<tr>
<td></td>
<td>- Event Priority Fault</td>
</tr>
<tr>
<td></td>
<td>- Event Priority Off-Fault</td>
</tr>
<tr>
<td></td>
<td>- Event Enable</td>
</tr>
<tr>
<td></td>
<td>- Device Description</td>
</tr>
<tr>
<td></td>
<td>- Device Designation</td>
</tr>
<tr>
<td></td>
<td>- Device Designation [Application View]</td>
</tr>
<tr>
<td></td>
<td>- Device Designation [Current View]</td>
</tr>
<tr>
<td></td>
<td>- Device Designation [Management View]</td>
</tr>
<tr>
<td></td>
<td>- Device Identifier [Internal]</td>
</tr>
<tr>
<td></td>
<td>- Device Location</td>
</tr>
<tr>
<td></td>
<td>- Device Location [Application View]</td>
</tr>
<tr>
<td></td>
<td>- Device Location [Current View]</td>
</tr>
<tr>
<td></td>
<td>- Device Location [Management View]</td>
</tr>
<tr>
<td></td>
<td>- Device Name</td>
</tr>
<tr>
<td></td>
<td>- System Name</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>BACnet Alarm Summary</th>
<th>Supports the following additional columns:</th>
<th>Supports only the Name (on devices only) and Row filter.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acked Transitions</td>
<td>- Alias [Device]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Device Designation</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Device Designation [Application View]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Device Designation [Current View]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Device Designation [Management View]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Device Identifier [Internal]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Device Location</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Device Location [Application View]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Device Location [Current View]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Device Location [Management View]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Device Name</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- System Name</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>BACnet Enrollment Summary</th>
<th>Supports the following additional columns:</th>
<th>Supports only the Name (on devices only) and Row filter.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notification Class</td>
<td>- Alias [Device]</td>
<td></td>
</tr>
<tr>
<td>Object Id</td>
<td>- Device Designation</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Device Designation [Application View]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Device Designation [Current View]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Device Designation [Management View]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Device Identifier [Internal]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Device Location</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Device Location [Application View]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Device Location [Current View]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Device Location [Management View]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Device Name</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- System Name</td>
<td></td>
</tr>
<tr>
<td>Trends</td>
<td>All Logs</td>
<td></td>
</tr>
<tr>
<td>----------------</td>
<td>-----------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>● DateTime</td>
<td>● Event Category</td>
<td></td>
</tr>
<tr>
<td>● Value</td>
<td>● Log Type</td>
<td></td>
</tr>
<tr>
<td>● Unit</td>
<td>● Event ID</td>
<td></td>
</tr>
<tr>
<td>● Quality</td>
<td>● Event Time</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● Previous Value</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● Event Message Text</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● Quality</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● Date/Time</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● Record Type</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● Event Cause</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● Event State</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● Previous Quality</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● Source Description</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● Action</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● Source Property</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● Value</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● Unit</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Supports the following additional columns</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Validation Profile</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Object Version</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Supports the Name filter, Condition filter, Time filter, and Row filter.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>However, the Condition filter is not supported on the Object Version and Validation Profile columns.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Does not support multiple Name filters.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Sorting is possible only on the DateTime column.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The information on the alias of an object (if present) displays above the column headings</td>
<td></td>
</tr>
<tr>
<td></td>
<td>(Present Value, Unit, and Quality) and appears next to the object hierarchy.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Supports the following additional columns</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Action Details</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Action Result</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Alert ID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Alias [Observer]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Alias [Source]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Attachment</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Discipline</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Event Mode</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Event Details</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Category Priority</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Management Station</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Observer Description</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Observer Designation</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Observer Name</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Observer Identifier</td>
<td></td>
</tr>
<tr>
<td></td>
<td>[Internal]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Observer Property</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Source Designation</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Source Designation</td>
<td></td>
</tr>
<tr>
<td></td>
<td>[Application View]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Source Designation [Current View]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>[Management View]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Source Identifier [Internal]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Source Location</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Source Location</td>
<td></td>
</tr>
<tr>
<td></td>
<td>[Application View]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Source Location [Current View]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>[Management View]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Source Location [Current View]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Source Name</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Subdiscipline</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Subtype</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Type</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- User</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- System Name</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Validation Profile</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Audit Trail</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Object Version</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Comment</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Reference Time</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Supports the Name filter, Condition filter, Time filter, and Row filter.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>For more information on the All Logs table and its constraints, see All Logs Report.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The values of filters applied on the Alias [Source] column are case sensitive.</td>
<td></td>
</tr>
</tbody>
</table>
### Orphans

- Orphan Type
- Object Identifier
- Object Location
- Object Property

- Supports the following additional columns
  - Object Designation
  - System Name

- Condition filter on the Orphan Type column is mandatory. You will not be able to retrieve data, if you do not apply the condition filter.
- This table displays only if you have enabled the View Orphan Logs application right from the Security node in the Management View.

### Orphan Activities

- Source Time
- Object Identifier
- Object Designation
- Object Property
- Log Type
- Action
- Status
- Previous Value Text
- Value Text
- User Name
- Management Station
- Message Text

- Supports the following additional columns
  - Attachment
  - Audit Trail
  - Comment
  - Error
  - Object Location
  - Object Version
  - Previous Quality
  - Quality
  - Reference Time
  - System Name

- Supports: Condition, Time, and Row filter.
- Condition filter on the Object Identifier column is mandatory.
- This table displays only if you have enabled the View Orphan Logs application right from the Security node in the Management View.

### Orphan Events

- Event Time
- Object Identifier
- Event State
- Event Category
- Event Cause
- Event ID
- Object Designation
- Object Property
- User Name

- Supports the following additional columns
  - Category Priority
  - Event Details
  - Event Message Text
  - Event Mode
  - Event Source
  - Event Value
  - Event Went
  - Object Location
  - System Name
  - Transition Time
  - Went Text

- Supports: Condition, Time, and Row filter.
- Condition filter on the Object Identifier column is mandatory.
- This table displays only if you have enabled the View Orphan Logs application right from the Security node in the Management View.

### Orphan Trends

- DateTime
- Value
- Object Identifier
- Quality
- Object Location

- Supports the following additional columns
  - Object Designation
  - System Name

- Supports: Condition, Time, and Row filter.
- Condition filter on the Object Identifier column is mandatory to fetch records of deleted trend log objects and trend log multiple objects.
- This table displays only if you have enabled the View Orphan Logs application right from the Security node in the Management View.

## Sorting

Sorting allows you to arrange data in a table in the ascending or descending order. Sorting priority depends on the order in which the column headers are clicked.

Sorting more than one column can be done by holding the **CTRL** key and then selecting multiple columns. The columns are prioritized in the order they have been clicked.
clicked. A number (starting with 1) on the column header indicates the sorting priority. For example, Source time (1), Date (2), Discipline (3), and so on. You can sort the table columns in **Edit** mode as well as in **Run** mode. If you sort the table columns in **Edit** mode, then the sorted data displays in **Run** mode according to the sort criteria specified in **Edit** mode. When sorting is applied on an executed report, data in the current snapshot is sorted.

**NOTE:**
Sorting is unavailable during report execution. Sorting is re-enabled once report execution is complete or you stop a report execution.

### Select Columns Dialog Box

You can add, remove, or reorder columns in a table using the **Select Columns** dialog box.

<table>
<thead>
<tr>
<th>Select Columns Dialog Box Components</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parent tab</td>
<td>Allows you to add, remove, or reorder Parent columns in the table.</td>
</tr>
<tr>
<td>Object Type</td>
<td>(Displays only for a Point table) Lists the object collection. When an object is selected in the <strong>Object Type</strong> drop-down list, all the associated properties are listed in the Available Columns list.</td>
</tr>
<tr>
<td>Type filter</td>
<td>(Displays only for an Objects table) Allows you to enter the object type description on which you want to filter the object types to be displayed in the <strong>Type</strong> drop-down list. For example, if you want the <strong>Type</strong> drop-down list to display all BACnet object types, enter BACnet as the type filter.</td>
</tr>
<tr>
<td>Type</td>
<td>(Displays only for an Objects table) Displays the list of object types available in the system. You must select the object type whose columns are to be displayed in the <strong>Available columns</strong> field. <strong>NOTE:</strong> In case of a distributed system, the <strong>Type</strong> drop down list displays the Object Models of only the current system on which the report is configured.</td>
</tr>
<tr>
<td>Load</td>
<td>(Displays only for an Objects table) Click this button to populate the <strong>Available columns</strong> list with the columns corresponding to the selected object type in the <strong>Type</strong> list.</td>
</tr>
<tr>
<td>Available columns</td>
<td>Displays the following information:</td>
</tr>
<tr>
<td>-------------------</td>
<td>------------------------------------</td>
</tr>
<tr>
<td></td>
<td>- Common columns applicable to any type of object. These are listed at the top of the list. For example, Discipline, Object Name, Object Description, and so on.</td>
</tr>
<tr>
<td></td>
<td>- Columns referring to properties supported by the selected object type. These are listed after the common columns and have a tree structure. When you click any such column, the tree expands and displays the attributes of the property. For example, if you click the expander of the Current_Priority property, its attributes such as Archive, Activity Log, Min, Max, Default, and so on display.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE</strong>: View-specific columns such as Source Location and Source Designation are dynamically added to the Available columns list when you create a new view.</td>
</tr>
<tr>
<td>Selected Columns</td>
<td>Displays the mandatory columns of a selected table. You can add columns to the selected columns list by selecting the check box associated with each column in the Available Columns list.</td>
</tr>
<tr>
<td>Select Default</td>
<td>Selects the default columns in the Available Columns list.</td>
</tr>
<tr>
<td>Clear All</td>
<td>Unchecks all columns except mandatory columns. The Selected Columns list displays only mandatory columns.</td>
</tr>
<tr>
<td>Move Up</td>
<td>Moves the selected column one step up in the Selected Columns list. The Move Up button is unavailable if you select the column on the top.</td>
</tr>
<tr>
<td>Move Down</td>
<td>Moves the selected column one step down in the Selected Columns list. The Move Down button is unavailable if you select the column at bottom.</td>
</tr>
<tr>
<td>Remove</td>
<td>Removes the selected column from the Selected Columns list.</td>
</tr>
</tbody>
</table>

**NOTE:**
You can add, reorder, and delete child records using the Child tab. The tab becomes available when you insert the Event Details table.

**Plot Group Box**
A plot displays data in a graphical view. The Plot group box contains different graphic elements from different data sources such as Trends and Graphics.

**Graphics Plot**
You can drag-and-drop any graphics definition or manual view port from System Browser onto a Report Definition to insert a graphics plot. This inserts a placeholder graphics plot and sets the Name filter to the dragged and dropped object.
When you execute a report containing a graphics plot, it displays the graphic image associated with the dragged and dropped object. If the object is not present in any of the graphics definitions, then an error message displays in the report management section.
Applicable filters: Name filter

**Trends Plot**
You can drag-and-drop a Trend View Definition from System Browser onto a Report Definition to insert a trends plot. The system behaves the same way as when inserting a graphics plot. For more information on the Trends Plot and its configuration, see Trends Plot.
Applicable filters: Name and Time
See also Inserting a Plot
Textgroup Box
Displays a label that you can add to a Report Definition. You can insert labels (Blank, Page, and Report) in the header/footer section or anywhere in the Report Definition. Using labels, you can type text to be displayed in the Report Definition or insert keywords. By default the labels display all the languages configured in the system.

Keyword Group Box
Keywords are pre-defined templates that can be added anywhere in a Report Definition. They are replaced with actual data in Run mode and when the report document (PDF, XLS) is created.

There are two types of keywords:
- Content-specific, which can be inserted only above tables/plots
- Generic, which can be inserted anywhere including the header and footer of the Report Definition

For example, you can add the Date keyword in the Report Definition header to display the date on which the report is executed.

The following keywords are supported by Reports:

<table>
<thead>
<tr>
<th>Content-specific Keyword</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content Type</td>
<td>Displays the name of the content provider – Alarm, Log, Reference, Objects, and Graphics.</td>
</tr>
<tr>
<td>Name Filter</td>
<td>Displays the Name filters set for the content provider.</td>
</tr>
<tr>
<td>Condition Filter</td>
<td>Displays the Condition filter expression set for a table. In case of Plot content, this keyword remains empty.</td>
</tr>
<tr>
<td>Time Range</td>
<td>Displays the Time filter set for the content provider.</td>
</tr>
<tr>
<td>Content Start</td>
<td>Displays the Date and Time when execution started for the content provider.</td>
</tr>
<tr>
<td>Content Stop</td>
<td>Displays the Date and Time when execution completed or stopped for the content provider.</td>
</tr>
<tr>
<td>Content Duration</td>
<td>Displays the time difference between Content Start and Content Stop.</td>
</tr>
<tr>
<td>Content State</td>
<td>Succeeded – Displays if content provider’s execution succeeds. Cancelled – Displays if content provider’s execution stops or fails.</td>
</tr>
<tr>
<td>Content ErrorState</td>
<td>Provides additional information about Content execution. It is independent of the Content state. The following states are possible: OK - Succeeded Errors - Errors occurred Failures - Severe errors occurred</td>
</tr>
<tr>
<td>Content ErrorState Message</td>
<td>Displays the error description of Content ErrorState.</td>
</tr>
<tr>
<td>Content Activity</td>
<td>Displays the detailed information about the Content creation activity.</td>
</tr>
<tr>
<td>Content Progress</td>
<td>Displays the Content execution progress from 0% to 100%.</td>
</tr>
<tr>
<td>Record Count</td>
<td>Displays the number of records in the table.</td>
</tr>
<tr>
<td>System Name</td>
<td>Displays the name of the system on which the current report is present.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Generic Keywords</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date</td>
<td>Displays the Date (format is location-dependent)</td>
</tr>
<tr>
<td>Time</td>
<td>Displays the Time (format is location-dependent)</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Page</td>
<td>Displays the page number when the report document (PDF) is created.</td>
</tr>
<tr>
<td>Pages</td>
<td>Displays the total number of pages when the report document (PDF) is created.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> Keywords <strong>Page</strong> and <strong>Pages</strong> are replaced by page numbers and total number of pages respectively only when inserted in Header or Footer of the Report Definition.</td>
</tr>
<tr>
<td>User</td>
<td>Displays the name of the logged-in user.</td>
</tr>
<tr>
<td>Desigo CC Name</td>
<td>Displays the name of the management station that created the report.</td>
</tr>
<tr>
<td>Report Name</td>
<td>Displays the name of the Report Definition.</td>
</tr>
<tr>
<td>Report Description</td>
<td>Displays the description typed for the Report Definition.</td>
</tr>
<tr>
<td>Report Start</td>
<td>Displays the Date and Time when report execution started.</td>
</tr>
<tr>
<td>Report Stop</td>
<td>Displays the Date and time when report execution completed or stopped.</td>
</tr>
<tr>
<td>Report Duration</td>
<td>Displays the time difference between Report Start and Report Stop.</td>
</tr>
<tr>
<td>Report State</td>
<td><strong>Succeeded</strong> - Displays if the report execution succeeds.</td>
</tr>
<tr>
<td></td>
<td><strong>Cancelled</strong> - Displays if the report execution stops or fails.</td>
</tr>
<tr>
<td>Report ErrorState</td>
<td>Provides additional information about report execution. It is independent of the report state.</td>
</tr>
<tr>
<td>Report ErrorState</td>
<td>Message Displays the error description of report ErrorState.</td>
</tr>
<tr>
<td>Report Activity</td>
<td>Displays detailed information about report creation activity.</td>
</tr>
<tr>
<td>Report Progress</td>
<td>Displays the report execution progress: If continuous progress is possible, a number between 0 and 100 displays. If no continuous progress is possible, In progress displays.</td>
</tr>
<tr>
<td>Report Summary</td>
<td>Displays the summary.</td>
</tr>
</tbody>
</table>

**Logo Group Box**

You can insert logos into a Report Definition using the Logo group box. For example, you can add your company’s logo to a report. You can define, and change the size, position, and indentation of a logo. To insert a logo to a Report Definition, you must upload it using the Manage Logo dialog box.
### Components of Manage Logo Dialog Box

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select logo to upload</td>
</tr>
<tr>
<td>Browse</td>
</tr>
</tbody>
</table>
| Upload                                           | Adds a new Logo to the Available Logos list.  
  **NOTE:** The Upload button remains unavailable until a valid path and file name is selected. |
| Thumbnail                                        | Displays the thumbnail view of an image. |
| Logo name                                        | Saves as Logo name. The Logo name must be unique. |
| Delete                                           | Deletes selected logos.  
  **NOTE:** The Delete button remains unavailable until a logo is selected. |
| Close                                           | Closes the Manage Logo dialog box. |

### Form Controls Group Box

Form controls are controls that you can edit in Run mode. There are four form controls - **Editable Field**, **Custom Text Selection**, **Text Group Selection**, and **Comments Table**. These controls are accessed from the Form Controls group box within the Insert group box in the Home tab of Reports.

The **Editable Field** control displays a watermark text that enables you to perform the required action. You can change this text if you want the control to display a different text when the report is executed. These controls can also be used to provide event treatment related information in reports for operating procedures.

Following is an overview of the form controls:

#### Editable Field

Use the **Editable Field** control, to enter text in Run mode. This field does not support keywords.

#### Custom Text Selection

The **Custom Text Selection** control provides a drop-down list that enables you to add, modify, and delete text entries in Edit mode and select entries in Run mode. You can add text in any of the languages configured in the system. In Run mode, this control displays text using the logged-in language of the user.

#### Components of the Custom Text Selection Control

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| Add  | Adds the text entered to the control.  
  **NOTE:** Available only when some text is entered. |
| Update | Modifies an existing entry.  
  **NOTE:** Available only when you change an existing entry. |
| Flag | Allows you to enter text for all languages configured in the system. |

Figure 23: Custom Text Selection Control

#### Text Group Selection

The **Text Group Selection** control provides a drop-down list with entries from a text group in Run mode. You can drag-and-drop a text group to this control in Edit mode and the values display in Run mode. However, you can add only one text group to the control. If more than one text group is added, the existing group is...
over written with the new group. If you add new entries, modify or delete existing entries from the associated text group, the control displays the updated values every time you run the report. If the text group is deleted, a message indicating that the group is no longer available displays.

**Comments Table**

The **Comments** table allows you to add, modify, and delete comments in **Run** mode. You can modify and delete your own comments by clicking **Edit** and **Delete** that are available in **Run** mode.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creation date</td>
<td>Displays the date and time stamp when comment is added</td>
</tr>
<tr>
<td>User</td>
<td>Displays the ID of the user who entered the comment</td>
</tr>
<tr>
<td>Management Station</td>
<td>Displays the workstation from where comment is added</td>
</tr>
<tr>
<td>Comment</td>
<td>Allows you to enter comments</td>
</tr>
</tbody>
</table>

Creation date, User, and Management Station are read only. These are populated with information after you enter the comments and press **ENTER**. To add a new line to the comments, press **ALT+ENTER**.

Unlike other tables, the columns in this table are fixed and you cannot perform column operations like adding, deleting, reordering, and sorting. Also, this table does not support filtering.

**8.2.5.2 View Group Box**

Use the **View** group box to choose how much of a Report Definition to view on the screen.

- **Page Width**
  - Adjusts the width of a report page to use all the available width of the Reports workspace.
- **Full Page**
  - Displays a full page to maximize the space available in the Reports workspace.
- **Original Size**
  - Displays the width of a report page in normal size.

**8.2.5.3 Options Group Box**

The **Options** group box provides additional options available in the **Home** tab:

- **Show in Related Items** check box
  - While creating a Report Definition, enable this check box to create a standard
Report. When you select an object from System Browser, this standard report displays as a link in the Related Items.

- **Date/time in UTC format** check box
  Selecting this check box, the date and time you type is represented in UTC format. The following elements in Reports display date/time values:
  - Keywords (Date, Time, Report Start, Report Stop, Content Start, Content Stop)
  - Columns of the tables
    - Source Time column (Activities)
    - Alert time and Transition time (Events)
    - Creation date time (Active Events)
    - Date
    - Alert time and Alert went (for parent record of Event Details)
    - Time (for child record of Event Details)
    - Event Stamp Fault, Event Stamp Off-Normal and Event Stamp Normal
      (BACnet Event Information)
  - **Time filter** dialog box
  - **Condition filter** dialog box (Data in the reports can be filtered based on data time values)

- **Fixed Locale** check box
  Selecting this check box and a locale from the corresponding list, displays the date/time and decimal separator according to the format set for the locale on the server. For example, if you select English-US as the locale, the date/time and decimal separator set for English-US on the server displays in the report.

### 8.2.6 Reports Ribbon — Filter Tab

The Filter tab allows you to define and apply different filters for data retrieval.

![Filter Tab](image)

**Figure 25: Filter Tab**

The various filters are:

- Name Filter
- Condition Filter
- Time Filter
- Row Filter: Allows you to set the maximum number of rows of a table to be displayed at runtime.
- Languages Filter: Allows you to set the language for a Report Definition. You can configure filters (Condition and Name) in the selected language.

### 8.2.6.1 Name Filter

The Name filter allows you to filter data based on the Name or Description of System Browser objects. You can apply a Name filter to a table or plot.

When an Activities, Events, Active Events, BACnet Alarm Summary, BACnet Enrollment Summary, BACnet Event Information, and/or Objects table is inserted in the Report Definition, a valid Name filter “CurrentSystemName.*:*” is added by default, where **CurrentSystemName** is the name of the system in which report definition is created or opened. This default Name filter can be replaced with a * to fetch the data from all the views of all the configured systems in a distributed environment. You can add Name filters from the **Name Filter** dialog box.
Name Filter Dialog Box

Use the Name Filter dialog box to add, edit and delete Name filter conditions. The added Name filter is also added to the Name Filter group box when the dialog box is closed.

![Name Filter Dialog Box](image)

Figure 26: Name Filter Dialog Box

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Creates a Name filter according to the object name displayed in System Browser.</td>
</tr>
<tr>
<td>Description</td>
<td>Creates a Name filter according to the object description displayed in the System Browser. A message in red displays below the Name Filter list if the filter is invalid.</td>
</tr>
<tr>
<td>Name Filter List</td>
<td>Lists all the Name filters and displays whether the applied filter is valid or not. The Name filter list contains four columns. <strong>Total no. of filters</strong>: Displays the total number of filters in the column header and displays the sequential number before each Name filter. <strong>Valid</strong>: Shows if the applied filter is valid or not (OK or question mark symbol (?) respectively). <strong>Children</strong>: Disabling this check box excludes the child nodes of the System Browser object from the Report Definition. <strong>Name filter</strong>: Displays the hierarchical path of the System Browser object.</td>
</tr>
<tr>
<td>Name Filter</td>
<td>Displays the filter that is currently selected in the Name Filter list. You can type a name into this field. The valid format for entering a Name filter is SystemName.ViewName:Hierarchy.<em>, where * is for displaying the child nodes of the selected object. For example, System1.Application View.Site.Building.Floor1.</em> <strong>NOTE</strong>: For a plot, you can set only one Name filter at a time.</td>
</tr>
</tbody>
</table>
### Validate
Checks whether the applied filter is valid or not.

**NOTE:** Displays only for Trends Table, Trends Plot, and Graphics Plot.

### Accept
Accepts the change made to a Name filter. This button is unavailable until a change is made to an existing Name filter.

### New
Adds a new Name filter to the Name Filter list. This button is unavailable until a Name filter is typed in the Name field or if any existing Name filters are selected in a Name Filter list.

**NOTE:** When you add the Name filter for the very first time, the default Name filter CurrentSystemName.*:.* is replaced.

### Delete
Deletes an existing Name filter. This button is unavailable until one or more Name filters is selected in the Name Filter list.

**NOTE:** When all the Name filters are deleted the default Name filter CurrentSystemName.*:.* is restored.

---

**NOTE 1:**
For Trends table, Trends plot, and Graphics plot no default Name filter is added. You can apply only single Name filter.

**NOTE 2:**
For Trends table, you can drag-and-drop Offline, Online Trend Logs, and Trend View Definitions.

---

### Wildcard Characters in Name Filters (For Single Systems):
You can use wildcard characters (* and ?) in a Name filter. The following examples will help you in using these characters:

- To display the details of only Analog Output objects of a device, Dev 1 in a report, specify the Name filter as "System1.ManagementView:ManagementView.FieldNetworks.BAC1.Hardware.Dev1.Local_IO.AO*". When you run the report, the details of all the Analog Output objects belonging to the Dev 1 device will display.

- To display the details of only Analog Output objects of all system devices present in System 1 in a report, specify the Name filter as "System1.ManagementView:ManagementView.FieldNetworks.BAC1.Hardware.Dev*.Local_IO.AO*". When you run the report, the details of all Analog Output objects belonging to all devices in the system with names starting with Dev will display.

- To display the details of Analog Output objects with names starting from Analog Output 11 through Analog Output 19 of device Dev 1 in a report, specify the Name filter as "System1.ManagementView:ManagementView.FieldNetworks.BAC1.Hardware.Dev1.Local_IO.AO_1?". When you run the report, the details of Analog Output objects with names starting from AO_11 through AO_19 belonging to device Dev 1 will display. The assumption here is that there is a device Dev1 in your system that has Analog Output objects with names starting from AO_11 through AO_19.

- If you want to display the details of Analog Output objects with names starting from Analog Output 11 through Analog Output 19 of all devices with names in the range of 21 through 29 in a report, specify the Name filter as "System1.ManagementView:ManagementView.FieldNetworks.BAC1.Hardware.Dev2?.Local_IO.AO_1?". When you run the report, the details of all analog output devices with names starting from AO_11 through AO_19 that are present in devices Dev21 through Dev29 will display. The assumption here is that there are devices in your system having names Dev 21 through Dev 29 and there are Analog Output objects having names AO_11 through AO_19 in those devices.

### Wildcard Characters in Name Filters (For Distributed Systems)
- To display the details of all the Analog Output objects of all system devices present in all the configured systems in a distributed environment, specify the
following Name filter in the report definition, 
"*.ManagementView:ManagementView.FieldNetworks.*.AO*". When you run the report, the details of all the Analog Output objects belonging to all the devices in all the systems configured in a distributed environment will display. However, when you apply wild cards to a Name filter, the report execution may be slower. Therefore, if you are processing an operating procedure form, report steps, or Log Viewer on a system, reports executed on this system must have more specific Name filters to achieve optimum performance.

8.2.6.2 Condition Filter

A Condition filter defines a filter expression that is composed of one or more filter expressions.

Condition Filter Condition

A Condition filter condition is composed of:
- Column name (Condition Name)
- Operators
- Condition value

Examples of Condition Filter Expressions

The following list contains some valid Condition filter expressions:
- Status = “Alarm”
- Status = (“Alarm”; “Alarm Acked”; “Alarm Unacked”) 
- Alarm Value = {12; “Text”}
- Time of last Change = “Current day”

NOTE:
You cannot apply the Condition filter to Plots.

The Condition filter also allows you to create complex filters and conditions using mathematical and logical operators, and wildcard characters. The following operators are supported:
- **Mathematical Operators:** Equal to (=), Not Equal to (<>), Greater than (>), Less than (<), Greater than Equal to (>=), Less than Equal to (<=), and (←) In operator
- **Logical Operators:** AND, OR, NOT
- **Wildcard Character:** Asterisk (*)

NOTE: The In operator (←) is used to filter data in a column that supports display of multiple values in a single cell. Following is an example of columns having the possibility to display multiple values in a single cell.

<table>
<thead>
<tr>
<th>Table Name</th>
<th>Columns with possibility to display multiple values in a single cell</th>
</tr>
</thead>
<tbody>
<tr>
<td>Objects</td>
<td>Related Items Type Related Items</td>
</tr>
<tr>
<td>Activities</td>
<td>Value Previous Value Quality Previous Quality</td>
</tr>
<tr>
<td>Active Events</td>
<td>Available Commands</td>
</tr>
</tbody>
</table>
Condition Filter Syntax

When you are creating a Condition filter, you must know the data type of the property for which you want to apply the filter. Following are some examples which will help you create Condition filters without syntax errors.

1. If property displays text data, for example string or enumeration, then the value must be enclosed within double quotes.
   - ‘[Current_Priority]’ = “Priority - 16”
   - ‘Object Description’ = “Analog Output 1”
   - ‘[Event_State]’ = “Normal”
   - ‘[Present_Value]’ = “INACTIVE”
   
   **NOTE:** The values of some properties such as [Current_Priority] are referenced in text groups. Therefore, whenever you are assigning values for such properties, you must refer to the respective text groups. In order to refer to the text groups in the Management View, you must have an Engineering license. In the absence of an Engineering license, you will have to run the report to find out the appropriate values for such properties.

2. If property displays values in the date time format, then the value must be in date time format configured in Windows on the server. Date must be in the short date format, time in the long time format (24 hours).
   - ‘Main Value’ = 3/13/2014 16:04:25 (assuming that the date format on the server is M/d/yyyy)

3. If property displays Boolean data, for example. TRUE, FALSE, then the value must be enclosed in double quotes
   - ‘[Stop_When_Full]’ = “True”
   - ‘[Log_Enable]’ = “False”

4. If property displays numeric data, for example,. 54.11, 25, -20, then the values must be specified as follows:
   - ‘[Present_Value]’ = 54.11
   - ‘[Present_Value]’ >= 25
   
   **NOTE:** The decimal separator will be according to your Windows Regional and Language settings.

5. If property displays bit string, then the value must be enclosed by double quotes
   - ‘[Status_Flags]’ <- “Fault”
   - ‘[Event_Enable]’ <- “To Fault”
   - ‘[Limit_Enable]’ <- “Low Limit Enable”

The Condition filter is applicable only to Objects, Active Events, Activities, Events, Event Details, and Trends tables. When you select any of these tables, you can display the **Condition Filter** dialog box.

For the Objects table, you can add a conditional filter that specifies the acceptable age of the data on which the filter is applied. For example, if you specify 0 as the acceptable age, the filter is always applied on the latest data from the field system. If you specify 2 weeks, the age of the data with the cache is checked. If the data is older than 2 weeks it is obtained from the field system, else the data from the cache is used for filtering. This setting helps in the faster report generation.

**Condition Filter Dialog Box**

This dialog box allows you to specify the condition to filter the report data. You can apply the Condition filter on all columns except columns of type date/time.
**Condition Filter Dialog Box Components**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type filter</strong></td>
<td>Displays only when an Objects table is selected in the Report Definition. Allows you to enter the object type description on which you want to filter the object types to be displayed in the <strong>Type</strong> drop-down list. For example, if you want the <strong>Type</strong> drop-down list to display all BACnet object types, enter BACnet as the type filter.</td>
</tr>
<tr>
<td><strong>Type</strong></td>
<td>Displays only when an Objects table is selected in the Report Definition. It lists all the object types available in the system. You must select the object type whose columns are to be displayed in the <strong>Available Columns</strong> list. <strong>NOTE:</strong> In case of a distributed system, the <strong>Type</strong> drop-down list displays the Object Models of only the current system on which the report is configured.</td>
</tr>
<tr>
<td><strong>Load</strong></td>
<td>Click this button to populate the <strong>Available columns</strong> list with the columns corresponding to the selected object type in the <strong>Type</strong> list.</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Available columns                           | Lists all the available columns of a selected table. For an Objects table, the columns corresponding to the object type selected in **Type** are listed. In case of the Objects table, displays the following information:  
  - Common columns applicable to any type of object. These are listed at the top of the list. For example, Discipline, Object Name, Object Description, and so on.  
  - Columns referring to properties supported by the selected object type. These are listed after the common columns and have a tree structure. When you click any such column, the tree expands and displays the attributes of the property. For example, if you click the expander of the Current_Priority property, its attributes such as Archive, Activity Log, Min, Max, Default, and so on display. |
| Operators List                              | Lists all the operators associated with a specific column selected in the **Available Columns** list.                                                                                                        |
| Values List                                 | Lists all the values associated with a specific column selected in the **Available Columns** list. Moreover, you can select multiple values by pressing **CTRL** or **SHIFT** and selecting different values.  
  **NOTE:** Multiple values can be typed within braces `{}` and are separated by a semicolon `;`.                                                                 |
| Filter expression field                     | Displays the filter expression. You can edit a filter expression in this field. **NOTE:** An invalid filter expression is highlighted in red.                                                                |
| Read all data from field system             | Displays only when an Objects table is selected in the Report Definition. If this option is selected the objects data for filtering is always read from the field system.                                         |
| Read all data from process image            | Displays only when an Objects table is selected in the Report Definition. If you select this option, the objects data is always read from the cache.                                                              |
| Read data from field system older than      | Displays only when an Objects table is selected in the Report Definition. It allows you to specify the acceptable age of the data on which the filter is applied. If you select this option, the value entered is compared with the age of the data in the cache. If the data in the cache is older than the value entered, it is obtained from the field system; otherwise data from the cache is used for filtering. |
| New/Update                                  | Allows you to add or update a filter expression. Update is enabled only when a valid filter expression is added or modified in the filter expression field.                                                    |
| AND/OR                                       | These are logical operators that allow you to combine filter expressions and create complex filters. This button is unavailable until a filter expression is added to the filter expression field.                          |
| "( )"                                        | Allows you to group filter conditions, which define the order of their evaluation. These brackets are unavailable until a filter expression is added to the filter expression field.                               |

**1)** The selected item displays below the list.

**Related Topics**

In Operator [➙ 331]
8.2.6.3 **Time Filter**

The **Time Filter** group box and the dialog box launcher icon is enabled only when you select a table or plot in a Report Definition for which the Time filter is applicable.

The Time filter allows you to specify time as a filter for retrieving records.

![Time Filter Dialog Box](image)

*Figure 27: Time Filter Dialog Box*
### Time Filter Dialog Box Components

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date time specification</td>
<td>Shows LOCAL, when the <strong>Date/Time in UTC format</strong> check box on the <strong>Home</strong> tab is not selected.</td>
</tr>
<tr>
<td>Select Column</td>
<td>Displays only when an <strong>Events</strong>, <strong>All Logs</strong>, or <strong>Activities</strong> table is selected in the Report Definition. The entries in the drop-down list depend on table selected and allow you to filter information accordingly. <strong>Events:</strong> Event Time - Time when the event occurred Event Went - Time when the event state changed Transition Time - Time when the event was closed <strong>All Logs:</strong> Date/Time – Date/Time when the activity is performed or state change of the event occurred. Event Time - Time when the event occurred Source Time - Reference Time – <strong>Activities:</strong> Source Time - Reference Time -</td>
</tr>
<tr>
<td>Custom</td>
<td>The Custom option allows you to set the date and time as per your requirement. Selecting the Custom option enables the <strong>From/To</strong> field. The To date should always be greater than From date. If the To date is less than the From date, then the <strong>To</strong> field is highlighted in red and an error message displays on mouse-over. The From and To date should be same as the date already set in Short date on your management station. The Short Date is to be found under <strong>Short date:</strong> (Start &gt; Control Panel &gt; Regional and Language Options &gt; Regional Options)</td>
</tr>
<tr>
<td>Relative</td>
<td>Relative has two options: Last and Current Period. The Last option allows you to filter data for the last ‘x’ period that you specify. For example, last ‘x’ hours, last ‘x’ months, last ‘x’ years, last ‘x’ weeks, last ‘x’ days, or last ‘x’ minutes. The Current Period option allows you to filter data for the current ‘x’ period that you specify. For example, current ‘x’ hours, current ‘x’ months, current ‘x’ years, current ‘x’ weeks, current ‘x’ days, or current ‘x’ minutes. For example, if the current date and time on your computer is 10/07/2014 10:35 AM and you specify any of the following: <strong>1 Hour in the Last option</strong> - The data for the 9:00 to 10:00 AM period is retrieved <strong>1 Hour in the Current Period option</strong> - The data for the 10:00 to 11:00 AM period is retrieved <strong>1 Month in the Last option</strong> - The data for the period June 01,2014 to July 01, 2014 is retrieved. <strong>1 Month in the Current Period option</strong> - The data for the period July 01, 2014 to August 01, 2014 is retrieved. <strong>1 Year in the Last option</strong> - The data for the period January 01, 2013 to January 01, 2014 is retrieved. <strong>1 Year in the Current Period option</strong> - The data for the period January 01, 2014 to January 01, 2015 is retrieved. <strong>NOTE:</strong> The <strong>Last</strong> and the <strong>Current Period</strong> field accepts only integer values up to 3 digits.</td>
</tr>
</tbody>
</table>
### 8.2.7 Reports Ribbon — Layout Tab

The **Layout** tab allows you define the format of layout elements of a Report Definition.

<table>
<thead>
<tr>
<th>Unlimited</th>
<th>Default selection. Allows you to retrieve all records.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Defined By Source</td>
<td>This option only displays for Trend objects. It sets the date and time to what you have defined for the selected Trend View Definition.</td>
</tr>
<tr>
<td>Null</td>
<td>Allows you to retrieve records with Null value.</td>
</tr>
<tr>
<td>Preview of Resulting Time range</td>
<td>Displays the resulting time range for the options selected in the Time filter dialog box. For example, if the present time is 02/06/2012 4:37 PM, then for the selection current 24 hrs the Preview of Resulting Time Range displays absolute time range for this selection as follows: From: Sunday, February 05, 2012 5:00:00 PM To: Monday, February 06, 2012 5:00:00 PM.</td>
</tr>
</tbody>
</table>

#### 8.2.7.1 Page Setup Group Box

The **Page Setup** group box allows you to set the orientation, page size, and margin of the Report Definition.

**Orientation**

The **Orientation** menu contains two submenus:
- **Portrait**: long vertical edge
- **Landscape**: long horizontal edge (default)

**Page Size**

The **Page Size** menu contains several pre-configured sizes including: A3, A4, A5, Letter, and so on. The default page size is A4.
Margins
The Margins menu has four preconfigured margins with values displayed for quick selection:
- Normal (default)
- Narrow
- Moderate
- Wide

8.2.7.2 Placement Group Box
The Placement group box provides icons so you can rearrange the position of the report elements in a Report Definition by selecting an element and using the icons:
- Move up
- Move down
- Move to top
- Move to bottom
When there is only one element present or if there are multiple elements but none is selected, then all four icons are unavailable.

8.2.7.3 Position Group Box
The Position group box allows you to adjust the position of the layout elements of a Report Definition.

![Figure 30: Position Group Box](image)

<table>
<thead>
<tr>
<th>Position Group Box</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alignment</td>
</tr>
<tr>
<td>Indentation</td>
</tr>
<tr>
<td>Spacing</td>
</tr>
<tr>
<td>Width</td>
</tr>
<tr>
<td>Height</td>
</tr>
</tbody>
</table>

8.2.7.4 Font Group Box
The Font group box allows you to apply a font type, size, style and/or color to the layout elements such as a label or a table. The Font group box becomes enabled only when you have inserted a label or a table in a Report Definition template while configuring a Report Definition.

![Figure 31: Font Group Box](image)
8.2.7.5 Auto-scaling Group Box

Selecting the Auto-scaling check box adjusts the column width automatically in PDF documents that are generated when you execute a report. If the Auto-scaling check box is not selected, then the PDF may not display all table columns.

8.2.8 Reports Ribbon — Data Tab

The Data tab allows you to specify the location from which the data is to be retrieved when you run the report. It also provides the option to define the Graphics filter.

<table>
<thead>
<tr>
<th>Table Group Box</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Read all data from…</strong></td>
</tr>
<tr>
<td>Field system</td>
</tr>
<tr>
<td>Process image</td>
</tr>
<tr>
<td>Field system older than…</td>
</tr>
</tbody>
</table>

**NOTE:**

If you have selected any of the options from the Table group box, the same option is also selected in the Condition Filter dialog box. Any change in selection reflects in the Condition Filter dialog box as well. However, if you change your selection in the Condition Filter dialog box, it does not reflect in the Table group box options of the Data tab.

**Graphics Group Box**

When All Related Graphics is selected, the related graphics and view ports of an object display in Run mode. To view the graphics and view ports, you must assign the object as a Name filter to the graphics plot.
8.2.9 Reports Ribbon — Settings Tab

The Settings tab allows you to configure the output format and destination for a Report Definition.

Report Output Group Box

The Report Output group box displays the configured entries for a Report Definition.

Figure 32: Report Output Group Box

The Report Output Definition dialog box allows you to configure the settings. The configured Report Output Definitions are executed when the Report Definition runs automatically.

For more information on configuring a Report Definition to be routed in different formats and to different destinations, see Routing Reports.

NOTE:

If there is a change in the configured email address of a recipient in the Address Book, it is automatically reflected in the Report Output group box. However, if the configured email address is deleted or the recipient is deleted in the Address Book, the entries for a Report Definition display in red. For more information, see the Automatic Update of Configured E-mail Addresses section in Report Output Definition Dialog Box – Email.
8.2.9.1 Report Output Definition Dialog Box

The Report Output Definition dialog box allows you to configure the Report Definition’s output format and destination for routing reports. You can create, modify, or delete a Report Definition output entry.

![Report Output Definition Dialog Box](image)

**Figure 33: Report Output Definition Dialog Box**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Report format  | Lists the following supported file formats.  
PDF  
Excel  
CSV  
XML – This format is available only if you have the relevant license.  
**NOTE 1:** According to the EMC requirement, the CSV report format is supported to export a Trends report in the CSV format. The EMC proxies have plug-ins that support converting data from CVS formats for import into EMC. To have Desigo CC trend data compatible with the EMC trend data import plug-in, the CSV columns (for trends table only) are modified: Date; Data Source; Value (separated by semicolon).  
**NOTE 2:** The CSV does not support logos or plots; also Report header/footer is not present.  
**NOTE 3:** The CSV format applies only to exporting the Trends table. |
| Destination types | Lists all the various destination types: File, Email and Printer. The Destination types displayed in the list depend on the type of format selected in Report format.  
**NOTE:** When you select the Destination Type as File or Email, you can specify the name of the file that will be generated upon automatic report execution using either of the following options:  
- Use report name as file name  
- Enter custom file name |
### 8.2.9.2 Creating and Viewing a Report as a PDF or Excel

After executing a Report Definition manually or automatically, you can view and save the report as a PDF or Excel (XLSX) document. This way you can share the PDF/Excel document with someone, or perform some calculations on the Excel document by applying Excel formulas. You can either view the PDF, Excel/CSV documents and consecutive split documents in the Report Management section under the Report snapshot when you generate the report manually or you can locate them in the folder configured in the Report Output Definition dialog box when you generate the report automatically.

#### PDF
You can view and save the report output in a PDF document. A PDF document contains all the report elements of the Report Definition with output data and sorting applied. It also displays the special formatting applied to Report Definition elements (such as tables, plots, keywords, and so on). The PDF document can have a maximum of 500 pages, if the number of pages exceeds 500 the document splits into two.
### NOTE 1:

Reports do not support TrueType collections for PDF generation.

To generate a PDF document for Asian languages, you must select TrueType fonts which support Asian characters in the Report Definition, for example, Arial Unicode MS.

### NOTE 2:

You can print the PDF file by clicking **Print**. This button is available when you click **Create and view PDF** on the generated report.

### NOTE 3:

You can add digital signatures or watermark text on the generated PDF reports using the Adobe Acrobat DC software (not included).

---

### Excel (XLSX)

You can view and save the report output as an Excel (XLSX) document. An Excel document contains all of the reporting elements of the Report Definition with output data and user-defined configuration. Form Controls in the report definition are not present in the Excel document. Any special formatting applied to the Report Definition elements are not retained in the Excel document.

---

**NOTE:**

If you have multiple tables or plots in a report definition, the generated Excel document displays the details of each table or plot in a separate worksheet. Each worksheet also displays information on other reporting elements such as keywords and logos in the report definition. Each column in the worksheet has a combo box that corresponds to a table column that enables you to perform analysis on the table data. In case of an **Event Details** table the generated Excel document does not have any combo boxes as the data displays parent and child records. However, if you remove the child columns from the **Select Columns** dialog box, run the report, and then generate the Excel document, only the parent records display and the columns display a combo box that enables you to perform data analysis.
In order to perform analysis on a specific set of columns in a table, you can add a PivotTable or chart to the generated Excel document and set this document as a template to the report definition having this table. When you run the report and generate the Excel document, information related to the columns you added to the PivotTable or chart displays in a separate worksheet.

The PivotTable or chart in the template must have columns of only those tables that are present in the report definition. For example, if you have a report definition with an All Logs table, the PivotTable or chart in the Excel document that is set as a template to this definition must have columns specific to the All Logs table only.

In case of an Event Details table, you must remove all the child columns for the PivotTable to be displayed.
NOTE 1: If the size of the document exceeds the Excel maximum of 1000 worksheets or 1,048,575 rows, a new Excel file is created for the next set of records.

NOTE 2: In case of a distributed system, the process of generating the PDF or XLS documents will stop if you switch over to a different system. During this process, if the document is likely to be split into multiple documents, then the pending documents will not be available.

NOTE 3: You can decide whether you want to proceed with the document generation process by confirming to the dialog box options that display when you switch over to a different system.
Generating a PDF Document

▷ You have run a Report Definition and it displays in Run mode.

1. Click Create and view PDF.
   - The PDF file opens in the PDF viewer.
   - When a PDF document exceeds the page limit of 500 pages, it splits into two documents.
   - After clicking Create and view PDF on the generated report, you can save, print, zoom in, and zoom out of the PDF file.
   - From the Report Management section, you can:
     - Click Stop to stop creating the PDF document and a consecutive PDF split document.
     - Click Delete to delete each entry.

Generating an Excel (XLSX)
You can generate an Excel document using any of the following procedures:
- Generating an Excel document without a template [➙ 308]
- Generating an Excel document with a template [➙ 309]

Generating an Excel Document without a Template

▷ You have run a Report Definition and it displays in Run mode.
▷ Microsoft Excel 2007 or later is installed on your system.

1. Click Create and view Excel.
   - An Excel file is created and stored under the following temporary path [Drive]:\Users\[UserID]\AppData\Local\Temp\temp\GMS. A dialog box displays, asks you if you want to save a permanent copy of this file.

NOTE 1:
The Excel creation progress for all the split Excel documents displays under the same Report Snapshot in the Report Management section.

NOTE 2:
From the Report Management section, you can do one of the following:
- Click Stop to stop creating an Excel document and a consecutive Excel split document.
- Click Delete to delete each entry.

NOTE 3:
If you have Internet Explorer 10.0 or higher, the Excel file opens outside the Reports workspace.
Generating an Excel Document with a Template

1. Click **Create and view Excel**.
   - An Excel file is created and stored at the following temporary location on your machine: 
     \[\text{[Drive]}:\text{Users}[/\text{UserID}]\text{AppDataLocalTemp\temp\GMS.}

2. Open the Excel file by clicking **Open** in the dialog box.
   - NOTE: If you are opening the file from the temporary location, you must first ensure that you save a copy of this file at a different location on your machine and proceed with the further steps on the saved copy.

3. Open the worksheet with the table information in the saved copy of the Excel file and select a row with data.

4. From the **Insert** menu, select the **PivotTable** option.
   - The **Create PivotTable** dialog box displays.

5. Select the **Select a table or range** option and specify the table details.

6. Select the **New Worksheet** option in the **Choose where you want the PivotTable report to be placed** section and click **OK**.
   - A new worksheet is added to the Excel document with the PivotTable options.

7. From the **PivotTable Field** list, select the columns to be added to the PivotTable.
   - The selected columns are added to the worksheet.

8. (Optional) Re-organize the columns as per your requirement in the **Drag fields between areas below** section in the **PivotTable Field** list.
   - Any changes you make in this section, reflect in the worksheet.

9. Select any row from the PivotTable, right click, and then select **PivotTable Options**.
   - The **PivotTable Options** dialog box displays.

10. Select the **Data** tab.

11. In the PivotTable Data section, clear the **Save source data with file** check box and select the **Refresh data when opening the file** check box.

12. Click **OK**.

13. Delete all the sheets in the Excel document, except the sheet having the PivotTable configuration.

   - The saved Excel document is a template that contains the PivotTable.

15. Select the Report Definition you created.

16. From the **Extended Operation** tab, specify the path of the template in the **Excel Output Template** field and click **Set**. By default, the **Excel Output Template** field does not display in the **Extended Operation** tab. In order to display this field, you must select the DL3 display level check box for the **Template Path** property in the Report Definition Object Model.
NOTE: The template path is the path of the Server machine. A Process Monitor User must have access to the folder in which the template file is present for the PivotTable to display.

17. Run the report.
   ➗ The generated report displays in the Run mode.

18. Click **Create and view Excel**.

19. Click **Open**.
   ➗ The Excel document displays. The first worksheet displays information on the PivotTable and the details of other tables in the Report display in the other sheets.

### 8.2.9.3 Destination Type - File

You can save a Report Output Definition in supported formats to a file.

**Report Output Folders Configuration Dialog Box**

Before you save a file at a specific location in your local management station, you must configure the output folder paths in the **Report Output Folders Configuration** dialog box. You can launch this dialog box from the **Report Output Definition** dialog box.

After configuration, you can view and select these output folder paths in the **Report Output Definition** dialog box.

![Report Output Folders Configuration Dialog Box](image)

*Folder Alias:* Reports

*Folder Path:* C:\New folder

*Folder Description:*

Fields marked by (*) are mandatory

![Figure 36: Report Output Folders Configuration Dialog Box](image)
# Report Output Folders Configuration Components

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Folder Alias</td>
<td>Displays the name of the destination folder. When you select <strong>File</strong> in the <strong>Destination Type</strong> field, this name will be displayed in the <strong>File</strong> drop-down list of the <strong>Report Output Definition</strong> dialog box.</td>
</tr>
<tr>
<td>Folder Path</td>
<td>Displays the folder path that you have selected using the <strong>Browse</strong> button. You can configure a maximum of 100 folder paths. An error message displays if the number of folder path exceeds 100.</td>
</tr>
<tr>
<td>Browse</td>
<td>Helps you to locate the destination folder. You can also create a new folder at a desired location. <strong>NOTE:</strong> If you do not have the required permission on the selected folder, an error message displays.</td>
</tr>
<tr>
<td>Folder Description</td>
<td><em>(Optional)</em> Describes the contents of a folder.</td>
</tr>
<tr>
<td>Add</td>
<td>Adds the Folder Alias, Folder Path, and Folder Description in the List of folders for Report Output. This button is unavailable until all the mandatory fields are filled.</td>
</tr>
<tr>
<td>List of Folders for Report Output</td>
<td>Displays list of configured output folders. On selecting a configured output folder, the <strong>Folder Alias</strong>, <strong>Folder Path</strong>, and <strong>Folder Description</strong> fields are populated.</td>
</tr>
<tr>
<td>Change</td>
<td>Modifies an existing output folder configuration in the list.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes a selected entry from the list. This button remains unavailable until an output folder is selected in the List of Folders for Report Output. If you try to delete an entry which is used in any other Report Definition, a confirmation message displays.</td>
</tr>
<tr>
<td>Clear</td>
<td>Clears all the fields that are populated when you select an output folder entry in the List of Folders for Report Output.</td>
</tr>
</tbody>
</table>
8.2.9.4 Destination Type - Email

The Report Output Definition dialog box allows you to send a report via email. You can send all documents in one mail or configure the number of documents to be sent per email. The default is one document per email.

The Email Contacts dialog box allows you to choose and filter from the list of all recipients having email addresses configured in the Contacts selection list.

NOTE 1:
Before sending an email you must configure the mail server.

NOTE 2:
The Email Contacts dialog box displays when you select the destination type as Email and then click the Select Contacts button.
**Email Contacts Dialog Box Components**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contacts selection</td>
<td>Shows the names of the configured contacts in the Address Book followed by their email address in brackets. This list is sorted alphabetically. <strong>NOTE:</strong> A recipient may have up to three different email addresses configured.</td>
</tr>
<tr>
<td>Filter List Entries</td>
<td>Allows you to type in a filter. For example, if you type the letter &quot;A&quot;, the recipient list displays all the contacts starting with the letter A.</td>
</tr>
</tbody>
</table>

**Automatic Update of Configured Email Addresses**

The Output Definition list in the Report Output Definition dialog box and Contacts selection list in the Email Contacts dialog box updates automatically, if you change or delete the email address of a particular recipient in Address Book.
### Action
A recipient email address is changed in the **Address Book**

### Result
The new email address reflects in the Output Definition list in the **Report Output Definition** dialog box and Contacts section list in the **Email Contacts** dialog box.

### Action
A listed email address of the configured contact is deleted in the **Address Book**

### Result
The list of email addresses in the Output Definition list in the **Report Output Definition** dialog box displays in red. On moving your mouse pointer over the text, the following tooltip message displays. One or more email addresses are invalid. Select the correct email address. Report will not be sent to the invalid email addresses. **On selecting the report output definition, the email addresses configured in the definition display in the Destination field. The deleted email address displays as Unknown object. In order to remove the unknown object from the list, you must select a valid email address from the Select contacts dialog box.**

### Action
The report is run by clicking the **Execute** button in the **Extended Operation** tab

### Result
Report is routed to the valid email addresses configured in the report output definition.

### Action
A recipient is deleted from the **Address Book**

### Result
The list of email addresses in the Output Definition list in the **Report Output Definition** dialog box displays in red. On moving your mouse pointer over the text, the following tooltip message displays. One or more email addresses are invalid. Select the correct email address. Report will not be sent to the invalid email addresses. **On selecting the report output definition, the email addresses configured in the definition display in the Destination field as Unknown objects.**

---

### Listed email address of the configured contact deleted in Address Book

### Recipient deleted from the Address Book

---

![Report Output Definition](image1.png)

![Recipient deleted from Address Book](image2.png)
8.2.9.5 Destination Type - Printer

The Report Output Definition dialog box allows you to send a Report Output Definition to a printer.

You can print all or the first 100 (default) pages. You can edit the default and enter the number of pages to be printed.

**NOTE 1:**
Currently only PDF report format is supported for printing. To print a PDF report format on a printer, you must configure a server printer.

**NOTE 2:**
The document to be printed depends on the sorting you applied to the columns of a table.
8.2.10 Report Management Section

The Report Management section displays the Report execution status, such as PDF/XLS document creation status, during Report execution. The Report execution/generation mode is called Run mode. It also provides quick and easy navigation to different Report snapshots. When you select a snapshot in the Report Management section, it displays in Reports.

If you have executed a report and both, a PDF and Excel document are generated from it, you can quickly switch between the two using the Report Management section.

The Reports toolbar has a toggle icon called Report Management, which shows or hides the Report Management section. This section is visible at the bottom of the Reports window.

The Report snapshot of an executed Report Definition in the Report Management section is available until the user logs out.

The Report snapshots in the Report Management section are displayed in a hierarchical manner. For example, if you execute a Report and then view it as a PDF or Excel (XLS) document, then in the Report Management section, the first entry is of Report execution and the second entry is the PDF/XLS creation as displayed in the following image.

You can also monitor the PDF/XLS document creation progress; stop it using the Stop button. All the consecutive split document creation will be stopped.

You can also delete the split document using the Delete button or all the documents by deleting the Report snapshot entry.

The entry of each split document in a Report Management section is a child of the entry for the Report snapshot. Selecting any document entry, displays the document linked to that entry in the Reports.

NOTE: This section does not display when the report is executed for a selected event from Assisted Treatment.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Header</td>
<td>Displays the name of the reporting object currently executing. For example, the Report Definition name when executing a report.</td>
</tr>
<tr>
<td>State</td>
<td>Displays the execution state of a Report, PDF, XLS. For example, Pending, Succeeded, Failed, and so on.</td>
</tr>
<tr>
<td>Activity</td>
<td>Displays the description of the task being performed.</td>
</tr>
</tbody>
</table>

Figure 38: Report Management Section
<table>
<thead>
<tr>
<th>Execution Start</th>
<th>Displays the execution start date and time.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action</td>
<td>Displays the <strong>Stop</strong> button when the execution of a reporting object starts. When the execution is finished, the <strong>Stop</strong> button changes to the <strong>Delete</strong> button.</td>
</tr>
<tr>
<td>Progress</td>
<td>Displays the Progress information in a progress bar to indicate the execution progress.</td>
</tr>
<tr>
<td>Summary</td>
<td>Displays the execution summary. For example, if a BACnet device is unavailable or available but offline, then the summary will be: Report snapshot created successfully. At least one error reported: BACnet error: Device has operational problem.</td>
</tr>
</tbody>
</table>

### 8.2.11 Related Items Tab

The **Related Items** tab displays New Report, Related Report, and Show-in Related Items Report as a link or icon upon selection of a System Browser object.

#### New Report

This report is always available for quick access to a new Report Definition (as a link or icon) in the Related Items tab upon selection of a System Browser object.

When clicking the New Report link/icon, a new Report Definition opens in the Secondary pane (if the Primary pane is unlocked – pushpin horizontal). This Report Definition, by default, contains the Objects table with the Name filter set to the selected object in System Browser.

**NOTE 1:**
If you select a Trend View Definition/Graphic Definition in System Browser and click the New Report link/icon, then the Report Definition contains a trend plot/graphics plot with the Name filter set to the selected Trend View Definition/Graphic Definition.

**NOTE 2:**
If multiple objects are selected in System Browser, such as Graphics Definitions, Trend Definitions or BACnet devices/points and you click the New Report link/icon in the Related Items tab, all the selected objects are set as Name filters for the Objects table (no graphics plot, trends plot).

You can then configure and run this report as usual.

#### Related Report

If the selected System Browser object is defined as a Name filter in a report, then this report becomes a related report for that object and displays as a link/icon in the Related Items tab.

When clicking this link/icon, the related report runs. During the related report execution, the data is retrieved according to the Name filter set for the report element in the Report Definition. The Name filter set in the report element is not replaced by the selected System Browser object.

For example, if an Event Details report is present in the Related Items tab, it can be run for the selected event in the Event List.
NOTE:
Ensure that in a Report Definition, you have set the complete path of the system object as the Name filter (without any wild cards). If a wild card (? or *) is used in the Name filter, then this Report Definition is not set as a related report and does not display in the Related Items tab.

Show in Related Items Report

When you select a System Browser object, the reports having Show In Related Items check box selected are displayed (as a link/icon) in the Related Items tab. When clicking this link/icon, the report runs.
During the report execution, the Name filter is set to the path of the selected object in System Browser. If a Name filter was configured in the report, it is replaced with the path of the selected object.

8.2.12 Reports Modes

Reports operates in two modes:

- **Edit** mode: This is the default mode, which allows you to design the layout of a Report Definition.
- **Run** mode: This mode allows you to view the actual data retrieved from the Reports service.

8.2.12.1 Edit Mode

When you create a new Report Definition, it opens in Edit mode (default mode).
**Edit** mode allows you to design the layout of a report, delete a report, and so on.
You can also display/hide the Reports ribbon using the Properties icon.

![Image of Edit Mode](image)

**Figure 39: Edit Mode**

NOTE:
You can switch to Run mode by clicking the Run icon or Run As icon in the Reports toolbar.
8.2.12.2 Run Mode

The Run mode executes a Report Definition and displays the data retrieved from Reports and other services. In Run mode, the ribbon disappears.

- The ribbon disappears.
- Keywords are replaced by actual data.
- No element can be added or deleted in this mode.
- You can perform the following activities:
  - Sorting (ascending or descending) or changing column width.
  - Selecting rows in tables.
  - Entering text in the Editable Field control.
  - Selecting text entries from the Custom Text Selection control or values of a text group from the Text Group Selection control.
  - Adding, modifying, and deleting comments from the Comments table.

- The Stop icon or the Stop button in the Report Management section stops the execution of a Report Definition.

In Run mode, the layout elements are populated with data.

Figure 40: Run Mode
NOTE 1:
You can toggle to Edit mode by clicking Edit on the Reports toolbar. If you perform sorting in Run mode and then switch to Edit mode, the Select Edit Option dialog box displays asking whether you want to save or discard the changes you made in Run, or to create a new Report Definition based on the changes.

NOTE 2:
In Run mode, when you move the cursor over a table/plot, a tooltip displays the applicable filter and the number of records (only for tables). The number of records tooltip is helpful in deciding the destination type, for example, Printer.

NOTE 3:
When you select Control Panel > Region and Language > Additional Settings, you can configure local settings for the following fields:
- numeric (including decimal symbol, no. of digits after decimal)
- short date
- short time
The report workspace specifications, such as page size/margin or table width/height, also change according to the local settings.

8.2.13 Report Workpanes
You can work with reports in the Primary, Secondary, and Contextual panes.

8.2.13.1 Primary Pane
In the Primary pane, you can view and work with all types of reports and perform activities including, but not limited, to the following:
- Create and configure a Report Definition by:
  - Adding various report elements
  - Configuring filters
  - Applying formatting
- Locate and Modify a Report Definition
- Run a selected Report Definition
- View report execution status, document creation status, and so on during report execution
- Display generated report in Run mode
- View a report as a PDF or XLS
- Export/Import a Report Definition
- Route a report to:
  - Folders as files (PDF/XLS)
  - Email recipients as a file attachment (PDF/XLS)
  - Local printers (PDF only)
### Figure 41: Reports – Primary Pane Workflow

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Report Definition Selection</td>
<td>Location of Report Definition and Report folders in the Application View of System Browser.</td>
</tr>
<tr>
<td>2. Report Execution</td>
<td>Reports toolbar containing Report Definition execution command icons: Run or Run As.</td>
</tr>
<tr>
<td>3. Executed Report Display</td>
<td>Location of executed Report Definition. <strong>NOTE:</strong> This displays in Run mode.</td>
</tr>
<tr>
<td>4. Report Management</td>
<td>Status details of the executed or currently running Report Definition.</td>
</tr>
<tr>
<td>5. Report Definition Properties</td>
<td>Properties (Last Run, Summary Status, and Show in Related Items) displayed in the Extended Operation tab.</td>
</tr>
</tbody>
</table>
8.2.13.2 Secondary Pane

If the Primary pane is unlocked (horizontal pushpin icon -), then you can work with the following three additional report types in the Secondary pane:

- Related Report: Opens the report related to the selected System Browser object.
- Show in Related Items Report: Opens a report with the Show in Related Items check box selected.

Figure 42: Reports - Secondary Pane Workflow

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Point Selection</td>
<td>Location of Point in the Application View or Management View of System Browser.</td>
</tr>
<tr>
<td>2 Report Definition Selection</td>
<td>Report Definition selected in the Related Items tab.</td>
</tr>
<tr>
<td>3 Executed Report Display</td>
<td>Location of selected Report Definition—before and after execution—with command toolbar to execute the Report Definition located on the left side of the Secondary pane. <strong>NOTE:</strong> Executed Report Definitions display in Run Mode.</td>
</tr>
<tr>
<td>4 Report Management</td>
<td>Status details of the executed or currently running Report Definition.</td>
</tr>
<tr>
<td>5 Report Definition Properties</td>
<td>Properties (Last Run, Summary Status, and Show in Related Items) displayed in the Extended Operation tab.</td>
</tr>
</tbody>
</table>
8.2.13.3 Contextual Pane — Extended Operation Tab

You can generate a selected report automatically by clicking **Execute** in the **Extended Operations** tab of the **Contextual pane**.

![Contextual Pane - Extended Operations](image)

**Figure 43: Contextual Pane - Extended Operations**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Report Definition Selection</td>
<td>Location of <strong>Report Definitions</strong> and <strong>Report</strong> folders in the <strong>Application View</strong> of System Browser.</td>
</tr>
<tr>
<td>2 Automatic report execution</td>
<td>Runs a Report Definition in the background.</td>
</tr>
<tr>
<td>3 Report Definition Properties</td>
<td>Properties (Last Run, Summary Status, and Show in Related Items) displayed in the <strong>Extended Operations</strong> tab.</td>
</tr>
</tbody>
</table>
8.2.14 Validating a Report Definition

The Report Definition is validated when you open or save it for:

- Columns of the tables present in the Report Definition
- Condition filters
- Availability of the content template

![Figure 44: Report Validation Dialog Box](image)

Columns in Tables Present in the Definition

When you open or save a Report Definition, it is checked for the validity of the selected columns present in the tables. If any of the columns in the Report Definition are invalid, an error message displays.

You can run a report containing invalid columns; however, in the executed report, the invalid column will not contain any data. The same is true for any PDF/XSL that you generate from the executed report.

Condition Filters

If you open a Report Definition where a Condition filter exists on an invalid column, an error message displays the name and position of the table, and any invalid Condition filters.

You can still run the report, but the tables containing invalid condition filters display empty. The same is true for any PDF/XSL that you generate from the report.

To resolve the validation error on invalid columns or Condition filters, do one of the following depending on the table type:

- Objects table: The table columns correspond to object properties. If any of the properties are no longer available, the error message displays when opening or saving a report having this property as a column. You must either import the related libraries or remove the invalid columns to resolve this error.
- Other tables: Remove the invalid columns.

Availability of the Content Template

When you open a Report Definition that contains a table or plot from which the associated content template is missing, an error message displays. While you can open the definition, any unsupported tables or plots do not display.
8.2.15 Report and Operators

8.2.15.1 Objects Report

An Objects report contains an Objects table that displays the run time property values of system objects. To know the property values of any object, such as present value, high limit, low limit and so on, you must configure an Objects report. Each object has a corresponding object model associated with it. An object model specifies the properties applicable to the object type, configuration attributes of properties, and additional settings like data type of the property, text group configured for the property, commands defined for the property and so on. Each property value has configuration attributes like property name, property descriptor, unit, resolution, minimum and maximum value, and so on. For example, the Present Value property has attributes such as Unit, Resolution, Type, Descriptor and so on. The Objects report also provides information on these attributes.

The properties applicable to an object type can be displayed as columns in the Objects table by setting the appropriate display levels in the Properties expander in the Models and Functions tab. In the following screenshot, the AlarmFault and Alarm.OffNormal properties cannot display as table columns since their display levels are not set.

If a property has array attributes assigned to it, then the text entries in the text group associated with the array attributes of the property can be set as the attribute columns in the Objects table. For example, the Event_Time_Stamps property of the BACnet Analog Input object type has the TxG_BACnetEventTransitionBits Text group associated with its array attributes. You can set the text entries of the text
group (To Off Normal, To Fault, To Normal) to display as columns in the Objects table.

Related Topics
Configuring an Objects Report [➜ 264]

8.2.15.2 Activities Report

The Activities report provides information on system activities over a period of time. For example, you can generate an Activities report to get the treatment-related information logged in the database for activities.

You can create and configure an Activities report if you want to determine the number of times the present value property of an Analog Input object has exceeded 100 in the last 24 hours. In order to monitor the change of value of any property in the activities report, you must ensure that the AL attribute for the property is selected for the respective Analog Input object. For this you must navigate to the Properties expander in Object Configurator.

Constraints

- You cannot sort or apply Condition filters for the following columns:

<table>
<thead>
<tr>
<th>No Sorting</th>
<th>No Condition Filter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Discipline</td>
<td>Error</td>
</tr>
<tr>
<td>Subdiscipline</td>
<td>DPE Name 1</td>
</tr>
<tr>
<td>Type</td>
<td>DPE Name 2</td>
</tr>
<tr>
<td>Subtype</td>
<td>Associated Object Description</td>
</tr>
<tr>
<td>Object Description</td>
<td>Associated Object Name</td>
</tr>
<tr>
<td>Object Name</td>
<td>Associated Object Designation</td>
</tr>
<tr>
<td>Object Property</td>
<td>Associated Object Location</td>
</tr>
<tr>
<td>Quality</td>
<td>Associated Object Name (Internal)</td>
</tr>
<tr>
<td>Previous Quality</td>
<td></td>
</tr>
<tr>
<td>Object Designation[Application View]</td>
<td></td>
</tr>
</tbody>
</table>
When you add a Condition filter to the Activities table, you cannot apply the OR operator between two filter expressions that are located on two different columns.

- You can apply the OR operator between two filter expressions set on the same column.
- You cannot apply the NOT operator in the Condition filter for an Activities table. For example, NOT 'Action' = "Add Camera" is invalid.

**Related Topics**
Configuring an Activities Report [➙ 265]

### 8.2.15.3 Event Details Report

The Event Details report provides information related to events and their treatment. When you run the report, the preliminary details of the event such as Event Time, Event Category, Event Cause, Event ID, Object Description, and Object Designation display as parent records. Additional information related to the treatment of the event such as Time, Action taken, Message text, User Name, Management Station, Attachment, Value, and Previous Value display as child records. The child records display only in the Run mode. The total number of available children can be read from the Row No. column.

The number of records that display in the child table depends on the following:

- If a Name filter with wild card characters is applied to the report or a default Name filter is applied, then the latest 1000 records display.
- If a single Name filter without any wild card characters is applied, then all records display. In this case, the Row Number column is empty.
- If multiple Name filters are applied, then the child table is restricted to the latest 1000 records.

You can configure an Event Details report for the following:
• Viewing event details of a particular event using Investigative Treatment.
• Viewing event details of a particular event using Assisted Treatment.
• Viewing event details for specific events using Reports. For example, you can configure an event details report to display all events of type Fault or Life Safety on an Analog Output object for a 24-hour period.

Constraints
• You cannot sort or apply Condition filters for the following columns:

<table>
<thead>
<tr>
<th>No Sorting</th>
<th>No Condition Filter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Discipline</td>
<td>DPE Observer</td>
</tr>
<tr>
<td>Subdiscipline</td>
<td>Event Source</td>
</tr>
<tr>
<td>Type</td>
<td>Observer Description</td>
</tr>
<tr>
<td>Subtype</td>
<td>Observer Name</td>
</tr>
<tr>
<td>Object Description</td>
<td>Observer Designation</td>
</tr>
<tr>
<td>Object Name</td>
<td>Observer Location</td>
</tr>
<tr>
<td>Object Property</td>
<td>Observer Identifier (Internal)</td>
</tr>
<tr>
<td>Object Designation</td>
<td>Event Went</td>
</tr>
<tr>
<td></td>
<td>Object Designation [Application View]</td>
</tr>
<tr>
<td></td>
<td>Object Designation [Current View]</td>
</tr>
<tr>
<td></td>
<td>Object Designation [Management View]</td>
</tr>
<tr>
<td></td>
<td>Object Identifier [Internal]</td>
</tr>
<tr>
<td></td>
<td>Object Location</td>
</tr>
<tr>
<td></td>
<td>Object Location [Application View]</td>
</tr>
<tr>
<td></td>
<td>Object Location [Current View]</td>
</tr>
<tr>
<td></td>
<td>Object Location [Management View]</td>
</tr>
<tr>
<td></td>
<td>Observer Description</td>
</tr>
<tr>
<td></td>
<td>Observer Name</td>
</tr>
<tr>
<td></td>
<td>Observer Designation</td>
</tr>
<tr>
<td></td>
<td>Observer Location</td>
</tr>
<tr>
<td></td>
<td>Observer Identifier (Internal)</td>
</tr>
<tr>
<td>Alias [Object]</td>
<td></td>
</tr>
<tr>
<td>Alias [Observer]</td>
<td></td>
</tr>
</tbody>
</table>

• When you add a Condition filter to the Event Details table, you cannot apply the OR operator between two filter expressions located on two different columns.
• You can apply the OR operator between two filter expressions set on the same column To apply the OR operator on the same column, select the column and the operator, press SHIFT or CTRL, depending on whether you want to select values listed next to each other or away from each other, and then click Add.
• You cannot apply the NOT operator in the Condition filter for an Event Details table.

Related Topics
Viewing Event Details using Investigative Treatment [➙ 267]
Viewing Event Details using Assisted Treatment [➙ 266]
Viewing Event Details for specific events using Reports [➙ 266]
8.2.15.4 Events Report

The Events table provides information related to events. It provides information such as Event Time, Event State, Event Category, Event Cause, Event ID, Object Description, and Object Designation.

Constraints

- You cannot sort or apply Condition filters on the following columns:

<table>
<thead>
<tr>
<th>No Sorting</th>
<th>No Condition Filter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Discipline</td>
<td>DPE Observer</td>
</tr>
<tr>
<td>DPE Observer</td>
<td>Event Source</td>
</tr>
<tr>
<td>Event Source</td>
<td>Observer Description</td>
</tr>
<tr>
<td>Subdiscipline</td>
<td>Observer Name</td>
</tr>
<tr>
<td>Type</td>
<td>Observer Designation</td>
</tr>
<tr>
<td>Subtype</td>
<td>Observer Location</td>
</tr>
<tr>
<td>Object Description</td>
<td>Observer Identifier (Internal)</td>
</tr>
<tr>
<td>Object Name</td>
<td></td>
</tr>
<tr>
<td>Object Designation</td>
<td></td>
</tr>
<tr>
<td>Object Designation [Application View]</td>
<td></td>
</tr>
<tr>
<td>Object Designation [Current View]</td>
<td></td>
</tr>
<tr>
<td>Object Designation [Management View]</td>
<td></td>
</tr>
<tr>
<td>Object Location</td>
<td></td>
</tr>
<tr>
<td>Object Location [Application View]</td>
<td></td>
</tr>
<tr>
<td>Object Location [Current View]</td>
<td></td>
</tr>
<tr>
<td>Object Location [Management View]</td>
<td></td>
</tr>
<tr>
<td>Object Identifier [Internal]</td>
<td></td>
</tr>
<tr>
<td>Object Property</td>
<td></td>
</tr>
<tr>
<td>Observer Description</td>
<td></td>
</tr>
<tr>
<td>Observer Name</td>
<td></td>
</tr>
<tr>
<td>Observer Designation</td>
<td></td>
</tr>
<tr>
<td>Observer Location</td>
<td></td>
</tr>
<tr>
<td>Observer Identifier (Internal)</td>
<td></td>
</tr>
<tr>
<td>Alias [Object]</td>
<td></td>
</tr>
<tr>
<td>Alias [Observer]</td>
<td></td>
</tr>
<tr>
<td>Unit</td>
<td></td>
</tr>
</tbody>
</table>

- When you add a Condition filter to the Event Details table, you cannot apply the OR operator between two filter expressions set on two different columns.
- You can apply the OR operator between two filter expressions set on the same column. To apply the OR operator on the same column, select the column and the operator, press **SHIFT** or **CTRL**, depending on whether you want to select values listed next to each other or away from each other and then click **Add**.
- You cannot apply the NOT operator in the Condition filter for an Events table.
8.2.15.5 Trends Plot

The Trends Plot provides a graphical representation of the change of value of an object over a period of time. In order to view the change of value graphically, you must assign a Trend View Definition as a Name filter to the Plot. You cannot add a Condition filter to the Trends Plot.

For example, you can create a Trends Plot if you want to track the change of value of an Analog Input object graphically over a period of 10 hours.

Related Topics
Configuring a Trends Plot [→ 267]

8.2.15.6 All Logs Report

The All Logs table provides information on system activities and events.

Constraints

- You cannot apply sorting on the following columns:

<table>
<thead>
<tr>
<th>No Sorting</th>
<th>Discipline</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Subdiscipline</td>
</tr>
<tr>
<td></td>
<td>Type</td>
</tr>
<tr>
<td></td>
<td>Subtype</td>
</tr>
<tr>
<td></td>
<td>Source Description</td>
</tr>
<tr>
<td></td>
<td>Source Name</td>
</tr>
<tr>
<td></td>
<td>Source Designation</td>
</tr>
<tr>
<td></td>
<td>Source Location</td>
</tr>
<tr>
<td></td>
<td>Source Designation [Application View]</td>
</tr>
<tr>
<td></td>
<td>Source Designation [Current View]</td>
</tr>
<tr>
<td></td>
<td>Source Designation [Management View]</td>
</tr>
<tr>
<td></td>
<td>Source Location [Application View]</td>
</tr>
<tr>
<td></td>
<td>Source Location [Current View]</td>
</tr>
<tr>
<td></td>
<td>Source Location [Management View]</td>
</tr>
<tr>
<td></td>
<td>Source Identifier [Internal]</td>
</tr>
<tr>
<td></td>
<td>Property</td>
</tr>
<tr>
<td></td>
<td>Quality</td>
</tr>
<tr>
<td></td>
<td>Previous Quality</td>
</tr>
<tr>
<td></td>
<td>Alias [Observer]</td>
</tr>
<tr>
<td></td>
<td>Alias [Source]</td>
</tr>
</tbody>
</table>

- When you add a Condition filter to the All Logs table, you cannot apply the OR operator between two filter expressions set on two different columns.
- You can apply the OR operator between two filter expressions set on the same column. To apply the OR operator on the same column, select the column and the operator, press SHIFT or CTRL, depending on whether you want to select values listed next to each other or away from each other, and then click Add.
- You cannot apply the NOT operator in the Condition filter for a Log View table.
- You can only apply the Equal to (=) operator to the following columns in the Condition Filter dialog box.
- Discipline
- Subdiscipline
- Type
- Subtype
- Source Description
- Source Name
- Source Designation
- Source Location
- Source Designation [Application View]
- Source Designation [Current View]
- Source Designation [Management View]
- Source Location [Application View]
- Source Location [Current View]
- Source Location [Management View]
- Source Identifier [Internal]

8.2.15.7 **In Operator**

The In operator is used to filter data in a column that supports display of multiple values in single cell.
### 8.2.16 Reports Troubleshooting

The following table may help you to resolve possible errors when working with reports for operating procedures.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Resolution</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reporting snap-in does not display.</td>
<td>• You do not have the Show privilege for Reporting.</td>
<td>• Contact the system administrator to obtain the Show privilege.</td>
<td></td>
</tr>
<tr>
<td>Report for operating procedures is not executed.</td>
<td>• Configured Report Definition is out of Scope.</td>
<td>• Contact the system administrator.</td>
<td>• See Configuring a New Operating Procedure for the configuration steps.</td>
</tr>
<tr>
<td></td>
<td>• Configured Report Definition is either deleted or corrupted.</td>
<td>• Configure a new report definition.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Report Definition is not configured in operating procedures.</td>
<td>• Ensure that the report definition is configured in the Operating Procedure step.</td>
<td></td>
</tr>
<tr>
<td>Save User Input and Send to Output buttons are not available.</td>
<td>• You do not have the Show privilege for Reporting.</td>
<td>• Contact the system administrator and get the Show privilege.</td>
<td>• See Configuring a New Operating Procedure for the configuration steps.</td>
</tr>
<tr>
<td></td>
<td>• Configured Report Definition is out of Scope.</td>
<td>• Contact the system administrator.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Configured Report Definition is either deleted or corrupted.</td>
<td>• Configure a new report definition.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Report Definition is not configured in operating procedures.</td>
<td>• Ensure that the report definition is configured in the Operating Procedure step.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Configured report does not contain form controls. In this case, only the Save User Input button is not available.</td>
<td>• Configure the report with form controls.</td>
<td></td>
</tr>
<tr>
<td>Report for operating procedure does not display the configured table in the Run mode.</td>
<td>• The configured table’s content provider is not available in the project.</td>
<td>• Contact the system administrator and get the content provider added to the project.</td>
<td>To create a graphics, see Creating a Graphic.</td>
</tr>
<tr>
<td></td>
<td>• One of the element such as graphics has not received data from the service/graphics engine.</td>
<td>• Create a graphics containing the object in event.</td>
<td></td>
</tr>
<tr>
<td>PDF document generated for operating procedure does not display any data.</td>
<td>Data is not available as per the filters applied to the configured table.</td>
<td>Check and correct the applied filters. Create a graphics containing the object in the event.</td>
<td>To create a graphics, see Creating a Graphic.</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>The report for the operating procedure cannot get routed to the specified printer.</td>
<td>Printer is faulty. Printer is out of paper. Printer is jammed. Printer is not available. Printer is offline. Printer door is open.</td>
<td>Rectify the printer related issues.</td>
<td></td>
</tr>
<tr>
<td>The report for the operating procedure cannot get routed to the specified folder.</td>
<td>You do not have permissions for the specified folder.</td>
<td>Either contact the system administrator to receive the required permissions on the configured folder or configure a new folder.</td>
<td></td>
</tr>
<tr>
<td>Table in the report does not display any data.</td>
<td>The Report Definition has an invalid condition filter.</td>
<td>Ensure that the Condition filter is applied properly.</td>
<td>For steps to apply the Condition filter to a table, see Applying a Condition filter.</td>
</tr>
</tbody>
</table>
9 Log Viewer

This section provides background information and instructions for using the Log Viewer application in Desigo CC.

9.1 Working with Log Viewer

This section provides step-by-step instructions for using Log Viewer. For background information see Log Viewer Reference [➙ 347]. Perform the procedures in this section as needed.

9.1.1 Accessing Log Viewer from System Browser

▷ System Manager is in Operating mode.

1. In System Browser, select Application View.
2. Select Applications > Log Viewer.
   ▷ Log Viewer displays with the combined data from the Activity Log and Event Log.

9.1.2 Configuring a Log View Definition

You can configure a log view definition by defining the size of the log view, specifying the columns to be displayed, applying filters on the displayed data, sorting log entries, and so on.

9.1.2.1 Defining the Log View Size

You can define a size for the log view to display a specific number of records. This view size is system specific in a distributed environment. So, if there are 3 systems configured for a distributed environment, each system will have its own view size.

1. In System Browser, select Application View.
2. Select Applications > Log Viewer.
3. Click the Extended Operation tab.
   ▷ The number of records in the log view displays in View Size.
4. In the Value field, specify a size for the log view. The maximum value is 250.000.
5. Click the Set button next to the Value field.
6. Click Refresh .
   ▷ The log view refreshes.
   NOTE: A large view size will slow down the process. In order to view and print a large amount of data, you must export the Log View Definition to Reports.

9.1.2.2 Selecting Columns

▷ The Log Viewer displays or the Detailed Log tab is open.

1. Click Select Columns .
   ▷ The Select Columns dialog box displays. In the Available Columns list, the default columns are selected. These columns also display in the Selected...
**Columns** list of the dialog box. These columns represent the columns of the Log View Definition.

2. In the Available Columns list, select the check box preceding the column names you want displayed.
   - The **Selected Columns** list box is updated.

3. Click OK.
   - The Log View Definition is updated.

**NOTE:**
For each view present in the system, you can add the view-specific columns (Object Location and Object Designation) to a log view from the **Select Columns** dialog box. If you run the Log View Definition from the **Secondary** pane and activities such as renaming a view are done in the **Primary** pane, the effect of these changes reflect in the Log View Definition only after you click **Refresh**.

### 9.1.2.3 Hiding Columns

Perform any of the following steps to hide columns:
- Right-click the column that you want to hide, and select **Hide Column**.
- Click the drop-down arrow on the header of the column that you want to hide and select **Hide Column**.

### 9.1.2.4 Reordering Columns

Log data displays in the **Log Viewer** or the **Detailed Log** tab.

1. Click **Select Columns**.
   - The **Select Columns** dialog box displays.

2. In the **Selected Columns** list, select the column whose position should be changed and click **Move Up** or **Move Down**.

3. Click OK.
   - The columns displayed in the log view are re-ordered.

**NOTE:**
You can manually reorder a column displayed in the grid by selecting the column and dragging and dropping it to a new location.

### 9.1.2.5 Removing Columns

Log data displays in the **Log Viewer** or the **Detailed Log** tab.

1. Click **Select Columns**.
   - The **Select Columns** dialog box displays.
2. In the **Selected Columns** list, select the column to be removed and click **Remove**.

3. Click **OK**.
   - The log view refreshes automatically and the column is removed.

### 9.1.2.6 Resizing Columns

- In the **Log Viewer** grid, drag the column separator next to the column to be resized.
   - The column is resized.
   - You cannot reduce the width of a column below its minimum width.

### 9.1.2.7 Applying Search Filters on Columns other than Date/Time

- Log data displays in the **Log Viewer** or the **Detailed Log** tab.
  1. Right-click the data value for which you want to apply the filter.
  2. From the menu options, select **Custom Filter**.
     - The **Custom Filter Dialog Box** displays.
  3. Click the **Search Filter** tab.
  4. Click the **Add Filter** button.
     - An empty row with the **Operator** and **Value** fields displays.
  5. Select a value from the **Operator** drop down list. In order to specify the value, you must either select a value from the **Value** drop down list or type a value in the field.
     - The filter expression displays in the **Filter expression** field.
  6. Click **OK**.
     - The data matching your filter condition is retrieved from the server.

### 9.1.2.8 Applying Search Filters on Date/Time Columns

- Log data displays in the **Log Viewer** or the **Detailed Log** tab.
  1. Position your cursor over a column with date-time data, such as **Date/Time**.
  2. Right-click and select **Custom Filter**.
     - The **Time Filter** dialog box displays.
  3. Click the **Search Filter** tab.
  4. Enter the appropriate date/time values in the **Exact**, **Custom**, or **Relative** options.
     - **NOTE**: By default, the **Unlimited** option is selected in the **Time Filter** dialog box. If you want to view records having NULL as the value, select the **Null** option.
     - A preview of the date/time values you specified displays in the **Preview of Resulting Time Range** section.
  5. Click **OK**.
  6. The log view refreshes and the data corresponding to the specified date time values displays.
9.1.2.9 Modifying Search/Result Filters on Columns other than Date/Time

- Log data displays in the **Log Viewer** or the **Detailed Log** tab.
- You have applied a search/result filter to the log data.

1. Right-click the data value in the column of the filter to be modified and select **Custom Filter**.
   - The **Custom Filter** dialog box displays.

2. Click the **Search** or **Result Filter** tab, depending on the filter that you want to modify.

3. Modify the filter condition.

4. Click **OK**.
   - The view refreshes and the data matching the modified filter displays.

9.1.2.10 Modifying Search/Result Filters on Date/Time Columns

- Log data displays in the **Log Viewer** or the **Detailed Log** tab.
- You have applied a search/result filter to a column displaying date time data.

1. Right-click the data value in the column pertaining to the filter to be modified and select **Custom Filter**.
   - The **Time Filter** dialog box displays.

2. Click the **Search** or **Result Filter** tab, depending on the filter that you want to modify.

3. Modify the filter condition.

4. Click **OK**.
   - The view refreshes and the data matching the modified filter displays.

9.1.2.11 Deleting Search Filters on Columns other than Date/Time

- Log data displays in the **Log Viewer** or the **Detailed Log** tab.
- You have applied a search filter to the log data.

1. Right-click the data value in the column pertaining to the search filter to be deleted.

2. From the menu options, select **Custom Filter**.
   - The **Custom Filter** dialog box displays.

3. Click the **Search Filter** tab.

4. Select the check box preceding the **Operator** and **Value** fields corresponding to the search filter expression to be deleted.

5. Click **Remove Filter**.

6. Click **OK**.
   - The log view refreshes and displays all the data from the database.
9.1.2.12 Deleting Search Filters on Date/Time Columns

- Log data displays in the Log Viewer or the Detailed Log tab.
- You have applied a search filter to a column displaying date time data.

1. Right-click the data value in the column pertaining to the filter to be modified.
2. From the menu options, select Custom Filter.
   - The Time Filter dialog box displays.
3. Click the Search Filter tab.
4. Select the Unlimited option.
5. Click OK.
   - The view refreshes.

9.1.2.13 Applying Result Filters on Columns other than Date/Time

You can apply a result filter on the data set displayed in a log view using any of the following techniques:

- Custom Filter
- Quick Filter
- Selection Filter
- Drag-and-Drop

When you apply a Result Filter on a column, a filter icon displays in the column header indicating that a filter is applied on the column.

**Custom Filter**

1. Right-click the data value for which you want to apply the filter.
2. Select Custom Filter.
   - The Custom Filter Dialog Box displays.
3. Click the Result Filter tab.
4. Click the Add Filter button.
   - An empty row with the Operator and Value fields displays.
5. Specify the operator by selecting values from the Operator and Value drop-down list.
   - The filter expression displays in the Filter Expression field.
6. Click OK.
   - The result filter is applied to the data set.

**Quick Filter**

To apply a quick filter, do the following:

- Right-click the data value for which you want to apply the filter and select the Filter By option.

**NOTE:** The last three filters applied on a column are listed as menu options that display when you right-click a data value. You can also apply a quick filter by selecting any of these options.

**Selection Filter**

The Selection filter is applicable for filtering ENUM type of data. See List of ENUM columns section in Custom Filter for a list of columns of type ENUM. Perform the following steps to apply the Selection filter:
1. Click the inverted arrow on any column displaying ENUM data.
   ▶️ The list of data entries for the column display as menu items.
2. Select the checkbox pertaining to the entry on which you want to apply the filter.
   **NOTE:** For faster retrieval of the data entries, you can type the value of the entry to be retrieved in the text box above the Selection filter.
3. Click **OK**.
   ▶️ The view displays the data filtered on the basis of the selected entry.
   **NOTE:** If you select more than one data entry, the system displays the data matching either of the selected entries.

**Drag-and-Drop**

You can also apply the result filter by using the drag-and-drop function. However, this function is not applicable when you are applying the result filter on the data displayed in the **Detailed Log** tab.

From System Browser, drag-and-drop an object that you want to set as a condition filter to a log view. You can also drag-and-drop multiple objects from System Browser. For this, ensure that the Manual navigation option in System Browser is checked. The log view displays the entries corresponding to the object. In case of multiple selection, the data matching either of the selected objects displays.

**NOTE:**
If you apply a result filter on a column with an existing result filter, the new filter condition replaces the older condition.

---

**9.1.2.14 Applying Result Filters on Date/Time Columns**

You can apply a result filter on the columns displaying date/time data using any of the following techniques:

- Custom Filter
- Date Filters
- Quick Filter

**Custom Filter**

1. Position your cursor over a column with date-time data, such as Date/Time.
2. Right-click and select **Custom Filter**.
   ▶️ The **Time Filter** dialog box displays.
3. Click the **Result Filter** tab.
4. Specify the appropriate date/time values in the **Exact**, **Custom**, or **Relative** options.
   **NOTE:** By default, the **Unlimited** option is selected in the **Time Filter** dialog box. If you want to view records having NULL as the value, select the **Null** option.
   ▶️ A preview of the date/time values you specified displays in the **Preview of Resulting Time Range** section.
5. Click **OK**.
   ▶️ The log view refreshes automatically and the data corresponding to the specified date time values displays.
   **NOTE:** If you specify a date in the **Exact** option, the data corresponding only to the specified date displays.
Date Filters
Using the Date Filters option, you can retrieve data for the current day, previous day, current week, previous week, current month, previous month, current year, or previous year. Perform the following steps to retrieve the data for the required time period.
1) Click the drop-down arrow on any column displaying date/time data, for example, Date/Time. A list of menu options displays.
2) Position your mouse pointer over Date Filters. A list of options to filter the data on the basis of the current day (Today), previous day (Yesterday), current week (This Week), previous week (Last Week), current month (This Month), previous month (Last Month), current year (This Year), or previous year (Last Year) displays.
3) Select the required option. The view refreshes and displays the data according to the selected time option.

Quick Filter
Perform the following step to apply a quick filter:
Right-click the data entry corresponding to the date time value for which you want to apply the filter and select Filter By. The log view refreshes and displays the entries corresponding to the selected date.

NOTE:
The last three filters applied on a column are listed as menu options that display when you right-click a data value. You can also apply a quick filter by selecting any of these options.

9.1.2.15 Deleting Result Filters
You can delete a result filter for a column displaying date/time or non date/time values by performing any of the following:

- Click Remove All Result Filters.
- Click the drop-down arrow on the column header with a result filter applied and click Remove Result Filter.
- Right-click the column entry on which the filter is applied, and select Remove Result Filter from the menu options.
- Remove the selection on the checkbox for the entry on which the filter is applied and clicking OK.
- For columns displaying values other than date/time: From the Custom Filter dialog box, click Remove Filter.
  NOTE: In order to make the Remove Filter button available, you must select the check box preceding the Operator and Value fields corresponding to the result filter expression you want to delete.

9.1.2.16 Moving Result Filters to Search Filters
A search filter obtains the data matching your filter expression from the database, whereas a result filter filters the data matching the filter expression from the data displayed in the log view.
For example, assume you apply a result filter on the data displayed in the log view to retrieve all records with Action as Primary Authentication. The records with Action as Primary Authentication display. However, there are more records with Action as Primary Authentication in the database than what displays in the log view. This is indicated by the following message: Configured View Size reached! Refine search via Search Filter. In this case, you must
move your result filter to a search filter to obtain all the matching data from the database.

**Moving Result Filters to Search Filters**

- You have applied a result filter on the data displayed in the log view.

1. Perform any of the following steps to move the result filter to a search filter.
   a. Click **Refresh**.
   b. Click the **Move to Search Filter** button in the **Custom Filter** dialog box for the column on which the result filter is applied and click **OK**.

   - The result filter is moved to a search filter and the data matching the filter condition is retrieved from the database.

   **NOTE:** When you move a result filter on a column to a search filter, any existing search filter present on the same column is replaced.

**9.1.2.17 Reverting to Saved Search Filters**

The Revert to Saved Search Filter function enables you to obtain the data provided by a previously defined search filter that is now being overwritten by a newly applied filter. For example, assume you apply a result filter on the log view to display all records of type Activity. The filter is moved to a Search filter in order to save it. You have now applied a new result filter to obtain data having Source Description as Users and have moved this to a search filter. So, the existing search filter is now replaced with the following new filter ('Record Type' = "Activity" AND 'Source Description' = "USERS") However, you want to retrieve the previously saved search filter ('Record Type' = "Activity").

- The log data displays.

1. Apply a result filter on any column. For example, Record Type = Activity.
   - The applied filter displays in the **Filters** area below the log view and the log view refreshes to display all records with Record Type as Activity.

2. Move the result filter to a search filter in order to save the filter condition.
   - The result filter is moved to a search filter and displays in the **Filters** area.
   - **Save** is enabled.

3. Save the information as a Log View Definition.
   - The saved Log View Definition is reloaded and the data matching the filter expression displays.

4. Apply a new result filter on any column. For example, Source Description is = Users.
   - The applied filter displays in the **Filters** area below the log view and the log view refreshes to display all records with Source Description as Users.

5. Move the result filter to a search filter.
   - The search filter is now modified and displays as follows in the **Filters** area.
   - ('Record Type' = "Activity" AND 'Source Description' = "USERS"). **Revert to Saved Search Filters** is now activated.
6. Click **Revert to Saved Search Filters**.
   - The view refreshes and displays the data according to the previously defined search filter ('Record Type' = "Activity"). The filter condition is also updated in the **Filters** area.

9.1.2.18 **Applying Search Filters on Columns Not Present in the Log View**

   - Log data displays in the Log Viewer or the Detailed Log tab.

1. Click **Search Filter**.
   - The **Search Filter** dialog box displays.

2. Select a column from the **Available Columns** list.
   - The operators and values associated with the selected column display in the **Operators and Values** list.

3. Select the required operator and value from the respective lists. If values are not displayed for the selected column, type in the value. To apply parentheses, select a filter expression and click ( ). The parentheses are applied at the start and end of the filter expression.

4. Click **Add**.
   - The filter expression displays in the **Filter Expression** field.

5. Click **OK**.
   - The log view refreshes.

9.1.2.19 **Modifying Search Filters on Columns Not Present in the Log View**

   - Log data displays in the Log Viewer or the Detailed Log tab.
   - You have applied a search filter to a Log View Definition.

1. Click **Search Filter**.
   - The **Search Filter** dialog box displays with the filter expression in the **Filter Expression** field.

2. Click the filter expression.
   - The column, operator, and value of the Condition filter expression display in their respective lists.

3. Modify the search filter expression as required.

4. Click **Update**.
   - The updated filter expression displays in the **Filter Expression** field.

5. Click **OK**.
   - The log view refreshes displaying the updated data according to the modified filter expression.
NOTE:
If you want to modify the search filter in a Log View Definition that is configured in a different language from your logged in language, you must change the filter language in the Configuration dialog box. This dialog box is accessed by clicking the Configuration icon.

9.1.2.20 Deleting Search Filters on Columns Not Present in the Log View

- Log data displays in the Log Viewer or the Detailed Log tab.
- You have applied a Condition filter to a Log View Definition.

1. Click Search Filter.
   - The Search Filter dialog box displays.
2. Delete the search filter expression from the Filter Expression field.
3. Click OK.
   - The log view refreshes displaying the latest data.

9.1.2.21 Sorting Log Entries

- Perform one of the following steps to sort the data. By default, the displayed data is sorted on the basis of the latest date and time.
  - To sort a column data in the ascending order, click the column header.
  - To change the sort order to descending, click the column header twice.
  - To sort the column data for multiple columns, click the column header of the first column, press the CTRL key and click the column headers of subsequent columns.
   - The data displays in the sorted order and a priority is assigned in case the sorting is applied to more than one columns.

NOTE 1:
When you save the data as a Log View Definition, the sort criteria is also saved. The next time when you load the Log View Definition, the data with the saved sort criteria displays.

NOTE 2:
You can change the sorting order of a column by pressing the CTRL key and clicking the column header.

NOTE 3:
To remove the sorting order and priority of a column, select a column on which sorting is not applied.

NOTE 4:
If you hide a column having a sort priority, the priority of other sorted columns changes. Additionally, the data in the log view is re-ordered based on the new priority. Re-selecting the hidden column from the Select Columns dialog box does not retain its sort order and priority.
9.1.3 Managing Log View Folders
Creating Log View folders enable you to properly organize Log View Definitions.

1. In System Browser, select Application View.
2. Select Applications > Log Viewer.
   - Log Viewer displays.
3. Click New Folder.
4. In the Create New Object dialog box, do the following:
   a. Enter a unique name and description.
   b. Click OK.
   - A new folder is created.

NOTE:
Deleting a folder also deletes its contents.

9.1.4 Saving a Log View Definition
You have configured a Log View Definition.

1. Click Save.
   - NOTE: You cannot save a result filter condition. In order to save the filter condition, you must move the result filter to a search filter and save the configuration as a Log View Definition.
   - In the Save Object As dialog box, do the following:
     a. Select the destination folder for saving the Log View Definition
     b. Enter a name and description.
     c. Click OK.
   - The Log View Definition is saved.
   - NOTE: If you have applied any filters to the Log View Definition the filter is also saved.

9.1.5 Creating a New Log View Definition from an Existing One
You have made modifications to an existing Log View Definition and want to save it as a new one.

1. Click Save As.
2. In the Save Object As dialog box, do the following:
   a. Select the destination folder for saving the new Log View Definition
   b. Enter a name and description.
   c. Click OK.
   - The new Log View Definition is saved.
   - NOTE: You cannot save a result filter condition. In order to save the filter condition, you must move the result filter to a search filter and save the configuration as a Log View Definition.
9.1.6 Saving a Log View Definition as a Report Definition

Log data displays in the Log Viewer or the Detailed Log tab.

1. (Optional) Perform any required configurations such as applying search filters, selecting columns, and applying sorting.

2. Click Save as Report Definition.

3. In the Save Object As dialog box, do the following:
   a. Select the Reports folder for saving the new Report Definition
   b. Enter a name and description.
   c. Click OK.

   A report definition is created and displays. This report definition contains the All Logs table. All configurations applied on the Log View Definition such as selected columns, order of columns, sorting on columns, search filters are present in the All Logs table in the report definition.

9.1.7 Creating a Default Log View Template

A default log view template enables you to create a customized template with a specific set of columns, their position, and size. The template also contains sorting applied to the column data. Any new Log View Definition is always based on the default template.

Log data displays in the Log Viewer or the Detailed Log tab.

1. (Optional) Configure the log view by selecting, reordering, or resizing the columns. You can also apply sorting on the displayed data.

2. Click Save as Default.

   A message box displays.

3. Click Yes.

   The log view is saved as a default template.

NOTE 1:
There can only be one default template. You can create a new template or use the one provided by the system. When you create a new template, the existing default template is overwritten. The default template in a distributed environment is system specific. So, if there are 3 systems configured for a distributed environment, each system will have its own default template.

NOTE 2:
View-specific columns in the log view template display in red color, if the view is deleted. You can get the details of the invalid columns by double-clicking the header text. The information displays in the Log View Validation message box.

NOTE 3:
If a saved log view definition contains view specific columns from a deleted view, the Log View Validation message box displays with details of the invalid columns when selecting the Log View Definition.
9.1.8 Deleting a Log View Definition

- At least one Log View Definition is available in System Browser.

1. In System Browser, select Application View.
2. Select Applications > Log Viewer > [Log View Definition].
3. Click Delete .
   - A confirmation message displays.
4. Click OK.
   - The Log View Definition is deleted.

9.1.9 Printing Log Grid Contents

- Log data displays in the Log Viewer or the Detailed Log tab.

1. In System Browser, select Application View.
2. Select Applications > Log Viewer.
3. Click Print .
4. In the Print dialog box, select the desired printer and specify the printing configurations.
5. Click Print.

NOTE:
The size of the font may vary depending on the number of columns in the log view grid.

Related Topics
Detailed Log Tab [→ 361]

9.1.10 Exporting a Log View Definition

1. In System Browser, select Application View.
2. Select Applications > Log Viewer > [Log View Definition].
3. Click Export .
   - The Browse for Folder dialog box displays.
4. Browse for the desired location and click OK.
   - A confirmation message displays. The Log View Definition is exported and saved.

9.1.11 Importing a Log View Definition

1. In System Browser, select the destination where you want to import the Log View Definition.
2. Click Import .
   - The File Open dialog box displays.
3. Browse to the folder where the exported Log View Definitions are available. Select the xml file to be imported and click **Open**.

   ➤ A confirmation message displays and the Log View Definition is added.

### 9.1.12 Viewing Object Properties and Hierarchy

You can view the properties as well as the hierarchy of an object associated with a log view entry using the following steps:

1. In System Browser, select **Application View**.
2. Select **Applications > Log Viewer**.
   
   ➤ **Log Viewer** displays the data.
3. Select a log view entry to view the properties of the object associated with it or double-click the entry to view its object hierarchy.

   ➤ When you select the log view entry, the properties of the object associated with the selected entry displays in the **Operation** and **Extended Operation** tabs. In case you select multiple objects, the property values of the selected objects display when you select the property name in the **Operation** and **Extended Operation** tabs. When double-clicking the log view entry, the complete hierarchy of the object associated with the entry displays.

### 9.1.13 Refreshing a Log View

You can refresh the data in a log view.

- Perform any one of the following steps to manually refresh the data:
  - Click **Refresh**. Any result filter on the log view is moved to the search filter.
  - Press **F5** on the keyboard.

   ➤ The system displays the updated data as per the configurations applied to the Log View Definition.

### 9.2 Log Viewer Reference

The main function of the Log Viewer application in Desigo CC is to present you the historical data from activities and events for performing analysis.

This section provides the general reference information on Log Viewer. For configuration and other procedures, see Working with Log Viewer [➙ 334].
9.2.1 Overview of Log Viewer

The Log Viewer application allows you to view the historical data related to system activities and events directly without creating and configuring a report from the Reports application.

The information related to all the system activities and events displays in a columnar pattern in a grid. You can create a subset of this information by applying the necessary configurations such as filters, identifying the columns to display, specifying the number of records to display, and other settings, such as resizing the column width or re-ordering the columns.

Once configured, this information can be saved as a Log View Definition that can be used later. When you access the Log View Definition at a later date, the latest data, according to the configurations that you have applied to the definition, displays.

In a distributed system, the data from all the systems displays in the log view grid. You can view log data using any of the following procedures:

- Selecting the Log Viewer root node, a log view folder, or a saved Log View Definition from the System Browser.
- Selecting an object from System Browser: This displays the Activity and Event Log records for the selected object in the Detailed Log tab.
- Selecting an object from any application such as Graphics, Trends, Textual Viewer, or Reports: This displays the latest 100 Activity and Event Log records for the object in the Detailed Log tab.
- Selecting an Activity type or Event type record in the log view: When you select an Activity type record from a log view, the latest 100 Activity and Event Logs for the selected object display in the Detailed Log tab. However, if an Event type record is selected, the details of the selected event including the different state changes of the event and the user activities performed in context of the event are displayed in the Detailed Log tab.
- Selecting an event from Event List: Displays information about the object involved in the event in the Detailed Log tab. However, if you have selected more than one object, the Detailed Log tab does not display any information.

NOTE:
When you select the Log Viewer root node, a log view folder, or a saved Log View Definition from System Browser, you may see the following message above the log view table: Configured View Size reached! Refine search via Search Filter. This means that there are more records in the database than can be displayed in the defined view size. In order to view such records you must either specify filters or modify existing filters.

The following table lists the default columns that display in the Log Viewer. In addition to these columns, you can add other columns from the Select Columns dialog box.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date/Time</td>
<td>Date/Time when the activity is performed or state change of event occurred.</td>
<td>Event ID</td>
<td>ID associated with the event.</td>
</tr>
<tr>
<td>Source</td>
<td>Description of the source object associated with the activity or event.</td>
<td>Log Type</td>
<td>The Desigo CC application where the activity, such as Event Printing or Commanding is performed.</td>
</tr>
<tr>
<td>Record Type</td>
<td>Type of information displayed. This information can be of type Activity or Event.</td>
<td>Action</td>
<td>Nature of the activity performed by the source object. For example, for a Users object type, the value of the Action field could be Login, Primary Authentication and so on.</td>
</tr>
<tr>
<td>-------------</td>
<td>---------------------------------------------------------------------------------</td>
<td>--------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Source Property</td>
<td>Name of the property associated with the source object on change of which the activity or event occurred.</td>
<td>Value</td>
<td>New value of the Source Property when an activity is performed.</td>
</tr>
<tr>
<td>Event Message Text</td>
<td>Event message text associated with the source object.</td>
<td>Quality</td>
<td>Quality of the new value.</td>
</tr>
<tr>
<td>Event Category</td>
<td>Category of the event.</td>
<td>Previous Value</td>
<td>Previous value of the Source Property when an activity is performed.</td>
</tr>
<tr>
<td>Event Time</td>
<td>Date/Time of the occurrence of the event.</td>
<td>Previous Quality</td>
<td>Quality of previous value.</td>
</tr>
<tr>
<td>Event State</td>
<td>State of the event.</td>
<td>Unit</td>
<td>Unit of measurement of value of source property.</td>
</tr>
<tr>
<td>Event Cause</td>
<td>Reason that triggered the event.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Additional Columns

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Details</td>
<td>Additional descriptive information of the activity performed.</td>
</tr>
<tr>
<td>Action Result</td>
<td>Status of a user activity. Possible values are Succeeded, Partially Succeeded, Failed, Unknown.</td>
</tr>
<tr>
<td>Attachment</td>
<td>Displays the link to the report output document that is created when performing the Operating Procedure Steps such as alarm printout, report, or treatment form.</td>
</tr>
<tr>
<td>Event mode</td>
<td>Mode in which the event is generated. Possible values are Normal and Maintenance.</td>
</tr>
<tr>
<td>Management Station</td>
<td>Displays the host name of the Desigo CC client from where the activity is performed.</td>
</tr>
<tr>
<td>System Name</td>
<td>Displays the name of the system to which the source object belongs. This is particularly helpful when working with a distributed environment, where you have data displaying from multiple systems.</td>
</tr>
<tr>
<td>Alias [Source]</td>
<td>Alias of the source object.</td>
</tr>
<tr>
<td>Source Designation</td>
<td>Default hierarchy of the source object composed using the names of the nodes present in the hierarchy.</td>
</tr>
<tr>
<td>Source Designation [Application View]</td>
<td>Hierarchy of the source object from Application View composed using the names of the nodes present in the hierarchy.</td>
</tr>
<tr>
<td>Source Designation [Current View]</td>
<td>Hierarchy of the source object from the currently selected view in the System Browser composed using the names of the nodes present in the hierarchy.</td>
</tr>
<tr>
<td>Source Designation [Management View]</td>
<td>Hierarchy of the source object from Management View composed using the names of the nodes present in the hierarchy.</td>
</tr>
<tr>
<td>Source Identifier [Internal]</td>
<td>Internal ID associated with the source object.</td>
</tr>
<tr>
<td>Source Location</td>
<td>Default hierarchy of the source object composed using the description of the nodes present in the hierarchy.</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Source Location [Application View]</td>
<td>Hierarchy of the source object from the Application View composed using the description of the nodes present in the hierarchy.</td>
</tr>
<tr>
<td>Source Location [Current View]</td>
<td>Hierarchy of the source object from the currently selected view in the System Browser composed using the description of the nodes present in the hierarchy.</td>
</tr>
<tr>
<td>Source Location [Management View]</td>
<td>Hierarchy of the source object from Management View composed using the description of the nodes present in the hierarchy.</td>
</tr>
<tr>
<td>Source Name</td>
<td>Name of the source object.</td>
</tr>
<tr>
<td>Observer Description</td>
<td>Description of the event enrollment object that monitors the source BACnet object.</td>
</tr>
<tr>
<td>Observer Property</td>
<td>Name of the property associated with the event enrollment object on change of which the activity or event occurred.</td>
</tr>
<tr>
<td>Observer Designation</td>
<td>Default hierarchy of the event enrollment object composed using the names of the nodes present in the hierarchy.</td>
</tr>
<tr>
<td>Observer Location</td>
<td>Default hierarchy of the event enrollment object composed using the description of the nodes present in the hierarchy.</td>
</tr>
<tr>
<td>Observer Name</td>
<td>Name of the Event Enrollment Object that monitors the source BACnet object.</td>
</tr>
<tr>
<td>Observer Identifier [Internal]</td>
<td>Internal Id for the Event Enrollment Object that monitors the source BACnet object.</td>
</tr>
<tr>
<td>Discipline</td>
<td>Discipline of the source object (for example, Building Automation).</td>
</tr>
<tr>
<td>Subdiscipline</td>
<td>Subdiscipline of the source object (for example, Communication for Management System discipline).</td>
</tr>
<tr>
<td>Type</td>
<td>Type of the source object (for example, network).</td>
</tr>
<tr>
<td>Subtype</td>
<td>Subtype of the source object (for example, BACnet for type Network).</td>
</tr>
<tr>
<td>Alert ID</td>
<td>Internal unique ID associated with an event.</td>
</tr>
<tr>
<td>User</td>
<td>Name of the user performing the activity or treating the event.</td>
</tr>
<tr>
<td>Validation Profile</td>
<td>Validation profile associated with the source object.</td>
</tr>
<tr>
<td>Audit Trail</td>
<td>Displays Audit Trail if the validated object creates an activity log. However, if an activity log is created by a non validated object, then this column displays Activity.</td>
</tr>
<tr>
<td>Object Version</td>
<td>Displays the version number of the validated object. The version number is incremented each time you perform an activity on the validated object. In case of a non validated object the Object Version column does not display any value.</td>
</tr>
<tr>
<td>Comment</td>
<td>Validation comment entered.</td>
</tr>
<tr>
<td>Reference Time</td>
<td>Displays the original time stamp of the record that is added, modified, or deleted using the Manual Correction snap-in.</td>
</tr>
<tr>
<td>Event Details</td>
<td>Message text associated with the event.</td>
</tr>
<tr>
<td>Category Priority</td>
<td>Priority associated with the event.</td>
</tr>
</tbody>
</table>
9.2.2 Log Viewer in Distributed Systems

When working with Log Viewer in a distributed environment, you must understand the details of the following additions, modifications, and applicable conditions.

Additions

System Name column - A column named System Name has been added as an additional column that displays the name of the system to which the source object belongs. As this is an additional column it must be explicitly added to the Log View Definition using the Select Columns dialog box.

Modifications

- View-Specific Columns - The column names of the view-specific columns such as Object Designation or Object Location in a distributed system depend on the presence of the views in a single system or multiple systems. Consider the following examples in which 3 systems (System 1, System2, and System 3) are configured in a distributed system.
  - A User-Defined View (UserView1) is present in System 1. In this case, the name of the Object Designation column will be Object Designation [System1.UserView1].
  - A User-Defined View (UserView1) is present in System 1 and System 2. A second User-Defined View (UserView2) is present in System 3. In this case, the name of the Object Designation column will be Object Designation [MultiSystem.UserView1] and Object Designation [System 3.UserView2].

Conditions

- In a distributed environment, the Detailed Log tab displays the default template of the system that is associated with the currently selected object. For example, if an Analog Input object belonging to System 1 is selected, then the default template for System 1 is loaded in the Detailed Log tab.
- The default log view template in a distributed environment is system specific. So, if there are 3 systems configured for a distributed environment, each system will have its own default template.
- The log view size in a distributed environment is system specific. So, if there are 3 systems configured for a distributed environment, each system will have its own view size.
9.2.3 Log Viewer Workspace

This section gives an overview of the Log Viewer workspace.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 System Browser</td>
<td>Displays all the saved Log View Definitions in Application View &gt; Applications &gt; Log Viewer.</td>
</tr>
<tr>
<td>2 Log Viewer Toolbar</td>
<td>Contains buttons for performing various actions in Log Viewer.</td>
</tr>
<tr>
<td>3 Log View</td>
<td>Displays the combined data from the Activity Log and Event Log.</td>
</tr>
<tr>
<td>4 Drop-down Arrow</td>
<td>When clicked, displays a menu with the following options:</td>
</tr>
<tr>
<td></td>
<td>Hide Column - Hides the column.</td>
</tr>
<tr>
<td></td>
<td>Select Column - Displays the Select Columns dialog box.</td>
</tr>
<tr>
<td></td>
<td>Remove Filters - Removes any online filters (if applied) on the column.</td>
</tr>
<tr>
<td></td>
<td>Custom Filter - Displays the Custom Filter dialog box.</td>
</tr>
<tr>
<td></td>
<td>Selection Filter - Applies only if the column displays ENUM data.</td>
</tr>
<tr>
<td></td>
<td>Displays a list of data entries for the column.</td>
</tr>
<tr>
<td></td>
<td>Date Filters - Applies only if the column displays date/time data.</td>
</tr>
<tr>
<td></td>
<td>Allows you to filter data on the basis of date and time.</td>
</tr>
<tr>
<td>5 Detailed Log tab</td>
<td>Displays information related to system activities and events.</td>
</tr>
</tbody>
</table>
### 9.2.4 Log Viewer Toolbar

The **Log Viewer** toolbar allows you to perform the following operations:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Folder Icon]</td>
<td>New Folder Creates a new folder below the <strong>Log Viewer</strong> root node.</td>
</tr>
<tr>
<td>![Save Icon]</td>
<td>Save Saves a newly created and configured Log View Definition or changes in the configuration of the currently selected Log View Definition. <strong>NOTE:</strong> This command is available only after you perform some operation on the displayed log view data. This command is not available if a result filter is applied to the log view. In order to enable this button, you must move the result filter to a search filter.</td>
</tr>
<tr>
<td>![Save as Icon]</td>
<td>Save as Saves the configuration of the currently selected Log View Definition as a new Log View Definition.</td>
</tr>
<tr>
<td>![Save as Default Icon]</td>
<td>Save as Default Saves the log view as a default template.</td>
</tr>
<tr>
<td>![Save as Report Definition Icon]</td>
<td>Save as Report Definition Saves the configuration of a Log View Definition such as search filters, column selection, sorting as a report definition.</td>
</tr>
<tr>
<td>![Delete Icon]</td>
<td>Delete Deletes the currently selected Log View Definition or a folder below the <strong>Log Viewer</strong> root node. Deleting the folder also removes its contents.</td>
</tr>
<tr>
<td>![Refresh Icon]</td>
<td>Refresh Refreshes the data displayed in a Log View Definition, <strong>Log Viewer</strong> root node, or a log view folder.</td>
</tr>
<tr>
<td>![Export Icon]</td>
<td>Export Exports the Log View Definition and saves it in an xml file format.</td>
</tr>
<tr>
<td>![Import Icon]</td>
<td>Import Imports a Log View Definition.</td>
</tr>
<tr>
<td>![Select Columns Icon]</td>
<td>Select Columns Displays the <strong>Select Columns</strong> dialog box that allows you to select the columns to display in the log view.</td>
</tr>
<tr>
<td>![Search Filter Icon]</td>
<td>Search Filter Displays the <strong>Search Filter</strong> dialog box that allows you to view a search filter condition and specify a filter condition on the columns that are not present in the log view.</td>
</tr>
<tr>
<td>![Remove all Result Filters Icon]</td>
<td>Remove all Result Filters Removes all the result filters applied on the log data.</td>
</tr>
<tr>
<td>![Revert to Saved Search Filters Icon]</td>
<td>Revert to Saved Search Filters Returns to the previously applied search filter.</td>
</tr>
<tr>
<td>![Stop Execution Icon]</td>
<td>Stop Execution Stops the execution of a log view.</td>
</tr>
<tr>
<td>![Configuration Icon]</td>
<td>Configuration Displays the <strong>Configuration</strong> dialog box that allows you to specify the filter language for modifying a search filter. This is essential when you are accessing a Log View Definition that is configured in a different language.</td>
</tr>
<tr>
<td>![Print Icon]</td>
<td>Print Displays the <strong>Print</strong> dialog box that allows you to print the log data.</td>
</tr>
</tbody>
</table>
9.2.5 Select Columns Dialog Box

The Select Columns dialog box allows you to add, remove, or reorder columns in a log view. You can access this dialog box using any of the following methods:

- Clicking the Select Column icon.
- Clicking the Select Column icon in the Detailed Log tab.
- Clicking the drop-down arrow on a column header and selecting the Select Column menu option.
- Right-clicking a column entry and selecting Select Column menu option.

![Select Columns Dialog Box](image)

**Figure 45: Select Columns Dialog Box**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parent tab</td>
<td>Allows you to add, remove, or reorder Parent columns in the log view.</td>
</tr>
<tr>
<td>Available Columns</td>
<td>Displays all the columns associated with the log view.</td>
</tr>
<tr>
<td></td>
<td>NOTE: View specific columns such as Source Location and Source Designation</td>
</tr>
<tr>
<td></td>
<td>are dynamically added to the Available Columns list when you create a new</td>
</tr>
<tr>
<td></td>
<td>view.</td>
</tr>
<tr>
<td>Selected Columns</td>
<td>Displays the default columns of a log view. You can add columns to the</td>
</tr>
<tr>
<td></td>
<td>selected columns list by selecting the check box associated with each</td>
</tr>
<tr>
<td></td>
<td>column in the Available Columns list.</td>
</tr>
<tr>
<td>Select Default</td>
<td>Selects the default columns in the Available Columns list.</td>
</tr>
<tr>
<td>Select All</td>
<td>Selects all the columns in the Available Columns list.</td>
</tr>
<tr>
<td>Clear All</td>
<td>Clears all the columns in the Available Columns list.</td>
</tr>
<tr>
<td>Move Up</td>
<td>Moves the selected column one step up in the Selected Columns list. The</td>
</tr>
<tr>
<td></td>
<td>Move Up button is unavailable if you select the column on the top.</td>
</tr>
<tr>
<td>Move Down</td>
<td>Moves the selected column one step down in the Selected Columns list. The</td>
</tr>
<tr>
<td></td>
<td>Move Down button is unavailable if you select the column at bottom.</td>
</tr>
<tr>
<td>Remove</td>
<td>Removes the selected column from the Selected Columns list.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
</table>
9.2.6 Custom Filter
A Custom filter allows you to define a filter expression from which you can filter data according to your specific requirements.

Custom Filter Condition
A Custom filter condition is composed of:
• Column name (Condition Name)
• Operators
• Condition value

Examples of Custom Filter Expressions
The following list contains some valid Custom filter expressions:
Event Category = "Life Safety"
Event Category = ("Status"; "Life Safety"; "Supervisory")
The Custom filter also allows you to create complex filters and conditions using mathematical and logical operators, and wildcard characters. The following operators are supported:

| Mathematical Operators | Enum Columns   | Equal to (=), Not Equal to (<>)
|                       | Enum Columns   | Equal to (=), Not Equal to (<>), Less than (<), Greater than (>), Less than Equal to (<=), Greater than Equal to (>=)
|                       | Text Columns   | Equal to (=), Not Equal to (<>), IN (-)
|                       | Variant Columns | Equal to (=), Not Equal to (<>), Less than (<), Greater than (>), Less than Equal to (<=), Greater than Equal to (>=), IN (-)
|                       | CNS Columns    | Equal to (=)
|                       | View Specific Columns | Equal to (=)

| Logical Operators | AND | Applying the custom filter expression on multiple columns. For example, 'Discipline' = "Building Automation" AND 'Subdiscipline' = "Access Control"
|                  | OR  | Applying the custom filter expression on the same column. For example, 'Discipline' = ("Building Automation","Energy Management")

- Wildcard Character: Asterisk (*)

List of ENUM columns
- Subtype
- Type
- Subdiscipline
- Discipline
- Record Type
- Action Result
- Event Mode
- Event Category
- Event State
- Log Type
- Action
- Quality
- Previous Quality

**Custom Filter Syntax**

To create a custom filter, you must know the data type of the column for which you want to apply the filter. The following examples should help you create custom filters without syntax errors.

1. If column displays text data, for example string or enumeration, then the value must be enclosed within double quotes.
   - ‘Source Description’ = “Analog Output 1”
   - ‘Event Mode’ = “Normal”
   - ‘Value’ = “True”
   - ‘Previous Quality’ = “#COM”

2. If column displays date time value, then the value must be in date time format configured in Windows on the server. Date must be in the short date format, time in the long time format (24 hours).
   - ‘Date/Time’ = 3/13/2014 16:04:25 (assuming that the date format on the server is M/D/YYYY)
   - ‘Value’ = 07/24/2014 11:52:00

3. If column displays Boolean data, such as TRUE or FALSE, the value must be enclosed in double quotes.
   - ‘Previous Value’ = “True”
   - ‘Value’ = “False”

4. If column displays numeric data, for example, 54.11, 25, -20, and so on, then the values must be specified as follows:
   - ‘Value’ = 54.11
   **NOTE:** The decimal separator must be according to your Windows Regional and Language settings.

5. If column displays bit string, then the value must be enclosed in double quotes.
   - ‘Quality’ = “Out of service”

6. Specify time values in a 24-hour clock format. For example, to specify the Source Time as 2.00 PM, type 14.00.

**Types of Custom Filters**

There are two types of custom filters that are applied to the log data:

- **Result filter:** The Result filter enables you to filter data from the displayed data set in the log view. You cannot save a result filter condition. In order to save the filter condition, you must move the result filter to a search filter and then save the configuration as a Log View Definition. You can apply a result filter from the Custom Filter dialog box, Quick filter, Selection filter, and using drag-and-drop.

- **Search filter:** The Search filter enables you to obtain the data matching the filter expression from the database. Any modification or addition to the search filter, refreshes the log view automatically, so that all the data matching the search filter is obtained from the database. To preserve the search filters, you must save the settings as a Log View Definition. Using the Search filter, you can filter the data for the columns that are present in the log view.
You can also apply a Search filter if you need to filter the data for a column that is not present in the log view. The combined Search filter is always available in the Search Filter dialog box.

For example, you can apply a result filter on the log data to retrieve all records with Source Description as "Analog Input 1". However, in order to save the filter condition, you must move the result filter to a Search filter.

**Custom Filter Dialog Box - For columns other than date/time**

The Custom Filter dialog box allows you to define Result and Search filter expressions on a particular column. You can access this dialog box by either:

- Clicking the dropdown arrow on a column heading displaying non date/time values and selecting Custom Filter.
- Right-clicking a log view entry displaying non date/time data and selecting Custom Filter.

<table>
<thead>
<tr>
<th>Custom Filter Dialog Box Components</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Result Filter</td>
<td>Allows you to specify a result filter.</td>
</tr>
<tr>
<td>Search Filter</td>
<td>Allows you to specify a search filter. <strong>NOTE:</strong> The Search Filter tab does not display when the Custom Filter dialog box is accessed from the Detailed Log tab in the Contextual Pane.</td>
</tr>
<tr>
<td>Operator</td>
<td>Lists the mathematical operators. The list of operators displayed in this box depends on the column type.</td>
</tr>
<tr>
<td>Value</td>
<td>Allows you to specify values. Depending on the column type, you can either select a value from the drop-down list or enter a value in the text field.</td>
</tr>
<tr>
<td>Add Filter</td>
<td>Adds a new filter expression row with the Operator and Value fields to the Custom Filter dialog box.</td>
</tr>
<tr>
<td>Remove Filter</td>
<td>Removes the filter set on the particular column. <strong>NOTE:</strong> In order to enable the Remove Filter button, you must select the check box preceding the Operator and Value fields corresponding to the result filter expression to be deleted.</td>
</tr>
</tbody>
</table>
AND
This is a logical operator that allows you to combine filter expressions and create complex filters. This button is available only when you add a new filter expression row and select the check boxes preceding the Operator drop-down list in the filter expression rows.

OR
This is a logical operator that allows you to combine filter expressions and create complex filters. This button is available only when you add a new filter expression row and select the check boxes preceding the Operator drop-down list in the filter expression rows.

Move to Search Filter
Displays only when the Result Filter tab is selected. Allows you to move the result filter to a search filter.

Filter expression field
Displays the filter expression. In case of multiple filter expressions, the OR operator is applied by default.

Time Filter Dialog Box
This dialog box allows you to define Result and Search filter expressions on a particular date/time column. You can access this dialog box using any of the following methods:

- Clicking the drop-down arrow on a column heading displaying date/time values, positioning your cursor over Date Filters and then selecting Custom Filter.
- Right-clicking a log view entry displaying date/time data and selecting Custom Filter.
### Time Filter Dialog Box Components

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Result Filter</td>
<td>Allows you to specify a result filter.</td>
</tr>
<tr>
<td>Search Filter</td>
<td>Allows you to specify a search filter.</td>
</tr>
<tr>
<td>NOTE: The Search Filter tab does not display when the Time Filter dialog box is accessed from the Detailed Log tab in the Contextual Pane.</td>
<td></td>
</tr>
<tr>
<td>Exact</td>
<td>Allows you to filter data based on the exact date specified.</td>
</tr>
<tr>
<td>Custom</td>
<td>This option allows you to set the date and time as per your requirement.</td>
</tr>
<tr>
<td>Selecting the Custom option enables the From and To fields. The To date should always be greater than From date. If the To date is less than the From date, then the To field is highlighted in red color and an error message displays when you move your cursor over the field.</td>
<td></td>
</tr>
<tr>
<td>Relative</td>
<td>Relative has two options: Last and Current Period.</td>
</tr>
<tr>
<td>Last</td>
<td>The Last option allows you to filter data for the last ‘x’ (where x stands for a number) period that you specified. Valid periods are hours, months, years, weeks, days, or minutes.</td>
</tr>
<tr>
<td>Current Period</td>
<td>The Current Period option allows you to filter data for the current x period. Valid periods are current x hours, months, years, weeks, days, or minutes. For example, if the current date and time on your computer is 10/07/2014 10:35 AM and you specify any of the following:</td>
</tr>
<tr>
<td>1 Hour in Last</td>
<td>The data for the 9:00 to 10:00 AM period is retrieved.</td>
</tr>
<tr>
<td>1 Hour in Current Period</td>
<td>The data for the 10:00 to 11:00 AM period is retrieved.</td>
</tr>
<tr>
<td>Last</td>
<td>The data for the period June 01, 2017 to July 01, 2017 is retrieved.</td>
</tr>
<tr>
<td>Last</td>
<td>The data for the period July 01, 2017 to August 01, 2014 is retrieved.</td>
</tr>
<tr>
<td>Last</td>
<td>The data for the period January 01, 2016 to January 01, 2017 is retrieved.</td>
</tr>
<tr>
<td>Current Period</td>
<td>The data for the period January 01, 2017 to January 01, 2018 is retrieved.</td>
</tr>
<tr>
<td>Unlimited</td>
<td>Default selection. Allows you to retrieve all records.</td>
</tr>
<tr>
<td>Null</td>
<td>Allows you to retrieve records with Null value.</td>
</tr>
<tr>
<td>Move to Search Filter</td>
<td>Displays only when the Result Filter tab is selected. Allows you to move the result filter to a search filter.</td>
</tr>
<tr>
<td>Preview of Resulting Time range</td>
<td>Displays the resulting time range for the options selected in the Time Filter dialog box. For example, if the present time is 08/07/2014 10:35 AM, then for the Current 1 hour selection, the Preview of Resulting Time Range displays the following:</td>
</tr>
<tr>
<td>From: Tuesday, July 08, 2014 10:00:00 AM</td>
<td></td>
</tr>
<tr>
<td>To: Tuesday, July 08, 2014 11:00:00 AM</td>
<td></td>
</tr>
<tr>
<td>NOTE: The Last and the Current Period fields accept only integer values up to three digits.</td>
<td></td>
</tr>
</tbody>
</table>

### Related Topics

- Moving Result Filters to Search Filters [➙ 340]
- Applying Result Filters on Columns other than Date/Time [➙ 338]
- Applying Result Filters on Date/Time Columns [➙ 339]
- Applying Search Filters on Columns other than Date/Time [➙ 336]
- Applying Search Filters on Date/Time Columns [➙ 336]
- Applying Search Filters on Columns Not Present in the Log View [➙ 342]

### 9.2.7 Search Filter Dialog Box

The Search Filter dialog box allows you to view a search filter condition and specify a filter condition on the columns that are not present in the log view. It also allows...
you to view, modify, and delete a combined search filter expression. You can apply the search filter on all columns except columns of type date and time.

![Search Filter Dialog Box](image)

**Figure 46: Search Filter Dialog Box**

<table>
<thead>
<tr>
<th>Search Filter Dialog Box Components</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Available Columns</strong>&lt;sup&gt;1&lt;/sup&gt;</td>
</tr>
<tr>
<td><strong>Operators</strong>&lt;sup&gt;1&lt;/sup&gt;</td>
</tr>
</tbody>
</table>
| **Values**<sup>1</sup>            | Lists all the values associated with a specific column selected in the Available Columns list. You can also select multiple values by pressing **CTRL** or **SHIFT** and selecting multiple values.  
**NOTE:** Multiple values can be typed within braces {} and separated by a semicolon (;). |
### Filter expression field
Displays the filter expression. You can edit a filter expression in this field. **NOTE:** An invalid filter expression displays in red.

### Add/Update
Allows you to add or update a filter expression. **Update** is enabled only when a valid filter expression is added or modified in the Filter expression field.

### And
This is a logical operator that allows you to combine filter expressions and create complex filters. This button is unavailable until a filter expression is added to the Filter expression field.

### "()"
Allows you to group filter conditions, which define the order of their evaluation. These brackets are unavailable until a filter expression is added to the Filter expression field.

---

1) The selected item displays below the list

### 9.2.8 Detailed Log Tab

You can view information related to system activities and events through the **Detailed Log** tab.

The information displayed in the **Detailed Log** tab is related to the following:

- An object selected from System Browser: When you select an object from the System Browser, the **Detailed Log** tab displays the latest 100 activities for that object.

- An object is selected from any application, such as **Graphics**, **Trends**, **Textual Viewer**, or **Reports**: If you select an object from any application, the **Detailed Log** tab displays the latest 100 Activities and Event Log records for the object.

- An activity or event type record is selected from the log view: When you select an activity type record from a log view, the latest 100 Activities and Event Logs for the selected object display in the **Detailed Log** tab. However, if an event type record is selected, the details of the selected event including the different state changes of the event and the user activities performed in context of the event are displayed in the **Detailed Log** tab of Event List, Investigative Treatment, and Assisted Treatment windows.

- Event handling: When you select an event from the Event List, the details of the selected event including the different state changes of the event and the user activities performed in context of the event are available in the **Detailed Log** tab of Event List, Investigative Treatment, and Assisted Treatment windows.

The **Detailed Log** tab however, does not display any information if you have selected more than one object.
You can customize the information displayed in the **Detailed Log** tab by:
- Applying Result Filters on Columns other than Date/Time
- Applying Result Filters on Date/Time Columns
- Selecting columns to be displayed
- Hiding columns
- Sorting Log Entries
- Reordering and Resizing Columns

By default, the following information displays for activity and event type data in the **Detailed Log** tab.

<table>
<thead>
<tr>
<th>Information Type - Activity</th>
<th>Information Type - Event</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date/Time</td>
<td>Date/Time</td>
</tr>
<tr>
<td>Source Property</td>
<td>RecordType</td>
</tr>
<tr>
<td>LogType</td>
<td>Source Property</td>
</tr>
<tr>
<td>Action Details</td>
<td>Event Message</td>
</tr>
<tr>
<td>Action</td>
<td>Event Category</td>
</tr>
<tr>
<td>Value</td>
<td>Event Time</td>
</tr>
<tr>
<td>Previous Value</td>
<td>Event Cause</td>
</tr>
<tr>
<td>Quality</td>
<td>Event ID</td>
</tr>
<tr>
<td>Previous Quality</td>
<td>Value</td>
</tr>
<tr>
<td>Unit</td>
<td>Unit</td>
</tr>
<tr>
<td>Action Result</td>
<td>User</td>
</tr>
<tr>
<td>User</td>
<td>Validation Profile</td>
</tr>
<tr>
<td>Validation Profile</td>
<td>Object Version</td>
</tr>
<tr>
<td>Audit Trail</td>
<td>Event Details</td>
</tr>
<tr>
<td>Object Version</td>
<td>Category Priority</td>
</tr>
<tr>
<td>Comment</td>
<td>Reference Time</td>
</tr>
</tbody>
</table>

You can also save the settings in the **Detailed Log** tab as default template. You can create individual customized templates for displaying activity and event information by specifying the respective columns, their order and size, and by applying sorting on the data displayed. Filters applied are not retained in the default template.

In a Distributed System, the **Detailed Log** tab displays the default template of the system that is associated with the currently selected object.
Figure 47: Detailed Log Tab

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SaveAsDefault</td>
<td>Saves the selected columns in the Detailed Log tab as a default template.</td>
</tr>
<tr>
<td>Refresh</td>
<td>Refreshes the data displayed in the Detailed Log tab.</td>
</tr>
<tr>
<td>Stop Execution</td>
<td>Stops the execution of the log view in the Detailed Log tab.</td>
</tr>
<tr>
<td>Select Columns</td>
<td>Displays the Select Columns dialog box that allows you to select the columns to display in the Detailed Log tab.</td>
</tr>
<tr>
<td>Remove all Result Filters</td>
<td>Removes all the Result filters applied to the log data in the Detailed Log tab.</td>
</tr>
<tr>
<td>Print</td>
<td>Displays the Print dialog box that allows you to print the log data displayed in the Detailed Log tab.</td>
</tr>
</tbody>
</table>

Related Topics
Event List Reference [➙ 96]
Investigative Treatment Window Reference [➙ 98]
Assisted Treatment Window Reference [➙ 99]
10 Macros
This section provides instructions and background information for using Macros in Desigo CC.

10.1 Working with Macros
This section provides step-by-step instructions for using Macros in Desigo CC. For background information, see Macros Reference [➙ 366]. Perform the procedures in this section as needed.

10.1.1 Browsing the Existing Macros in the System
1. In System Browser, select Application View.
2. Select Applications > Logics > Macros.
   ➔ The macros configured in the system display in the Macros folder, and may be further organized into subfolders under it.
3. To examine a particular macro, select it in System Browser.
   ➔ Properties and commands for the selected macro display in the Operation tab.

Related Topics
Properties and Commands of a Macro [➔ 367]

10.1.2 Executing a Macro from the Operation Tab
1. In System Browser, select Application View.
2. Select Applications > Logics > Macros > [Macro to be executed].
   ➔ The properties of the macro display in the Operation tab.
3. Click Enable to enable the macro.
4. Check that the Activity Status of the macro is Idle. If it is Running, you must wait for the macro to finish, or click Abort to interrupt it.
5. Once the macro is both Enabled and Idle, click Execute to run it.
   ➔ The Activity Status changes to Executing, and then back to Idle when the macro finishes running. An execution outcome message displays alongside the button, and the Last Execution properties update accordingly.

Related Topics
Properties and Commands of a Macro [➔ 367]
10.1.3 Executing a Macro from a Graphic

Macros can also be executed from a graphic, if a special macro button is placed on the graphic. Clicking the button in the graphic will put the object in focus in the Operation tab. The macro can be executed from there, or you can right-click the button and open the Status and Commands window from where you can operate the macro.

10.1.4 Manually Executing the Project Backup Macro

➤ You want to make a backup of the project database using the predefined system macro provided for this purpose.

1. In System Browser, select Application View.
2. Select Applications > Logics > Macros > Backups > Backup Online.
3. In the Operation tab, click Execute.

➤ The system begins backing up the project database. The default backup location is C:\GMSBackups.

Related Topics
Properties and Commands of a Macro [➙ 367]

10.1.5 Using a ‘Block Command Macro’ to Acknowledge all Devices on a Fire Network

Scenario: You want to use a block command macro to send an Acknowledge command simultaneously to all the devices on a specific BACnet fire network. In this example, the network is called firenet1.

➤ The Block-Acknowledge command (BLOCK_ACK_firenet1) is enabled for the firenet1 network.

1. In System Browser, select Application View.
2. Select Applications > Logics > Macros > Block Command Macros > BLOCK_ACK_firenet1.
3. In the Operation tab, click Execute.

➤ The system broadcasts the Acknowledge command to all the devices on the firenet1 network.

Related Topics
Block Command Macros [➙ 369]
Macros are predefined lists of instructions that enable you to issue a sequence of commands to specified devices with a single action. Some macros can be started manually by the operator, while others may be run automatically by the system as part of automatic reactions (see Reactions Reference [➙ 371]).

In Operating mode you can view the macros already configured in the system and manually execute (run) or abort (interrupt) them. You can also enable or disable macros. For related procedures, see Working with Macros [➙ 364].

Location of Macros
Macro objects are located under Applications > Logics > Macros in the Application View of System Browser. They may be further organized into subfolders under the main Macros folder.
System-Defined Macros
The following subfolders contain predefined special-purpose macros, created by the system:

- **Backups** (always present): These are macros that create backup copies of the system data. **Backup History** backs up the history (sql) database. **Backup Online** backs up the project database.

- **Block Command Macros** (present in some configurations). These are macros for broadcasting fire alarm handling commands (such as Acknowledge, Reset, and Silence/Unsilence) to multiple devices at the same time. See Block Command Macros [➙ 369].

### 10.2.1 Properties and Commands of a Macro
When you select a macro object in System Browser, its properties and commands display in the **Operation** tab.

![Figure 48: Select a Macro to View its Information and Commands](image1)

![Figure 49: Macro Properties and Control Commands](image2)
### Macro Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operational Status</td>
<td>Indicates whether the macro is enabled (meaning it is available to be run by the user):</td>
</tr>
<tr>
<td></td>
<td>- <strong>Enabled</strong>: the macro is currently active, and the Disable command is available.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Disabled</strong>: the macro is currently inactive, and the Enable command is available.</td>
</tr>
<tr>
<td>Activity Status</td>
<td>Indicates whether the macro is currently running, aborting, or not running:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Executing</strong>: the macro is running.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Idle</strong>: the macro is not running.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Aborting</strong>: the macro is in the process of stopping.</td>
</tr>
<tr>
<td>Last Execution Status</td>
<td>Indicates the outcome the last time the macro was run:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Never Executed</strong>: the macro has not previously been run.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Succeeded</strong>: the previous execution of the macro ended successfully.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Aborted by user</strong></td>
</tr>
<tr>
<td></td>
<td>- <strong>Failed</strong></td>
</tr>
<tr>
<td></td>
<td>- <strong>Partially failed</strong></td>
</tr>
<tr>
<td>Last Execution User</td>
<td>Name of the user who last executed the macro.</td>
</tr>
<tr>
<td>Last Execution Time</td>
<td>Date and time when the macro was last executed.</td>
</tr>
</tbody>
</table>

### Macro Control Commands

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable</td>
<td>Disabling a macro prevents it from being executed by any operators or stations, while still retaining the macro within the system. For example, you might do this for macros that are not yet complete or ready to be put into general use. You can only disable a macro if it is Idle.</td>
</tr>
<tr>
<td>Enable</td>
<td>Enabling a macro makes it available to be executed by all authorized users of the system or by the management platform itself. If a macro is disabled, you must enable it before you can execute it. Newly-created macros are enabled by default.</td>
</tr>
<tr>
<td>Abort</td>
<td>Interrupts execution of the macro. You can abort a macro if it is currently Executing. Note that a macro in execution can be aborted at any time regardless of whether any of its instructions will be executed with an initial delay.</td>
</tr>
<tr>
<td>Execute</td>
<td>Runs the macro. You can only execute a macro if it is Enabled and Idle. When the macro finishes running, an execution successful message displays alongside the command, and the Last Execution properties update accordingly.</td>
</tr>
</tbody>
</table>
Disabling Macros
Do not disable any of the system macros (in the Backups or Block Command Macros folders), as this will prevent the system from properly executing the associated functions.

If a macro is used in a reaction or other automated logic (schedule, and so on) then disabling the macro will result in a failure of the corresponding reaction/schedule. Also, if a macro is invoked by another macro (nested macros) then disabling it will result in a failure of the calling macro.

---

NOTE:
When you disable a macro, the management platform generates an event. This event is automatically cleared when you re-enable the macro.

10.2.2 Block Command Macros
Block-command macros are macros that broadcast a fire alarm handling command--such as Acknowledge, Reset, and Silence/Unsilence--to all the devices on a given fire network at the same time.

Each block command macro is associated with a specific fire network, meaning the command in the macro will be sent to all the devices on that network. For example, BLOCK_ACK_net will send an Acknowledge command to all the devices on the network called net.

Location of Block Command Macros
Block Command macros are located under Macros > Block Command Macros subfolder. This contains any block command macros already created in the system.

<table>
<thead>
<tr>
<th>System Browser</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application View</td>
</tr>
<tr>
<td>Show Description</td>
</tr>
<tr>
<td>Send</td>
</tr>
<tr>
<td>Applications</td>
</tr>
<tr>
<td>Address Book</td>
</tr>
<tr>
<td>Documents</td>
</tr>
<tr>
<td>Graphics</td>
</tr>
<tr>
<td>Log Viewer</td>
</tr>
<tr>
<td>Logics</td>
</tr>
<tr>
<td>Macros</td>
</tr>
<tr>
<td>Backups</td>
</tr>
<tr>
<td>Block Command Macros</td>
</tr>
<tr>
<td>BLOCK_ACK_net</td>
</tr>
<tr>
<td>BLOCK_RESET_net</td>
</tr>
<tr>
<td>BLOCK_SILENCE_net</td>
</tr>
<tr>
<td>BLOCK_UNSILENCE_net</td>
</tr>
</tbody>
</table>
- When you send an alarm-handling command from Event List (for example, **ACK**), the corresponding block command macro is automatically invoked (for example **BLOCK_ACK_net**) to broadcast that command to the entire fire network.

- When you send an alarm-handling command to an object from the **Operation** tab or **Graphics Viewer** tab, the block command macro may or may not be invoked. See the documentation of the specific fire network.
11 Reactions
This section provides background information and instructions for using Reactions in Desigo CC.

11.1 Enabling or Disabling a Reaction
▷ You want to manually change the operational status of a reaction.
1. In System Browser, select Application View.
2. Select Applications > Logics > Reactions > [reaction].
   ◄ In the Operation tab, the Operational Status (Enabled/Disabled) of the reaction displays.
3. Click Enable or Disable.
   ◄ The Operational Status (Enabled/Disabled) of the reaction updates accordingly.

Related Topics
Properties and Commands of a Reaction [➙ 372]

11.2 Reactions Reference

Reactions are automations programmed into the system, so that when a specific situation occurs on the site, a command or series of commands—similar to those in a macro—are automatically executed.

For example, in Total Building Solution (TBS) architectures (combination of danger management and building automation), a reaction may be configured to control a fire door or a ventilation system when a fire alarm occurs.

In Operating mode you can only view the reactions already configured in the system, and issue commands to enable or disable them.

Location of Reactions
Reaction objects are located under Applications > Logics > Reactions in the Application View of System Browser. They may be further organized into subfolders under the main Reactions folder.
11.2.1 Properties and Commands of a Reaction

When you select a reaction object in System Browser, its properties and commands display in the **Operation** tab.

![Figure 50: Select a Reaction to View its Information](image)

![Figure 51: Reaction Properties and Commands](image)
### Reaction Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Operational Status</strong></td>
<td>Indicates whether the reaction is enabled or disabled, and the reason why if it is disabled:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Enabled</strong>: The reaction is currently active, and the Disable command is available in all Activity Status conditions, except Executing.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Disabled</strong>: The reaction is currently inactive, and the Enable command is available.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Disabled for invalid configuration</strong>: The reaction is currently inactive owing to its invalid configuration. The Disable and Enable commands are unavailable.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Disabled for missing license</strong>: The reaction is currently inactive because some or all required license options are missing.</td>
</tr>
<tr>
<td></td>
<td>- If the reaction was enabled and the license is lost, the Disable and Enable commands are unavailable. If the reaction was disabled, when the license is lost, the Enable command will appear available, but you still cannot enable the reaction.</td>
</tr>
<tr>
<td><strong>Activity Status</strong></td>
<td>Indicates whether the reaction is currently running:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Executing</strong>: the reaction is running.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Idle</strong>: the reaction is not running.</td>
</tr>
<tr>
<td><strong>Last Execution Status</strong></td>
<td>Indicates the outcome the last time the reaction was executed:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Never Executed</strong></td>
</tr>
<tr>
<td></td>
<td>- <strong>Succeeded</strong></td>
</tr>
<tr>
<td></td>
<td>- <strong>Aborted by user</strong></td>
</tr>
<tr>
<td></td>
<td>- <strong>Failed</strong></td>
</tr>
<tr>
<td></td>
<td>- <strong>Exception</strong></td>
</tr>
<tr>
<td><strong>Last Execution Time</strong></td>
<td>Date and time when the reaction was last executed.</td>
</tr>
</tbody>
</table>

### Reaction Control Commands

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Disable</strong></td>
<td>Disabling a reaction prevents it from being triggered, while still retaining the reaction within the system. For example, you might do this for reactions that are not yet complete or ready to be put into general use. You can disable a reaction if it is Enabled and currently Idle.</td>
</tr>
<tr>
<td><strong>Enable</strong></td>
<td>Enabling a reaction means that it will be executed when its trigger conditions occur. If a reaction is disabled, you need to enable it first before the management platform can execute it. You can enable a reaction if it is currently Disabled (but not due to missing license or invalid configuration).</td>
</tr>
</tbody>
</table>

**Related Topics**
Enabling or Disabling a Reaction [⇒ 371]
12 Organization Modes
This section provides background information and instructions for using Organization Modes in Desigo CC.

12.1 Manually Setting an Organization Mode
Scenario: You want to manually change the value of the Day and Night organization mode from Day to Night.
1. In System Browser, select Management View.
2. Select Project > System Settings > Organization Modes.
3. From the Organization Modes folder, select Day and Night.
   In the Operation tab, the Value parameter displays the current value of the organization mode.
4. From the drop-down list, select Night.
5. Click Set.
   The Value parameter is saved with the new setting.

Related Topics
Organization Modes Reference [➙ 374]

12.2 Organization Modes Reference
Organization modes are system objects that can reflect the operational status or schedule of the building control site (for example, whether the facility is open or closed, its occupancy status, whether it is day or night, and so on).
- Organization modes are used as inputs that combined with other conditions can trigger a variety of automated functions. For example, to trigger reactions, automated handling of alarms, operating procedures, or graphic animations.
- Organization modes are typically set by automated logic (for example, as a result of a schedule or reaction). But they can also be toggled manually by the operator.
- The system comes with some predefined organization modes, but you can also configure additional ones.

In Operating mode, you can view existing organization modes, manually toggle their state, or create schedules to automatically set them. For related procedures, see Working with Organization Modes.

Location of Organization Modes
Organization mode objects are accessed in the Management View of System Browser, under Project > System Settings > Organization Modes.
The list under **Organization Modes** includes the predefined organization modes (Day and Night, Occupancy Status, On and Off, Open and Close, Operational Status) as well as any others that have been configured.

### Values of an Organization Mode

Each organization mode has a set of associated values. For example, the predefined **Occupancy Status** organization mode has two possible values: Occupied or Unoccupied.

You can view the current value of an organization mode in the **Operation/Extended Operation** tab, and also manually set its value from there. See Properties and Commands of an Organization Mode [➙ 375]. However, organization modes are more commonly set by automated logic.

#### 12.2.1 Properties and Commands of an Organization Mode

When you select an organization mode object in System Browser (for example, On and Off), you can view its current **Value** in the **Operation** tab.

To manually toggle the organization mode, you can select a different value from the drop-down list (for example, Off) and click **Set**.
13 Address Book
This section provides background information and instructions for using the Desigo CC Address Book.

13.1 Working with Address Book
This section provides step-by-step instructions for some common Address Book tasks. For background information, see Address Book Reference [➙ 378]. Perform the procedures in this section as needed.

13.1.1 Creating Email Recipients for Reports in the Address Book
1. In System Browser, select Application View.
2. Select Applications > Address Book.
   ➔ The Address Book workspace displays.
3. Click Add recipient .
   ➔ A new empty row is added to the list of contacts.
4. Click the newly-created row to select the contact.
5. Open the Details expander.
   ➔ From here you can enter the details of the new contact.
6. In the General expander, enter contact’s full name in the Full Name field (for example, John Doe). This value has to be unique.
7. In the Devices expander, enter the contact’s full email address in the Email1 field.
8. (Optional) If you have other email addresses for that contact, you can enter them in the Email2 and Email 3 fields.
   NOTE: When you email a report, you will be able to choose from all the configured email addresses for that contact.
9. Click Save .
   ➔ The contact’s entry in the list updates to display the details you entered.
10. Repeat this procedure to add other email recipients.

Related Topics
Address Book Reference [➙ 378]
Overview of Reports [➙ 269]

13.1.2 Creating Recipient Groups for Remote Notifications in the Address Book
1. In System Browser, select Application View.
2. Select Applications > Address Book.
   ➔ The Address Book workspace displays.
3. Click Add recipient .
   ➔ A new empty row is added to the list of contacts.
4. Click the newly-created row to select the contact.
5. Open the **Details** expander.
   ✚ From here you can enter the details of the new contact.

6. In the **General** expander, enter the contact's full name in the **Full Name** field (for example, John Doe). This value has to be unique.

7. In the **Devices** expander, enter the contact’s email address in the **Email1** field, and enter the contact’s mobile phone number in the **SMS1** field.

8. In the **Preferred Device** expander, from the **Preferred device** drop-down list, select **Email1**, and from the **Fallback device** drop-down list, select **SMS1**.
   **NOTE:** With this setting, when the system attempts to send out notifications to the contact, it will try sending an email first. If that fails, it will try sending an SMS.

9. In the **Groups** expander, enter the name of the group you want to create (in this example, Operators) directly into the empty drop-down list field and click **Add**.
   ✚ The Operators group displays in **Groups** expander for this contact.

10. Click **Save**.
    ✚ The contacts list updates to display the details you entered.

11. Repeat the following steps to add other contacts to the Operators group:
    a. Repeat steps 3 through 8 to create another contact.
    b. In the **Groups** expander, select Operators from the drop-down list.
    c. Click **Save**.

**Related Topics**
Address Book Reference [➙ 378]
Remote Notifications Reference [➙ 143]

### 13.1.3 Assigning Existing Address Book Contacts to a Recipient Group for Remote Notifications

**Scenario:** You want to use the remote notifications feature. For this, you need to have at least one group of recipients configured in the Desigo CC address book. In this example you will create a recipient group called Supervisors, and then assign some existing contacts in the address book to this group.

➤ You already have a set of contacts entered in the Desigo CC address book.

1. In System Browser, select **Application View**.

2. Select **Applications > Address Book**.
   ✚ The **Address Book** workspace displays.

3. In the contacts list, click the first contact that you want to add to the Supervisors group.
   ✚ The contacts' information displays in the **Details** expander.

4. In the **Groups** expander, enter the name of the group you want to create (in this example, Supervisors) directly into the empty drop-down list field.

5. Click **Add**.
   ✚ The Supervisors group displays in **Groups** expander for this contact.

6. Click **Save**.
   ✚ The contact’s entry in the list updates to display Supervisors in the **Groups** column.
7. In the contacts list, click the next contact that you want to add to the Supervisors group.

8. In the Groups expander, select Supervisors from the drop-down list.

9. Click Save.

10. Repeat Steps 7-9 for all the contacts that you want to add to the Supervisors group.

Related Topics
Address Book Reference [➙ 378]
Importing Outlook Contacts into the Address Book [➙ 378]
Remote Notifications Reference [➙ 143]

13.1.4 Importing Outlook Contacts into the Address Book

You have a CSV file containing the contacts exported from Microsoft Outlook, which meets the requirements set out in Outlook Import Rules for the Address Book [➙ 382].

System Manager is in Operating or Engineering mode.

1. Copy the CSV file to removable storage or to a location you can access from the Desigo CC computer.

2. In System Browser, select Application View.

3. Select Applications > Address Book.
   -> The Address Book workspace displays.

4. Click Import address book.

5. In the Open dialog box, browse for and select the CSV contacts file that you want to import.

6. Click Open.
   -> When the import procedure is complete, a message box informs you of how many new contacts were created, how many existing ones were updated, and how many were skipped owing to importing rules.

7. Click OK.
   -> The imported contacts are available in the Address Book workspace.

Related Topics
Address Book Reference [➙ 378]

13.2 Address Book Reference

The Desigo CC address book stores a list of contacts (called recipients) which the system can use for sending out remote notifications or for emailing reports. The contacts you add to the address book do not have to be Desigo CC users. This is an entirely separate list.

You can view and edit the address book in both Operating and Engineering mode. For related procedures, see Working with Address Book [➙ 376].

Location of the Address Book
The address book is accessed in the Application View of System Browser, at the path Applications > Address Book.
The left panel shows the list of contacts already configured in the address book. The Details expanders on the right displays the details of the currently selected contact. See Details of an Address Book Contact [➙ 379] for more information about these fields.

13.2.1 Details of an Address Book Contact

When you select a contact in the Address Book, the Details expanders displays all the information about that individual.

**General:**
- **Full Name:** For example, John Doe. This value must be unique.
- **Short Name:** Optional nickname or initials for the contact.
- **Language:** Default is English (U.S.).

**Groups:**
Here you can optionally assign a contact to one or more Groups (for example, Operator, Administrator, and so on).
NOTE:
Groups are required for remote notifications, which are addressed to recipient groups, not to individuals. You do not need groups for reports, which can instead be emailed to individual contacts.

The Groups expander shows any groups to which the selected contact is already assigned.

- To assign a contact to an existing group, you must select the group name from the drop-down list and click Add. (The drop-down list shows only the groups to which the contact does not already belong.)
- To remove a contact from a group, you must select the group name in the field and click Remove. If all contacts are removed from a group (the group becomes empty) the group itself is eliminated, and no longer displays in the drop-down list.
- To create a new group and assign it to the contact, you must type a new group name directly into the empty drop-down list field, click Add, and click Save. This group will then become available in the drop-down list for other contacts as well.
- To rename a group, select the group from the Groups expander, you must type its name in the drop-down list field, click Update, and click Save. The group will be renamed for all the contacts that use it.

Devices:
Here you can specify one or more devices, that is, methods which can be used for contacting that person, such as email addresses, mobile phone numbers for SMS messages, and/or a pager number:

- Email: you can specify up to three email addresses.
- SMS: you can specify up to two mobile phone numbers for SMS messages.
- Number/Provider: Depending on the pager service configured, you must specify a pager number only or a pager number and provider.

NOTE:
Reports can be sent by email. Remote notifications can be sent by email, SMS, and/or pager. For each of these communication methods to work, the corresponding service (email, SMS or pager) needs to be configured on the management platform.

Preferred Device:

- Preferred Device: This is the first method of contacting the person to be tried. By default, it is set to the first email address that you configured in the Devices expander. You can select a different preferred device from the drop-down list.
- Fallback Device: This is the method that will be used if sending a message to the preferred device fails. It has to use a different service from the preferred device. For example, if the preferred device is an email address, the fallback cannot be a different email address. It has to be an SMS number or a pager number.
NOTE:
The preferred and fallback device settings are used only by remote notifications. When you email a report you can choose from all the email addresses entered for each contact.

13.2.2 Address Book Toolbar

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save Recipient</td>
<td>Save any changes made to the details of the currently selected contact.</td>
</tr>
<tr>
<td>Add Recipient</td>
<td>Add a new contact to the address book.</td>
</tr>
<tr>
<td>Remove Recipient</td>
<td>Delete the currently selected contact.</td>
</tr>
<tr>
<td>Remove All Recipients</td>
<td>Clear the entire address book.</td>
</tr>
<tr>
<td>Import Address Book</td>
<td>Import a CSV contacts file exported from Microsoft Outlook.</td>
</tr>
<tr>
<td>Search in the address book</td>
<td>To search for contacts in the address book, type some characters in the search field. See Address Book Search Field [➙ 381] for more information.</td>
</tr>
</tbody>
</table>

NOTE:
If you accidentally delete a contact or clear the address book, you can recover by exiting the Address Book workspace without saving the changes made. To do this, select a different node in System Browser, and when prompted Unsaved data. Do you want to save the data before leaving this page? Click No.

13.2.3 Address Book Search Field

When the address book contains many entries, you can use the search feature to help you find a specific contact.

- To run a new search, in the Search field at the top, start typing in some letters/characters contained in the following fields: contact’s Full Name, Groups, or Preferred/Fallback Device.
  - As you type, the contact list is filtered to show only the contacts that match the entered characters.
- To repeat a recent search, or to quickly filter by groups, click the Search-field drop-down list to display a list of your Recent Searches, along with a list of the configured Groups (under Saved Searches).
  - Click a search in the list to repeat it.
  - Click x alongside a search to remove it from the list.
- To clear a search, click X alongside the search field to remove the filter and display the full contact list again.
13.2.4 Outlook Import Rules for the Address Book

The Desigo CC address book can import CSV contacts files exported from Microsoft Outlook 2003 and 2007 but only in English language.

If a CSV file is not already available, you can export contacts from Microsoft Outlook into a CSV file as follows:

- If your language is not English, change this setting to English in Microsoft Outlook before proceeding to export the contacts. See also:
- In Microsoft Outlook, select **File > Import and Export > Export to a File > Comma-Separated Values** and then choose a location on disk and a name for the file (for example, myContacts.csv).
  - The CSV file is created in the specified location.

Once you have obtained an exported CSV file, you can check it by opening it in a text editor. You should see:

- A multi-line text file where each line contains values separated by commas.
- The first row contains the field headers, while the succeeding rows contain the data, one contact per row.

The fields in the **Address Book** workspace are populated with data from the CSV file as follows:

- **Preferred Device.** The contact’s first valid email address in the CSV file is set as the preferred device. If there is no valid email address, a mobile phone number or pager is taken as the preferred device. If there is no valid email, SMS number, or pager number, then the contact is skipped (not added to the address book).
- **SMS.** Phone numbers in the CSV file can contain the following special characters:
  - A plus sign (+) as a prefix to the number; during import this character is replaced by two zeros (00).
  - An empty space, a hyphen (-), or a comma (,) between digits; during import these characters are removed.
- **Full Name.** The contact’s first name, middle name and last name (with space as a separator) in the CSV file are used to populate the **Full Name** field in the address book. It is limited to 50 alphanumeric characters.
- **Email.** Email addresses are limited to 50 alphanumeric characters. If the email address in the CSV file exceeds this limit, the field in the address book is left empty.

The following rules apply when re-importing a CSV file (for example, an updated version of a previously-imported Outlook contacts file):

- Any duplicated contacts (for which all the fields are unchanged) are skipped.
- If the preferred device field is changed (for example, a different email address), a new entry for the same contact is created.
- If any other data is changed (for example, name or other phone number) the existing contact entry in the address book is updated.
14 Documents

This section provides background information and instructions for using Documents in Desigo CC.

14.1 Working with Documents

This section provides step-by-step instructions for some common Documents tasks. For background information, see Documents Reference [➙ 385]. Perform the procedures in this section as needed.

14.1.1 Viewing the Documents Configured in the System

1. In System Browser, select Application View.

2. Select Applications > Documents.

   ➤ The document objects configured in the system display under the Documents folder. They may be further organized into subfolders.

3. To view one of the documents, select it in System Browser.

   ➤ The contents of the document display.

4. If the document is a PDF, you can click Zoom in, Zoom out, or Print the document.

Related Topics
Documents Reference [➙ 385]

14.1.2 Opening Documents from Related Items

➤ You selected a system object, and the Related Items tab displays links to one or more documents related to that object.

1. In the Related Items tab, click the document you want to open.

   ➤ The contents of the selected document display (by default) in the Secondary pane. If the Primary pane pushpin is locked ➩ the document displays in the Primary pane instead.

2. If there are multiple documents to consult in the Related Items tab, you can look through them using:

   ➤ Backward or Forward.

   ➤ The keyboard shortcuts ALT + P (previous related item) and ALT + N (next related item).

Related Topics
Documents Reference [➙ 385]
Making a Document Display as a Related Item of Other Objects [➙ 384]
14.1.3 Setting the File or Web Link of a Document Object

1. In System Browser, select Application View.
2. Select Applications > Documents > [Document].
   ﴿ The current contents of the document display.
3. (Optional) Click Edit to display the Document Settings panel.
4. To set the new content of the document object, do one of the following:
   – Click Web URL and type in the web link that you want to use.
   – Click Select file and, from the drop-down list, choose from one of the available (txt, pdf, or rtf) files.
     
     **NOTE:** You can only choose from the files previously stored under the project documents folder at the following path on the Desigo CC Server station: ...\GMSProjects\[Project]\documents.
5. Click Preview to display the contents of the selected file or web link.
6. Click Save.
   ﴿ The document object is now associated with this new content.
7. Click Operate to go back to normal viewing of the document.

Related Topics
Document Settings Fields [➙ 386]

14.1.4 Making a Document Display as a Related Item of Other Objects

**Scenario:** A document with evacuation instructions for a building (Building1EvacuationPDF) is configured in System Browser. You now want to configure this document so that it displays as a related item of that building’s floor plan graphic (Building1_floorplan).

1. In System Browser, select Application View.
2. Under Applications > Documents > [Document] (Building1EvacuationPDF).
   ﴿ The contents of the PDF file display.
3. (Optional) Click Edit to display the Document Settings panel.
4. In System Browser, select the Manual navigation check box.
5. Under Applications > Graphics, navigate to the Building1_floorplan graphic object.
6. Drag-and-drop the Building1_floorplan graphic object into the Manually assigned field of the Associated Objects expander.
7. Click Save.
8. Click Operate to go back to normal viewing of the document.

﴿ When you next select the Building1_floorplan graphic object, a link to the Building1EvacuationPDF document will display in the Related Items tab. Clicking that link opens the PDF in the Secondary pane.

Related Topics
Documents Reference [➙ 385]
14.2 Documents Reference

The management platform can be configured to include a set of read-only reference documents for the operator to consult. These documents can be files (.PDF, .RTF, .TXT) or web links (URLs of HTML pages). They will typically contain instructions, procedures, or other information relevant to the operation of the building automation system. Note that Microsoft .DOC and .DOCX formats are not supported. Documents can be configured to display as related items of other objects, or as part of an assisted treatment procedure. They can also be consulted directly from System Browser.

For Operating mode related procedures, see Working with Documents [➙ 383].

Location of Documents

Document objects are located under Applications > Documents in the Application View of System Browser. They may be further organized into subfolders under the main Documents folder.
14.2.1 Document Settings Fields

When you select a document object in System Browser, you can click **Edit** to display the Document Settings panel which lets you modify the content of the document, and its associated objects.

**Web URL**

This option to set a web link as the content of the document.

**Select file**

This option sets a file (txt, pdf, rtf) as the content of the document. The drop-down list lets you choose from the files previously stored under the project documents folder at the following path on the Desigo CC Server station:

```
...\GMSProjects\[Project]\documents.
```

**Manually assigned**

The current document will appear as a Related Item of all the objects listed in this field. You can drag-and-drop objects here from System Browser.

**Automatically assigned**

The current document will also appear as a related item of all the objects listed in this field. These links are created by the coverage area feature of **Graphics Editor** and you cannot remove them.

**Related Topics**

Working with Documents [➜ 383]
### 14.2.2 Document Toolbar Controls

When you select a document object, a toolbar becomes available that lets you modify, save, duplicate or delete that document object.

When you select a documents folder in **Engineering** mode, a toolbar is available that lets you create/delete folders, or create new document objects.

<table>
<thead>
<tr>
<th>Selection in System Browser</th>
<th>Document Object [Operating or Engineering mode]</th>
<th>Documents Folder [Engineering mode]</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>n.a.</td>
<td>Create a new subfolder under the currently selected one.</td>
</tr>
<tr>
<td>Save</td>
<td>Save the changes made to the current document object.</td>
<td>n.a.</td>
</tr>
<tr>
<td>Save As</td>
<td>Save the currently selected document with a different name. You can use this to create a new document object from an existing one.</td>
<td>Create a new empty document object from scratch.</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete the currently selected document object.</td>
<td>Delete the currently selected documents folder, and any document objects contained inside it. (You cannot delete the main Documents folder.)</td>
</tr>
<tr>
<td>Edit</td>
<td>Display the Document Settings panel, which lets you configure the content of the document (web link or file), and the associated system objects.</td>
<td>n.a.</td>
</tr>
<tr>
<td>Operate</td>
<td>Close the Document Settings panel and go back to normal viewing of the document.</td>
<td>n.a.</td>
</tr>
<tr>
<td>Zoom in</td>
<td>Available only for PDF documents.</td>
<td>n.a.</td>
</tr>
<tr>
<td>Zoom out</td>
<td></td>
<td>n.a.</td>
</tr>
<tr>
<td>Print</td>
<td></td>
<td>n.a.</td>
</tr>
</tbody>
</table>
15 Licensing

This section provides background information about Desigo CC Licensing feature.

15.1 Licensing Reference

The Desigo CC software requires a valid license to run. Typically, the license is stored on the Desigo CC Server.

Generally, a valid customer license includes:

- A set of license features to cover the hardware configuration of the system and the site, such as the number of client stations or field points.
- A set of option license features to enable additional or extended functionality, such as Assisted Treatment or Reactions. See License Features List [➙ 389].

Depending on the license found on the server, the Desigo CC clients may run in the following ways:

- If a valid and sufficient license is found, the Desigo CC Client will run normally, with full functionality. See Normal License Mode [➙ 390].
- If no valid license is found, the Desigo CC Client can only run for 30 minutes. See Demo License Mode [➙ 391].
- If there is a valid license but it is not sufficient (for example, it does not cover all the field points in the management platform) then the Desigo CC Client can operate for a maximum of 30 days. See Courtesy License Mode [➙ 391].

Location of Licenses Information

Licenses information is located under Project > Management System > Servers > Main Server > Licenses in the Management View of System Browser.

15.1.1 Licenses Properties

When you select the Licenses node in System Browser, the license properties display in the Operation tab. This provides information about the currently active license.

<table>
<thead>
<tr>
<th>Operation</th>
<th>Extended Operation</th>
<th>Detailed Log</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Licenses</strong></td>
<td>Normal Mode</td>
<td></td>
</tr>
<tr>
<td>Sabotage attempts</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Time remaining in this session</td>
<td>00:02:02 DHH:MM</td>
<td></td>
</tr>
<tr>
<td>Time remaining in Courtesy Mode</td>
<td>29:22:35 DHH:MM</td>
<td></td>
</tr>
<tr>
<td>Total operating time with valid license</td>
<td>0:00:00 DHH:MM</td>
<td></td>
</tr>
<tr>
<td>Engineering license will expire in</td>
<td>0 d</td>
<td></td>
</tr>
</tbody>
</table>
## 15.1.2 License Features List

When you select the **Licenses** node in System Browser, the detailed list of installed license features displays in the **Default** tab.

You can also quickly automatically jump to the **Licenses** node by clicking the license text (for example, Demo Mode, or Courtesy Mode) in the Summary bar.

The tab displays the current license mode, for example, Normal Mode and a list of the installed license features.

For each license feature:
- The **Required** column indicates how many copies of that license feature must be installed for the system to operate normally (that is, for Desigo CC to run in Normal Mode). Note that the **Required** column will show 0 for option license features (such as Assisted Treatment) because the system will still function in Normal mode even without those features installed.
- The **Assigned** column indicates how many copies of that license feature are being used by the system. The assigned copies of each license feature must match (or exceed, in the case of option license features) the required copies for the system to run in Normal Mode.
- The **Remaining** column indicates how many copies of that license feature are still available (that is, how many of the installed copies are still unused).

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>License mode</td>
<td>Desigo CC current license mode.</td>
</tr>
<tr>
<td>Sabotage attempts</td>
<td>Number of sabotage attempts.</td>
</tr>
<tr>
<td>Time remaining in this session</td>
<td>Residual time in the current Demo Mode or Engineering-language session.</td>
</tr>
<tr>
<td></td>
<td>- When the 30-minute demo time expires the project will be stopped and the operator will be forced to log off.</td>
</tr>
<tr>
<td></td>
<td>- When the 48-hour Engineering license time expires, the system will switch back to its previous license mode.</td>
</tr>
<tr>
<td>Time remaining in Courtesy Mode</td>
<td>Residual time in Courtesy Mode, during which it is possible to temporarily work with the project until a valid and sufficient license is installed again.</td>
</tr>
<tr>
<td>Total operating time with valid license</td>
<td>Duration counter that indicates how long Desigo CC has been continuously working with a valid and sufficient license (that is, in Normal Mode).</td>
</tr>
<tr>
<td>Engineering license will expire in</td>
<td>How many days until the Engineering license expires.</td>
</tr>
</tbody>
</table>

For more details about the currently active license, see License Features List [➙ 389].
**NOTE 1:**
For license features covering software functionality, one assigned copy is sufficient to enable that functionality for all Desigo CC clients. For example, Assigned=1 for sbt_gms_ext_sm enables System Manager for all clients.

**NOTE 2:**
For license features covering field data points, the **Required** column indicates how many are physically connected to the Desigo CC Server: the **Assigned** column must match this value (for the system to run in Normal mode); and the **Remaining** column shows how many further points you can connect.

**NOTE 3:**
Some license features have the effect of providing unlimited copies of another license feature. For example, one assigned copy of Unlimited Web or Installed Clients (sbt_gms_add_max_cl ) sets the assigned copies of Concurrent Web or Installed Client Sessions (sbt_gms_add_client) to Unlimited.

---

**License Features Check**

On system startup and at 5-minute intervals afterwards, the Desigo CC Server carries out an automatic check on the installed license features and counts the:

- Installed Clients, Web Clients, and Windows App Clients. If a client disconnects from the server (because it is manually shut down, or owing to a malfunction), the count decreases.
- Physical objects in scan, such as Desigo CC data points, and third-party objects (for example, SCADA data points). These objects are grouped by disciplines (physical/logical objects). Every physical/logical object is represented by the corresponding data point in the database. Out of scan objects are not counted.

This check determines whether Desigo CC can run normally (**Normal Mode**) or under special restricted license modes (**Demo Mode** or **Courtesy Mode**).

---

**15.1.3 Normal License Mode**

Desigo CC is functioning normally with a valid and sufficient license (sufficient license features to cover the field hardware). In this case you will not see any special messages on the expanded Summary bar.
15.1.4 Demo License Mode

On initial startup, or during normal operation, if no valid license is found the Desigo CC Server switches to Demo Mode, and the system operates for 30 minutes. When the 30-minute Demo Mode time limit expires, the Desigo CC Server stops the project and the operators are forced to log off. If the project is subsequently restarted, the system will run in Demo Mode for another 30 minutes.

Demo Mode Characteristics

- When Demo Mode is active, this is visually indicated on the Summary bar in green, with a timer that shows how much time is left.
- If you view the license data, the license set will be highlighted in red. Assigned and Remaining will indicate 0.
- If a valid license is detected before the 30-minute Demo Mode time expires, Desigo CC switches back to Normal Mode.

NOTE:
In Demo Mode you can only switch from Engineering to Operating mode. Once you are in Operating mode you cannot switch back to Engineering mode.

15.1.5 Courtesy License Mode

The Desigo CC Server switches to Courtesy Mode when the license set is installed, but one of the following situations occurs:

- An insufficient set of license features for field points is detected. That is, the site project was configured with a certain number of physical objects, but only a subset of these are licensed. For example, if the site project was configured with 2000 fire data points but only 1000 are licensed, Courtesy Mode activates.
- The system detects 3 or more sabotage attempts within a 30-minute period. Sabotage means any unauthorized attempt to modify the system’s license data directly in the database (for example, inappropriate changes to the time remaining in a specific license mode). Only the system itself is allowed to write to the license data.

In the event of sabotage by unauthorized software:

- If the system detects fewer than 3 sabotage attempts within 30 minutes, at the end of the 30 minutes the sabotage attempt counter is reset.
- If the system detects 3 sabotage attempts within 30 minutes, Desigo CC switches to Courtesy Mode but the license features are still considered valid. An alarm is also generated to inform the operator.
- If the system detects more than 3 sabotage attempts within 30 minutes, Desigo CC switches to Courtesy Mode and the license features are invalidated (even if the license features are installed the system treats them as no longer valid).

When Courtesy Mode activates, the management platform can continue to operate for a total of 30 days cumulatively.
When Courtesy Mode is active, this is visually indicated on the Summary bar in red, with a countdown timer that shows how much time is left.

If you check the licenses, any license features that are insufficient will be highlighted in red. The **Required**, **Assigned** and **Remaining** columns will indicate the discrepancy: **Remaining** shows how many of the installed copies of that license feature are still unused while **Assigned** shows how many copies of that license feature are being used by the system.

During Courtesy Mode, if a sufficient set of license features is detected during a license check (that is, the site project was reconfigured so that all the field objects are licensed), the Desigo CC Server switches back to Normal Mode.

If the Desigo CC Server switches back to Courtesy Mode, the countdown timer does not restart from 30 days, but from the previous time remaining in Courtesy Mode.

After the Desigo CC Server has run in Normal Mode for 180 days without switching to Courtesy Mode, the next time it switches to Courtesy Mode, the countdown timer starts at 30 days.

If the time allowed for operation in Courtesy Mode expires, Desigo CC shuts down and it is necessary to install again all the license features required to run the system.

---

**Courtesy Mode Characteristics**

- When Courtesy Mode is active, this is visually indicated on the Summary bar in red, with a countdown timer that shows how much time is left.
- If you check the licenses, any license features that are insufficient will be highlighted in red. The **Required**, **Assigned** and **Remaining** columns will indicate the discrepancy: **Remaining** shows how many of the installed copies of that license feature are still unused while **Assigned** shows how many copies of that license feature are being used by the system.
- During Courtesy Mode, if a sufficient set of license features is detected during a license check (that is, the site project was reconfigured so that all the field objects are licensed), the Desigo CC Server switches back to Normal Mode.
- If the Desigo CC Server switches back toCourtesy Mode, the countdown timer does not restart from 30 days, but from the previous time remaining in Courtesy Mode.
- After the Desigo CC Server has run in Normal Mode for 180 days without switching to Courtesy Mode, the next time it switches to Courtesy Mode, the countdown timer starts at 30 days.
- If the time allowed for operation in Courtesy Mode expires, Desigo CC shuts down and it is necessary to install again all the license features required to run the system.